
Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Questa guida descrive la configurazione e l’utilizzo della Interchangeable Lens Digital Camera ILME-FR7 / ILME-FR7K.

Fare riferimento a questo manuale e alle istruzioni per l’uso dei dispositivi correlati secondo le proprie necessità.

Guida – Pagine raccomandate

Iniziando a utilizzare questo prodotto, l’utente accetta i termini del contratto di licenza del software.

Descrizione generale

Accesso all’app Web tramite un browser Web

Collegando l’unità a un tablet o a un computer, è possibile azionarla e configurarla tramite un browser Web.

Configurazione iniziale dell’unità

Inizializzazione delle impostazioni dell’unità, quali le informazioni sull’amministratore, la lingua di visualizzazione e le impostazioni
di data e ora tramite l’app Web.

Reset delle impostazioni dell’unità

È possibile ripristinare tutte le impostazioni di rete e dell’unità sulle impostazioni predefinite di fabbrica.

Pannello connettori

Questo argomento descrive la posizione e la funzione dei componenti del pannello connettori dell’unità.

Connessione di un Telecomando RM-IP500

L’unità consente il collegamento di un telecomando RM-IP500.

Specifiche tecniche

Specifiche dettagliate dell’unità.

Ricerca e risoluzione dei problemi

Descrive i sintomi, le cause e le soluzioni per i problemi che possono verificarsi durante l’utilizzo dell’unità.

Connessione dell’unità a un dispositivo di rete tramite connessione cablata

È possibile collegare l’unità a una rete priva di server DHCP (modalità indirizzo IP fisso). Vedere “Connessione a una rete senza
server DHCP”.

Tipiche applicazioni d’uso
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Operazioni preliminari

Esempio di configurazione del sistema

Comando di una singola unità utilizzando il telecomando a infrarossi in dotazione

Comando di una singola unità utilizzando un tablet o un computer

Controllo di una singola unità tramite un telecomando esterno

Comando di più unità tramite un telecomando esterno

Posizione e funzione delle parti

Vista anteriore

Vista posteriore

Pannello connettori

Vista laterale

Vista dall’alto

Vista dal basso

Supporto obiettivo

Posizione e funzione delle parti del telecomando a infrarossi (fornito in dotazione)

Schermata dell’app Web

Schermata dell’app Web – Descrizione generale

Struttura dell’area comune delle schermate

Struttura della schermata delle operazioni live

Struttura della schermata delle impostazioni PTZ AFR

Struttura della schermata delle operazioni di riproduzione

Struttura della schermata delle impostazioni

Menu della telecamera

Significato delle indicazioni a schermo

Montaggio dell’unità

Montaggio verticale in una posizione fissa

Montaggio verticale in una posizione fissa elevata

Montaggio a soffitto

Montaggio e rimozione di un obiettivo

Precauzioni per il montaggio e la rimozione di un obiettivo

Controllo dei selettori dell’obiettivo
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Ripresa

Precauzioni per l’uso di obiettivi zoom

Montaggio dell’obiettivo

Rimozione dell’obiettivo

Collegamento dei cavi

Connessione dell’unità a un dispositivo di rete tramite connessione cablata

Collegamento dell’alimentazione

Alimentazione CA

Alimentazione PoE++

Reset di pan e tilt

Configurazione prima della ripresa

Inizializzazione dell’unità tramite l’app Web

Accesso all’app Web tramite un browser Web

Configurazione iniziale dell’unità

Reset delle impostazioni dell’unità

Configurazione delle operazioni di base

Preparazione delle schede di memoria

Schede di memoria supportate

Inserimento delle schede di memoria

Espulsione di una scheda di memoria

Formattazione (inizializzazione) di schede di memoria

Controllo del tempo di registrazione rimanente

Ripristino delle schede di memoria

Operazioni di base

Avvio e arresto della registrazione

Passaggio da una scheda di memoria all’altra

Controllo dell’audio

Specifica dei dati temporali

Rivedere una registrazione (Rec Review)

Regolazione dell’inquadratura

Schermata di regolazione dell’inquadratura

Regolazione della direzione di ripresa
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Regolazione della direzione di ripresa tramite l’app Web

Impostazione della velocità di pan e tilt

Impostazione dell’accelerazione del movimento di pan e tilt

Regolazione della direzione di ripresa utilizzando il telecomando a infrarossi fornito in dotazione

Regolazione dello zoom

Impostazione del tipo di zoom

Regolazione dello zoom tramite l’app Web

Impostazione della velocità operativa dello zoom

Regolazione dello zoom utilizzando il telecomando a infrarossi fornito in dotazione

Salvataggio e ripristino delle posizioni di pan, tilt e zoom della telecamera (posizione di preset)

Calibrazione di un obiettivo E-mount

Salvataggio e ripristino delle posizioni di pan, tilt e zoom e dell’impostazione della messa a fuoco tramite l’app Web

Rinomina delle posizioni di preset tramite l’app Web

Sostituzione di una posizione di preset salvata con una nuova posizione tramite l’app Web

Eliminazione di una posizione di preset salvata tramite l’app Web

Sincronizzazione dei movimenti di pan e tilt e delle operazioni di zoom e messa a fuoco durante il ripristino di una posizione di preset

Modifica della velocità di transizione (pan-tilt/zoom/fuoco) durante il ritorno a una posizione di preset

Modifica del tempo di transizione (pan-tilt/zoom) durante il ritorno a una posizione di preset

Salvataggio e ripristino della posizione di pan e tilt e della posizione di zoom tramite il telecomando a infrarossi fornito in dotazione

Registrazione e riproduzione delle operazioni di inquadratura della telecamera (PTZ Trace)

Registrazione delle operazioni di inquadratura della telecamera tramite l’app Web

Riproduzione delle operazioni di inquadratura della telecamera tramite l’app Web

Eliminazione delle operazioni di inquadratura della telecamera tramite l’app Web

Registrazione delle operazioni di inquadratura della telecamera utilizzando il telecomando a infrarossi fornito in dotazione

Riproduzione delle operazioni di inquadratura della telecamera utilizzando il telecomando a infrarossi fornito in dotazione

Inquadratura automatica della telecamera (inquadratura automatica PTZ)

Inquadratura automatica PTZ

Configurazione delle impostazioni iniziali dell’inquadratura automatica PTZ

Specifica dei soggetti per il seguimento automatico (modalità di avvio manuale del seguimento)

Selezione e seguimento automatico dei soggetti in una posizione specificata (modalità di avvio automatico del seguimento)

Richiamo di un preset di composizione di inquadratura automatica PTZ

Rinomina di un preset di composizione di inquadratura automatica PTZ

Sostituzione di un preset di composizione di inquadratura automatica PTZ con un nuovo preset
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Controllo da remoto dello stato dell’inquadratura automatica PTZ

Regolazione della messa a fuoco

Schermata di regolazione della messa a fuoco

Regolazione manuale della messa a fuoco (Manual Focus)

Regolazione manuale tramite l’app Web

Regolazione manuale utilizzando il telecomando a infrarossi fornito in dotazione

Messa a fuoco specificando una posizione di messa a fuoco (Spot Focus)

Utilizzo della funzione di messa a fuoco automatica temporanea (Push Auto Focus (AF))

Utilizzo della funzione Single-Shot Auto Focus (Push Auto Focus (AF-S))

Regolazione automatica della messa a fuoco (Auto Focus)

Regolazione automatica tramite l’app Web

Regolazione automatica utilizzando il telecomando a infrarossi fornito in dotazione

Impostazione dell’area di messa a fuoco automatica e della sua posizione (Focus Area)

Modifica rapida dell’area di messa a fuoco (Focus Setting)

Spostamento del riquadro dell’area di messa a fuoco tramite touchscreen (area di messa a fuoco Touch)

Regolazione dell’operazione di messa a fuoco (Velocità di transizione AF, Sensibilità al cambiamento del soggetto AF)

Selezione manuale del soggetto della messa a fuoco (AF Assist) tramite l’app Web

Messa a fuoco manuale durante la messa a fuoco automatica utilizzando il telecomando a infrarossi fornito in dotazione

Messa a fuoco manuale temporanea durante la messa a fuoco automatica (Push Manual Focus)

Seguimento con la funzione di rilevamento del viso e degli occhi (Face/Eye Detection AF)

Seguimento di un soggetto specificato (Realtime Tracking AF)

Regolazione della luminosità

Schermata di regolazione della luminosità

Impostazione della sensibilità di base

Impostazione del livello ottimale per la regolazione automatica della luminosità

Regolazione del diaframma

Regolazione automatica del diaframma

Regolazione manuale del diaframma

Regolazione del guadagno

Regolazione automatica del guadagno

Regolazione manuale del guadagno

Regolazione dell’otturatore
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Funzioni utili

Regolazione automatica dell’otturatore

Regolazione manuale dell’otturatore

Regolazione del livello di luce (filtro ND)

Informazioni sul filtro ND

Regolazione in modalità Preset

Regolazione automatica in modalità variabile

Regolazione manuale in modalità variabile

Come ottenere colori naturali (bilanciamento del bianco)

Schermata di regolazione del bilanciamento del bianco

Regolazione automatica del bilanciamento del bianco

Regolazione manuale del bilanciamento del bianco

Esecuzione del bilanciamento automatico del bianco

Configurazione dell’audio da registrare

Schermata di configurazione dell’audio

Selezione del dispositivo di ingresso audio

Regolazione automatica del livello di registrazione audio

Regolazione manuale del livello di registrazione audio

Utilizzo del Direct Menu

Pulsanti programmabili

Slow & Quick Motion

Registrazione di video a intervalli (Interval Rec)

Registrazione di immagini preregistrate nella cache (Picture Cache Rec)

Registrazione simultanea sulle schede di memoria A e B (Simul Rec su 2 slot)

Monitor segnale video

Flag dei clip

Compensazione dell’effetto breathing

Registrazione proxy

Descrizione generale della registrazione proxy

Registrazione di proxy

Ripresa con il look desiderato

Descrizione generale dei look
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Funzioni di rete

Selezione di un look

Importazione del look di base desiderato

Personalizzazione di un look

Salvataggio di un look

Eliminazione di un look di base

Ripresa con regolazione del look in post-produzione

Ripresa con regolazione del look in post-produzione

Applicazione di una LUT a uscita HDMI e streaming

Modifica di una LUT

Modifica della distribuzione delle ombre e delle alte luci nell’immagine registrata

Registrazione RAW

Registrazione di video RAW

Registrazione di video RAW in modalità Slow & Quick Motion

Regolazione del bokeh (funzione di controllo bokeh)

Attivazione e disattivazione della funzione di controllo del bokeh

Regolazione del livello di bokeh

Salvataggio e caricamento dei dati di configurazione

Salvataggio e caricamento dei dati di configurazione

Salvataggio di un file ALL

Caricamento di un file ALL

Trasferimento dei file

Informazioni sul trasferimento di file

Registrazione di una destinazione di trasferimento file

Selezione di file e upload

Upload dalla schermata delle miniature di clip proxy contenuti in una scheda di memoria

Upload dalla schermata delle miniature di file originale contenuti in una scheda di memoria

Controllo dello stato del trasferimento del file

Upload tramite Secure FTP

Configurazione dello streaming

Informazioni sullo streaming
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Schermata delle miniature

Menu della telecamera e impostazioni dettagliate

Impostazione del formato di streaming

Impostazione del codec video per lo streaming

Impostazione del codec audio per lo streaming

Avvio e arresto dello streaming

Schermata delle miniature

Riproduzione di clip e altre operazioni sui clip

Riproduzione dei clip registrati

Operazioni sui clip registrati

Configurazione del menu della telecamera

Utilizzo del menu della telecamera

Utilizzo del menu della telecamera

Immissione di una stringa di caratteri

Menu User

User

Menu Edit User

Edit User

Menu Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce
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SteadyShot

Menu Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Menu Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Menu Pan-Tilt

P/T Acceleration

Menu TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life
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Menu Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Menu Audio

Audio Input

Audio Output

Menu Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Menu Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Menu Network

Wired LAN

File Transfer

Menu Maintenance

Language

Clock Set

10



Menu Web e impostazioni dettagliate

Hours Meter

Impostazioni e valori predefiniti del menu Shooting

Impostazioni e valori predefiniti di ISO/Gain

Impostazioni e valori predefiniti di AGC Limit

Impostazioni di qualità dell’immagine salvate per ciascuna modalità di ripresa

Configurazione del menu Web

Utilizzo del menu Web

Menu Shooting

Focus

Menu Project

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Menu Paint/Look

Base Look

Menu Pan-Tilt

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Menu Monitoring

Output Format

Output Display

Menu Audio

Audio Input
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Audio Output

Menu Technical

Tracking Data Output

Tracking Data

Tally

IR Remote

RCP/MSU

Lens Controller

Menu Network

Camera Name

User

Wired LAN

File Transfer

Da FTP Server 1 a 3

SSL

SSH

Referer Check

Brute Force Attack Protection

Menu Stream

Stream

Video Stream

Audio Stream

Menu Maintenance

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service
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Connessione di un dispositivo esterno

Appendice

Software

Connessione di monitor e dispositivi di registrazione esterni

Connessione di un RCP/MSU (opzione)

Connessione con RCP/MSU/CNA-2

Connessione uno a uno tra l’unità e un RCP

Utilizzo dell’unità in ambienti multitelecamera con MSU, CNA-2 o Software di comando a distanza della telecamera

Elenco delle funzioni supportate

Utilizzo del Telecomando RM-IP500 (opzionale)

Utilizzo del Telecomando RM-IP500 (opzionale)

Connessione di un Telecomando RM-IP500

Utilizzo di Camera Remote SDK

Informazioni su Camera Remote SDK

Sincronizzazione con un dispositivo esterno

Sincronizzazione con un dispositivo esterno

Sincronizzazione della fase del segnale video (Genlock)

Sincronizzazione del codice temporale con altri dispositivi

Collegamento di un microfono esterno o di un dispositivo audio esterno

Gestione ed editing di clip con un computer

Emissione di un segnale su fibra ottica

Connessione di un segnale di tally

Emissione in uscita dei dati di tracking

Montaggio di un dispositivo di comando obiettivo

Regolazione dello zoom mediante un dispositivo di comando obiettivo

Precauzioni per l’uso

Formati di uscita e limitazioni

Ricerca e risoluzione dei problemi

Messaggi di errore e avvisi

Elenco delle voci di menu

Impostazioni salvate per le posizioni di preset

Diagrammi a blocchi
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5-041-957-34(1) Copyright 2022 Sony Corporation

Aggiornamento del software di un obiettivo con innesto E-mount

Montaggio della protezione del pulsante di sblocco dell’obiettivo

Licenze

Specifiche tecniche

Marchi di fabbrica
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Esempio di configurazione del sistema

Questa unità può essere combinata con altri dispositivi periferici per formare varie configurazioni di sistema.

5-041-957-34(1) Copyright 2022 Sony Corporation

Obiettivo con innesto E-mount1.

Adattatore per innesto A-mount LA-EA3 / LA-EA42.

Telecomando a infrarossi (in dotazione)3.

Schede di memoria CFexpress Type A / schede di memoria SDXC4.

Lettore di schede CFexpress Type A / lettore di schede SD5.

Microfono ECM-680S, ECM-678*, ECM-674*6.
Richiede l’utilizzo di cavetto adattatore XLR da 3 a 5 pin EC-0.5X3F5M.*

Adattatore CA (in dotazione)7.

Monitor video8.

Telecomando RM-IP5009.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Comando di una singola unità utilizzando il telecomando a infrarossi in dotazione

È possibile comandare una singola unità da remoto utilizzando il telecomando a infrarossi in dotazione.

 Segnale video
 Direzione del segnale

5-041-957-34(1) Copyright 2022 Sony Corporation

Telecomando a infrarossi (in dotazione)1.

Monitor video2.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Comando di una singola unità utilizzando un tablet o un computer

È possibile collegare un tablet o un computer all’unità per comandarla tramite un browser Web.

 Segnale video
 Segnale di comando a distanza

  Direzione del segnale

5-041-957-34(1) Copyright 2022 Sony Corporation

Monitor video1.

Tablet2.

Computer3.

Punto di accesso4.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Controllo di una singola unità tramite un telecomando esterno

È possibile controllare l’unità da remoto utilizzando un dispositivo di telecomando.

 Segnale video
 Segnale di comando a distanza

  Direzione del segnale

5-041-957-34(1) Copyright 2022 Sony Corporation

Monitor video1.

Telecomando RM-IP5002.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Comando di più unità tramite un telecomando esterno

È possibile comandare fino a 100 unità da remoto utilizzando un singolo dispositivo di comando a distanza.

 Segnale video
 Segnale di comando a distanza
 Segnale tally/contatto

  Direzione del segnale

5-041-957-34(1) Copyright 2022 Sony Corporation

Monitor video1.

Switcher video2.

Hub Ethernet3.

Telecomando RM-IP5004.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista anteriore

Questo argomento descrive la posizione e la funzione dei componenti sul lato anteriore dell’unità.

Suggerimento

Questa descrizione si riferisce all’illustrazione dell’unità priva dell’obiettivo.

Corpo della telecamera

Nota
Proteggere sempre il corpo della telecamera da forti impatti.

1.

Indicatore di registrazione/tally
Se configurato come indicatore di registrazione, l’indicatore si illumina in rosso durante la registrazione su una scheda di memoria.
L’indicatore lampeggia quando lo spazio libero rimanente sulla scheda di memoria è insufficiente oppure quando si verifica un
errore.

Per informazioni dettagliate, vedere “Messaggi di errore e avvisi”.

Se configurato come indicatore tally, l’indicatore si illumina in rosso o in verde in base al segnale di tally esterno.

Per informazioni dettagliate, vedere “Connessione di un segnale di tally”.

2.
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Argomento correlato
Messaggi di errore e avvisi

Quando [Technical] > [Tally] > [Tally Control] è impostato su [PTZ AFR] nel menu Web, mostra lo stato dell’operazione di
inquadratura automatica.

Per informazioni dettagliate fare riferimento a “Controllo da remoto dello stato dell’inquadratura automatica PTZ”.
Sensore immagine

Nota
Non toccare direttamente con le mani.

3.

Pulsante di sblocco obiettivo
Premere per rimuovere l’obiettivo.

Per informazioni dettagliate, vedere “Rimozione dell’obiettivo”.

4.

Contatti di segnale obiettivo

Nota
Non toccare direttamente con le mani.

5.

Indicatore POWER6.

Indicatore NETWORK
Lo stato dell’unità viene segnalato tramite il colore e la modalità di illuminazione (illuminato, lampeggiante, spento) degli indicatori
POWER e NETWORK.

7.

Indicatore POWER Indicatore
NETWORK Stato dell’unità

Luce fissa verde*1
Luce fissa verde Unità accesa (rete connessa)

Spento Unità accesa (rete non connessa)

Lampeggiante verde Spento Processo di accensione in corso

Luce fissa arancione Spento Alimentazione in standby

Lampeggiante giallo Spento Aggiornamento del software in corso

Lampeggiamento
lento arancione*2

Lampeggiamento
lento verde*2

L’unità non è in grado di funzionare normalmente. Per informazioni dettagliate,
fare riferimento ai log di sistema. Se il problema persiste anche dopo aver
messo l’unità in modalità standby o aver spento e riacceso l’alimentazione,
rivolgersi al servizio di assistenza Sony.

Lampeggiamento
rapido arancione*3

Lampeggiamento
rapido verde*3

Si è verificato un malfunzionamento sull’unità. Contattare il servizio di
assistenza Sony.

Lampeggia in verde quando viene ricevuto un comando dal telecomando a infrarossi in dotazione.*1

Lampeggiamento lento: una volta al secondo*2

Lampeggiamento rapido: quattro volte al secondo*3

Sensore telecomando infrarossi
Riceve il segnale a infrarossi del telecomando in dotazione.

8.

Apertura ingresso aria

Nota
Non impedire il libero flusso dell’aria. Questo potrebbe causare un guasto.

9.
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Connessione di un segnale di tally

Controllo da remoto dello stato dell’inquadratura automatica PTZ
Rimozione dell’obiettivo

5-041-957-34(1) Copyright 2022 Sony Corporation
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista posteriore

Questo argomento descrive la posizione e la funzione dei componenti sul lato posteriore dell’unità.

Argomento correlato
Vista laterale

5-041-957-34(1) Copyright 2022 Sony Corporation

Levetta di blocco del corpo della telecamera
Blocca il movimento avanti/indietro del corpo della telecamera.

Nota

Mantenere sempre sulla posizione di blocco eccetto che per la sostituzione dell’obiettivo.

Durante il trasporto dell’unità, rimuovere sempre l’obiettivo e spostare sulla posizione di blocco.

Spegnere l’alimentazione dell’unità e bloccare il movimento orizzontale della telecamera utilizzando la levetta di blocco pan/tilt prima di
azionare questa levetta di blocco per evitare il rischio di schiacciamento delle dita. Per informazioni dettagliate sulla levetta di blocco pan/tilt,
vedere “Levetta di blocco pan/tilt” in “Vista laterale”.

1.

Base scorrevole2.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Pannello connettori

Questo argomento descrive la posizione e la funzione dei componenti del pannello connettori dell’unità.

 Connessione di terra
Collegare a terra collegando questo connettore al morsetto di terra di una presa di corrente oppure a un opportuno dispersore di
terra.

1.

Connettore DC IN (jack c.c. standard)
Per il collegamento a un adattatore CA.

Nota

Utilizzare esclusivamente l’adattatore CA fornito in dotazione. L’uso di adattatori diversi potrebbe provocare incendi o guasti.

2.

Connettore  LAN (rete) (RJ-45)
Consente il collegamento di un cavo di rete (categoria 5e o superiore) per la comunicazione di rete e l’alimentazione PoE++*.

Stato del LED di indicazione della velocità
Indica la velocità della connessione di rete.

3.

PoE++: Power over Ethernet Plus Plus. Conforme a IEEE802.3bt (Type 4 Class 8). Per informazioni dettagliate sulla connessione, fare riferimento alle
istruzioni per l’uso del dispositivo di alimentazione.

*

Indicazione  Velocità della connessione

Spento
Connessione 10 Mbps

Connessione 100 Mbps

Luce fissa arancione Connessione 1000 Mbps
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Stato del LED di indicazione Link/ACT
Indica lo stato della connessione di rete.

Nota

Il collegamento del prodotto a Internet deve essere realizzato mediante un sistema in grado di fornire funzioni di protezione, ad esempio un
router o un firewall. In caso di collegamento senza tale protezione si potrebbero verificare problemi di sicurezza.

Indicazione  Stato della connessione

 Spento Nessun collegamento

Lampeggiante verde Collegamento stabilito, dati attivi

Luce fissa verde Collegamento attivo

Connettore TC IN
Consente l’ingresso di un segnale di codice temporale esterno di riferimento.

Per informazioni dettagliate, vedere “Sincronizzazione del codice temporale con altri dispositivi”.

4.

Connettore HDMI
Fornisce in uscita come segnale HDMI il video proveniente dall’unità.

Per informazioni dettagliate, vedere “Connettore HDMI OUT (tipo A)” in “Connessione di monitor e dispositivi di registrazione
esterni”.

5.

Vite di montaggio della piastrina di fissaggio cavo HDMI
Per evitare la rimozione del cavo HDMI, montare la piastrina di fissaggio del cavo HDMI in dotazione utilizzando la vite di
montaggio fornita (M2.6×6) e fissare il cavo HDMI utilizzando una normale fascetta fissacavi disponibile in commercio.

Per informazioni dettagliate sul montaggio della piastrina di fissaggio del cavo HDMI, fare riferimento a “Collegamento dei cavi”.

6.

Connettore OPTION
Consente il collegamento di un segnale tally proveniente da un dispositivo esterno o un dispositivo di comando obiettivo.

Per informazioni dettagliate, vedere “Connessione di un segnale di tally” e “Montaggio di un dispositivo di comando obiettivo”.

7.

Fermacavo
Consente il fissaggio del cavo dell’adattatore CA.

8.

Pulsante RESET
Premere per almeno 5 secondi utilizzando la punta di una penna o un oggetto analogo per ripristinare le impostazioni dell’unità sui
valori predefiniti di fabbrica.
È possibile scegliere se reimpostare solo le impostazioni della connessione di rete oppure tutte le impostazioni mediante il
selettore SETUP 1.

9.

Connettore di uscita OPTICAL
Quando è connesso un modulo SFP+ (opzionale), emette in uscita un segnale SDI convertito in formato ottico.

Per informazioni dettagliate, vedere “Emissione di un segnale su fibra ottica”.

10.

Selettori SETUP

Consentono di configurare le impostazioni indicate di seguito.
Selettore 1: Specifica quali impostazioni vengono ripristinate con la pressione del pulsante RESET.

11.
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Selettore 2: Specifica se l’alimentazione +48 V (alimentazione phantom) attivata o disattivata quando è connesso un dispositivo di
ingresso audio. Questa impostazione viene applicata immediatamente.
Questa funzione è abilitata quando [Audio] > [Audio Input] > [AUDIO IN Select] è impostato su [MIC] nel menu della telecamera.

Nota
Prima di spostare il selettore 2 sulla posizione ON, assicurarsi che il microfono connesso sia compatibile con una sorgente a +48V per
evitare di danneggiarlo. Controllare questa impostazione prima di procedere con il collegamento.

Selettore 3: Abilita o disabilita la modalità di comunicazione VISCA over IP. Le impostazioni vengono applicate al momento
dell’accensione della telecamera.
Spostare sulla posizione ON per utilizzare l’unità con la connessione a un telecomando (RM-IP500).

Nota

Se non è stata configurata una password amministratore, la comunicazione VISCA over IP rimane disabilitata, indipendentemente dalla
posizione del selettore. Per informazioni dettagliate sulla configurazione della password amministratore, vedere “Configurazione iniziale
dell’unità”.

Selettore 4: Imposta l’indirizzo IP su un valore specifico.

Suggerimento
A partire dalla versione software 3.0, il selettore 4 configura l’indirizzo IP.

Con versioni software precedenti alla 3.0, questo selettore imposta il telecomando a infrarossi. Per informazioni dettagliate, vedere
[Technical] > [IR Remote] > [Pan-Tilt Speed] nel menu Web.
OFF: Pan e tilt operano a velocità normale.
ON: Pan e tilt operano ad alta velocità.

Impostazione Descrizione

OFF
(predefinito)

Ripristina solo le impostazioni della connessione di rete. Vengono ripristinate solo le impostazioni di rete, le
impostazioni di sicurezza e le impostazioni utente (nome utente e password) dell’unità.

ON Ripristina i valori predefiniti di fabbrica di tutte le impostazioni.

Impostazione Descrizione

OFF
(predefinito)

Non fornisce alimentazione +48 V (alimentazione phantom). Configurare questa impostazione quando si
utilizza un dispositivo audio esterno (ad esempio un mixer), un microfono dinamico o un microfono con
batteria incorporata.

ON
Fornisce alimentazione +48 V (alimentazione phantom) a un microfono compatibile con tale forma di
alimentazione connesso al connettore AUDIO IN (CH-1 o CH-2).

Impostazione Descrizione

OFF (predefinito) Non risponde ai comandi VISCA over IP.

ON Accetta i comandi VISCA over IP.

Impostazione Descrizione

OFF (predefinito) L’utente imposta l’indirizzo IP.

ON

Imposta l’indirizzo IP dell’unità su 192.168.0.100 all’avvio (modalità indirizzo IP fisso).

Nota
Se l’indirizzo IP viene modificato dopo l’avvio nel menu Web, impostare questo selettore sulla posizione OFF.

Connettore SDI OUT12.
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Argomento correlato
Sincronizzazione del codice temporale con altri dispositivi

Connessione di monitor e dispositivi di registrazione esterni

Collegamento dei cavi
Connessione di un segnale di tally

Montaggio di un dispositivo di comando obiettivo

Emissione di un segnale su fibra ottica
Configurazione iniziale dell’unità

Sincronizzazione della fase del segnale video (Genlock)

IR Remote

Collegamento di un microfono esterno o di un dispositivo audio esterno

5-041-957-34(1) Copyright 2022 Sony Corporation

Fornisce in uscita il video proveniente dall’unità in formato di segnale 12G/6G/3G/HD-SDI.
L’unità può essere configurata anche per fornire in uscita un segnale RAW.

Per informazioni dettagliate, vedere “Connettore SDI OUT (tipo BNC)” in “Connessione di monitor e dispositivi di registrazione
esterni”.

 Sensore del telecomando a infrarossi (posteriore)
Sensore a infrarossi per il telecomando a infrarossi fornito in dotazione.

13.

Uscita aria / ventola
Espelle il calore generato all’interno dell’unità.

Nota

Non coprire l’apertura per l’uscita dell’aria. Questo potrebbe causare un guasto.

Si osservi che le superfici circostanti all’uscita dell’aria potrebbero diventare calde.

14.

Connettore GENLOCK
Consente di fornire in entrata un segnale di sincronizzazione esterno.

Per informazioni dettagliate, vedere “Sincronizzazione della fase del segnale video (Genlock)”.

15.

Connettore AUDIO IN (connettore tipo XLR a 5 pin)
Consente di fornire in entrata il segnale proveniente da un dispositivo audio o microfono esterno.
Funziona come connettore AUDIO IN CH-1 o connettore AUDIO IN CH-2.

Per informazioni dettagliate, vedere “Collegamento di un microfono esterno o di un dispositivo audio esterno”.

16.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista laterale

Questo argomento descrive la posizione e la funzione dei componenti sul lato dell’unità.

Suggerimento

Questa descrizione si riferisce all’illustrazione dell’unità priva dell’obiettivo.

Levetta di blocco pan/tilt
Blocca il meccanismo di pan e tilt dell’unità. Utilizzare nei seguenti casi:

Durante il trasporto o l’imballaggio dell’unità.
Durante il montaggio o la rimozione di un obiettivo. Per informazioni dettagliate, vedere “Montaggio dell’obiettivo” oppure
“Rimozione dell’obiettivo”.
Quando si utilizza un obiettivo che non supporta le funzioni di pan e tilt (ad esempio, gli obiettivi Sony SEL100400GM /
SEL200600G / SEL400F28GM / SEL600F40GM).
Durante il trasporto dell’unità, rimuovere sempre l’obiettivo e spostare sulla posizione di blocco.

Suggerimento
Il movimento di pan e tilt può essere bloccato sulle angolazioni indicate di seguito.

1.
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Argomento correlato
Montaggio dell’obiettivo

Rimozione dell’obiettivo
Inserimento delle schede di memoria

Accesso all’app Web tramite un browser Web

5-041-957-34(1) Copyright 2022 Sony Corporation

Base scorrevole2.

Fori filettati per dispositivi esterni (4 posizioni)
Per viti M3 di lunghezza fino a 6 mm.

Nota
Non utilizzare viti di lunghezza superiore a 6 mm. Questo potrebbe causare un guasto.

3.

Indicatore di accesso A4.

Indicatore di accesso B
L’indicatore si illumina con luce fissa o lampeggiante quando è inserita una scheda per la registrazione.

Per informazioni dettagliate, vedere “Inserimento delle schede di memoria”.

5.

Slot per scheda CFexpress Type A o scheda SD (A)6.

Slot per scheda CFexpress Type A o scheda SD (B)
Slot per l’inserimento delle schede di registrazione.

Per informazioni dettagliate, vedere “Inserimento delle schede di memoria”.

7.

Codice QR per la connessione di rete
Utilizzare per la configurazione delle impostazioni iniziali.

Per informazioni dettagliate, vedere “Accesso all’app Web tramite un browser Web”.

8.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista dall’alto

Questo argomento descrive la posizione e la funzione dei componenti sul lato superiore dell’unità.

Suggerimento

Questa descrizione si riferisce all’illustrazione dell’unità priva dell’obiettivo.

5-041-957-34(1) Copyright 2022 Sony Corporation

Fori filettati per dispositivi esterni (2 posizioni)
Compatibili con viti UNC 1/4-20 per treppiede.
Lunghezza massima 6 mm.

1.

ɸ (indicazione piano imager)
Questa indicazione si trova sullo stesso piano del sensore immagine.
Utilizzare questa indicazione come punto di riferimento per misurare con precisione la distanza tra l’unità e il soggetto.

2.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista dal basso

Questo argomento descrive la posizione e la funzione dei componenti sul lato inferiore dell’unità.

Suggerimento

Questa descrizione si riferisce all’illustrazione dell’unità priva dell’obiettivo.

Argomento correlato

Fori delle viti di fissaggio della staffa per montaggio a soffitto (6 posizioni, profondità utile della filettatura: 5,5 mm)
Per montare l’unità a soffitto o su un ripiano in una posizione elevata, fissare la staffa di fissaggio corpo (opzione) alla base
dell’unità avvitando in questi fori le sei apposite viti di montaggio della staffa stessa.

Per informazioni dettagliate su questa modalità di montaggio, vedere “Montaggio verticale in una posizione fissa elevata” e
“Montaggio a soffitto”.

1.

Viti di montaggio su treppiede (2 posizioni)
Utilizzate per il montaggio dell’unità su un treppiede per telecamera (opzione, viti 1/4-20 UNC con lunghezza fino a 5,5 mm).

Nota
Non utilizzare viti di lunghezza superiore a 5,5 mm. Questo potrebbe causare un guasto.

2.
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Montaggio verticale in una posizione fissa elevata

Montaggio a soffitto
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Supporto obiettivo

Questo argomento descrive la posizione e la funzione dei componenti di supporto dell’obiettivo dell’unità.

Suggerimento

Questa descrizione si riferisce all’illustrazione dell’unità priva dell’obiettivo.

Asta di supporto obiettivo (2)
Sostiene l’obiettivo.
Utilizzabile anche per il montaggio di accessori generali per aste con diametro Ø15.

1.

Supporto obiettivo
Il supporto dell’obiettivo può essere spostato in avanti o indietro, in base all’obiettivo utilizzato, e quindi fissato in posizione.

2.

Vite di fissaggio del piedino del supporto dell’obiettivo
Fissare al piedino del supporto dell’obiettivo. È possibile regolare la posizione verticale della vite in base all’altezza del piedino del
supporto dell’obiettivo.

3.
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Levetta di blocco della barra del supporto dell’obiettivo (2)
Blocca il movimento in avanti o indietro del gruppo di supporto dell’obiettivo.

4.

Levetta di blocco della vite di fissaggio del piedino del supporto dell’obiettivo
Blocca la posizione verticale della vite di fissaggio del piedino del supporto dell’obiettivo.

Suggerimento

Se una levetta di blocco viene a trovarsi in una posizione che ne rende difficoltosa la rotazione, rilasciarla e ruotarla in una posizione più
comoda. Quando si trova nella posizione desiderata, serrare la levetta di blocco.

A: Levetta di blocco della vite di fissaggio del piedino del supporto dell’obiettivo
B: Levetta di blocco della barra del supporto dell’obiettivo

Nota
Per evitare che il gruppo di supporto dell’obiettivo interferisca con il movimento di pan e tilt, avvicinarlo al corpo della telecamera quando il
suo utilizzo non è necessario e spostare la vite di fissaggio del piedino del supporto dell’obiettivo sulla sua posizione più alta (più vicina
all’obiettivo).

5.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Posizione e funzione delle parti del telecomando a infrarossi (fornito in dotazione)

Questo argomento descrive la posizione e la funzione delle parti del telecomando a infrarossi (fornito in dotazione).

Pulsante REC● (START/STOP registrazione)
Premere per avviare o arrestare la registrazione.

1.

Pulsante MENU
Premere per aprire o chiudere il menu della telecamera.

2.

Pulsanti di comando GUI (pulsanti grafici a schermo)
Premere questi pulsanti per eseguire operazioni nel menu della telecamera, nelle finestre di dialogo dei messaggi che includono
pulsanti e altre funzioni di visualizzazione sullo schermo.

3.

Pulsante CANC./BACK
Premere per annullare un’impostazione o per tornare alla schermata precedente del menu della telecamera dell’unità.

4.

Pulsanti di comando pan e tilt
Premere i pulsanti freccia per eseguire i movimenti di pan e tilt della telecamera. Premere il pulsante HOME per riportare la
telecamera sulla sua posizione centrale.

5.

Pulsanti di comando delle posizioni di preset
Premere e mantenere premuto il pulsante PRESET e quindi premere uno dei pulsanti da 1 a 3 per memorizzare la direzione della
telecamera, lo zoom e la regolazione di messa a fuoco nel pulsante numerico premuto.

6.
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Batteria del telecomando a infrarossi

Il telecomando a infrarossi richiede due batterie AA (LR6).
Inserire le batterie nel telecomando a infrarossi come mostrato nella figura seguente.

Per richiamare le impostazioni, premere il pulsante numerico in cui sono memorizzate.
Pulsanti di comando della messa a fuoco
Consentono di regolare la messa a fuoco.
Per regolare la messa a fuoco automaticamente, premere il pulsante AF.
Per regolare la messa a fuoco manualmente, premere il pulsante MF, quindi premere il pulsante F (lontano) per mettere a fuoco su
soggetti lontani oppure il pulsante N (vicino) per mettere a fuoco su soggetti vicini.

7.

Pulsanti programmabili da 1 a 3
Ciascuno di questi pulsanti programmabili esegue le funzioni ad esso assegnate tramite il menu della telecamera.
Assegnando la funzione [Direct Menu] a un pulsante programmabile, è possibile regolare l’esposizione, il bilanciamento del bianco
ed altre impostazioni utilizzando i pulsanti di comando GUI (pulsanti grafici a schermo).

Per informazioni dettagliate sull’assegnazione tramite il menu della telecamera, vedere “Pulsanti programmabili”.

Per informazioni dettagliate sul Direct Menu, vedere “Utilizzo del Direct Menu”.

8.

 Pulsante di alimentazione
Premere per accendere l’unità o per commutare l’alimentazione alla modalità standby.

9.

Pulsante THUMBNAIL
Visualizza la schermata delle miniature che mostra i clip registrati sulla scheda di memoria dell’unità.

Per informazioni dettagliate sulla schermata delle miniature, vedere “Schermata delle miniature”.

La schermata delle miniature consente di selezionare clip e controllarne la riproduzione utilizzando i pulsanti di comando GUI.

Per informazioni dettagliate sulla selezione di clip e il controllo della riproduzione, vedere “Riproduzione dei clip registrati” e
“Operazioni sui clip registrati”.

10.

Pulsante SLOT SEL(selezione dello slot per schede di memoria (A) o (B))
Se sono inserite due schede di memoria, premere questo pulsante per passare da una scheda di memoria all’altra per la
registrazione.
Premere questo pulsante mentre è visualizzata la schermata delle miniature per passare da una scheda di memoria all’altra per la
visualizzazione.

11.

Pulsante P/T RESET (reset pan/tilt)
Resetta le funzioni di pan e tilt. Premere il pulsante quando gli indicatori POWER e NETWORK lampeggiano contemporaneamente
oppure quando il pulsante [Execute Pan-Tilt Reset] è visualizzato nel pannello di controllo dell’inquadratura dell’app Web.

12.

Pulsanti di comando dello zoom
Per aumentare lo zoom, premere il pulsante T (telefoto).
Per diminuire lo zoom, premere il pulsante W (grandangolo).

13.
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Nota

Utilizzare esclusivamente batterie al manganese o alcaline in quanto altri tipi potrebbero corrodersi e dar luogo a perdite.

Smaltire le batterie usate in osservanza delle norme vigenti nel paese o regione di utilizzo.

Argomento correlato
Pulsanti programmabili
Utilizzo del Direct Menu

Schermata delle miniature

Riproduzione dei clip registrati
Operazioni sui clip registrati
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Schermata dell’app Web – Descrizione generale

Collegando un tablet o un computer, è possibile eseguire operazioni di pan, tilt e zoom, eseguire registrazioni, riprodurre video
registrati e configurare l’unità tramite un browser Web (di seguito, questa funzione viene denominata “app Web”).

Per informazioni dettagliate sull’avvio dell’app Web, vedere “Accesso all’app Web tramite un browser Web”.

Nota
L’app Web non supporta l’uscita di audio dalla telecamera.

All’avvio, l’app Web visualizza la seguente schermata delle operazioni live.

Schermata delle operazioni live

Per informazioni dettagliate sulla schermata delle operazioni live, vedere “Struttura della schermata delle operazioni live”.
I pulsanti e le icone comuni alla schermata delle operazioni live e alla schermata delle operazioni di riproduzione sono visualizzati
nella parte superiore dello schermo.

Per informazioni dettagliate sulle parti comuni delle schermate, vedere “Struttura dell’area comune delle schermate”.
Per passare da una schermata all’altra, premere le schede di scelta della schermata nell’area comune.

Schermata delle impostazioni PTZ AFR
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Questa schermata consente di configurare e modificare le impostazioni iniziali dell’inquadratura automatica PTZ.

Per la configurazione, fare riferimento a “Struttura della schermata delle impostazioni PTZ AFR” e “Configurazione delle
impostazioni iniziali dell’inquadratura automatica PTZ”.

Schermata delle operazioni di riproduzione

Premere la scheda [Playback] per visualizzare la schermata delle operazioni di riproduzione.
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Per informazioni dettagliate sulla schermata delle operazioni di riproduzione, vedere “Struttura della schermata delle operazioni di
riproduzione”.

Schermata delle impostazioni

Premere la scheda [Settings] per visualizzare la schermata delle impostazioni (di seguito denominata menu Web).

Nota
Nel menu Web, le impostazioni non vengono applicate fino a quando non si preme il pulsante [OK]. Dopo aver modificato impostazioni in una
pagina in cui è presente il pulsante [OK], premere tale pulsante [OK] per applicarle.

Per informazioni dettagliate sulla schermata delle impostazioni, vedere “Struttura della schermata delle impostazioni”.
In questa guida, la schermata delle impostazioni della app Web è definita semplicemente menu Web.

Argomento correlato
Accesso all’app Web tramite un browser Web

Struttura della schermata delle operazioni live
Struttura dell’area comune delle schermate

Struttura della schermata delle impostazioni PTZ AFR

Configurazione delle impostazioni iniziali dell’inquadratura automatica PTZ
Struttura della schermata delle operazioni di riproduzione

Struttura della schermata delle impostazioni

5-041-957-34(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struttura dell’area comune delle schermate

Questo argomento descrive la struttura dell’area comune delle schermate.

Nome della telecamera
Visualizza il nome della telecamera.
È possibile modificare il nome, utilizzando [Network] > [Camera Name] nel menu Web.
Il colore dello sfondo cambia in base al segnale di tally esterno.

1.

Pulsante di alimentazione
Quando l’unità è accesa, viene aggiunto un segno di spunta a [Power ON] nel menu di accensione.
Premere il pulsante di alimentazione e selezionare [Power Standby] nel menu di accensione per commutare l’alimentazione
dell’unità sulla modalità standby.
In modalità standby alimentazione, viene visualizzata la seguente schermata.

Per riaccendere l’alimentazione, premere il pulsante di alimentazione e selezionare [Power ON] nel menu di alimentazione.

2.

Schede di selezione della schermata operativa
Premere una scheda per visualizzare la schermata delle operazioni corrispondente.
Scheda [Live]: Visualizza la schermata delle operazioni live.
Scheda [PTZ AFR Settings]: Visualizza la schermata delle impostazioni dell’inquadratura automatica PTZ.
Scheda [Playback]: Visualizza la schermata delle operazioni di riproduzione.
Scheda [Settings]: Visualizza la schermata delle impostazioni (menu Web).

3.

Indicatore PoE++, avviso di temperatura anomala
L’indicatore PoE++ viene visualizzato quando l’unità è collegata a una sorgente PoE++. Se si verifica una condizione di
temperatura anomala, viene visualizzato il simbolo  (Avviso temperatura).

4.

Indicatore notifiche
Quando arriva un messaggio, l’indicatore cambia, come mostrato di seguito.

 (Notifiche attive)
Eseguire l’azione necessaria in base al messaggio visualizzato nel pannello dell’immagine della telecamera.

Nota

5.
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Non vengono visualizzati messaggi quando [Monitoring] > [Output Display] > [HDMI/Stream] è impostato su [Off] nel menu Web. Impostare
su [On] per controllare il contenuto dei messaggi.

Pulsante  (stato della telecamera)
Premere questo pulsante per visualizzare su una schermata separata informazioni sul segnale dell’immagine di uscita e
dell’immagine registrata dalla telecamera, sull’obiettivo e sull’eventuale dispositivo di comando obiettivo (opzione).

In caso di notifiche relative al dispositivo di comando obiettivo (opzione), l’indicazione cambia come mostrato di seguito.

6.

Selettore di blocco dei comandi dello schermo
 (Sblocco operazioni): Spostare il selettore a sinistra per consentire l’utilizzo dei comandi nella schermata delle operazioni live

e nella schermata delle operazioni di riproduzione.
 (Blocco operazioni): Spostare il selettore a destra per disabilitare i comandi nella schermata delle operazioni live e nella

schermata delle operazioni di riproduzione e impedire l’azionamento involontario di comandi non desiderati.

7.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struttura della schermata delle operazioni live

Questo argomento descrive la struttura della schermata delle operazioni live.
Quando la funzione di inquadratura automatica PTZ non è attiva

Quando la funzione di inquadratura automatica PTZ è attiva
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Pannello di controllo delle posizioni di preset
Visualizza, utilizzando una miniatura, la posizione memorizzata in un preset. Toccare rapidamente due volte la miniatura per
ripristinare la posizione memorizzata nel preset.

Per informazioni dettagliate sulle posizioni di preset, vedere “Salvataggio e ripristino delle posizioni di pan, tilt e zoom e
dell’impostazione della messa a fuoco tramite l’app Web”.
Per informazioni dettagliate sulla funzione PTZ Trace, vedere “Registrazione delle operazioni di inquadratura della telecamera
tramite l’app Web”.

1.

Pannello dell’immagine della telecamera
Visualizza l’immagine corrente della telecamera e lo stato dell’unità.
Visualizza la stessa immagine dell’uscita HDMI.
Sopra all’immagine vengono visualizzate informazioni di stato, come indicato di seguito. Intorno all’immagine viene visualizzata
anche una cornice rossa o verde in base al segnale di tally esterno ricevuto.

2.
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Pulsante [Display]
Premere questo pulsante per visualizzare informazioni relative alla telecamera sull’immagine.
Mentre sono visualizzate le informazioni sulla telecamera, premere nuovamente il pulsante per nasconderle.

Oltre agli altri indicatori, vengono visualizzati, in base allo stato, anche indicatori e messaggi relativi alla messa a fuoco automatica,
i quali non possono essere nascosti premendo il pulsante [Display].

Per maggiori dettagli sulle informazioni relative alla telecamera visualizzate, vedere “Significato delle indicazioni a schermo”.

Pulsante di arresto di AF con seguimento in tempo reale
Premere questo pulsante per interrompere il seguimento di un soggetto.

Per informazioni dettagliate, vedere “Seguimento di un soggetto specificato (Realtime Tracking AF)”.

N. Indicazione Descrizione

2-
1

Indicatore della modalità di messa a fuoco
Vedere “Indicatore della modalità di messa a fuoco” in “Significato delle
indicazioni a schermo”.

2-
2

Indicatore di modalità di registrazione, slot
A/B, intervallo di registrazione Interval Rec

Vedere “Indicatore di modalità di registrazione, slot A/B, intervallo di
registrazione Interval Rec” in “Significato delle indicazioni a schermo”.

2-
3

Indicatore dello stato dello streaming
Visualizzato solo durante lo streaming (solo quando [Stream Setting] è
impostato su [RTMP] o [SRT-Caller]).

2-
4

Indicatore di stato dell’operazione di uscita
RAW

Indica lo stato di uscita del segnale RAW. Per informazioni dettagliate sulla
modalità RAW, vedere “Registrazione di video RAW”.

2-
5

Indicatore dello spazio rimanente sui
supporti di memoria

Vedere “Indicatore dello spazio rimanente sui supporti di memoria” in
“Significato delle indicazioni a schermo”.

2-
6

Indicazione della posizione di zoom

Vedere “Indicazione della posizione di zoom” in “Significato delle indicazioni
a schermo”.
Se è connesso un dispositivo di comando obiettivo (opzione), è visualizzato

. Se si verifica un errore nel dispositivo di comando obiettivo (opzione),
viene visualizzato .

2-
7

Indicatore di stato della funzione PTZ Trace
Indicatore di stato dell’inquadratura
automatica PTZ

Visualizzato quando è abilitata la funzione PTZ Trace oppure Inquadratura
automatica PTZ.

2-
8

Indicatore modalità AE/livello AE
Vedere “Indicatore modalità AE/livello AE” in “Significato delle indicazioni a
schermo”.

Pulsante START/STOP registrazione
Premere questo pulsante per avviare la registrazione. Durante la registrazione, il pulsante START/STOP di registrazione si illumina
di rosso.
Premere di nuovo durante la registrazione per arrestare la registrazione.
È possibile spostare il selettore Hold sulla posizione Hold per evitare l’azionamento accidentale del pulsante START/STOP di
registrazione.

3.

Pannello di controllo PTZ AFR
L’inquadratura automatica PTZ è abilitata quando il selettore PTZ AFR è impostato sulla posizione di attivazione. Toccare la
persona da seguire nel pannello delle immagini della telecamera.
È possibile anche impostare in anticipo la telecamera in modo che segua automaticamente una persona che appare in una
posizione specifica nella schermata di impostazione PTZ AFR. Per informazioni dettagliate, fare riferimento a “Configurazione delle

4.
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impostazioni iniziali dell’inquadratura automatica PTZ”.
Durante il seguimento, l’area intorno al pulsante [Pause] si illumina in blu.
Se è richiesto l’intervento dell’operatore apparirà una luce lampeggiante blu. Controllare il messaggio visualizzato nel pannello di
controllo della telecamera ed eseguire l’azione richiesta.
Pannello di controllo dei preset di composizione
Visualizza, come miniature, i preset di composizione registrati. Toccare rapidamente due volte una miniatura per ripristinare
l’inquadratura memorizzata nel preset.
Visualizzato quando la funzione di inquadratura automatica PTZ è abilitata.

5.

Pannello di configurazione di base della telecamera
Visualizza pulsanti per l’impostazione delle funzioni di base necessarie per la ripresa. Premere un pulsante per visualizzare, nel
pannello di regolazione della configurazione di base della telecamera sottostante (5), la schermata di configurazione della funzione
corrispondente.

6-1 [FPS]
6-2 [ISO/Gain / Exposure Index]
6-3 [Shutter]
6-4 [Iris]
6-5 [ND Filter]
6-6 [Scene File / Base Look/LUT]
6-7 [White Balance]

Per informazioni dettagliate, fare riferimento alla descrizione della funzione corrispondente.

6.

Funzione Riferimento

FPS “Slow & Quick Motion”

ISO/Gain
“Impostazione della sensibilità di base”, “Regolazione automatica del guadagno” e “Regolazione manuale del
guadagno” in “Regolazione del guadagno”

Exposure
Index

“Impostazione della sensibilità di base” e “Modifica della distribuzione delle ombre e delle alte luci nell’immagine
registrata”

Shutter “Regolazione automatica dell’otturatore” e “Regolazione manuale dell’otturatore” in “Regolazione dell’otturatore”

Iris
“Regolazione automatica del diaframma” e “Regolazione manuale del diaframma” in “Regolazione del
diaframma”

ND Filter “Informazioni sul filtro ND” in “Regolazione del livello di luce (filtro ND)”

Scene File “Descrizione generale dei look” e altri argomenti in “Ripresa con il look desiderato”

Base
Look/LUT

“Ripresa con regolazione del look in post-produzione”

White
Balance

“Schermata di regolazione del bilanciamento del bianco”

Pannello pulsanti programmabili/regolazione della configurazione di base della telecamera
Durante il funzionamento normale visualizza i pulsanti programmabili. Premere i pulsanti del pannello di configurazione di base
della telecamera (voce 6) per visualizzarne le relative voci di configurazione. Premere il pulsante [X] o premere nuovamente il
pulsante del pannello di configurazione della telecamera per tornare alla visualizzazione dei pulsanti programmabili.

7.
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Per informazioni dettagliate sui pulsanti programmabili, vedere “Pulsanti programmabili”.
Per informazioni dettagliate sul pannello di regolazione della configurazione di base della telecamera, fare riferimento alla
descrizione di ciascuna funzione.

Pannello di controllo dell’inquadratura / Pannello dei comandi GUI / Pannello di regolazione della composizione AFR
Le schede in alto consentono di passare dal pannello di controllo dell’inquadratura al pannello dei comandi GUI e viceversa.
Premere il pulsante  (chiudi) in alto a destra dello schermo per nascondere il pannello di controllo ed evitare azioni indesiderate.
Qualora il pannello di controllo non sia visualizzato, premere il pulsante  (apri) per visualizzarlo.
Regolare l’inquadratura servendosi del pannello di controllo dell’inquadratura. Premere la scheda  (pan/tilt/zoom) per
visualizzare il pannello di controllo dell’inquadratura.

Per informazioni dettagliate sull’utilizzo, vedere “Regolazione dell’inquadratura”.

Suggerimento
Di seguito è illustrata la sezione del joystick del pannello di controllo dell’inquadratura quando la funzione pan/tilt è disabilitata, quando è
necessaria l’inizializzazione della funzione pan/tilt oppure quando si è verificato un errore sul controller dell’obiettivo.

Quando la funzione pan/tilt è stata bloccata mediante la levetta di blocco pan/tilt

Quando la funzione pan/tilt non è inizializzata

Quando è necessario eseguire il reset della funzione pan/tilt

8.
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Quando si è verificato un errore sul controller dell’obiettivo

Quando la funzione pan/tilt è disabilitata

Quando la funzione pan/tilt non è inizializzata oppure è necessario eseguirne il reset, è possibile accedere rapidamente al pulsante 
(reset pan/tilt) nel pannello di controllo della telecamera semplicemente toccando il messaggio visualizzato sotto al joystick.

Il pannello dei comandi GUI consente di interagire con il menu della telecamera, riprodurre clip ed eseguire altre funzioni. Premere
la scheda  (pannello comandi (GUI) della telecamera) per visualizzarlo.

Per informazioni dettagliate sull’utilizzo, vedere “Utilizzo del menu della telecamera”e “Riproduzione dei clip registrati”.

Utilizzare il pannello di regolazione della composizione AFR per regolare la composizione dell’inquadratura automatica PTZ.
Premere la scheda  (regolazione composizione AFR) per visualizzare il pannello di regolazione della composizione AFR.
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Suggerimento

Di seguito è illustrata la sezione di regolazione della composizione del pannello di regolazione della composizione AFR quando la funzione
pan/tilt è disabilitata, quando è necessaria l’inizializzazione della funzione pan/tilt oppure quando si è verificato un errore sul controller
dell’obiettivo.

Quando la funzione pan/tilt è stata bloccata mediante la levetta di blocco pan/tilt

Quando è necessario inizializzare la funzione pan/tilt

Quando si è verificato un errore sul controller dell’obiettivo

Per informazioni sull’utilizzo, fare riferimento a “Specifica dei soggetti per il seguimento automatico (modalità di avvio manuale del
seguimento)”.
Pannello di controllo della telecamera
Questa sezione consente di configurare le funzioni necessarie per l’azionamento della telecamera.
Servirsi delle schede in alto per passare da una schermata all’altra.

9.

49



Premere il pulsante  (chiudi) in alto a destra dello schermo per nascondere il pannello di controllo ed evitare azioni indesiderate.
Qualora il pannello di controllo non sia visualizzato, premere il pulsante  (apri) per visualizzarlo.

Per informazioni dettagliate, fare riferimento alla descrizione della funzione corrispondente.

Scheda  (Main)
Visualizza le voci di configurazione delle funzioni più frequentemente utilizzate.
È possibile scegliere la funzione dei cursori superiore e inferiore premendo il pulsante [▼] e selezionando la funzione desiderata
nell’elenco visualizzato. Possono essere selezionate le seguenti funzioni:

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

Scheda  (Focus)
Visualizza le voci di configurazione relative alla messa a fuoco.

Scheda  (Audio)

Visualizza le voci di configurazione relative all’audio.

Visualizzato in base alle impostazioni del menu.*
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Scheda  (Stream)
Visualizza le voci di configurazione relative allo streaming.
Gli elementi visualizzati potranno variare in base all’impostazione del formato di streaming.
Quando impostato su [RTMP] o [SRT-Caller], questa schermata consente di avviare e arrestare lo streaming.

Per informazioni dettagliate, vedere “Informazioni sullo streaming” e altri argomenti in “Configurazione dello streaming”.
In caso di errori di connessione, vengono visualizzate informazioni relative all’errore stesso. Per maggiori dettagli sulle
informazioni di errore, vedere “Messaggi di errore e avvisi”.

Scheda  (Others)
Visualizza le voci di configurazione relative ad altre funzioni.

Premere il pulsante [Full Screen Display] per aprire una nuova scheda nel browser web e visualizzare il pannello dell’immagine
della telecamera a schermo intero.
Questa funzionalità permette unicamente di visualizzare l’immagine. Non sono disponibili né la funzione Touch AF né altre funzioni.

Nota
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Argomento correlato
Salvataggio e ripristino delle posizioni di pan, tilt e zoom e dell’impostazione della messa a fuoco tramite l’app Web

Registrazione delle operazioni di inquadratura della telecamera tramite l’app Web

Inquadratura automatica PTZ
Significato delle indicazioni a schermo

Registrazione di video RAW

Seguimento di un soggetto specificato (Realtime Tracking AF)
Slow & Quick Motion

Impostazione della sensibilità di base

Regolazione automatica del guadagno
Regolazione manuale del guadagno

Modifica della distribuzione delle ombre e delle alte luci nell’immagine registrata

Regolazione automatica dell’otturatore
Regolazione manuale dell’otturatore

Regolazione automatica del diaframma

Regolazione manuale del diaframma
Informazioni sul filtro ND

Descrizione generale dei look

Ripresa con regolazione del look in post-produzione
Schermata di regolazione del bilanciamento del bianco

Pulsanti programmabili

Riproduzione dei clip registrati
Utilizzo del menu della telecamera

Informazioni sullo streaming

Messaggi di errore e avvisi

5-041-957-34(1) Copyright 2022 Sony Corporation

La schermata delle operazioni live nella scheda originale continua ad essere attiva. Se non è necessario eseguire operazioni, si consiglia di
chiudere la scheda per ridurre il numero di connessioni simultanee.

Premere il pulsante  (inizializzazione dispositivo di comando obiettivo) per inizializzare il dispositivo di comando
obiettivo (opzione fornita da terzi). Questo pulsante è abilitato solo quando [Technical] > [Lens Controller] > [Zoom] > [Setting] è
impostato su [On] nel menu Web.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struttura della schermata delle impostazioni PTZ AFR

Questo argomento descrive la struttura della schermata delle impostazioni per l’inquadratura automatica PTZ.

Schede delle voci di configurazione
Visualizza le voci di configurazione.

1.

Schermata delle impostazioni
Visualizza la schermata delle impostazioni e la guida per la configurazione.

2.

Pulsante [Next]
Viene visualizzata la schermata di configurazione successiva.

Suggerimento

Quando sono applicate le modifiche alle impostazioni, viene visualizzato il pulsante [OK].

Durante l’inizializzazione delle impostazioni, viene visualizzato [Start].

Durante l’inizializzazione delle impostazione, è possibile selezionare solo le schede delle voci di configurazione [Initial Setup] e [Others]. Una
volta completata la loro configurazione, le impostazioni iniziali possono essere configurate singolarmente.

Per informazioni dettagliate, fare riferimento a “Configurazione delle impostazioni iniziali dell’inquadratura automatica PTZ”.

3.
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Argomento correlato
Configurazione delle impostazioni iniziali dell’inquadratura automatica PTZ

5-041-957-34(1) Copyright 2022 Sony Corporation
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struttura della schermata delle operazioni di riproduzione

Questo argomento descrive la struttura della schermata delle operazioni di riproduzione.

Pannello dell’immagine della telecamera
Visualizza l’immagine di riproduzione e le relative informazioni. Quando la riproduzione è arrestata, viene visualizzata la schermata
dell’immagine della telecamera.

1.
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1-1 Ora e data di ripresa
1-2 Indicatore dello stato della riproduzione
1-3 Indicatore formato di riproduzione (dimensioni immagine)
1-4 Indicatore formato di riproduzione (codec)
1-5 Nome del clip
1-6 Numero del clip/numero totale dei clip
1-7 Nome della LUT
1-8 Indicatore dello stato dello streaming
1-9 Indicatore del formato di riproduzione (frequenza fotogrammi e metodo di scansione)
1-10 Indicatore del look di registrazione

Pannello di controllo della riproduzione

Visualizza i pulsanti di comando della riproduzione.

Pulsante [Display]
Premere per passare da una visualizzazione all’altra sull’immagine.
Pulsante [Thumbnail]
Visualizza come miniature nel pannello dell’immagine della telecamera i clip registrati sulla scheda di memoria della telecamera.

Premere di nuovo il pulsante [Thumbnail] mentre è visualizzata la schermata delle miniature per chiuderla e tornare all’immagine
della telecamera.

Per informazioni dettagliate sulla schermata delle miniature, vedere “Schermata delle miniature”.

Pulsante [Slot Select]
Passa da un supporto di memoria selezionato per la riproduzione all’altro.

2.

Pulsante Funzione

Pulsante  (play/pausa) Riproduce un clip. Durante la riproduzione, mette in pausa il clip.

Pulsante  (avanti veloce), pulsante
 (indietro veloce)

Riproduce un clip ad alta velocità. Premendo il pulsante, la velocità di riproduzione
incrementa gradualmente (tre velocità).

Pulsante  (successivo), pulsante 
(precedente)

Salta all’inizio del clip corrente o al clip precedente o successivo.

Pulsante  (stop) Arresta la riproduzione.

Pulsanti programmabili
Visualizza i pulsanti programmabili a cui sono assegnate funzioni sull’unità.

3.
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Argomento correlato
Schermata delle miniature
Pulsanti programmabili

Riproduzione dei clip registrati

5-041-957-34(1) Copyright 2022 Sony Corporation

Per informazioni dettagliate sui pulsanti programmabili, vedere “Pulsanti programmabili”.
Pannello dei comandi GUI
Il pannello dei comandi GUI consente di interagire con il menu della telecamera, riprodurre clip ed eseguire altre funzioni.

Per informazioni dettagliate sull’utilizzo, vedere “Utilizzo del menu della telecamera”e “Riproduzione dei clip registrati”.

4.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struttura della schermata delle impostazioni

La schermata delle impostazioni consente di configurare varie impostazioni dell’unità, fra cui le impostazioni iniziali, le impostazioni di
rete, le impostazioni di ripresa e riproduzione tramite il menu Web.

Nota

Nel menu Web, le impostazioni non vengono applicate fino a quando non si preme il pulsante [OK] come regola generale. Dopo aver modificato
impostazioni in una pagina in cui è presente il pulsante [OK], premere tale pulsante [OK] per applicarle.

Per informazioni dettagliate sulla schermata delle impostazioni, vedere “Menu Web e impostazioni dettagliate”.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Menu della telecamera

Nel pannello dei comandi GUI della schermata delle operazioni live o nella schermata delle operazioni di riproduzione, premere il
pulsante [Menu] per visualizzare il menu della telecamera nel pannello dell’immagine della telecamera.

Il menu della telecamera consente di configurare le varie impostazioni necessarie per la ripresa e la riproduzione.
Premere il pulsante [Menu] mentre è visualizzato il menu della telecamera per chiuderlo.
Utilizzare il pannello dei comandi GUI per interagire con il menu della telecamera.

Per informazioni dettagliate sul menu della telecamera, vedere “Menu della telecamera e impostazioni dettagliate”.

Nota
Il menu della telecamera non è visualizzato nel pannello dell’immagine della telecamera se [Monitoring] > [Output Display] > [HDMI/Stream] è
impostato su Off nel menu Web (disabilita la sovraimpressione delle informazioni nella schermata visualizzata a schermo). Si tenga presente,
tuttavia, che rimane possibile eseguire operazioni con il menu del pannello dei comandi GUI. Per evitare risultati indesiderati, non eseguire
nessuna operazione con il menu utilizzando il pannello dei comandi GUI quando [HDMI/Stream] è impostato su Off.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Significato delle indicazioni a schermo

È possibile visualizzare in sovraimpressione sull’immagine emessa in uscita dalla telecamera lo stato e le impostazioni dell’unità. È
possibile specificare le uscite per le quali sono abilitate le indicazioni a schermo utilizzando [Monitoring] > [Output Display] nel menu
Web.
È possibile visualizzare o nascondere queste informazioni utilizzando il pulsante [Display]. Anche se nascoste, verranno sempre
visualizzate quando si eseguono operazioni con il Direct Menu.
È possibile visualizzare o nascondere le voci individualmente utilizzando [Monitoring] > [Display On/Off] nel menu della telecamera.

Informazioni visualizzate sullo schermo durante le riprese

Indicatore di upload/indicatore file rimanenti

Per informazioni dettagliate sul trasferimento di file, vedere “Informazioni sul trasferimento di file” e altri argomenti in
“Trasferimento dei file”.

1.

Indicatore dell’area di messa a fuoco
Visualizza l’area di messa a fuoco per la messa a fuoco automatica.

Per informazioni dettagliate sulla messa a fuoco automatica, vedere “Regolazione automatica tramite l’app Web” e altri
argomenti in “Regolazione automatica della messa a fuoco (Auto Focus)”.

2.

Indicatore di modalità di registrazione, slot A/B, intervallo di registrazione Interval Rec

Per informazioni dettagliate sulla modalità Interval Rec, vedere “Registrazione di video a intervalli (Interval Rec)”.

3.

Indicazione Significato

●Rec Registrazione

Stby Standby registrazione

Indicatore di profondità di campo4.

Indicatore della modalità di scansione dell’imager
In caso di mancata corrispondenza fra le dimensioni del cerchio immagine dell’obiettivo e l’impostazione delle dimensioni
immagine effettive della modalità di scansione dell’immagine viene visualizzata l’indicazione  (mancata corrispondenza).
Quando Imager Scan Mode è impostata su FF, verrà visualizzata l’indicazione “C” nelle modalità con un angolo di visuale più
stretto (cropping).

5.
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Il cropping ha luogo nelle modalità indicate di seguito.

Quando il formato di registrazione è 3840×2160 e la frequenza fotogrammi di S&Q Motion è 100 fps o 120 fps
Quando [Codec] è impostato su RAW o RAW & XAVC-I e il formato di uscita RAW è 3840×2160
Per informazioni dettagliate sulla modalità di scansione dell’imager, vedere “Impostazione della modalità di scansione
dell’imager” in “Configurazione delle operazioni di base”.

Indicatore di stato dell’operazione di uscita RAW
Indica lo stato di uscita del segnale RAW.

Per informazioni dettagliate sulla modalità RAW, vedere “Registrazione di video RAW”.

6.

Indicatore della frequenza fotogrammi in modalità di ripresa Slow & Quick Motion

Per informazioni dettagliate sulla modalità di ripresa Slow & Quick Motion, vedere “Slow & Quick Motion”.

7.

Indicatore della posizione di messa a fuoco

Indica la posizione di messa a fuoco.

8.

Indicatore della modalità di messa a fuoco

Modalità AF con rilevamento del viso o degli occhi

Per informazioni dettagliate sulla modalità AF con rilevamento del viso o degli occhi, vedere “Seguimento con la funzione di
rilevamento del viso e degli occhi (Face/Eye Detection AF)”.

9.

Indicazione Significato

Focus Hold Modalità Focus Hold

MF Modalità MF

AF Modalità AF

 (modalità AF con seguimento in tempo reale) Modalità AF con seguimento in tempo reale

Indicazione Significato

 (modalità AF con rilevamento del viso o degli occhi) Indica che è attiva la modalità AF con rilevamento del viso o degli occhi

 (modalità AF con solo rilevamento viso o occhi) Indica che è attiva la modalità AF con solo rilevamento viso o occhi

 (Icona AF PTZ AFR) Indica che è attiva la funzione di inquadratura automatica PTZ

 (Icona viso da seguire salvato) Indica che è stato salvato un viso da seguire

 (AF in pausa) Indica che la modalità AF è in pausa*

Visualizzata solo quando non è stato salvato nessun viso da seguire e non è stato rilevato nessun viso, oppure quando è stato salvato un viso da seguire,
ma tale viso non è stato rilevato.

*

Indicazione della posizione di zoom
Visualizza la posizione dello zoom come lunghezza focale (se è montato un obiettivo che supporta la visualizzazione della
posizione dello zoom).
È possibile scegliere se visualizzare questa indicazione come barra o come indicazione della posizione dello zoom configurando
l’opzione [Technical] > [Lens] > [Zoom Position Display] del menu della telecamera.
Quando è abilitata la funzione Clear Image Zoom, vengono visualizzate sul display anche le indicazioni elencate di seguito.

10.

Indicazione Significato

 (Clear Image Zoom abilitato) Clear Image Zoom abilitato

Valore di ingrandimento Quando è utilizzata la funzione Clear Image Zoom
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Per informazioni dettagliate sullo zoom, vedere “Impostazione del tipo di zoom” e altri argomenti in “Regolazione dello zoom”.
Indicatore della modalità di stabilizzazione dell’immagine11.

Indicatore dello stato di Rec Control sull’uscita SDI o HDMI
Indica lo stato di uscita del segnale REC Control.

Per informazioni dettagliate, vedere “Connessione di monitor e dispositivi di registrazione esterni”.

12.

Indicatore della messa a fuoco

Per informazioni dettagliate, vedere “Utilizzo della funzione Single-Shot Auto Focus (Push Auto Focus (AF-S))” in “Regolazione
della messa a fuoco”.

13.

Indicatore dello spazio rimanente sui supporti di memoria
Se la scheda di memoria è protetta da scrittura viene visualizzata l’icona  (protezione).

14.

Indicatore modalità bilanciamento del bianco15.

Indicazione Significato

 (ATW) Modalità auto

 (ATW Hold) Modalità auto in pausa

W:P Modalità Preset

W:A Modalità memoria A

Indicatore della sincronizzazione con codice temporale esterno o indicatore dati temporali
Visualizza “EXT-LK” quando l’apparecchio è sincronizzato sul codice temporale di un dispositivo esterno.

Per informazioni dettagliate sul codice temporale, vedere “Specifica dei dati temporali”.

16.

Indicatore filtro ND

Per informazioni dettagliate sui filtri ND, vedere “Regolazione del livello di luce (filtro ND)”.
Per informazioni dettagliate sul controllo del Bokeh, vedere “Regolazione del bokeh (funzione di controllo bokeh)”.

17.

Indicazione Significato

 (A) Modalità auto

 (B) Modalità di controllo Bokeh

Indicatore file di scena

Per informazioni dettagliate sui file di scena, vedere “Descrizione generale dei look” e altri argomenti in “Ripresa con il look
desiderato”.

18.

Indicatore valore di diaframma
Visualizza il valore di diaframma (numero F) se è montato un obiettivo che supporta questa funzione.

Per informazioni dettagliate sul diaframma, vedere “Regolazione automatica del diaframma” e “Regolazione manuale del
diaframma”.

19.

Indicatore di avviso livello video20.

Indicatore guadagno
Visualizza il valore EI in modalità Cine EI/Cine EI Quick.

21.

Indicazione Significato

 (A) Modalità auto
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Per informazioni dettagliate sul guadagno, vedere “Regolazione automatica del guadagno” e “Regolazione manuale del
guadagno”.
Per informazioni dettagliate sulle modalità Cine EI/Cine EI Quick, vedere “Impostazione della modalità di ripresa” in
“Configurazione delle operazioni di base”.

Indicazione Significato

L Modalità L di preset

 (Modalità di regolazione temporanea) Modalità di regolazione temporanea

 (B) Modalità di controllo Bokeh

Visualizzazione nome clip
Visualizza il nome del clip in corso di registrazione o che verrà registrato successivamente.
Lampeggia per indicare che le impostazioni di [Camera ID] o [Reel Number] sono diverse da quelle dell’ultimo clip sul supporto di
registrazione. Per ulteriori informazioni, fare riferimento alla descrizione di [Clip Name Format] > [Auto Naming].

22.

Indicatore otturatore

Per informazioni dettagliate sull’otturatore, vedere “Regolazione automatica dell’otturatore” e “Regolazione manuale
dell’otturatore”.

23.

Indicatore modalità AE/livello AE

Per informazioni dettagliate sull’esposizione automatica (AE), vedere “Impostazione del livello ottimale per la regolazione
automatica della luminosità”.

24.

Indicatore di orizzontalità
Visualizza l’orizzontalità in incrementi di ±1° fino a un massimo di ±15°.

25.

Indicatore di livello audio
Indica il livello audio di ciascun canale.

26.

Monitor segnale video
Visualizza forma d’onda, vettorscopio e istogramma.
La linea arancione indica il valore impostato dell’indicatore del livello di luminosità.
Nelle modalità di ripresa Log, il tipo di LUT monitor target è indicato sopra alla visualizzazione.

Per informazioni dettagliate, vedere “Monitor segnale video”.
Per informazioni dettagliate sulle modalità di ripresa Log, vedere “Impostazione della modalità di ripresa” in “Configurazione
delle operazioni di base”.

27.

Indicatore Base Sensitivity / indicatore Base ISO
Nella modalità Custom, visualizza la sensibilità di base impostata utilizzando il pulsante [ISO/Gain / Exposure Index] nel pannello di
configurazione di base della telecamera oppure [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] nel menu della telecamera.
Nelle modalità di ripresa Log, visualizza la sensibilità base Base ISO impostata utilizzando il pulsante [ISO/Gain / Exposure Index]
nel pannello di configurazione di base della telecamera oppure [Shooting] > [ISO/Gain/EI] > [Base ISO] nel menu della telecamera.

Per informazioni dettagliate sulla sensibilità di base, vedere “Selezione della sensibilità di base (Base Sensitivity)”.
Per informazioni dettagliate sulle modalità di ripresa Log, vedere “Impostazione della modalità di ripresa” in “Configurazione
delle operazioni di base”.

28.

Indicatore del look di monitoraggio
Nelle modalità di ripresa Log, visualizza l’impostazione della LUT monitor.

Per informazioni dettagliate sull’impostazione della LUT, vedere “Ripresa con regolazione del look in post-produzione” e
argomenti correlati.
Per informazioni dettagliate sulle modalità di ripresa Log, vedere “Impostazione della modalità di ripresa” in “Configurazione
delle operazioni di base”.

29.

Indicatore look di base/look di registrazione
Visualizza l’impostazione del Look di base.
Nelle modalità di ripresa Log, visualizza il segnale video da registrare sulle schede di memoria.

30.
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Informazioni visualizzate sullo schermo durante la riproduzione

Le seguenti informazioni vengono sovraimposte sull’immagine riprodotta.

Per informazioni dettagliate sul look di base, vedere “Descrizione generale dei look” in “Ripresa con il look desiderato”.
Per informazioni dettagliate sulle modalità di ripresa Log, vedere “Impostazione della modalità di ripresa” in “Configurazione
delle operazioni di base”.

Indicatore stato proxy31.

Indicatore del formato di registrazione (codec)
Visualizza il nome del formato di registrazione sulle schede di memoria.
Impostare il formato di registrazione (codec) utilizzando [Project] > [Rec Format] > [Codec] nel menu Web o nel menu della
telecamera.

32.

Indicatore formato di registrazione (frequenza fotogrammi e metodo di scansione)33.

Indicatore formato di registrazione (dimensioni immagine)
Visualizza le dimensioni immagine per la registrazione sulle schede di memoria.
Impostare il formato di registrazione (dimensioni immagine) utilizzando [Project] > [Rec Format] > [Codec] nel menu Web o nel
menu della telecamera.

34.

Indicatore tally
Visualizza intorno all’immagine una cornice rossa o verde in base al segnale di tally esterno ricevuto.

35.

Indicatore di upload/indicatore file rimanenti1.

Numero clip2.

Indicatore dello stato della riproduzione3.

Indicatore formato di riproduzione (frequenza fotogrammi e metodo di scansione)4.

Indicatore formato di riproduzione (dimensioni immagine)5.

Indicatore formato di riproduzione (codec)6.

Indicatore supporto
Se la scheda di memoria è protetta da scrittura viene visualizzata l’icona  (protezione).

7.

Visualizzazione dati temporali8.

Visualizzazione nome clip9.

Indicatore assistenza visualizzazione gamma10.
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Argomento correlato
Informazioni sul trasferimento di file
Regolazione automatica tramite l’app Web

Registrazione di video a intervalli (Interval Rec)

Configurazione delle operazioni di base
Registrazione di video RAW

Slow & Quick Motion

Seguimento con la funzione di rilevamento del viso e degli occhi (Face/Eye Detection AF)
Impostazione del tipo di zoom

Connessione di monitor e dispositivi di registrazione esterni

Utilizzo della funzione Single-Shot Auto Focus (Push Auto Focus (AF-S))
Specifica dei dati temporali

Descrizione generale dei look

Regolazione automatica del diaframma

Regolazione manuale del diaframma
Regolazione automatica del guadagno

Regolazione manuale del guadagno

Regolazione automatica dell’otturatore
Regolazione manuale dell’otturatore

Impostazione del livello ottimale per la regolazione automatica della luminosità

Monitor segnale video
Ripresa con regolazione del look in post-produzione

Clip Name Format

5-041-957-34(1) Copyright 2022 Sony Corporation

Indicatore di livello audio
Visualizza il livello di riproduzione dell’audio.

11.

Indicatore look di base/look di registrazione12.

Indicatore tally13.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montaggio verticale in una posizione fissa

Questo argomento descrive il montaggio dell’unità su un ripiano o un treppiede.

Note di installazione
Per proteggere l’obiettivo e i connettori dell’obiettivo dell’unità, mantenere sempre montati il copriobiettivo e il coperchietto di
protezione fino al montaggio dell’obiettivo.
Per evitare danni all’obiettivo, non afferrare l’obiettivo durante il lavoro.
Per evitare danni all’unità, non afferrare il corpo della telecamera durante il lavoro.

Controllare lo spazio a disposizione per il montaggio.

Montaggio su ripiano
Montare l’unità su una superficie piana, assicurando la presenza di uno spazio sufficiente per la rotazione dell’obiettivo e i
cablaggi sul retro dell’unità.

Nota

Montare in una posizione non soggetta a vibrazioni. La presenza di vibrazioni potrà dar luogo a immagini mosse.

Se l’unità deve essere installata su una superficie inclinata, assicurarsi che l’inclinazione di tale superficie non ecceda i ±15° dall’orizzontale
e adottare opportune misure evitare la caduta dell’unità.

Montaggio su treppiede
Fissare il treppiede al foro di montaggio del treppiede presente sul lato inferiore.
Assicurarsi che la vite del treppiede sporga dalla superficie di montaggio della lunghezza indicata di seguito e stringerla con un
cacciavite a mano.

A: Viti di montaggio per treppiede 1/4-20 UNC, ISO 1222 (6,35 mm)
B: Sporgenza (da 4,5 mm a 5,5 mm)

Non montare l’unità in posizioni elevate fissandola con viti per treppiede.

Nota

1
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Montare quindi l’obiettivo. Vedere “Montaggio dell’obiettivo”, prestando attenzione anche alle informazioni fornite in “Precauzioni per il
montaggio e la rimozione di un obiettivo”, “Controllo dei selettori dell’obiettivo” e “Precauzioni per l’uso di obiettivi zoom”.

Argomento correlato
Precauzioni per il montaggio e la rimozione di un obiettivo

Controllo dei selettori dell’obiettivo
Precauzioni per l’uso di obiettivi zoom

Montaggio dell’obiettivo
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Selezionare sempre un treppiede stabile, che non si ribalti durante la rotazione dell’obiettivo.
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montaggio verticale in una posizione fissa elevata

Questo argomento descrive la procedura per il montaggio dell’unità in posizione diritta su una superficie elevata utilizzando la staffa
per montaggio a soffitto (CIB-PCM1 (opzione)).

Per il montaggio dell’unità in una posizione elevata, rivolgersi a personale specializzato.
Per il montaggio in una posizione elevata, assicurarsi che la superficie a cui si desidera fissare l’unità e i relativi materiali (esclusi
gli accessori) siano in grado di sostenere un peso di almeno 200 kg, quindi montare l’unità come descritto in questa guida. Se il
montaggio non è sufficientemente robusto, l’unità potrebbe cadere e causare danni o gravi infortuni alle persone.
Fissare il cavetto anticaduta alla staffa per montaggio a soffitto CIB-PCM1 (opzione) per impedire la caduta dell’unità.
Quando l’unità è montata in una posizione elevata, controllare almeno una volta all’anno che il montaggio non si sia allentato.
Controllare più frequentemente se richiesto dalle condizioni di utilizzo.

Note di installazione
Per proteggere l’obiettivo e i connettori dell’obiettivo dell’unità, mantenere sempre montati il copriobiettivo e il coperchietto di
protezione fino al montaggio dell’obiettivo.
Per evitare danni all’obiettivo, non afferrare l’obiettivo durante il lavoro.
Per evitare danni all’unità, non afferrare il corpo della telecamera durante il lavoro.

Controllare gli accessori per il montaggio in posizione elevata e lo spazio a disposizione.

Kit staffa per montaggio a soffitto CIB-PCM1 (opzionale)
Prima di iniziare, controllare di avere a disposizione quanto segue.

Staffa di fissaggio al corpo della telecamera (1)
Staffa per montaggio a soffitto (1)
Protezione del pulsante di sblocco dell’obiettivo (1)
Cavetto anticaduta (1)
Viti +PSW M3×8 (9)
Vite +PSW M4×8 in acciaio inox per il cavetto anticaduta (1)

Nota
Il cavetto anticaduta è progettato per essere in grado di sostenere l’unità se sospesa ad esso. Non applicare ad esso carichi diversi da
quello esercitato dall’unità.

Spazio di montaggio

1
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Fare riferimento al seguente disegno per determinare la posizione e la direzione di montaggio, assicurando la presenza di uno
spazio sufficiente per la rotazione dell’obiettivo e il cablaggio sul retro dell’unità.

A: Raggio di movimento del corpo della telecamera (es. SEL70200GM2 (con SEL20TC montato): Ø370)
B: Staffa per montaggio a soffitto (foro sul lato della superficie di montaggio (Ø150))
C: Foro di allineamento del montaggio

Nota

Montare in una posizione non soggetta a vibrazioni. La presenza di vibrazioni potrà dar luogo a immagini mosse.

Se l’unità deve essere installata su una superficie inclinata, assicurarsi che l’inclinazione di tale superficie non ecceda i ±15° dall’orizzontale
e adottare opportune misure evitare la caduta dell’unità.

Spostare la levetta di blocco pan/tilt sulla posizione LOCK per bloccare il movimento di rotazione e inclinazione del
corpo della telecamera.

Nota
Se il movimento di rotazione e inclinazione (pan/tilt) della telecamera non si blocca quando la levetta di blocco si trova sulla posizione
LOCK, spostare manualmente il corpo della telecamera fino al blocco in posizione.

2
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Assicurare la staffa di fissaggio corpo al lato inferiore della telecamera, utilizzando le sei viti in dotazione (M3×8).

Utilizzare le viti in dotazione. L’uso di viti diverse potrebbe danneggiare i componenti interni dell’unità.

3

Fissare il cavetto anticaduta alla staffa di fissaggio del corpo della telecamera.4
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A: Cavetto anticaduta fornito　
B: Viti Phillips fornite (M4×8)
C: Asola per il cavetto anticaduta

Utilizzare la vite in dotazione. L’uso di una vite diversa da quella fornita potrebbe compromettere l’efficacia del cavetto anticaduta.

Fissare la staffa per montaggio a soffitto alla superficie, ad esempio una mensola, dove verrà montata l’unità.5
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A: Parete　
B: Indicatore △ (direzione avanti della telecamera)
C: Foro per cavi di collegamento
D: Ripiano o altra superficie di montaggio

Fissare il cavetto anticaduta in prossimità della superficie di montaggio.

Utilizzando una vite M5 (3/16 di pollice) a testa cava esagonale (opzione), assicurare il cavetto a un punto in prossimità del
ripiano o della superficie a cui è fissata la staffa per montaggio a soffitto.

6
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A: Cavetto anticaduta　
B: Vite a testa cava esagonale (M5, 3/16 di pollice)

Allineare il foro della vite 〇 nella parte anteriore della staffa di fissaggio corpo con il foro ◇ della staffa per montaggio a
soffitto, quindi inserire l’unità e assicurare temporaneamente la staffa di fissaggio corpo nella staffa per montaggio a
soffitto ruotando l’unità in senso orario.

7
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A: Foro 〇
B: Foro ◇

Assicurare insieme la staffa di fissaggio corpo alla staffa per montaggio a soffitto utilizzando le tre viti di blocco della
rotazione fornite (M3×8).

8
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Montare quindi l’obiettivo. Vedere “Montaggio dell’obiettivo”, prestando attenzione anche alle informazioni fornite in “Precauzioni per il
montaggio e la rimozione di un obiettivo”, “Controllo dei selettori dell’obiettivo” e “Precauzioni per l’uso di obiettivi zoom”.

Nota

Dopo aver montato l’obiettivo, controllare che sia saldamente fissato.
L’obiettivo non ha nessuna protezione contro la caduta. Sony non può assumersi alcuna responsabilità in caso di caduta di un obiettivo dall’unità.

Argomento correlato
Precauzioni per il montaggio e la rimozione di un obiettivo

Controllo dei selettori dell’obiettivo
Precauzioni per l’uso di obiettivi zoom

Montaggio dell’obiettivo
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Controllare il montaggio.

Specificatamente, controllare quanto segue: 

Le viti di montaggio sono fissate correttamente.
Il cavetto anticaduta è fissato correttamente e non è attorcigliato.
L’unità è montata orizzontalmente (senza inclinazione o oscillazioni).
L’unità non si muove liberamente se si cerca di farla ruotare a mano.

9
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montaggio a soffitto

Questo argomento descrive la procedura per il montaggio dell’unità su un soffitto utilizzando la staffa per montaggio a soffitto (CIB-
PCM1 (opzione)).

Per il montaggio dell’unità su un soffitto, rivolgersi a personale specializzato.
Per il montaggio a soffitto, assicurarsi che la superficie a cui si desidera fissare l’unità e i relativi materiali (esclusi gli accessori)
siano in grado di sostenere un peso di almeno 200 kg, quindi montare l’unità come descritto in questa guida. Se il montaggio non è
sufficientemente robusto, l’unità potrebbe cadere e causare danni o gravi infortuni alle persone.
Fissare il cavetto anticaduta alla staffa per montaggio a soffitto CIB-PCM1 (opzione) per impedire la caduta dell’unità.
Quando l’unità è montata su un soffitto, controllare almeno una volta all’anno che il montaggio non si sia allentato. Controllare più
frequentemente se richiesto dalle condizioni di utilizzo.

Note di installazione
Per proteggere l’obiettivo e i connettori dell’obiettivo dell’unità, mantenere sempre montati il copriobiettivo e il coperchietto di
protezione fino al montaggio dell’obiettivo.
Per evitare danni all’obiettivo, non afferrare l’obiettivo durante il lavoro.
Per evitare danni all’unità, non afferrare il corpo della telecamera durante il lavoro.

Controllare gli accessori per il montaggio a soffitto e lo spazio a disposizione.

Kit staffa per montaggio a soffitto CIB-PCM1 (opzionale)
Prima di iniziare, controllare di avere a disposizione quanto segue.

Staffa di fissaggio al corpo della telecamera (1)
Staffa per montaggio a soffitto (1)
Protezione del pulsante di sblocco dell’obiettivo (1)
Cavetto anticaduta (1)
Viti +PSW M3×8 (9)
Vite +PSW M4×8 in acciaio inox per il cavetto anticaduta (1)

Nota
Il cavetto anticaduta è progettato per essere in grado di sostenere l’unità se sospesa ad esso. Non applicare ad esso carichi diversi da
quello esercitato dall’unità.

Spazio di montaggio

1
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Fare riferimento al seguente disegno per determinare la posizione e la direzione di montaggio, assicurando la presenza di uno
spazio sufficiente per la rotazione dell’obiettivo e il cablaggio sul retro dell’unità.

A: Raggio di movimento del corpo della telecamera (es. SEL70200GM2 (con SEL20TC montato): Ø370)
B: Staffa per montaggio a soffitto (foro sul lato del soffitto (Ø150))
C: Foro di allineamento del montaggio

Nota

Montare solo su soffitti con una resistenza sufficiente (es. cemento).

Se il soffitto non ha una resistenza sufficiente, prevedere opportuni rinforzi.

Montare in una posizione non soggetta a vibrazioni. La presenza di vibrazioni potrà dar luogo a immagini mosse.

Se l’unità deve essere installata su una superficie inclinata, assicurarsi che l’inclinazione di tale superficie non ecceda i ±15° dall’orizzontale
e adottare opportune misure evitare la caduta dell’unità.

Il lato opposto al foro △ sulla staffa di montaggio a soffitto è la direzione di ripresa (lato anteriore della telecamera).

Spostare la levetta di blocco pan/tilt sulla posizione UNLOCK per sbloccare il movimento di rotazione e di inclinazione,
quindi ruotare la testa della telecamera di 180° nella direzione di inclinazione (tilt).

2

Spostare la levetta di blocco pan/tilt sulla posizione LOCK per bloccare il movimento di rotazione e inclinazione del
corpo della telecamera.

3
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Corpo della telecamera ruotato di 180°

Nota
Se il movimento di rotazione e inclinazione (pan/tilt) della telecamera non si blocca quando la levetta di blocco si trova sulla posizione
LOCK, spostare manualmente il corpo della telecamera fino al blocco in posizione.

Assicurare la staffa di fissaggio corpo al lato inferiore della telecamera, utilizzando le sei viti in dotazione (M3×8).4
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Utilizzare le viti in dotazione. L’uso di viti diverse potrebbe danneggiare i componenti interni dell’unità.

Fissare la staffa per montaggio a soffitto a una piastra di montaggio (opzione), quindi assicurare la piastra al soffitto.

A: Staffa per montaggio a soffitto
B: Soffitto
C: Piastra di montaggio
D: Foro △

5
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Fissare la staffa, in base all’orientamento della staffa per montaggio a soffitto
Si osservi che in caso di montaggio a soffitto, la parte anteriore della telecamera si trova sul lato opposto della staffa per
montaggio a soffitto rispetto a un normale montaggio verticale. Montare correttamente facendo riferimento al diagramma che
indica la direzione di montaggio.

A: Lato anteriore per montaggio verticale (orientamento foro △)
B: Lato anteriore per montaggio a soffitto

Nota

Il materiale della superficie di montaggio è di responsabilità del cliente.

Fissare il cavetto anticaduta al soffitto.

A: Staffa per montaggio a soffitto
B: Vite a testa cava esagonale (M5, 3/16 di pollice)
C: Cavetto anticaduta (fornito)
D: Piastra di montaggio
E: Soffitto

6

Fare passare il cavetto anticaduta attraverso il foro al centro della staffa per montaggio a soffitto e assicurarlo alla staffa
di fissaggio corpo.

Far passare il cavetto anticaduta nell’apposita asola in metallo della staffa di fissaggio corpo e assicurarlo saldamente alla staffa
utilizzando la vite in acciaio inox in dotazione (M4×8).

7
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A: Cavetto anticaduta fornito
B: Viti Phillips fornite (M4×8)
C: Asola per il cavetto anticaduta

Utilizzare la vite in dotazione. L’uso di una vite diversa da quella fornita potrebbe compromettere l’efficacia del cavetto anticaduta.

Nota

Si raccomanda che una persona sostenga l’unità come mostrato nella figura seguente mentre una seconda persona provvede al
montaggio dell’unità.

Durante il montaggio dell’unità, non sostenerla afferrando il corpo della telecamera o il supporto dell’obiettivo. In caso di caduta dell’unità, è
presente il rischio di danni a persone o cose.

Al momento della connessione elettrica, prestare la massima attenzione che i cavi e i morsetti di connessione non vengano cortocircuitati
dal cavetto anticaduta.

Il sistema di montaggio è in grado di sostenere una massa sospesa di fino a 8,8 kg (incluso l’obiettivo). Per evitare la caduta dell’unità, non
eccedere il peso massimo previsto.
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Allineare il foro per vite (A) della staffa di fissaggio corpo con il foro ◇ (B) della staffa per montaggio a soffitto, inserire
l’unità e ruotarla di circa 60 gradi in senso orario fino ad allineare il foro per vite (A) con il foro per vite (C).

A: Foro per vite sulla staffa di fissaggio corpo
B: Foro per vite sulla staffa per montaggio a soffitto (foro ◇)
C: Foro per vite
D: Soffitto
E: Piastra di montaggio

8

Assicurare insieme la staffa di fissaggio corpo alla staffa per montaggio a soffitto utilizzando le tre viti di blocco della
rotazione fornite (M3×8).

9
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Montare quindi l’obiettivo. Vedere “Montaggio dell’obiettivo”, prestando attenzione anche alle informazioni fornite in “Precauzioni per il
montaggio e la rimozione di un obiettivo”, “Controllo dei selettori dell’obiettivo” e “Precauzioni per l’uso di obiettivi zoom”.

Nota

Per azionare il movimento di pan e tilt nella direzione corretta quando l’unità è montata a soffitto, impostare [Pan-Tilt] > [Direction] > [Ceiling] su
[On] nel menu Web.

Dopo aver montato l’obiettivo, controllare che sia saldamente fissato.
L’obiettivo non ha nessuna protezione contro la caduta. Sony non può assumersi alcuna responsabilità in caso di caduta di un obiettivo dall’unità.

Argomento correlato
Precauzioni per il montaggio e la rimozione di un obiettivo
Controllo dei selettori dell’obiettivo

Precauzioni per l’uso di obiettivi zoom

Montaggio dell’obiettivo
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Controllare il montaggio.

Specificatamente, controllare quanto segue:

Le viti di montaggio sono fissate correttamente.
Il cavetto anticaduta è fissato correttamente e non è attorcigliato.
L’unità è montata orizzontalmente (senza inclinazione o oscillazioni).
L’unità non si muove liberamente se si cerca di farla ruotare a mano.

10
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Precauzioni per il montaggio e la rimozione di un obiettivo

Non lasciare l’obiettivo rivolto verso il sole. La luce solare diretta condotta dalle ottiche dell’obiettivo può mettersi a fuoco all’interno
dell’unità e causare incendi.

Nota
Montare e smontare l’obiettivo solo con l’unità spenta.

Gli obiettivi sono componenti di elevata precisione. Non appoggiare mai un obiettivo su una superficie con il suo innesto rivolto verso il basso.
Montare sempre il coperchietto di protezione fornito.

Suggerimento
Per informazioni dettagliate sugli obiettivi supportati dall’unità, contattare il servizio di assistenza Sony.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Controllo dei selettori dell’obiettivo

È necessario eseguire i controlli e le configurazioni che si descrivono di seguito, in base al tipo di obiettivo.

Obiettivo con selettore di modalità di messa a fuoco

Spostare il selettore su AF/MF o AF.
Se il selettore della messa a fuoco dell’obiettivo si trova sulle posizioni MF o Full MF, la messa a fuoco può essere eseguita solo
agendo sulla ghiera dell’obiettivo.

Nota
Quando si utilizza un obiettivo con innesto A-mount, potrebbe non essere possibile eseguire la regolazione manuale con un telecomando.

Obiettivo con selettore zoom

Spostare il selettore su SERVO.
Se il selettore si trova sulla posizione MANUAL, lo zoom potrà essere regolato solo usando la ghiera dell’obiettivo. I comandi di zoom
inviati dall’unità non hanno alcun effetto.

Obiettivo con selettore Auto Iris

Spostare il selettore su AUTO.
Se il selettore non si trova sulla posizione AUTO, sarà possibile regolare il diaframma solo usando la ghiera dell’obiettivo. I comandi di
regolazione del diaframma provenienti dall’unità non hanno alcun effetto.

Obiettivo con selettore di stabilizzazione dell’immagine

Spostare il selettore su OFF.
Se il selettore si trova sulla posizione ON, potrebbero verificarsi comportamenti anomali durante i movimenti di pan e tilt.

SELP28135G

A: Spostare la ghiera di messa a fuoco sulla sua posizione in avanti (modalità AF/MF).
B: Spostare il selettore ZOOM sulla posizione SERVO.
C: Spostare la ghiera del diaframma su “A” e il selettore IRIS LOCK sulla posizione LOCK.
D: Spostare su OFF il selettore della stabilizzazione dell’immagine.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Precauzioni per l’uso di obiettivi zoom

Se si utilizzano obiettivi zoom non motorizzati, la posizione di zoom potrebbe cambiare, in base all’ambiente di montaggio. Assicurare
la ghiera dello zoom nella posizione desiderata utilizzando nastro adesivo.

Nastro adesivo in plastica: 471 BLA 50 o equivalente

5-041-957-34(1) Copyright 2022 Sony Corporation
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Montaggio dell’obiettivo

Questo argomento descrive il montaggio di obiettivi con innesto E-mount o A-mount.

Nota

Non trasportare l’unità con l’obiettivo ancora montato.

Quando si utilizza un obiettivo con innesto A-mount, il diaframma è impostato manualmente e la messa a fuoco è impostata su MF.

Spostare la levetta di blocco pan/tilt sulla posizione LOCK per bloccare il movimento di rotazione e inclinazione del
corpo della telecamera.

Nota
Se il movimento di rotazione e inclinazione (pan/tilt) della telecamera non si blocca quando la levetta di blocco si trova sulla posizione
LOCK, spostare manualmente il corpo della telecamera fino al blocco in posizione.

1

Ruotare la levetta di blocco della vite di fissaggio del piedino del supporto dell’obiettivo in senso antiorario per
sbloccarla, quindi spostare la vite di fissaggio del piedino del supporto dell’obiettivo in una posizione che non
interferisca con l’obiettivo.

A: Posizione corretta
B: Posizione errata

2
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Ruotare la levetta di blocco del corpo della telecamera nella direzione della freccia per sbloccare il corpo della
telecamera.

Nota

Fino a quando non ne viene ripristinato il blocco, è presente il rischio che il corpo della telecamera si muova sotto il proprio peso.
Sostenere il corpo della telecamera con la mano durante l’operazione.

3

Spostare il corpo della telecamera in avanti fino all’arresto.4

Ruotare la levetta di blocco del corpo della telecamera nella direzione della freccia per bloccarlo in posizione.

Nota

5
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Assicurarsi che la levetta di blocco del corpo della telecamera non entri in contatto con altre parti per evitare interferenze con i movimenti di
inclinazione verticale (tilt).

Rimuovere i coperchietti di protezione dal corpo della telecamera e dall’obiettivo.6

Allineare l’indicatore dell’innesto dell’obiettivo (bianco) con quello dell’unità, inserire l’obiettivo nel corpo della
telecamera con la massima attenzione e quindi ruotare l’obiettivo in senso orario fino allo scatto di blocco in posizione.

A: Indicatori di allineamento (bianchi)

Nota
Per poter montare un obiettivo con innesto A-mount, è necessario montare prima sull’unità l’apposito adattatore (opzionale).

7

Ruotare la levetta di blocco del corpo della telecamera nella direzione della freccia per sbloccare il corpo della
telecamera.

Nota
Fino a quando non ne viene ripristinato il blocco, è presente il rischio che il corpo della telecamera si muova sotto il proprio peso.
Sostenere il corpo della telecamera con la mano durante l’operazione.

8

Assicurarsi di mantenere l’equilibrio del corpo della telecamera spostandolo avanti o indietro in modo che la base
scorrevole rimanga orizzontale.

9
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Se si utilizza uno dei seguenti obiettivi, è possibile eseguire approssimativamente il bilanciamento dell’unità e dell’obiettivo
facendo riferimento alla scala graduata sulla slitta di scorrimento.

Nota
La scala sulla base della slitta di scorrimento offre solo un’indicazione approssimativa.

Al momento del montaggio dell’obiettivo, apportare le regolazioni necessarie in modo che l’unità non si inclini avanti o indietro.

Regolare il bilanciamento su una superficie orizzontale.

Rimuovere il supporto dell’obiettivo quando si utilizza un obiettivo SELC1635G.

Posizione della scala Modello dell’obiettivo

0,5 SEL70200GM (con SEL20TC montato)

1,7 SEL70200GM

2,0 SEL70200GM2 (con SEL20TC montato)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

5,0 o superiore SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Ruotare la levetta di blocco del corpo della telecamera nella direzione della freccia per bloccarlo in posizione.

Nota

10
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Assicurarsi che la levetta di blocco del corpo della telecamera non entri in contatto con altre parti per evitare interferenze con i movimenti di
inclinazione verticale (tilt).
Metodo per la verifica: spostare la levetta di blocco pan/tilt sulla posizione UNLOCK, quindi ruotare manualmente la sezione telecamera in
modo che sia rivolta verso l’alto e verificare visualmente che non sia in contatto con altre parti. In caso di contatto, ruotare nuovamente la
levetta di blocco del corpo della telecamera nella direzione della freccia.

Ruotare in senso antiorario le levette di blocco del supporto dell’obiettivo per sbloccarlo.

A: Levetta di blocco della barra del supporto dell’obiettivo (2)
B: Supporto obiettivo

11

Spostare il supporto dell’obiettivo in modo che il piedino del supporto dell’obiettivo sia allineato con la vite di fissaggio
del piedino del supporto dell’obiettivo, quindi ruotare la vite in senso orario per fissare il piedino di supporto
dell’obiettivo.

Nota
Assicurarsi che il piedino del supporto dell’obiettivo sia perpendicolare alla sua vite di fissaggio, quindi stringere.

12

Ruotare la levetta di blocco della vite di fissaggio del piedino di supporto dell’obiettivo in senso orario per bloccare tale
vite di fissaggio.

A: Vite di fissaggio del piedino del supporto dell’obiettivo
B: Foro della vite di fissaggio
C: Levetta di blocco della vite di fissaggio del piedino del supporto dell’obiettivo

Suggerimento

13
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Argomento correlato
Calibrazione di un obiettivo E-mount

5-041-957-34(1) Copyright 2022 Sony Corporation

Se una levetta di blocco viene a trovarsi in una posizione che ne rende difficoltosa la rotazione, rilasciarla e ruotarla in una posizione più
comoda. Quando si trova nella posizione desiderata, serrare la levetta di blocco.

A: Levetta di blocco della vite di fissaggio del piedino del supporto dell’obiettivo
B: Levetta di blocco della barra del supporto dell’obiettivo

Ruotare in senso orario le due levette di blocco della barra del supporto dell’obiettivo per bloccare il supporto.14

Controllare che entrambe le levette siano ben serrate e non siano allentate, controllare che l’obiettivo sia montato
correttamente e che i selettori dell’obiettivo si trovino sulle posizioni corrette.

L’obiettivo potrebbe cadere e danneggiarsi se non è montato correttamente o se anche una sola delle levette è allentata.
Se si utilizza un obiettivo con zoom motorizzato di tipo E-mount, è necessario inoltre calibrare tale obiettivo separatamente
per poter ripristinare con precisione le posizioni di zoom memorizzate nella telecamera come posizioni di preset. Per
informazioni dettagliate, vedere “Calibrazione di un obiettivo E-mount”.

15
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Rimozione dell’obiettivo

Per la rimozione di un obiettivo, utilizzare in ordine inverso la stessa procedura utilizzata per il suo montaggio.

Nota
Afferrare saldamente l’obiettivo con la mano per impedirne la caduta.

Se non viene montato un altro obiettivo immediatamente, montare sempre il coperchietto di protezione del corpo.

Argomento correlato
Montaggio dell’obiettivo

5-041-957-34(1) Copyright 2022 Sony Corporation

Controllare che il movimento di pan e tilt sia bloccato.1

Ruotare la levetta di blocco della vite di fissaggio del piedino di supporto dell’obiettivo in senso antiorario per
sbloccarla.

2

Rimuovere la vite di fissaggio del piedino del supporto dell’obiettivo sul supporto dell’obiettivo e spostarlo in una
posizione che non interferisca con l’obiettivo.

3

Sbloccare il corpo della telecamera e spostarlo in avanti il più possibile.

Per informazioni dettagliate, vedere i passi da 3 a 5 in “Montaggio dell’obiettivo”.

4

Mantenendo premuto il pulsante di rilascio dell’obiettivo, ruotare l’obiettivo in senso antiorario sostenendolo con la
mano.

5

Con gli indicatori (bianchi) della telecamera e dell’obiettivo allineati, estrarre l’obiettivo tirandolo in avanti.6
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Collegamento dei cavi

Questo argomento descrive la connessione dei cavi.

5-041-957-34(1) Copyright 2022 Sony Corporation

Collegare i cavi necessari ai connettori presenti sul pannello posteriore.

Per evitare l’estrazione del cavo HDMI, svitare la vite di montaggio della piastrina di fissaggio del cavo HDMI (M2.6×6, nera) dal
pannello connettori e utilizzarla per montare la piastrina di fissaggio del cavo HDMI fornita. Assicurare il cavo HDMI all’apposita
piastrina di fissaggio utilizzando una normale fascetta fissacavi disponibile in commercio.

A: Vite di montaggio della piastrina di fissaggio del cavo HDMI (M2.6×6, nera)
B: Fascetta fissacavi disponibile in commercio
C: Piastrina di fissaggio cavo HDMI (fornita)

1
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Connessione dell’unità a un dispositivo di rete tramite connessione cablata

Questo argomento descrive la connessione dell’unità a un dispositivo di rete tramite connessione cablata.

Connessione a una rete senza server DHCP

Per impostazione predefinita di fabbrica, l’unità è configurata per ottenere un indirizzo IP automaticamente da un server DHCP.
In generale, i router Wi-Fi disponibili in commercio sono dotati di funzione di server DHCP. Tuttavia, per la connessione a una rete che
non dispone di un server DHCP, impostare un indirizzo IP fisso utilizzando la procedura seguente.

Collegare l’unità un dispositivo di rete (ad esempio un punto di accesso Wi-Fi o uno switch) utilizzando un cavo LAN di
categoria 5e o superiore.

1

Accedere all’app Web e configurare le impostazioni iniziali dell’unità.

Per informazioni dettagliate, vedere “Accesso all’app Web tramite un browser Web” e “Configurazione iniziale dell’unità”.

2

Disconnettere l’alimentazione dall’unità.1.
Spostare sulla posizione ON il selettore SETUP 4 situato sul pannello dei connettori dell’unità (modalità indirizzo IP fisso).2.

Collegare l’alimentazione all’unità.
L’indirizzo IP dell’unità verrà impostato su 192.168.0.100, indipendentemente dall’impostazione dell’indirizzo IP nel menu Web.

3.

Impostare l’indirizzo IP del computer di configurazione su un indirizzo univoco sulla stessa rete, ad esempio 192.168.0.200.4.
Collegare direttamente il computer di configurazione all’unità utilizzando un cavo LAN.5.
Sul computer di configurazione, immettere “192.168.0.100” nella barra degli indirizzi di un browser Web
Viene visualizzata l’app Web dell’unità. Verrà richiesto di immettere il nome utente e la password. Configurare le impostazioni come
descritto in “Configurazione iniziale dell’unità”.

6.

Configurare quanto segue in [Network] > [Wireless LAN] > [IPv4] nel menu Web e premere il pulsante [OK].
Le impostazioni sono indicate a solo titolo di esempio. Modificare le impostazioni in base alla rete specifica a cui connettersi.

7.

Voce Impostazione Note

[DHCP] [Off]
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Argomento correlato
Accesso all’app Web tramite un browser Web

Configurazione iniziale dell’unità

Alimentazione PoE++

5-041-957-34(1) Copyright 2022 Sony Corporation

Voce Impostazione Note

[IP Address] 192.168.0.101
L’ultimo segmento deve essere un numero univoco e non assegnato a nessun altro dispositivo
connesso alla stessa rete.

[Subnet
Mask]

255.255.255.0

[Gateway] 192.168.0.1 Configurare le impostazioni in base alla rete.

Attendere 10 secondi circa, quindi rimuovere l’alimentazione dall’unità.8.
Spostare sulla posizione OFF il selettore SETUP 4 situato sul pannello dei connettori.9.
Ricollegare il cavo LAN di rete all’unità.10.
Collegare l’alimentazione all’unità.11.
Immettere l’indirizzo IP configurato nel passo 7 in un browser Web connesso alla rete.
Viene visualizzata la schermata dell’App Web.

12.
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Alimentazione CA

Questo argomento descrive la procedura per l’alimentazione dell’unità dalla rete elettrica.

Spostare la levetta di blocco pan/tilt sulla posizione LOCK per bloccare il movimento di rotazione e inclinazione del
corpo della telecamera.

1

Collegare l’adattatore CA (fornito) al connettore DC IN dell’unità, quindi collegarne il cavo di alimentazione (fornito) a
una presa di corrente.

A: Connettore DC IN
B: Cavo di alimentazione
C: Adattatore CA

2

Per evitare lo scollegamento del cavo di alimentazione CA, assicurarlo utilizzando l’apposito dispositivo di fissaggio.

Sbloccare il dispositivo di fissaggio, fare passare il cavo attraverso di esso come mostrato nella seguente figura, quindi bloccare
nuovamente il dispositivo di fissaggio.

3
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Nota

Non utilizzare adattatori CA o cavi di alimentazione diversi da quelli forniti insieme all’unità. Il collegamento di adattatori o cavi di alimentazione
diversi potrebbe dar luogo a incendi o guasti.

Non collegare né utilizzare l’adattatore CA in uno spazio ristretto, ad esempio fra una parete e un mobile.

Non cortocircuitare le parti metalliche dello spinotto dell’adattatore CA. Questo potrebbe causare un guasto.

Collegare l’adattatore CA alla presa di corrente di rete più vicina. In caso di problemi durante l’uso, estrarre immediatamente la spina dalla presa
di corrente.

Per scollegare l’adattatore CA dall’unità, assicurarsi di afferrarne solo lo spinotto ed estrarlo senza ruotarlo. Non tirare il cavo per evitare possibili
malfunzionamenti.

A: Dispositivo di fissaggio
B: Blocco del dispositivo di fissaggio
C: Cavo dell’adattatore CA

Controllare che l’indicatore POWER, sul lato anteriore dell’unità, cessi di lampeggiare e rimanga illuminato con luce
fissa verde, e che la procedura di avvio sia completata.

Se l’unità si è avviata normalmente ed è connessa alla rete, l’indicatore NETWORK si illumina con luce verde.

Quando si utilizza un obiettivo che non supporta il movimento di pan e tilt, bloccare la levetta di blocco pan/tilt ed omettere i
passaggi seguenti. Per informazioni dettagliate sugli obiettivi che supportano la funzione di pan e tilt, rivolgersi al proprio
rivenditore o servizio di assistenza Sony.

4

Spostare la levetta di blocco pan/tilt sulla posizione UNLOCK per sbloccare il movimento di rotazione e inclinazione
(pan e tilt) del corpo della telecamera.

5

Eseguire il reset di pan e tilt.

Per informazioni dettagliate, vedere “Reset di Pan e Tilt”.

6
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Argomento correlato
Reset di pan e tilt

5-041-957-34(1) Copyright 2022 Sony Corporation
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Alimentazione PoE++

Quando l’unità è connessa a un alimentatore PoE++, l’alimentazione viene fornita all’unità tramite un cavo di rete disponibile in
commercio.
Questo metodo consente di fornire alimentazione all’unità senza dover installare cavi di alimentazione in ambienti in cui non sono
presenti prese di alimentazione elettrica in prossimità della posizione di montaggio.

Spostare la levetta di blocco pan/tilt sulla posizione LOCK per bloccare il movimento di rotazione e inclinazione del
corpo della telecamera.

1

Collegare l’unità a un alimentatore di tipo PoE++ mediante un normale cavo di rete disponibile in commercio.

A: Cavo di rete
B: Alimentatore PoE++

2

Controllare che l’indicatore POWER, sul lato anteriore dell’unità, cessi di lampeggiare e rimanga illuminato con luce
fissa verde, e che la procedura di avvio sia completata.

Se l’unità si è avviata normalmente ed è connessa alla rete, l’indicatore NETWORK si illumina con luce verde.

Nota
Quando l’alimentazione viene fornita tramite PoE++, l’autenticazione iniziale viene eseguita durante l’intervallo fino al termine della
procedura di avvio.

Quando si utilizza un obiettivo che non supporta il movimento di pan e tilt, bloccare la levetta di blocco pan/tilt ed omettere i passaggi
seguenti. Per informazioni dettagliate sugli obiettivi che supportano la funzione di pan e tilt, rivolgersi al proprio rivenditore o servizio di
assistenza Sony.

3
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Nota

L’unità è conforme a IEEE802.3bt Type 4 Class 8. Per informazioni dettagliate sui dispositivi di alimentazione PoE++ compatibili verificati
rivolgersi al proprio rivenditore o rappresentante dell’assistenza tecnica Sony.

L’unità è compatibile con autenticazione soft (LLDP), ma potrebbe essere necessario configurare i dispositivi di rete (conformi a IEEE802.3bt).

Non collegare un adattatore CA quando si utilizza l’alimentazione PoE++ con l’autenticazione soft (LLDP) abilitata.

Se sono collegati contemporaneamente un adattatore CA e un dispositivo di alimentazione PoE++, l’alimentazione viene fornita dall’adattatore
CA.

Per la fornitura di alimentazione tramite PoE++, utilizzare un cavo di rete di categoria 5e o superiore.

Attendere circa 10 secondi dopo aver riacceso l’unità quando è alimentata tramite PoE++.

Se la fornitura di alimentazione è realizzata tramite PoE++, collegare a terra il morsetto di messa a terra.

Nelle connessioni con alimentazione tramite PoE++ non si dovranno posare cavi in esterni.

Quando si utilizza l’erogazione di alimentazione PoE++, non sarà possibile utilizzare contemporaneamente la registrazione e l’inquadratura
automatica PTZ.

Argomento correlato
Reset di pan e tilt
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Spostare la levetta di blocco pan/tilt sulla posizione UNLOCK per sbloccare il movimento di rotazione e inclinazione
(pan e tilt) del corpo della telecamera.

4

Eseguire il reset di pan e tilt.

Per informazioni dettagliate, vedere “Reset di Pan e Tilt”.

5
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Reset di pan e tilt

La seguente procedura consente di eseguire il reset di pan e tilt in caso, ad esempio, della sostituzione dell’obiettivo.

5-041-957-34(1) Copyright 2022 Sony Corporation

Spostare la levetta di blocco pan/tilt sulla posizione UNLOCK e verificare che movimento di rotazione e inclinazione del
corpo della telecamera sia sbloccato.

1

Eseguire la funzione di reset di pan e tilt.

Il reset di pan e tilt può essere eseguito con il telecomando a infrarossi, con l’app Web o con il Telecomando RM-IP500
(opzionale).

Reset con telecomando a infrarossi: premere il pulsante P/T RESET.
Reset con app Web: premere il pulsante  (reset pan/tilt) nella scheda  (Others) del pannello di controllo della
telecamera nella schermata delle operazioni live.
Reset con Telecomando RM-IP500: fare riferimento alle istruzioni per l’uso del Telecomando RM-IP500.

Nota

Il reset di pan e tilt causa la rotazione di obiettivo e corpo della telecamera. Verificare l’assenza di ostruzioni prima dell’esecuzione.

L’unità è dotata di una funzione che limita l’escursione del movimento di pan e tilt, ma questa funzione è disabilitata quando l’unità viene
accesa oppure quando viene eseguito il reset di pan e tilt.

Suggerimento
Al termine dell’operazione di reset di pan e tilt, l’unità torna alla posizione in cui trovava prima.

2
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Accesso all’app Web tramite un browser Web

Collegando l’unità a un tablet o a un computer, è possibile azionarla e configurarla tramite un browser Web.

Verificare se il tablet o il computer supportano l’utilizzo dell’app Web.

Nota
La visualizzazione di video nel browser Web potrebbe risultare insoddisfacente se non sono soddisfatti i requisiti richiesti oppure in certe
condizioni d’uso del tablet o computer.

L’app Web di questa unità utilizza JavaScript. Se si utilizza un software antivirus sul tablet o computer, la pagina Web potrebbe non essere
visualizzata correttamente.

1

Voce Requisito

Display
Risoluzione consigliata: 1080×810 pixel o superiore
Dimensioni schermo tablet consigliate: 10 pollici o
superiore

Sistema operativo e browser Web
supportati

Windows

Sistema
operativo

Windows 10 o successivo

Browser web Google Chrome

Mac

Sistema
operativo

macOS 10.15 o successivo

Browser web
Google Chrome
Safari

iPad

Sistema
operativo

iPadOS 16 o versioni successive

Browser web
Google Chrome
Safari

Android

Sistema
operativo

Android 12 o successivo

Browser web Google Chrome

Controllare che l’unità, il tablet o il computer e le periferiche siano accesi.2

Controllare che l’unità sia collegata alla rete locale tramite connessione LAN cablata.3

Controllare che il tablet o il computer siano collegati alla rete locale tramite connessione Wi-Fi o LAN cablata.4

Collegarsi all’unità dal browser Web del tablet o del computer.

Connessione tramite un codice QR
Eseguire la scansione del codice QR stampato sul coperchietto degli slot per schede sul lato dell’unità utilizzando la fotocamera
del tablet.

5
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Nota

Se il numero di porta HTTP è stato cambiato e non è 80, immettere “http://indirizzo IP dell’unità:numero di porta” nella barra degli indirizzi.

Per la connessione tramite un codice QR o inserendo l’URL nella barra degli indirizzi del browser Web, utilizzare un dispositivo che supporti
mDNS*.

Suggerimento

Successivamente, sarà possibile accedere rapidamente all’unità utilizzando la funzione segnalibro del browser Web.

Argomento correlato
Configurazione iniziale dell’unità

Connessione dell’unità a un dispositivo di rete tramite connessione cablata
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Aprire il collegamento visualizzato sul tablet.
Il browser Web del tablet si apre visualizzando la schermata dell’app Web dell’unità.

Connessione immettendo un URL nella barra degli indirizzi del browser
Avviare un browser Web sul tablet o sul computer ed immettere l’URL riportato sul coperchietto degli slot per schede sul lato
dell’unità.
Il browser Web dovrebbe quindi visualizzare la schermata dell’app Web dell’unità.

Connessione immettendo l’indirizzo IP dell’unità nella barra degli indirizzi del browser
Avviare un browser Web sul tablet o sul computer e immettere “http://indirizzo IP dell’unità” nella barra degli indirizzi.
Il browser Web dovrebbe quindi visualizzare la schermata dell’app Web dell’unità.

mDNS: Un protocollo di comunicazione usato per determinare l’indirizzo IP da un nome host su una rete locale.*
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Configurazione iniziale dell’unità

Assicurarsi di configurare l’unità utilizzando la seguente procedura quando si utilizza l’unità per la prima volta.
Per informazioni dettagliate sull’accesso all’app Web, vedere “Accesso all’app Web tramite un browser Web”.

Suggerimento

La configurazione iniziale dovrà essere ripetuta anche nel caso in cui la batteria di backup dovesse scaricarsi completamente.

Collegarsi all’unità da un tablet o da un computer e avviare l’app Web.

Quando l’unità viene utilizzata per la prima volta, verrà richiesto di immettere un nome utente e una password nel browser Web.
Immettere le seguenti impostazioni.

Nome utente: admin
Password: (lasciare vuoto)

Seguire le istruzioni indicate a schermo per eseguire la configurazione iniziale.

1

Immettere il nome utente e la password dell’amministratore (Administrator) quindi premere il pulsante [OK].

1: Immettere il nome utente dell’amministratore.
2: Impostare la password dell’amministratore.
3: Immettere nuovamente la stessa password per confermarla.

Nota

Il nome utente e la password possono contenere i caratteri indicati di seguito. La password deve avere una lunghezza compresa fra 8 e 64
caratteri e deve contenere almeno una lettera maiuscola, una lettera minuscola e un numero.

Caratteri alfanumerici
Simboli (!$%`*+-./<=>?@[]^_{|}~)

Il browser Web si ricaricherà e verrà richiesto di inserire il nome utente e la password.

2
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Viene visualizzata la schermata live per le operazioni di ripresa. Continuare con la configurazione delle operazioni di base dell’unità in
base alle modalità operative.

Suggerimento
In alcuni casi, ad esempio quando si utilizza l’unità sempre abbinata a uno stesso tablet, potrebbe essere più semplice utilizzare un indirizzo IP
fisso per l’unità.

Per impostare un indirizzo IP fisso, per prima cosa disattivare [Network] > [Wired LAN] > [IPv4] > [DHCP] (selettore spostato a sinistra) nel menu
Web.

Vengono visualizzate le voci di configurazione relative all’indirizzo IP fisso. Configurare le voci, quindi premere il pulsante [OK] sullo schermo.

Argomento correlato
Accesso all’app Web tramite un browser Web

Immettere il nome utente e la password configurati al passo 2.

Viene visualizzata la schermata di impostazione di lingua e orologio.

3

Specificare le seguenti voci e premere il pulsante [OK].

[Language]
Selezionare la lingua da utilizzare per la visualizzazione delle schermate dell’App web e della telecamera. La scelta di una lingua
diversa cambia la lingua di visualizzazione dell’App web.
[Date & Time Format]
Scegliere il formato di visualizzazione di data e ora fra le opzioni seguenti.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
“yyyy” indica l’anno, “mm” indica il mese, “dd” indica il giorno, “hh” indica l’ora, “mm” indica i minuti e “ss” indica i secondi.
[12 h/24 h]
Selezionare [12 h] (orologio a 12 ore) oppure [24 h] (orologio a 24 ore) per la visualizzazione dell’ora.
[Time Setting]
Selezionare il metodo per l’impostazione di data e ora.
[Synchronize with PC]: Sincronizza la data e l’ora con l’orologio del computer o tablet.
[Manual setting]: Impostazione manuale. Quando è selezionato questo metodo vengono visualizzati i campi per l’immissione di
data e ora.
[Time Zone]
Selezionare il fuso orario.

4
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Reset delle impostazioni dell’unità

Questo argomento descrive come eseguire il reset dell’unità.
Le impostazioni che vengono ripristinate variano a seconda dell’impostazione del selettore SETUP 1 sul pannello connettori.

Argomento correlato
Pannello connettori

Reset

5-041-957-34(1) Copyright 2022 Sony Corporation

Collegare l’alimentazione all’unità.1

Configurare il selettore SETUP 1 situato sul pannello dei connettori dell’unità.

Per ripristinare solo le impostazioni di rete allo stato predefinito di fabbrica, spostare il selettore 1 su OFF.
Per ripristinare tutte le impostazioni dell’unità allo stato predefinito di fabbrica, spostare il selettore 1 su ON.

2

Servirsi della punta di una penna o di un altro oggetto appuntito per premere e mantenere premuto il pulsante RESET
per almeno 5 secondi.

Le impostazioni vengono ripristinate e l’unità si riavvia.

3

108



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Configurazione delle operazioni di base

Questo argomento descrive come configurare l’unità per le operazioni di base.

Impostazione della modalità di ripresa

È possibile selezionare la modalità di ripresa dell’unità in base al flusso di lavoro utilizzato.

Modalità Custom: Crea immagini durante le riprese in modalità flessibili.
Modalità di ripresa Log: Registra contenuti S-Log.

Modalità Flexible ISO: Le impostazioni di esposizione sono determinate mediante la regolazione del valore ISO in base alla
scena ripresa.
Modalità Cine EI / modalità Cine EI Quick: L’unità si comporta in maniera analoga a una macchina cinematografica a pellicola,
senza finalizzare la creazione dell’immagine durante la ripresa. Le immagini riprese vengono poi sviluppate in post produzione.

Nella modalità Cine EI Quick, viene selezionata automaticamente una sensibilità di base adatta all’impostazione di Exposure Index.
Selezionare la modalità di ripresa utilizzando [Project] > [Base Setting] > [Shooting Mode] nel menu Web o nel menu della telecamera.

Modalità Custom
Consente di selezionare lo standard video.
Selezionare utilizzando [Project] > [Base Setting] > [Target Display] nel menu Web o nel menu della telecamera.

[SDR(BT.709)]: Ripresa con lo standard di broadcast HD
[HDR(HLG)]: Ripresa con lo standard di broadcast 4K di prossima generazione

Per informazioni dettagliate, vedere “Descrizione generale dei look” e altri argomenti in “Ripresa con il look desiderato”.

Modalità di ripresa Log
(modalità Flexible ISO / modalità Cine EI / modalità Cine EI Quick)
Nelle modalità di ripresa Log, l’operatore seleziona il gamut di colore di base per i segnali registrati e i segnali di uscita. Il gamut di
colore selezionato qui è il gamut di colore dell’uscita video quando le impostazioni [LUT On/Off] sono configurate su [MLUT Off].
È possibile scegliere il gamut di colore utilizzando [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] nel menu della telecamera.

[S-Gamut3.Cine/SLog3]: Gamut di colore per il cinema digitale di facile regolazione (DCI-P3).
[S-Gamut3/SLog3]: Gamut di colore Sony molto ampio che copre il gamut di colore ITU-R BT.2020.

Per informazioni dettagliate, vedere “Ripresa con regolazione del look in post-produzione ”.
 
La seguente tabella indica le funzioni supportate in ciascuna modalità di ripresa.
●: supportata, –: non supportata

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ● (collegata a EI)

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●
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Suggerimento

Nelle modalità Cine EI Quick e Cine EI, le riprese avvengono alla sensibilità ISO di base senza utilizzare nessun guadagno per massimizzare le
prestazioni del sensore immagine. La luminosità viene regolata utilizzando l’illuminazione e il filtro ND per modulare la quantità di luce che
raggiunge il sensore immagine.

Impostazione della frequenza di sistema

Selezionare utilizzando [Project] > [Rec Format] > [Frequency] nel menu Web o nel menu della telecamera. Dopo la selezione, l’unità
potrebbe riavviarsi automaticamente, a seconda del valore selezionato.

Nota

Non è possibile cambiare la frequenza di sistema durante la registrazione o la riproduzione.

Impostazione della modalità di scansione dell’imager

Le dimensioni di immagine effettive e la risoluzione del sensore immagini possono essere impostate secondo le proprie esigenze.
Selezionare utilizzando [Project] > [Rec Format] > [Imager Scan Mode] nel menu Web o nel menu della telecamera.
[FF]: Formato Full Frame.
[S35]: Formato Super 35mm.

Nota
Non è possibile cambiare la modalità di scansione dell’imager durante la registrazione o la riproduzione.

Se impostata su S35, il formato video è limitato a 1920×1080.

Impostazione del codec

È possibile scegliere il codec da utilizzare per la registrazione.
Selezionare utilizzando [Project] > [Rec Format] > [Codec] nel menu Web o nel menu della telecamera.

Nota
Non è possibile cambiare il codec durante la registrazione o la riproduzione.

Impostazione del formato video

È possibile scegliere sia il formato video per la registrazione che il formato di uscita per l’emissione in uscita dalla telecamera.

Selezionare il formato video per la registrazione utilizzando [Project] > [Rec Format] > [Video Format] nel menu Web o nel menu
della telecamera.
Selezionare il formato di uscita sui connettori SDI OUT e HDMI OUT utilizzando [Monitoring] > [Output Format] nel menu Web o nel
menu della telecamera.

Nota

Non è possibile cambiare il formato video durante la registrazione o la riproduzione.

In base alle impostazioni del formato video, potrebbero essere presenti limitazioni relative al segnale fornito dai connettori SDI OUT e HDMI OUT.

Argomento correlato
Descrizione generale dei look

Ripresa con regolazione del look in post-produzione

Custom Flexible ISO Cine EI Cine EI Quick

Scene File ● – – –

Paint/Look
(eccetto Base Look)

● – – –
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Schede di memoria supportate

L’unità registra audio e video su schede di memoria CFexpress Type A (disponibili separatamente) o schede di memoria SDXC
(disponibili separatamente) inserite negli appositi slot. Le schede di memoria vengono utilizzate anche per la registrazione proxy.

Schede di memoria CFexpress Type A

Utilizzare con l’unità le schede di memoria Sony CFexpress Type A* indicate in “Schede di memoria consigliate per la registrazione”.
Per informazioni dettagliate sull’utilizzo di supporti di memoria di altri fabbricanti, fare riferimento alle relative istruzioni per l’uso o
consultare le informazioni del fabbricante.

Schede di memoria SDXC

Utilizzare con l’unità le schede di memoria SDXC* indicate in “Schede di memoria consigliate per la registrazione”.

Schede di memoria consigliate per la registrazione

Le condizioni operative garantite variano a seconda delle impostazioni di Rec Format e Recording.

CFexpress Type A
Conformi a VPG400/200
Supportate per tutti i formati di registrazione dell’unità.

SDXC
Supportate nelle condizioni indicate nella tabella seguente. “●” indica che il funzionamento è stato verificato e “–” indica che il
funzionamento non è garantito.

RAW Out & XAVC-I, 4096×2160 Class 300, modalità normale

RAW Out & XAVC-I, 3840×2160 Class 300, modalità normale

Indicate semplicemente come “schede CFexpress” in questa guida.*

Indicate semplicemente come “schede SD” in questa guida.*

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (60 fps o inferiore)

RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Non sono disponibili schede verificate.

XAVC-I, 4096×2160 Class 300, modalità normale

XAVC-I, 4096×2160 Class 300, S&Q (60 fps o inferiore)

XAVC-I, 3840×2160 Class 300, modalità normale

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

24P – – – – – – ●

23.98P – – – – – – ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●
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XAVC-I, 3840×2160 Class 300, S&Q (60 fps o inferiore)

XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Non sono disponibili schede verificate.

XAVC-I, 1920×1080 Class 100, modalità normale

XAVC-I, 1920×1080 Class 100, S&Q (60 fps o inferiore)

XAVC-I, 1920×1080 Class 100, S&Q (100 fps, 120 fps)

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

25P – – – – – ● ●

23.98P – – – – – ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●
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XAVC-I, 1920×1080 Class 100, S&Q (150 fps, 180 fps)
Non sono disponibili schede verificate.

XAVC-I, 1920×1080 Class 100, S&Q (200 fps, 240 fps)
Non sono disponibili schede verificate.

XAVC-L, 3840×2160 420, modalità normale

XAVC-L, 3840×2160 420, S&Q (60 fps o inferiore)

XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, modalità normale

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD50, S&Q (60 fps o inferiore)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●
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XAVC-L, 1920×1080 HD35, modalità normale

XAVC-L, 1920×1080 HD35, S&Q (60 fps o inferiore)

XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●
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Frequenza di sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Inserimento delle schede di memoria

Questo argomento descrive le precauzioni per l’inserimento delle schede di memoria.

Aprire il coperchietto della sezione slot schede.1

Inserire una scheda di memoria.

Per le schede CFexpress, l’etichetta è rivolta verso l’alto.

Nota
Per le unità montate a soffitto, l’etichetta è rivolta verso il basso.

Per le schede SD, l’etichetta è rivolta verso il basso.

Nota

Per le unità montate a soffitto, l’etichetta è rivolta verso l’alto.

L’indicatore di accesso si illumina di rosso, quindi diventa verde se la scheda è utilizzabile.

Nota

Qualora l’indicatore di accesso lampeggi continuamente in rosso senza diventare verde, provare a spegnere momentaneamente l’unità,
quindi rimuovere e reinserire la scheda di memoria.

2

Chiudere il coperchietto.3

119



Nota

La scheda di memoria, lo slot e i dati di immagine contenuti sulla scheda potrebbero subire danni se la scheda venisse forzata nello slot con
l’orientamento errato.

Per la registrazione su schede CFexpress Type A o SD contenute nei due slot A e B, è necessario che entrambe le schede inserite siano di tipo
adatto al formato della registrazione.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Espulsione di una scheda di memoria

Aprire il coperchietto della sezione slot schede ed esercitare una leggera pressione sulla scheda di memoria per espellerla.

Nota

Se l’unità viene spenta o la scheda viene rimossa durante l’accesso alla scheda, non è possibile garantire l’integrità dei dati contenuti sulla
scheda. Tutti i dati registrati sulla scheda potrebbero essere danneggiati. Assicurarsi sempre che l’indicatore di accesso sia illuminato in verde o
sia spento prima di spegnere l’unità o rimuovere la scheda di memoria.

Se si rimuove una scheda di memoria immediatamente dopo la registrazione, è possibile che sia calda. Questo tuttavia non indica un problema.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Formattazione (inizializzazione) di schede di memoria

Se viene inserita una scheda di memoria non formattata o formattata con altre specifiche, il pannello immagine della telecamera
mostrerà il messaggio “Media Needs to be Formatted”.
Formattare la scheda come descritto di seguito.

Nota

La formattazione di una scheda di memoria elimina tutti i dati che contiene, comprese le registrazioni video e i file di setup.

A seconda della durata, potrebbero essere visualizzati messaggi anche durante il processo di formattazione.

Se la formattazione non riesce
Non è possibile formattare schede di memoria non supportate dall’unità.
Viene visualizzato un messaggio di avvertimento. Seguire le istruzioni e sostituire la scheda con una scheda di memoria supportata.

Utilizzo di una scheda formattata con questa unità nello slot di un altro dispositivo
Eseguire il backup di tutti i dati registrati sulla scheda, quindi riformattare la scheda nel dispositivo in cui deve essere utilizzata.

5-041-957-34(1) Copyright 2022 Sony Corporation

Selezionare [TC/Media] > [Format Media] nel menu della telecamera.1

Selezionare Media(A) (slot A) o Media(B) (slot B), quindi selezionare il metodo di formattazione desiderato (Full Format o
Quick Format).

Viene visualizzato un messaggio di conferma.
[Full Format]: Inizializza completamente la scheda, compresa la regione contenente i dati e le informazioni di gestione dei dati.
[Quick Format]: Inizializza solamente le informazioni di gestione dei dati della scheda.

2

Selezionare [Execute].

Durante la formattazione è visualizzato un messaggio e l’indicatore di accesso si illumina di rosso.
Al termine della formattazione viene visualizzato un messaggio di conferma.

3
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Controllo del tempo di registrazione rimanente

Durante la ripresa (registrazione/standby), è possibile monitorare la capacità rimanente sulla scheda di memoria di ciascuno slot
mediante gli indicatori di capacità rimanente degli slot A e B visualizzati nel pannello dell’immagine della telecamera.
Il tempo di registrazione rimanente è calcolato sulla base della capacità rimanente della scheda di ciascuno slot e del formato di
registrazione corrente (bit rate di registrazione) ed è indicato in minuti.

Tempi di sostituzione delle schede di memoria
Quando il tempo di registrazione rimanente totale sulle due schede di memoria scende al di sotto di 5 minuti viene visualizzato il
messaggio “Media Near Full” e l’indicatore di registrazione/tally comincia a lampeggiare come avvertimento.
Sostituire con una scheda con spazio libero sufficiente.
Se si prosegue con la registrazione fino a esaurire completamente lo spazio disponibile, appare il messaggio “Media Full” e la
registrazione si arresta.

Nota

Una scheda di memoria consente la registrazione di un massimo di 600 clip circa.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Ripristino delle schede di memoria

Qualora si verifichi un errore su una scheda di memoria, la scheda dovrà essere ripristinata prima di poter essere nuovamente
utilizzata.
Se si inserisce una scheda di memoria che deve essere ripristinata, il pannello dell’immagine della telecamera visualizza un
messaggio che chiede di confermarne il ripristino.

Ripristino di una scheda di memoria
Selezionare [Execute] con i pulsanti freccia del pannello dei comandi GUI, quindi premere il pulsante [Set].
Durante la formattazione lo schermo visualizza un messaggio e la percentuale (%) di avanzamento dell’operazione. L’indicatore di
accesso è inoltre illuminato in rosso.
Al termine del ripristino viene visualizzato un messaggio di conferma.

Se il ripristino non riesce
Non è possibile ripristinare schede di memoria su cui sono presenti errori di memoria. Viene visualizzato un messaggio di
avvertimento. Seguire le istruzioni e sostituire la scheda la scheda di memoria.
Le schede di memoria che contengono errori di memoria potrebbero diventare nuovamente utilizzabili se riformattate.
In alcuni casi, potranno essere ripristinati solo alcuni clip e non altri. I clip ripristinati possono essere riprodotti normalmente.

Nota
Per ripristinare schede registrate con questa unità è necessario utilizzare questa unità.

Questa unità non consente di ripristinare schede registrate con apparecchi diversi o con unità di versione diversa (anche se dello stesso
modello).

I clip di durata inferiore a 2 secondi non possono essere ripristinati.
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Avvio e arresto della registrazione

Questo argomento descrive come avviare e arrestare la registrazione.

Collegare i dispositivi necessari e controllare che l’alimentazione sia presente sia per l’unità che per i dispositivi esterni.1

Inserire almeno una scheda di memoria.2

Controllare lo stato di alimentazione dell’unità nell’angolo superiore sinistro della schermata dell’app Web.

Alimentazione attiva
Al momento dell’accensione dell’unità, l’app Web mostrerà la schermata delle operazioni live, la schermata delle operazioni di
riproduzione oppure il menu Web.

L’indicatore POWER sul lato anteriore dell’unità si illumina e l’immagine proveniente dalla telecamera viene visualizzata nella
schermata delle operazioni live dell’app Web.

Nota
Se non è già stata configurata una password amministratore, viene visualizzata una schermata che ne richiede di la configurazione. Vedere
“Configurazione iniziale dell’unità”.

Alimentazione in modalità standby
Quando l’alimentazione dell’unità è in stato di standby, l’app Web visualizza un messaggio che lo segnala.

In questo stato, premere il pulsante di alimentazione e selezionare [Power ON] nel menu di accensione. L’unità si accende,
l’indicatore POWER sul lato anteriore dell’unità si illumina con luce verde e l’immagine proveniente dalla telecamera viene
visualizzata nella schermata delle operazioni live dell’app Web.

Suggerimento

È possibile accendere l’unità anche utilizzando il pulsante di alimentazione del telecomando a infrarossi fornito in dotazione.

3

Premere il pulsante START/STOP registrazione.

La registrazione si avvia e l’indicatore di registrazione/tally (in 2 posizioni) dell’unità si illumina.

4
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Commutazione dell’alimentazione dell’unità alla modalità standby
Premere il pulsante di alimentazione dell’app Web e selezionare [Power Standby] per commutare l’alimentazione dell’unità sulla
modalità standby.

Suggerimento
È possibile commutare l’alimentazione alla modalità standby anche utilizzando il pulsante di alimentazione del telecomando a infrarossi fornito in
dotazione.

Argomento correlato
Configurazione iniziale dell’unità
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Durante la registrazione, il pulsante START/STOP registrazione è illuminato. Sono visualizzate anche un’icona che indica il
supporto di registrazione utilizzato e l’indicazione [●Rec].

Per arrestare la registrazione, premere di nuovo il pulsante START/STOP registrazione.

La registrazione si arresta e l’indicatore di registrazione/tally (in 2 posizioni) dell’unità si spegne.
Nella modalità standby di registrazione, il pulsante START/STOP di registrazione non è illuminato. Sono visualizzate anche
un’icona che indica il supporto di registrazione utilizzato e l’indicazione [Stby].

Suggerimento
È possibile avviare e arrestare la registrazione anche utilizzando il pulsante START/STOP di registrazione del telecomando a infrarossi
fornito in dotazione.

5
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Passaggio da una scheda di memoria all’altra

Se sono inserite due schede di memoria, è possibile passare da una scheda di memoria all’altra premendo il pulsante [Slot Select] sul
pannello di controllo della riproduzione dell’app Web.

Suggerimento

Per passare da una scheda di memoria all’altra è possibile anche premere il pulsante SLOT SEL (selezione dello slot per schede di memoria (A)
o (B)) del telecomando a infrarossi in dotazione.

Registrazione continuata (relay)

Durante la registrazione continuata, l’unità passa automaticamente alla seconda scheda di memoria immediatamente prima
dell’esaurimento completo dello spazio sulla prima scheda (registrazione relay). È possibile eseguire registrazioni continuate
ininterrottamente sostituendo ogni volta la scheda di memoria piena con una nuova.

Nota
Non è possibile passare da una scheda all’altra durante la riproduzione. Non è inoltre possibile la riproduzione continuata di un clip che si
estende su entrambe le schede di memoria dei due slot A e B.

Dati registrati

Quando si arresta la registrazione, il video, l’audio e i dati accessori dall’inizio alla fine della registrazione vengono salvati come un
unico “clip” sulla scheda di memoria.

Nome dei clip dei dati registrati

Il nome dei clip registrati dal camcorder viene assegnato automaticamente secondo l’impostazione di [TC/Media] > [Clip Name Format]
nel menu della telecamera.

Durata massima dei clip

Fino a 6 ore per clip.
La durata massima di una registrazione continua è identica alla durata massima di un clip. Se il tempo di registrazione del clip supera
la lunghezza massima consentita, viene creato automaticamente un nuovo clip e la registrazione continua. Il nuovo clip apparirà sulla
schermata delle miniature come un clip separato.
Nella funzione di registrazione relay, vengono registrati più clip in successione l’uno dopo l’altro. In questa modalità, la registrazione si
arresta automaticamente dopo circa 24 ore.

Nota

Non espellere una scheda di memoria mentre è in corso la registrazione su di essa. Durante la registrazione, sostituire schede di memoria solo
negli slot il cui indicatore di accesso non è illuminato.

Quando la capacità rimanente sulla scheda di memoria su cui viene eseguita la registrazione diventa inferiore a un minuto ed è presente una
scheda di memoria registrabile nell’altro slot, viene visualizzato il messaggio “Will Switch Slots Soon”. Il messaggio scompare dopo il passaggio
all’altro slot.

La registrazione relay può non essere possibile se la registrazione viene avviata quando la capacità rimanente della scheda di memoria è
inferiore a un minuto. Per consentire il funzionamento corretto della registrazione relay, controllare che la capacità rimanente sulla scheda di
memoria sia superiore a un minuto prima di iniziare la registrazione.

I video creati con la funzione di registrazione relay dell’unità non possono essere riprodotti senza interruzioni sull’unità.

Per unire insieme video creato con la funzione di registrazione relay dell’unità, utilizzare il software “Catalyst Browse”.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Controllo dell’audio

L’audio viene emesso sui connettori SDI e HDMI dell’unità. Selezionare la combinazione di canali audio emessi in uscita sul connettore
HDMI utilizzando [Audio] > [Audio Output] > [HDMI/Stream Output CH] nel menu della telecamera.
CH1/CH2: Combinazione di CH1 e CH2
CH3/CH4: Combinazione di CH3 e CH4
Durante il monitoraggio dell’audio nell’app Web, utilizzare l’indicatore di livello audio nella sezione in basso a destra dell’immagine
della telecamera.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Specifica dei dati temporali

Questo argomento descrive come impostare i dati temporali.

Impostazione del codice temporale

Impostare il codice temporale da registrare utilizzando [TC/Media] > [Timecode] nel menu della telecamera.

Impostazione dei bit utente

È possibile aggiungere all’immagine registrata un numero esadecimale a 8 cifre come bit utente. Il bit utente può essere anche
impostato sull’ora corrente. Impostare utilizzando [TC/Media] > [Users Bit] nel menu della telecamera.

Visualizzazione dei dati temporali

Impostare il codice temporale da visualizzare utilizzando [TC/Media] > [TC Display] > [Display Select] nel menu della telecamera.
Premendo un pulsante programmabile a cui è assegnata la funzione [DURATION/TC/U-BIT], è possibile visualizzare in sequenza il
codice temporale, i bit utente e la durata.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Rivedere una registrazione (Rec Review)

È molto semplice rivedere sullo schermo l’ultimo clip registrato (revisione della registrazione).

Nota

La funzione Rec Review non è supportata se il formato video è stato modificato dopo la registrazione del clip.

Impostazione della posizione iniziale di Rec Review

È possibile impostare la posizione di avvio della riproduzione su una delle opzioni indicate di seguito utilizzando [Technical] > [Rec
Review] nel menu della telecamera.

Ultimi 3 secondi del clip
Ultimi 10 secondi del clip
Inizio del clip

Suggerimento
Per rivedere un determinato clip dopo averne registrati diversi, premere il pulsante [Thumbnail] per visualizzare la schermata delle miniature,
quindi selezionare il clip desiderato.

Per visualizzare la schermata delle miniature è possibile anche premere il pulsante THUMBNAIL del telecomando a infrarossi in dotazione.

Metodo di esecuzione di Rec Review

Assegnare in anticipo la funzione Rec Review a uno dei pulsanti programmabili del pannello di regolazione della configurazione di
base.

Per informazioni dettagliate sull’assegnazione, vedere “Pulsanti programmabili” in “Funzioni utili”.

Arrestare la registrazione, quindi premere il pulsante programmabile a cui è stata assegnata la funzione Rec Review per avviare la
riproduzione dell’ultimo clip registrato.
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Il clip viene riprodotto fino alla fine e l’unità esce dalla funzione Rec Review tornando alla modalità di Stby (standby).

Per arrestare Rec Review
Premere il pulsante programmabile a cui è assegnata la funzione Rec Review oppure premere il pulsante [Cancel/Back].

Suggerimento
Per uscire dalla funzione Rec Review, è possibile anche premere il pulsante [Cancel/Back] del telecomando a infrarossi fornito in dotazione.
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Argomento correlato
Pulsanti programmabili
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Schermata di regolazione dell’inquadratura

L’inquadratura può essere regolata utilizzando le parti della schermata delle operazioni live descritte di seguito.
Quando la funzione di inquadratura automatica PTZ non è attiva

Quando la funzione di inquadratura automatica PTZ è attiva
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Nota

In base alla direzione della telecamera, la lunghezza focale dell’obiettivo e la posizione dello zoom, è possibile che rimangano visibili parti
dell’unità o dei cavi collegati al pannello connettori. Prima delle riprese, controllare il campo di visuale per l’obiettivo e la lunghezza focale che si
stanno utilizzando. È possibile anche limitare l’escursione del movimento di pan e tilt utilizzando [Pan-Tilt] > [P/T Range Limit] nel menu Web.
Questa limitazione impostata viene ignorata all’accensione dell’unità e durante l’esecuzione del reset di pan e tilt. Per informazioni dettagliate,
vedere [Pan-Tilt] > [P/T Range Limit] nel menu Web.

Suggerimento
È possibile regolare l’inquadratura anche utilizzando il telecomando a infrarossi fornito in dotazione.
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Pannello di controllo delle posizioni di preset1.

Scheda  (Main) / scheda  (Others)2.

Pannello di controllo dell’inquadratura3.
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Regolazione della direzione di ripresa tramite l’app Web

La rotazione sul piano orizzontale della telecamera è denominata pan (panoramica) mentre la rotazione sul piano verticale è
denominata tilt (inclinazione).
È possibile regolare la direzione di ripresa orientando la telecamera orizzontalmente (pan) e verticalmente (tilt).

Suggerimento
Qualora sotto al joystick appaia il messaggio [Execute Pan-Tilt Reset], si è verificata un’incongruenza nelle informazioni sull’origine del comando
di pan e tilt dell’unità. Eseguire la funzione di reset di pan e tilt per aggiornare le informazioni sull’origine. Per informazioni dettagliate, vedere
“Reset di Pan e Tilt”.

Ripristino dell’orientamento frontale della telecamera
Premere il pulsante  (posizione iniziale pan/tilt) nella scheda  (Others) del pannello di controllo della telecamera.

Nota
In base alla direzione della telecamera, la lunghezza focale dell’obiettivo e la posizione dello zoom, è possibile che rimangano visibili parti
dell’unità o dei cavi collegati al pannello connettori. Prima delle riprese, controllare il campo di visuale per l’obiettivo e la lunghezza focale che si
stanno utilizzando. È possibile anche limitare l’escursione del movimento di pan e tilt utilizzando [Pan-Tilt] > [P/T Range Limit] nel menu Web.
Questa limitazione impostata viene ignorata all’accensione dell’unità e durante l’esecuzione del reset di pan e tilt. Per informazioni dettagliate,
vedere [Pan-Tilt] > [P/T Range Limit] nel menu Web.

Argomento correlato
Reset di pan e tilt
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Premere la scheda  (pan/tilt/zoom) nel pannello di controllo dell’inquadratura per visualizzare il joystick.1

Trascinare il centro del joystick nella direzione che si desidera visualizzare, controllando il risultato ottenuto nel
pannello dell’immagine della telecamera.

La direzione e la velocità di spostamento della telecamera cambieranno in risposta alla direzione e alla velocità del
trascinamento.
È possibile regolare pan e tilt in modo più preciso toccando le aree periferiche del joystick.

2
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Impostazione della velocità di pan e tilt

È possibile cambiare la velocità dei movimenti di pan e tilt utilizzando il cursore [Pan-Tilt Speed] nel pannello di controllo della
telecamera azionando il joystick nel pannello di regolazione dell’inquadratura.

Nota
Se è presente una parete o un altro ostacolo all’interno del raggio del movimento della telecamera, prestare attenzione a non urtarlo durante i
movimenti di pan e tilt.

L’accelerazione dei movimenti di pan e tilt dipendono da caratteristiche fisiche, quali ad esempio il bilanciamento dei pesi dell’obiettivo. È
possibile cambiare l’impostazione dell’accelerazione utilizzando [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] nel menu Web o nel menu della
telecamera.
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Premere la scheda  (Main) nel pannello di controllo della telecamera.1

Selezionare il cursore [Pan-Tilt Speed] nell’elenco.

Se il cursore [Pan-Tilt Speed] non è visualizzato, selezionare uno dei due pulsanti di selezione della funzione del cursore per
visualizzarlo.

2

Spostare il cursore verso sinistra o verso destra.

Lo spostamento del cursore verso sinistra diminuisce la velocità operativa, mentre lo spostamento del cursore verso destra la
aumenta.

3
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Impostazione dell’accelerazione del movimento di pan e tilt

È possibile impostare il livello di accelerazione utilizzando [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] nel menu Web o nel menu
della telecamera. Sono disponibili nove livelli di accelerazione. Aumentare il valore per cambiamenti di velocità più rapidi o diminuire il
valore per cambiamenti di velocità più graduali.
Per ottenere una maggiore reattività durante l’utilizzo della funzione di pan e tilt, selezionare un valore compreso tra 7 e 9.
Per ottenere una maggiore precisione posizionale all’inizio e alla fine del movimento verso una posizione di preset preimpostata,
scegliere un valore compreso fra 1 e 6.

Per informazioni dettagliate sulle posizioni di preset, vedere “Salvataggio e ripristino delle posizioni di pan, tilt e zoom”.

Nota
L’impostazione di questo livello su valori elevati potrebbe impedire il funzionamento corretto della funzione, soprattutto se sono montati degli
obiettivi più pesanti. Verificarne il funzionamento corretto prima dell’uso effettivo.

Relazione fra l’impostazione di [Ramp Curve] e il movimento di pan e tilt

Durante il movimento di pan e tilt

Durante il richiamo di una posizione di preset
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Regolazione della direzione di ripresa utilizzando il telecomando a infrarossi fornito in
dotazione

È possibile regolare la direzione di ripresa della telecamera utilizzando i pulsanti di comando pan e tilt del telecomando a infrarossi in
dotazione.

Ripristino dell’orientamento frontale della telecamera
Premere il pulsante HOME.

Nota

In base alla direzione della telecamera, la lunghezza focale dell’obiettivo e la posizione dello zoom, è possibile che rimangano visibili parti
dell’unità o dei cavi collegati al pannello connettori. Prima delle riprese, controllare il campo di visuale per l’obiettivo e la lunghezza focale che si
stanno utilizzando. È possibile anche limitare l’escursione del movimento di pan e tilt utilizzando [Pan-Tilt] > [P/T Range Limit] nel menu Web.
Questa limitazione impostata viene ignorata all’accensione dell’unità e durante l’esecuzione del reset di pan e tilt. Per informazioni dettagliate,
vedere [Pan-Tilt] > [P/T Range Limit] nel menu Web.
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Premere i pulsanti freccia per eseguire i movimenti di pan e tilt.

Controllando il risultato sull’immagine proveniente dalla telecamera, premere il pulsante freccia della direzione desiderata.
Per spostarsi di una breve distanza, premere il pulsante freccia brevemente.
Per spostarsi di una distanza più lunga, premere il pulsante freccia più a lungo.
Per spostarsi in diagonale, premere e mantenere premuto il pulsante  (freccia su) o il pulsante  (freccia giù) e quindi
premere allo stesso tempo anche il pulsante  (freccia sinistra) o  (freccia destra).

1
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Impostazione del tipo di zoom

Impostare il tipo di zoom utilizzando [Technical] > [Zoom] > [Zoom Type] nel menu della telecamera.
I tipi di zoom disponibili varieranno in base al tipo di obiettivo montato sul camcorder.

Nota
Clear Image Zoom non è disponibile nei casi descritti di seguito.

Quando l’opzione [Shooting] > [S&Q Motion] > [Setting] è impostata su On e l’opzione [Frame Rate] nel menu della telecamera è impostata su
un valore superiore a 60 fps
Quando [Project] > [Rec Format] > [Codec] nel menu della telecamera è impostato su [RAW] o su un’opzione che include RAW.

Se viene azionato il selettore SERVO/MANUAL dell’obiettivo, l’ingrandimento di Clear Image Zoom viene reimpostato su 1×.

La funzione AF-S non è supportata durante Clear Image Zoom.

Clear Image Zoom

L’unità è dotata di una funzione di zoom che utilizza una metodologia di elaborazione del segnale denominata Clear Image Zoom.
Quando Clear Image Zoom è attivato, diventa possibile eseguire lo zoom anche con obiettivi a focale fissa. Questa funzione consente
anche di estendere il campo di zoom oltre al campo ottico fisicamente disponibile su obiettivi con zoom motorizzato.
Il rapporto massimo di zoom offerto da Clear Image Zoom varia a seconda della risoluzione di registrazione.

Con risoluzione di registrazione QFHD/4K: 1,5×
Con risoluzione di registrazione HD: 2×
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Tipo di obiettivo montato
Impostazione di [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Obiettivo a focale fissa o con zoom
manuale

La funzione di zoom non è
supportata.

Clear Image Zoom è supportato.

Obiettivo con zoom motorizzato È supportato solo lo zoom ottico.
Sono disponibili sia zoom ottico che Clear Image
Zoom.
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Regolazione dello zoom tramite l’app Web

È possibile regolare lo zoom dell’unità utilizzando lo zoom ottico o la funzione Clear Image Zoom. Questo argomento descrive come
eseguire regolazioni utilizzando l’app Web. Per informazioni dettagliate su Clear Image Zoom, vedere “Impostazione del tipo di zoom”.

Nota

In base alla direzione della telecamera, la lunghezza focale dell’obiettivo e la posizione dello zoom, è possibile che rimangano visibili parti
dell’unità o dei cavi collegati al pannello connettori. Prima delle riprese, controllare il campo di visuale per l’obiettivo e la lunghezza focale che si
stanno utilizzando. È possibile anche limitare l’escursione del movimento di pan e tilt utilizzando [Pan-Tilt] > [P/T Range Limit] nel menu Web.
Questa limitazione impostata viene ignorata all’accensione dell’unità e durante l’esecuzione del reset di pan e tilt. Per informazioni dettagliate,
vedere [Pan-Tilt] > [P/T Range Limit] nel menu Web.

Le effettive velocità e precisione dello zoom variano a seconda dell’obiettivo. Verificarne il funzionamento prima dell’uso effettivo.

Suggerimento
L’unità consente di azionare lo zoom di un obiettivo con comando di zoom manuale utilizzando un opportuno dispositivo di comando obiettivo
(opzione) compatibile. Per informazioni dettagliate, vedere “Montaggio di un dispositivo di comando obiettivo” e “Regolazione dello zoom
mediante un dispositivo di comando obiettivo”.

Argomento correlato
Impostazione del tipo di zoom

Montaggio di un dispositivo di comando obiettivo

Regolazione dello zoom mediante un dispositivo di comando obiettivo

5-041-957-34(1) Copyright 2022 Sony Corporation

Premere la scheda  (pan/tilt/zoom) nel pannello di controllo dell’inquadratura per visualizzare il pannello di
controllo pan e tilt.

1

Spostare il cursore [Zoom] nella direzione [T] (telefoto) oppure [W] (grandangolo) per regolare lo zoom.

La velocità dello zoom varia con il movimento del cursore.

2
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Impostazione della velocità operativa dello zoom

È possibile cambiare la velocità di azionamento dello zoom del cursore [Zoom] nel pannello di regolazione dell’inquadratura utilizzando
il cursore [Zoom Speed] del pannello di controllo della telecamera.

Nota
Le effettive velocità e precisione dello zoom variano a seconda dell’obiettivo. Verificarne il funzionamento prima dell’uso effettivo.

5-041-957-34(1) Copyright 2022 Sony Corporation

Premere la scheda  (Main) nel pannello di controllo della telecamera.1

Selezionare il cursore [Zoom Speed] nell’elenco.

Se il cursore [Zoom Speed] non è visualizzato, selezionare uno dei due pulsanti di selezione della funzione del cursore per
visualizzarlo.

 

2

Spostare il cursore [Zoom Speed] verso sinistra o verso destra.

Lo spostamento del cursore verso sinistra diminuisce la velocità operativa, mentre lo spostamento del cursore verso destra la
aumenta.

3
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Regolazione dello zoom utilizzando il telecomando a infrarossi fornito in dotazione

È possibile regolare lo zoom dell’unità utilizzando lo zoom ottico o la funzione Clear Image Zoom. Questo argomento descrive come
eseguire regolazioni utilizzando il telecomando a infrarossi fornito in dotazione. Per informazioni dettagliate su Clear Image Zoom,
vedere “Impostazione del tipo di zoom”.

Nota
In base alla direzione della telecamera, la lunghezza focale dell’obiettivo e la posizione dello zoom, è possibile che rimangano visibili parti
dell’unità o dei cavi collegati al pannello connettori. Prima delle riprese, controllare il campo di visuale per l’obiettivo e la lunghezza focale che si
stanno utilizzando. È possibile anche limitare l’escursione del movimento di pan e tilt utilizzando [Pan-Tilt] > [P/T Range Limit] nel menu Web.
Questa limitazione impostata viene ignorata all’accensione dell’unità e durante l’esecuzione del reset di pan e tilt. Per informazioni dettagliate,
vedere [Pan-Tilt] > [P/T Range Limit] nel menu Web.

Suggerimento
L’unità consente di azionare lo zoom di un obiettivo con comando di zoom manuale utilizzando un opportuno dispositivo di comando obiettivo
(opzione) compatibile. Per informazioni dettagliate, vedere “Montaggio di un dispositivo di comando obiettivo” e “Regolazione dello zoom
mediante un dispositivo di comando obiettivo”.

Argomento correlato
Impostazione del tipo di zoom

Montaggio di un dispositivo di comando obiettivo
Regolazione dello zoom mediante un dispositivo di comando obiettivo

5-041-957-34(1) Copyright 2022 Sony Corporation

Premere il pulsante dello zoom per regolare lo zoom.

Controllando il risultato sullo schermo, premere i pulsanti T (telefoto) o W (grandangolo) per regolare lo zoom.
Per aumentare lo zoom, premere il pulsante T.
Per diminuire lo zoom, premere il pulsante W.

1
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Calibrazione di un obiettivo E-mount

La calibrazione corregge le differenze nella posizione dello zoom dovute alle differenze nei singoli obiettivi quando si utilizza un
obiettivo zoom motorizzato con innesto E-mount.
Per calcolare con precisione la posizione dello zoom, calibrare l’obiettivo per correggere le differenze dell’obiettivo specifico utilizzando
la procedura descritta di seguito.

Dati di calibrazione
Possono essere salvati sull’unità i dati di calibrazione di cinque obiettivi diversi. Se viene calibrato un sesto o un ulteriore obiettivo,
i dati meno recenti verranno sovrascritti.
È possibile controllare l’esistenza di dati di calibrazione per l’obiettivo montato premendo il pulsante  (stato della telecamera)
nell’area comune della schermata dell’app Web e selezionando [Lens] > [Calibration Data].

5-041-957-34(1) Copyright 2022 Sony Corporation

Se l’obiettivo è dotato di un selettore SERVO/MANUAL, spostarlo sulla posizione SERVO.

Nota
Se il selettore si trova sulla posizione MANUAL, l’obiettivo non sarà in grado di ricevere i comandi di zoom dall’unità.

1

Eseguire la procedura di calibrazione utilizzando [Technical] > [Lens] > [Lens Calibration] nel menu della telecamera.

Durante la calibrazione, l’obiettivo zoom si muove automaticamente e viene misurato.

2
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Salvataggio e ripristino delle posizioni di pan, tilt e zoom e dell’impostazione della messa a
fuoco tramite l’app Web

La posizione di pan e tilt della telecamera, la posizione dello zoom e l’impostazione della messa a fuoco possono essere salvate e
richiamate in seguito, quando necessario, utilizzando l’app Web (funzione posizione preset).

Per informazioni dettagliate sulle impostazioni che possono essere salvate e ripristinate, vedere “Impostazioni salvate per le
posizioni di preset”.

Nota

Se l’impostazione [Pan-Tilt] > [P/T Direction] > [Ceiling] nel menu Web viene modificata, vengono eliminate anche tutte le posizioni di preset
salvate.

Impostare la modalità di assistenza PTZ su [Pos.] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

1

Determinare la posizione che si desidera salvare utilizzando le funzioni di pan, tilt e zoom.2

Premere il pulsante [+] nel pannello di controllo delle posizioni di preset.

L’immagine che mostra la posizione salvata è mostrata nel pannello di controllo delle posizioni di preset.

Suggerimento
Qualora il pannello di controllo delle posizioni di preset non sia visualizzato, premere il pulsante  (apri) per visualizzarlo.

Le posizioni vengono salvate in sequenza a partire da [Preset1].

Se sono presenti numeri di preset non utilizzati nella sequenza di preset, le posizioni saranno salvate iniziando con i preset non ancora
utilizzati. Ad esempio, se sono salvate posizioni di preset in [Preset1] e in [Preset3] ma non in [Preset2], le posizioni di preset successive
verranno salvate prima in [Preset2] e quindi in [Preset4].

Possono essere memorizzate fino a 100 posizioni di preset.

Le posizioni di preset possono essere rinominate con il nome desiderato. Per informazioni dettagliate, vedere “Rinomina delle posizioni di
preset tramite l’app Web”.

3
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Annullamento dell’azione di ripristino di una posizione di preset
Premere il pulsante  (annulla ripristino) visualizzato sul pannello di controllo delle posizioni di preset durante l’operazione di
ripristino della posizione di preset per annullare l’operazione di ripristino. Regolare l’inquadratura servendosi del joystick e del cursore
[Zoom].

Argomento correlato
Impostazioni salvate per le posizioni di preset

Rinomina delle posizioni di preset tramite l’app Web
Modifica della velocità di transizione (pan-tilt/zoom/fuoco) durante il ritorno a una posizione di preset

Impostazione dell’accelerazione del movimento di pan e tilt

Ripristino di una posizione salvata.

Premere due volte la miniatura della posizione desiderata, visualizzata nel pannello di controllo delle posizioni di preset, per
ripristinare la posizione corrispondente.

Suggerimento
È possibile ripristinare una posizione anche premendo l’immagine, premendo il pulsante  (menu posizione preset) visualizzato e
selezionando quindi [Recall].

La velocità di transizione con la quale viene raggiunta la posizione salvata è determinata dall’impostazione di [Pan-Tilt] > [P/T Preset] >
[Pan-Tilt] > [Pan-Tilt Speed for Common] nel menu Web attiva al momento del salvataggio della posizione. È possibile modificare la
velocità di transizione anche dopo il salvataggio. Per informazioni dettagliate, vedere “Modifica della velocità di transizione (pan-
tilt/zoom/fuoco) durante il ritorno a una posizione di preset”.

La velocità di spostamento durante i movimenti di pan e tilt verso una posizione di preset può essere regolata utilizzando le impostazioni
della velocità di transizione e di [Ramp Curve]. Per informazioni dettagliate, vedere “Modifica della velocità di transizione (pan-
tilt/zoom/fuoco) durante il ritorno a una posizione di preset” e “Impostazione dell’accelerazione del movimento di pan e tilt”.

Se viene richiamato un preset diverso durante la riproduzione di un preset, l’azione del primo preset richiamato si arresta e si avvia l’azione
del preset richiamato successivamente.

Nota
Qualora la temperatura ambiente sia cambiata significativamente dal momento in cui il preset era stato salvato al momento in cui viene
riprodotto, è possibile si verifichino differenze nell’inquadratura.

Durante il ripristino di una posizione di preset, le uniche operazioni che possono essere eseguite sono il ripristino e l’annullamento della
posizione di preset.

Quando si ripristina la posizione di preset di una zona Clear Image Zoom, lo zoom non agisce gradualmente (la posizione di preset viene
ripristinata istantaneamente).

4
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Rinomina delle posizioni di preset tramite l’app Web

Le posizioni di preset possono essere rinominate secondo le proprie esigenze.

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare la modalità di assistenza PTZ su [Pos.] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

1

Premere la posizione di preset da rinominare.

Viene visualizzato il pulsante  (menu posizione preset) nella sezione in alto a destra dell’immagine.

2

Premere il pulsante  (menu posizione preset) e selezionare [Rename] nel menu visualizzato.3

Immettere il nuovo nome del preset.4
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Sostituzione di una posizione di preset salvata con una nuova posizione tramite l’app Web

Le posizioni di preset salvate possono essere sostituite con nuove posizioni.

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare la modalità di assistenza PTZ su [Pos.] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

1

Determinare la posizione che si desidera salvare utilizzando le funzioni di pan, tilt e zoom.2

Premere l’immagine della posizione da sostituire nel pannello di controllo delle posizioni di preset.

Viene visualizzato il pulsante  (menu posizione preset) nella sezione in alto a destra dell’immagine.

3

Premere il pulsante  (menu posizione preset) e selezionare [Replace] nel menu visualizzato.

La nuova posizione sostituisce quella corrente.

4
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Eliminazione di una posizione di preset salvata tramite l’app Web

Le posizioni di preset possono essere eliminate.

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare la modalità di assistenza PTZ su [Pos.] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

1

Premere l’immagine della posizione da eliminare nel pannello di controllo delle posizioni di preset.

Viene visualizzato il pulsante  (menu posizione preset) nella sezione in alto a destra dell’immagine.

2

Premere il pulsante  (menu posizione preset) e selezionare [Delete] nel menu visualizzato.

La posizione salvata viene eliminata.

3
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Sincronizzazione dei movimenti di pan e tilt e delle operazioni di zoom e messa a fuoco durante
il ripristino di una posizione di preset

Durante il ripristino di una posizione di preset precedentemente salvata, i movimenti di pan e tilt e le operazioni di zoom possono
essere sincronizzati per ottenere un’inquadratura più fluida.

Suggerimento
Le impostazioni utilizzate per registrare una posizione di preset possono essere specificate in anticipo. Impostare [Pan-Tilt] > [P/T Preset] >
[Default] > [Zoom Sync] su [On] nel menu Web.

Quando [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] è impostato su [Common], tutte le posizioni di preset verranno ripristinate alla
velocità impostata con [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed for Common].

Dopo aver completato il movimento di zoom, la telecamera si sposta sulla posizione di messa a fuoco salvata.

Una volta completato il movimento, [AF Transition Speed] ritorna all’impostazione originale.

Nota

A seconda della gamma di velocità dello zoom dell’obiettivo, l’operazione di zoom potrebbe terminare prima o continuare dopo la fine
dell’operazione di movimento pan o tilt. Controllare il funzionamento corretto prima dell’impiego.

Impostare la modalità di assistenza PTZ su [Pos.] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

1

Premere l’immagine della posizione di preset di cui si desidera modificare la velocità di transizione.

Viene visualizzato il pulsante  (menu posizione preset) nella sezione in alto a destra dell’immagine.

2

Premere il pulsante  (menu posizione preset) e selezionare [Edit…] nel menu visualizzato.

Viene visualizzata la schermata di configurazione della posizione di preset selezionata.

3

Spostare il selettore [Zoom Sync] a destra per attivare la funzione e premere il pulsante [OK].

La prossima volta che viene ripristinata una posizione salvata, la telecamera si muoverà alla velocità configurata.

4
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Modifica della velocità di transizione (pan-tilt/zoom/fuoco) durante il ritorno a una posizione di
preset

È possibile modificare la velocità di transizione (movimento di pan e tilt, regolazione dello zoom, messa a fuoco) durante il ritorno a
una posizione di preset precedentemente salvata.

Suggerimento
Quando [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] è impostato su [Common], tutte le posizioni verranno ripristinate alla velocità
impostata con [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed for Common].

Dopo aver completato il movimento di zoom, la telecamera si sposta sulla posizione di messa a fuoco salvata.

Una volta completato il movimento, [AF Transition Speed] ritorna all’impostazione originale.

Quando si ripristina la posizione di preset di una zona Clear Image Zoom, lo zoom non agisce gradualmente (la posizione di preset viene
ripristinata istantaneamente).

Impostare [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] su [Separate] nel menu Web.1

Impostare la modalità di assistenza PTZ su [Pos.] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

2

Premere l’immagine della posizione di preset di cui si desidera modificare la velocità di transizione.

Viene visualizzato il pulsante  (menu posizione preset) nella sezione in alto a destra dell’immagine.

3

Premere il pulsante  (menu posizione preset) e selezionare [Edit…] nel menu visualizzato.

Viene visualizzata la schermata di configurazione della posizione di preset selezionata.

4

Selezionare [Pan-Tilt Speed Unit] > [Speed Table] e impostare le velocità di transizione (pan-tilt/zoom/fuoco) che si
desidera modificare utilizzando i cursori oppure inserirne direttamente i valori, quindi premere il pulsante [OK].

La prossima volta che viene ripristinata una posizione salvata, la telecamera si muoverà alla velocità configurata.

5
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Modifica del tempo di transizione (pan-tilt/zoom) durante il ritorno a una posizione di preset

È possibile modificare il tempo di transizione (movimento di pan e tilt, regolazione dello zoom) durante il ritorno a una posizione di
preset precedentemente salvata.

Suggerimento
Quando [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] è impostato su [Common], tutte le posizioni verranno ripristinate alla velocità
impostata con [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed for Common].

Dopo aver completato il movimento di zoom, la telecamera si sposta sulla posizione di messa a fuoco salvata.

Una volta completato il movimento, [AF Transition Speed] ritorna all’impostazione originale.

Se [Pan-Tilt] > [P/T Preset] > [Default] > [Zoom Sync] è impostato su [On] nel menu Web, anche lo zoom agisce con il tempo specificato.

Quando [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] è impostato su [Common], viene applicato il tempo di transizione configurato qui.

Il tempo di transizione può essere impostato in incrementi di 0,5 secondi.

Impostare [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] su [Separate] nel menu Web.1

Impostare la modalità di assistenza PTZ su [Pos.] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

2

Premere l’immagine della posizione di preset di cui si desidera modificare il tempo di transizione.

Viene visualizzato il pulsante  (menu posizione preset) nella sezione in alto a destra dell’immagine.

3

Premere il pulsante  (menu posizione preset) e selezionare [Edit…] nel menu visualizzato.

Viene visualizzata la schermata di configurazione della posizione di preset selezionata.

4

Selezionare [Pan-Tilt Speed Unit] > [Time] e impostare i tempi di transizione (pan-tilt/zoom) che si desidera modificare
utilizzando i cursori oppure inserirne direttamente i valori, quindi premere il pulsante [OK].

La prossima volta che viene ripristinata una posizione salvata, il movimento della telecamera avverrà nel tempo configurato.

5
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Quando si ripristina la posizione di preset di una zona Clear Image Zoom, lo zoom non agisce gradualmente (la posizione di preset viene
ripristinata istantaneamente).

Nota
La precisione e l’accelerazione massima potrebbero variare in base al tipo di obiettivo montato e alla temperatura ambiente. In questo caso la
telecamera potrebbe non operare nella maniera specificata.

I tempi specificati potrebbero essere soggetti a errori in base all’entità degli spostamenti di pan e tilt.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Salvataggio e ripristino della posizione di pan e tilt e della posizione di zoom tramite il
telecomando a infrarossi fornito in dotazione

La posizione di pan e tilt e la posizione dello zoom possono essere salvati e ripristinati in seguito, quando necessario, utilizzando il
telecomando a infrarossi fornito in dotazione.

Argomento correlato
Modifica della velocità di transizione (pan-tilt/zoom/fuoco) durante il ritorno a una posizione di preset

5-041-957-34(1) Copyright 2022 Sony Corporation

Regolare la posizione di pan e tilt e lo zoom della telecamera.1

Impostare la modalità di assistenza PTZ su [Pos.] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset dell’app Web.

2

Mantenendo premuto il pulsante PRESET, premere uno dei pulsanti da 1 a 3.

L’orientamento della telecamera e la posizione dello zoom vengono salvati come posizione di preset.

3

Ripristinare una posizione di preset precedentemente salvata.

Per ripristinare una posizione di preset, premere uno dei pulsanti da 1 a 3.

Suggerimento
La velocità di transizione durante il ripristino di una posizione di preset è determinata dal valore di [Pan-Tilt] > [P/T Preset] > [Pan-Tilt
Speed] salvato nel menu Web. È possibile modificare la velocità di transizione anche dopo averne salvato il valore. Per informazioni
dettagliate, vedere “Modifica della velocità di transizione (pan-tilt/zoom/fuoco) durante il ritorno a una posizione di preset”.

4
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Registrazione delle operazioni di inquadratura della telecamera tramite l’app Web

L’app Web consente di registrare le operazioni di inquadratura della telecamera.

Raggiungere la posizione da cui avranno inizio le operazioni della telecamera.1

Impostare la modalità di assistenza PTZ su [Trace] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

2

Premere il pulsante [+] nel pannello di controllo delle posizioni di preset.

Viene aggiunta una miniatura e la telecamera passa allo stato di standby di registrazione.

Suggerimento
È possibile premere il pulsante  (chiudi) sulla miniatura per uscire dallo stato di standby di registrazione e tornare al normale
funzionamento.

3

Avviare le operazioni di inquadratura utilizzando il joystick e il cursore [Zoom].4
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Suggerimento
Il tempo di registrazione rimanente è visualizzato nella parte superiore del pannello dell’immagine della telecamera durante la registrazione.

Nota
Le operazioni di inquadratura registrate verranno eliminate se si passa alla modalità di montaggio a soffitto

La modifica della frequenza di sistema potrebbe eliminare le operazioni di inquadratura registrate.

Quando è montato un dispositivo di comando obiettivo, i movimento dello zoom non vengono registrati.

La durata massima di registrazione di ciascuna operazione di inquadratura è di 3 minuti. La registrazione si interromperà automaticamente
quando la durata della registrazione raggiunge i 3 minuti.

Se la telecamera viene azionata da un altro dispositivo durante la registrazione di un’operazione di inquadratura, verranno registrate anche le
operazioni gestite dall’altro dispositivo. Per informazioni dettagliate sulla registrazione di operazioni utilizzando un dispositivo di comando a
distanza di altri fabbricanti, contattare il relativo fabbricante.

Le impostazioni di messa a fuoco e qualità dell’immagine non vengono registrate da questa funzione.

Le operazioni di pan, tilt e zoom registrate durante la registrazione di un’operazione di inquadratura non potranno essere replicate con totale
esattezza durante la riproduzione dell’inquadratura.

Se si imposta una limitazione all’escursione del movimento di pan e tilt utilizzando [Pan-Tilt] > [P/T Range Limit] nel menu Web dopo aver
registrato un’operazione di inquadratura, tale limitazione all’escursione del movimento di pan e tilt non verrà applicata durante la riproduzione
dell’inquadratura registrata. Se si desidera applicare una limitazione all’escursione del movimento di pan e tilt durante un’operazione di
inquadratura, è necessario impostare tale limitazione prima della registrazione dell’operazione di inquadratura desiderata.

La registrazione e/o riproduzione delle operazioni di inquadratura non sono disponibili nei seguenti casi:
Quando è selezionata l’uscita di video RAW
Quando il segnale video non viene emesso dal connettore di uscita SDI
Quando la funzione di inquadratura automatica PTZ è attiva

5-041-957-34(1) Copyright 2022 Sony Corporation

La registrazione inizia dal momento in cui inizia l’operazione di inquadratura.

Premere il pulsante  (arresta registrazione) sulla miniatura per arrestare la registrazione.5
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Riproduzione delle operazioni di inquadratura della telecamera tramite l’app Web

L’app Web consente di riprodurre le operazioni di inquadratura della telecamera precedentemente registrate.

Impostare la modalità di assistenza PTZ su [Trace] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

1

Selezionare la miniatura corrispondente all’operazione di inquadratura da riprodurre.

Sulla miniatura appare il pulsante  (prepara).

2

Premere il pulsante  (prepara).

La telecamera si sposta sulla posizione iniziale dell’operazione di inquadratura e passa allo stato di standby della riproduzione.

3

Premere il pulsante  (riproduci) sulla miniatura.

La riproduzione dell’inquadratura si avvia.

4
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Suggerimento
Nello stato di standby della riproduzione e durante la riproduzione, è possibile annullare la riproduzione e tornare al funzionamento normale
eseguendo una delle operazioni indicate di seguito.

Premere il pulsante  (stop) sulla miniatura o nel pannello di controllo delle posizioni di preset.
Azionare il joystick.
Azionare il cursore [Zoom].

Il tempo di riproduzione trascorso è visualizzato nella parte superiore del pannello dell’immagine della telecamera durante la riproduzione.

Nota

Se l’impostazione di Clear Image Zoom durante la riproduzione delle operazioni di inquadratura è diversa da quella che era presente al momento
della registrazione potrebbero verificarsi comportamenti imprevisti.

La riproduzione dei movimenti dello zoom non è supportata quando è montato un dispositivo di comando dell’obiettivo. L’azionamento dello zoom
arresterà la riproduzione delle operazioni di inquadratura.

Durante la riproduzione dell’operazione di inquadratura, la modifica della limitazione all’escursione del movimento di pan e tilt utilizzando [Pan-
Tilt] > [P/T Range Limit] nel menu Web non ha alcun effetto. Impostare la limitazione all’escursione del movimento di pan e tilt prima della
registrazione dell’operazione di inquadratura.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Eliminazione delle operazioni di inquadratura della telecamera tramite l’app Web

L’app Web consente di eliminare operazioni di inquadratura della telecamera precedentemente registrate.

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare la modalità di assistenza PTZ su [Trace] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

1

Selezionare la miniatura corrispondente all’operazione di inquadratura da eliminare.

Sulla miniatura appare il pulsante  (menu Trace).

2

Premere il pulsante  (menu Trace).

Appare il menu.

3

Selezionare [Delete] nel menu visualizzato.

L’operazione di inquadratura selezionata viene eliminata.

4
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Registrazione delle operazioni di inquadratura della telecamera utilizzando il telecomando a
infrarossi fornito in dotazione

Le operazioni di inquadratura della telecamera possono essere registrate anche utilizzando il telecomando a infrarossi fornito in
dotazione.

Per informazioni dettagliate sulla riproduzione di un’operazione di inquadratura registrata, vedere “Riproduzione delle operazioni di
inquadratura della telecamera utilizzando il telecomando a infrarossi fornito in dotazione”.

Nota
La durata massima di registrazione di ciascuna operazione di inquadratura è di 3 minuti. La registrazione si interromperà automaticamente
quando la durata della registrazione raggiunge i 3 minuti.

Se la telecamera viene azionata da un altro dispositivo durante la registrazione di un’operazione di inquadratura, verranno registrate nelle
operazioni di inquadratura anche le operazioni gestite dall’altro dispositivo.

Se la qualità dell’immagine viene regolata durante la registrazione di un’operazione di inquadratura, tale modifica non viene registrata.

Argomento correlato
Riproduzione delle operazioni di inquadratura della telecamera utilizzando il telecomando a infrarossi fornito in dotazione

5-041-957-34(1) Copyright 2022 Sony Corporation

Accedere alla schermata delle operazioni live dell’app Web.1

Impostare la modalità di assistenza PTZ su [Trace] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

2

Raggiungere la posizione da cui avranno inizio le operazioni della telecamera utilizzando il telecomando a infrarossi.3

Mantenendo premuto il pulsante PRESET, premere uno dei pulsanti POSITION (da 1 a 3).

La telecamera entra nello stato di standby di registrazione.

4

Eseguire l’operazione di inquadratura da registrare.5

Per terminare la registrazione, premere e mantenere premuto il pulsante PRESET e premere lo stesso pulsante
POSITION premuto al punto 4.

6
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Riproduzione delle operazioni di inquadratura della telecamera utilizzando il telecomando a
infrarossi fornito in dotazione

Il telecomando a infrarossi fornito in dotazione consente di riprodurre le operazioni di inquadratura della telecamera precedentemente
registrate.

Nota
La riproduzione si arresta se vengono comandati movimenti di pan, tilt o zoom sulla telecamera.

Argomento correlato
Registrazione delle operazioni di inquadratura della telecamera utilizzando il telecomando a infrarossi fornito in dotazione

5-041-957-34(1) Copyright 2022 Sony Corporation

Accedere alla schermata delle operazioni live dell’app Web.1

Impostare la modalità di assistenza PTZ su [Trace] nell’elenco a discesa situato nella parte superiore del pannello di
controllo delle posizioni di preset.

2

Selezionare e premere uno dei pulsanti POSITION (da 1 a 3) su cui è stata registrata l’operazione di inquadratura
desiderata.

La telecamera esegue i movimenti di pan, tilt e zoom necessari per raggiungere la posizione iniziale della riproduzione.

3

Quando la telecamera ha raggiunto la posizione iniziale della riproduzione, premere nuovamente lo stesso pulsante
POSITION.

La riproduzione inizia.

4
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Inquadratura automatica PTZ

L’unità è dotata di una funzione di inquadratura automatica PTZ che riconosce le persone e regola automaticamente la direzione della
telecamera e la posizione dello zoom.
La funzione di inquadratura automatica PTZ prevede due modalità: la “modalità di avvio manuale del seguimento”, in cui l’operatore
può avviare manualmente il seguimento di una persona, e la “modalità di avvio automatico del seguimento” in cui il seguimento di una
persona si avvia automaticamente quando la persona entra in un’area configurata manualmente in precedenza.
Impostare la modalità da utilizzare prima di utilizzare questa funzione utilizzando la procedura descritta in “Configurazione delle
impostazioni iniziali dell’inquadratura automatica PTZ”.

Per informazioni dettagliate sul funzionamento dell’inquadratura automatica PTZ nella modalità di avvio manuale del seguimento,
vedere “Specifica dei soggetti per il seguimento automatico (modalità di avvio manuale del seguimento)”.
Per informazioni dettagliate sul funzionamento dell’inquadratura automatica PTZ nella modalità di avvio automatico del
seguimento, vedere “Selezione e seguimento automatico dei soggetti in una posizione specificata (modalità di avvio automatico del
seguimento)”.

La funzione di inquadratura automatica PTZ prevede sei stati, indicati di seguito.

Per selezionare il soggetto da seguire toccare la persona desiderata all’interno del riquadro dell’immagine della telecamera negli stati
[Detecting], [Tracking] e [Target Lost].
È possibile monitorare lo stato di esecuzione dell’inquadratura automatica PTZ utilizzando l’indicatore tally dell’unità. Per informazioni
dettagliate fare riferimento a “Controllo da remoto dello stato dell’inquadratura automatica PTZ”.

Nota
Quando si utilizza l’inquadratura automatica, configurare le seguenti impostazioni nell’app Web:

[Pan-Tilt] > [P/T Speed] > [Speed Step]: [Extended]
[Pan-Tilt] > [P/T Acceleration] > [Ramp Curve]: da 7 a 9

Durante l’inquadratura automatica PTZ, le informazioni visualizzate sull’immagine della telecamera sono minime.

Durante la messa a fuoco automatica, la persona che viene seguita è l’obiettivo della messa a fuoco. Per mettere a fuoco un soggetto diverso
dalla persona che si sta seguendo, impostare la messa a fuoco manuale.

Le impostazioni relative alla messa a fuoco automatica non possono essere modificate durante l’operazione di inquadratura automatica PTZ.

Il corretto funzionamento del seguimento automatico potrebbe non essere possibile se la messa a fuoco o l’esposizione della telecamera non
sono impostate correttamente oppure a causa di fattori quali l’ambiente di ripresa (ad esempio, la luminosità), l’angolo di ripresa (angolo
estremamente alto o angolo basso) o la densità, le dimensioni, l’abbigliamento, il movimento o l’oscuramento delle persone.

Indicazione sulla schermata
delle operazioni live Stato

(Nessuna indicazione) Funzione di inquadratura automatica PTZ non attiva.

[Preparing] Preparazione all’esecuzione dell’inquadratura automatica PTZ.

[Return to Start Position]
Spostamento alla posizione di avvio configurata (solo modalità di avvio automatico del
seguimento).

[Detecting] Il soggetto del seguimento viene rilevato (solo modalità di avvio automatico del seguimento).

[Select Target]
Attesa della selezione del soggetto da seguire. Toccare la persona da seguire nel riquadro delle
immagini della telecamera.

[Tracking] Il soggetto viene seguito.

[Tracking Paused]
Il seguimento entra in pausa. Premere il pulsante [Resume] o toccare una persona all’interno
del riquadro dell’immagine della telecamera per riprendere il seguimento.

[Target Lost] Il seguimento del soggetto selezionato è andato perso.
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La piena efficacia della funzione di riconoscimento del viso potrebbe non essere ottenuta se non sono soddisfatte le seguenti condizioni:
Soggetto rivolto in avanti
Espressione del viso normale (occhi chiusi, nessuna intensa espressione, quale rabbia o pianto)
Viso non coperto eccessivamente (occhiali da sole, mascherine, ecc.)

Le effettive velocità e precisione dello zoom variano a seconda dell’obiettivo. Verificarne il funzionamento prima dell’uso effettivo.

Se viene cambiato l’obiettivo, oppure se viene modificato [Zoom Type], [Imager Scan Mode], [S&Q Motion], [P/T Range Limit] o [P/T Direction] >
[Ceiling], modificare le impostazioni nella schermata [Start Position] e nella schermata [Detection Settings] della schermata delle impostazioni
PTZ AFR. Per informazioni dettagliate, fare riferimento a “Configurazione delle impostazioni iniziali dell’inquadratura automatica PTZ”.

Quando si utilizza l’erogazione di alimentazione PoE++, non sarà possibile utilizzare contemporaneamente la registrazione e l’inquadratura
automatica PTZ.

L’inquadratura automatica PTZ non può essere eseguita durante la visualizzazione delle miniature, la riproduzione, Rec Review, la
visualizzazione delle barre di colore, la calibrazione dell’obiettivo e quando l’uscita HDMI non è possibile.

Nessuna operazione potrà essere accettata per alcuni secondi immediatamente dopo l’attivazione o la disattivazione dell’inquadratura
automatica PTZ.

L’inquadratura automatica PTZ non può essere utilizzata se l’uscita HDMI è superiore a 1920×1080. Inoltre, dopo aver modificato le impostazioni
dell’uscita video, potrebbero essere necessari diverse decine di secondi per l’avvio dell’inquadratura automatica PTZ. È consigliabile quindi
prevedere un opportuno margine di tempo prima dell’uso.

L’inquadratura automatica PTZ non potrà essere utilizzata se [Stream] > [Stream] > [Stream Setting] > [Setting] è impostato su [RTSP] e, allo
stesso tempo, [Stream] [Video Stream] > [Codec 2] è impostato su un valore diverso da [Off] nel menu Web.

L’inquadratura automatica PTZ non potrà essere utilizzata se [Stream] > [Stream] > [Stream Setting] > [Setting] è impostato su [NDI|HX] e, allo
stesso tempo, [Stream] > [Video Stream] > [Frame Rate 2] è impostato su un valore superiore a 10fps nel menu Web.

Argomento correlato
Configurazione delle impostazioni iniziali dell’inquadratura automatica PTZ

Specifica dei soggetti per il seguimento automatico (modalità di avvio manuale del seguimento)

Selezione e seguimento automatico dei soggetti in una posizione specificata (modalità di avvio automatico del seguimento)
Controllo da remoto dello stato dell’inquadratura automatica PTZ

5-041-957-34(1) Copyright 2022 Sony Corporation
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Configurazione delle impostazioni iniziali dell’inquadratura automatica PTZ

Questo argomento descrive come configurare le impostazioni iniziali dell’inquadratura automatica PTZ.

Premere la scheda [PTZ AFR Settings].

Viene visualizzata la schermata [Initial Setup] della schermata di configurazione di PTZ AFR.

1

Controllare la descrizione sullo schermo e premere il pulsante [Start].

Suggerimento
Il pulsante [Start] viene visualizzato solo quando si configurano le impostazioni per la prima volta.

Viene avviata la configurazione delle impostazioni di inquadratura automatica PTZ.

2

Regolare la composizione di inquadratura automatica PTZ desiderata nella schermata [Framing].3
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A: Cursore delle dimensioni del corpo umano
B: Pannello di regolazione della composizione
C: Riquadro di composizione
Regolare le dimensioni e la posizione della persona all’interno dell’immagine.
[Lead Room Effect]: Imposta l’intensità dell’effetto che crea spazio bianco nella composizione in base all’orientamento del viso.

Suggerimento
Facendo doppio clic su un’icona sul lato sinistro del cursore delle dimensioni del corpo umano, il riquadro di composizione verrà impostato
sulle dimensioni (rapporto di zoom) e sulla posizione della persona per quell’icona.

Nota
Se il riquadro di composizione bianco si sovrappone alla zona grigia, diventa più facile perdere persone che si muovono nella direzione
opposta.

Se si compone l’inquadratura in modo da ingrandire le dimensioni della persona, diventa più facile perdere persone che si muovono
rapidamente. In questo caso, ridurre le dimensioni della persona e collocarla in modo che intorno ad essa sia presente abbastanza spazio
per il suo movimento.

Al termine della configurazione, premere il pulsante [Next].

Viene visualizzata la schermata di configurazione successiva.

4

Impostare la modalità di seguimento nella schermata [Tracking Operation].5
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Imposta la modalità di avvio del seguimento.

[Auto]: In questa modalità, il seguimento di una persona si avvia automaticamente quando tale persona entra nella zona di
rilevamento specificata nel campo di visuale configurato come posizione di avvio (modalità di avvio automatico del
seguimento). Quando questa impostazione è selezionata, è necessario eseguire la configurazione nella schermata [Start
Position] e [Detection Settings].
[Manual]: In questa modalità, il seguimento non viene avviato finché non si specifica manualmente la persona da seguire
(modalità di avvio manuale del seguimento).

Al termine della configurazione, premere il pulsante [Next].

Viene visualizzata la schermata di configurazione successiva.

Quando è selezionato [Auto], continuare con il passo 7.
Quando è selezionato [Manual], continuare con il passo 11.

6

Impostare la posizione iniziale per il seguimento automatico nella schermata [Start Position].

Configurare la posizione iniziale utilizzata quando l’inquadratura automatica PTZ si trova in modalità di avvio automatico del
seguimento. Questa impostazione non è necessaria per la modalità di avvio manuale del seguimento.
Quando viene premuto il pulsante  (Riavvio) nella schermata delle operazioni live oppure quando il seguimento della persona
desiderata viene perso, la telecamera torna alla sua posizione iniziale.

7
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A: Pannello dell’immagine della telecamera
B: Pannello di controllo dell’inquadratura
Impostare la posizione iniziale.

Impostare la posizione iniziale utilizzando i comandi di pan, tilt e zoom nel pannello di controllo dell’inquadratura, e
controllando l’immagine ripresa dalla telecamera nel pannello dell’immagine della telecamera. È possibile regolare la velocità
di transizione pan e tilt e zoom utilizzando gli appositi cursori.
Per impostazione predefinita, il pulsante [Move to the set start position] è disabilitato. Viene abilitato dopo il completamento
della configurazione iniziale. Premerlo per raggiungere la posizione iniziale attualmente configurata.
Premere il pulsante [Pan-Tilt Reset] per eseguire il reset di pan e tilt. Premere il pulsante quando gli indicatori POWER e
NETWORK lampeggiano contemporaneamente sul pannello anteriore dell’unità oppure quando appare il messaggio [Execute
Pan-Tilt Reset] nel pannello di controllo dell’inquadratura.

Nota

Nei casi indicati di seguito sarà necessario eseguire nuovamente la configurazione.
Quando viene cambiato l’obiettivo o si modifica l’impostazione di [Imager Scan Mode]
Quando [Rec Format] > [Video Format] viene cambiato da 1920×1080 a 3840×2160 mentre è attivo Clear Image Zoom
Quando viene modificata l’impostazione di [Zoom Type]
Quando [S&Q Motion] > [Frame Rate] viene impostato su un valore superiore a 60fps
Quando [P/T Range Limit] viene modificato
Quando [P/T Direction] > [Direction] > [Ceiling] viene modificato

Al termine della configurazione, premere il pulsante [Next].

Viene visualizzata la schermata di configurazione successiva.

8

Configurare le impostazioni dettagliate relative all’avvio automatico del seguimento nella schermata [Detection
Settings].

Questa impostazione non è necessaria per la modalità di avvio manuale del seguimento.

9
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A: Pannello di configurazione del campo di rilevamento
Specifica il campo per il rilevamento della persona da seguire.

Impostare il campo di seguimento trascinando i cerchietti situati ai quattro angoli del riquadro arancione nel pannello di
configurazione del campo di rilevamento controllando allo stesso tempo l’immagine della telecamera. La persona che entra
nel campo così configurato diventa il soggetto del seguimento.
Per impostazione predefinita, il pulsante [Move to the set start position] è disabilitato. Viene abilitato dopo il completamento
della configurazione iniziale. Premerlo per raggiungere la posizione iniziale attualmente configurata.
[Tracking Timeout]: Imposta il tempo dopo il quale la telecamera ritorna alla posizione iniziale nel caso in cui venga perso il
rilevamento del viso del soggetto da seguire. Impostare su 0 secondi per disabilitare la funzione di timeout (valore predefinito:
0 secondi). Questo imposta il tempo che deve trascorrere prima che la telecamera cessi automaticamente il seguimento di
una persona di cui non è visibile il viso (ad esempio spettatore rivolto in direzione opposta alla telecamera ma che sia
diventato erroneamente il soggetto del seguimento) e torni alla posizione iniziale.
[Detection Restart Time]: Imposta il tempo che intercorre tra l’avvio del rilevamento automatico e il riavvio automatico.
Impostare su 0 secondi per disabilitare la funzione di riavvio automatico (valore predefinito: 0 secondi). Se si desidera
cambiare a intervalli regolari il soggetto del seguimento durante le riprese anziché seguire una sola persona specifica, è
possibile impostare un tempo trascorso il quale il seguimento si arresta automaticamente e si riavvia automaticamente.

Nota
Se l’impostazione della posizione iniziale viene modificata, sarà necessario eseguire nuovamente la configurazione.

Al termine della configurazione, premere il pulsante [Next].

Viene visualizzata la schermata di configurazione successiva.

10

Configurare le impostazioni nella schermata [Others].11

171



Configurare le impostazioni indicate di seguito, se necessario.

[Personal Identification]: Impostare sulla posizione di attivazione per il funzionamento normale. Impostare sulla posizione di
disattivazione se si desidera che la telecamera segua automaticamente un soggetto senza identificarlo.
[Wait Time]: Impostare il tempo di arresto dell’operazione di pan/tilt/zoom e attesa in caso di perdita del soggetto del
seguimento.
[PTZ AFR On when Power On]: Impostare sulla posizione di attivazione per iniziare con l’inquadratura automatica PTZ
abilitata all’accensione dell’unità.
[Detected Indicator]: Impostare sulla posizione di attivazione per visualizzare un riquadro attorno al viso della persona rilevata
come soggetto o candidata per il seguimento automatico. Visualizza anche il campo di rilevamento per la posizione di avvio.

Al termine della configurazione, premere il pulsante [Done].

Viene visualizzata la schermata di completamento riportata di seguito.

12
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Una volta completata la configurazione iniziale, è possibile aprire ogni pagina singolarmente utilizzando le voci sul lato sinistro della
schermata delle impostazioni PTZ AFR. Se vengono modificate impostazioni, premere il pulsante [OK] su ciascuna pagina per
applicarle.

Argomento correlato
Struttura della schermata delle impostazioni PTZ AFR

5-041-957-34(1) Copyright 2022 Sony Corporation

Questo completa la configurazione delle impostazioni iniziali di inquadratura automatica PTZ.
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Specifica dei soggetti per il seguimento automatico (modalità di avvio manuale del seguimento)

In questa modalità, viene specificata manualmente la persona da seguire per avviare il seguimento.

Controllare che la modalità di avvio del seguimento di essere umano sia impostata sulla modalità di avvio manuale del
seguimento nella schermata di configurazione di PTZ AFR.

Per informazioni dettagliate sulla modalità di avvio del seguimento, vedere “Configurazione delle impostazioni iniziali
dell’inquadratura automatica PTZ”.
Se le impostazioni iniziali non sono state configurate, l’unità opera in modalità di avvio manuale del seguimento.

1

Catturare la persona da seguire nel pannello di controllo dell’inquadratura dell’app Web utilizzando la telecamera.

Suggerimento
È possibile anche richiamare un’impostazione di posizione di preset e utilizzare tale inquadratura per catturare la persona desiderata.

2

Spostare il selettore [PTZ AFR] sulla posizione di attivazione nella schermata delle operazioni live.

L’area intorno al pulsante [Pause] lampeggia in blu.

3

Toccare la persona da seguire nel pannello delle immagini della telecamera.

L’area intorno al pulsante [Pause] è illuminata in blu.
Durante il seguimento automatico, il pulsante [Pause] è abilitato.
Durante l’inquadratura automatica è sempre possibile cambiare la scelta della persona da seguire. Toccare sullo schermo la
persona da seguire desiderata per farla diventare il nuovo soggetto del seguimento.

4

Se necessario, premere il pulsante [Pause] per mettere in pausa il movimento di pan, tilt e zoom attivato dal seguimento
automatico.

L’area intorno al pulsante [Pause] lampeggia in blu.

Premendo il pulsante [Pause] durante l’inquadratura automatica, il movimento di pan, tilt e zoom attivato dal seguimento
automatico viene sospeso e il pulsante diventa [Resume]. Per riavviare l’inquadratura automatica, premere il pulsante
[Resume].
Se si aziona il joystick o il cursore dello zoom, oppure si richiama una posizione di preset durante l’inquadratura automatica, il
movimento di pan, tilt e zoom attivato dal seguimento automatico viene sospeso e il pulsante diventa [Resume]. Per riavviare,
premere il pulsante [Resume].
Per riavviare, è possibile anche toccare una persona sullo schermo invece di utilizzare il pulsante [Resume].

5

Premere la scheda  (regolazione composizione AFR) nella schermata delle operazioni live per visualizzare il
pannello di regolazione della composizione AFR.

6

Regolare le dimensioni della persona e la posizione della composizione nel pannello di regolazione della composizione
AFR.

7
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Suggerimento
In assenza di esigenze specifiche, si consiglia di impostare la messa a fuoco automatica. La funzione di seguimento sarà meno efficace se la
persona non è a fuoco.

Nella modalità di avvio manuale del seguimento, il pulsante  (Riavvio) è disabilitato.

Argomento correlato
Configurazione delle impostazioni iniziali dell’inquadratura automatica PTZ
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A: Cursore delle dimensioni del corpo umano
B: Pannello di regolazione della composizione
Regolare le dimensioni e la posizione della persona all’interno dell’immagine.

Impostare le dimensioni della persona all’interno dell’immagine utilizzando il cursore delle dimensioni del corpo umano.
Impostare la posizione della persona all’interno dell’immagine utilizzando il pannello di regolazione della composizione.
Specificare la composizione trascinando il riquadro di composizione bianco.

Nota
Se il riquadro di composizione bianco si sovrappone alla zona grigia circostante, diventa più facile perdere persone che si muovono nella
direzione opposta. In sintesi, regolare il riquadro di composizione in modo che la persona non entri nell’area grigia.

Se si compone l’inquadratura in modo da ingrandire le dimensioni della persona, diventa più facile perdere persone che si muovono
rapidamente. In questo caso, ridurre le dimensioni della persona e collocarla in modo che intorno ad essa sia presente abbastanza spazio
per il suo movimento.
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Selezione e seguimento automatico dei soggetti in una posizione specificata (modalità di avvio
automatico del seguimento)

È possibile seguire automaticamente una persona che appare in una posizione specificata.

Suggerimento
In assenza di esigenze specifiche, si consiglia di impostare la messa a fuoco automatica. La funzione di seguimento sarà meno efficace se la
persona non è a fuoco.

Premendo il pulsante [Pause] durante l’inquadratura automatica, il movimento di pan, tilt e zoom attivato dal seguimento automatico viene
sospeso e il pulsante diventa [Resume]. Per riavviare l’inquadratura automatica, premere il pulsante [Resume].

Se si aziona il joystick o il cursore dello zoom, oppure si richiama una posizione di preset durante l’inquadratura automatica, il movimento di pan,
tilt e zoom attivato dal seguimento automatico viene sospeso e il pulsante diventa [Resume]. Per riavviare, premere il pulsante [Resume].

Durante l’inquadratura automatica, è possibile regolare la composizione nel pannello di regolazione della composizione AFR. Per informazioni
dettagliate, vedere “Specifica dei soggetti per il seguimento automatico (modalità di avvio manuale del seguimento)”.

Se è stato specificato manualmente un soggetto del seguimento nella modalità di avvio automatico del seguimento, il seguimento di tale persona
avrà la priorità. Per tornare alla modalità di avvio automatico del seguimento, premere il pulsante  (Riavvio).

Se la telecamera perde completamente di vista una persona specificata manualmente, torna alla modalità di avvio automatico del seguimento.

Argomento correlato
Struttura della schermata delle impostazioni PTZ AFR

Specifica dei soggetti per il seguimento automatico (modalità di avvio manuale del seguimento)

Controllare che la modalità di avvio del seguimento di essere umano sia impostata sulla modalità di avvio automatico
del seguimento nella schermata di configurazione di PTZ AFR e che siano state configurate le impostazioni necessarie
per il seguimento automatico.

Per informazioni dettagliate, fare riferimento a “Configurazione delle impostazioni iniziali dell’inquadratura automatica PTZ”.

1

Spostare il selettore [PTZ AFR] sulla posizione di attivazione nella schermata delle operazioni live.

L’area intorno al pulsante [Pause] lampeggia in blu.

L’immagine della telecamera si sposta automaticamente sulla posizione iniziale. Il seguimento automatico si avvia quando una
persona entra nell’area di rilevamento.
Durante il seguimento automatico, il pulsante [Pause] è abilitato e l’area circostante è illuminata in blu.

Se il rilevamento della persona seguita viene perso, è possibile premere il pulsante  (Riavvia) per tornare alla posizione
iniziale e attendere il rilevamento di un soggetto di seguimento per riavviare il seguimento. È anche possibile portare
manualmente il soggetto da seguire nel campo visivo servendosi delle funzioni di pan, tilt e zoom e premere quindi il pulsante
[Resume] per riavviare il seguimento.

2
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Richiamo di un preset di composizione di inquadratura automatica PTZ

Quando l’inquadratura automatica PTZ è abilitata, la schermata delle operazioni live visualizza tre preset di composizione.
È possibile cambiare la composizione istantaneamente richiamando un preset di composizione invece di utilizzare il pannello di
regolazione della composizione AFR.
L’unità viene fornita con tre preset di composizione tipici.

A: Primo piano
B: Mezzo corpo
C: Corpo intero

Rinomina di un preset di composizione

I preset di composizione possono essere rinominati con il nome desiderato. Per informazioni dettagliate, vedere “Rinomina di un
preset di composizione di inquadratura automatica PTZ”.

Modifica di un preset di composizione

I preset di composizione possono essere modificati secondo le proprie esigenze. Per informazioni dettagliate, vedere “Sostituzione di
un preset di composizione di inquadratura automatica PTZ con un nuovo preset”.

Suggerimento
Il numero di preset di composizione è fissato su tre. Non è possibile aggiungerne o eliminarli.

Spostare il selettore [PTZ AFR] sulla posizione di attivazione nella schermata delle operazioni live.

Il pannello di controllo dei preset di composizione è visualizzato sul lato sinistro della schermata delle operazioni live.

1

Premere il preset di composizione desiderato per richiamarlo.

Nella sezione in alto a destra dell’immagine è visualizzato il pulsante  (menu inquadratura preset).

2

Premere il pulsante  (menu inquadratura preset) e selezionare [Recall] nel menu visualizzato.

Il preset di composizione selezionato viene richiamato nel pannello di regolazione della composizione AFR.

Suggerimento
È possibile anche toccare due volte rapidamente un preset di composizione per richiamarlo.

3
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Argomento correlato
Rinomina di un preset di composizione di inquadratura automatica PTZ

Sostituzione di un preset di composizione di inquadratura automatica PTZ con un nuovo preset
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Rinomina di un preset di composizione di inquadratura automatica PTZ

5-041-957-34(1) Copyright 2022 Sony Corporation

Spostare il selettore [PTZ AFR] sulla posizione di attivazione nella schermata delle operazioni live.

Il pannello di controllo dei preset di composizione è visualizzato sul lato sinistro della schermata delle operazioni live.

1

Premere il preset di composizione da rinominare.

Nella sezione in alto a destra dell’immagine è visualizzato il pulsante  (menu inquadratura preset).

2

Premere il pulsante  (menu inquadratura preset) e selezionare [Rename] nel menu visualizzato.3

Immettere il nuovo nome del preset di composizione.4
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Sostituzione di un preset di composizione di inquadratura automatica PTZ con un nuovo preset

È possibile sostituire un preset di composizione esistente con una nuova composizione.

Suggerimento
[Framing] nella schermata delle impostazioni PTZ AFR e il pannello di regolazione della composizione AFR sono collegati. Per tornare alla
composizione predefinita, sostituire la composizione impostando una composizione tipica in [Framing].

Argomento correlato
Specifica dei soggetti per il seguimento automatico (modalità di avvio manuale del seguimento)
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Spostare il selettore [PTZ AFR] sulla posizione di attivazione nella schermata delle operazioni live.

Il pannello di controllo dei preset di composizione è visualizzato sul lato sinistro della schermata delle operazioni live.

1

Regolare la posizione e le dimensioni della persona nel pannello di regolazione della composizione AFR.

Per informazioni dettagliate sulla regolazione, vedere “Specifica dei soggetti per il seguimento automatico (modalità di avvio
manuale del seguimento)”.

2

Selezionare il preset di composizione da sostituire e premere il pulsante  (menu inquadratura preset) e selezionare
[Replace] nel menu visualizzato.

La composizione configurata al punto 2 viene registrata come preset di composizione.
Il preset di composizione viene modificato in base alla nuova composizione.

Esempio di sostituzione

3
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Controllo da remoto dello stato dell’inquadratura automatica PTZ

È possibile monitorare lo stato dell’inquadratura automatica PTZ utilizzando l’indicatore tally dell’unità.

Argomento correlato
Tally

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare [Technical] > [Tally] > [Tally Control] su [PTZ AFR] nel menu Web.

L’illuminazione dell’indicatore tally cambia come descritto di seguito in base allo stato dell’inquadratura automatica PTZ.

Suggerimento
Nella modalità di avvio automatico del seguimento, l’indicatore tally lampeggia con luce verde fino a quando una persona non entra nella
zona di rilevamento.

1

Indicatore tally Stato dell’inquadratura automatica PTZ

Spento Funzione di inquadratura automatica PTZ non attiva.

Luce fissa verde Seguimento automatico in corso.

Lampeggiante
verde

L’inquadratura automatica PTZ è attiva, ma è necessario l’intervento dell’operatore. Controllare il
messaggio visualizzato nel pannello dell’immagine della telecamera nella schermata delle operazioni live
ed eseguire l’azione richiesta.
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Schermata di regolazione della messa a fuoco

La messa a fuoco può essere regolata utilizzando le parti della schermata delle operazioni live descritte di seguito.

5-041-957-34(1) Copyright 2022 Sony Corporation

Pannello dell’immagine della telecamera
È possibile regolare la messa a fuoco toccando l’immagine della telecamera. Per disabilitare l’uso del touchscreen per la messa a
fuoco nell’app Web, spostare su Off il selettore [Touch Focus] nella scheda  (Focus) del pannello di controllo della telecamera.

1.

Pannello di controllo della telecamera – Scheda  (Focus)2.

Pannello dei comandi GUI3.
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Regolazione manuale tramite l’app Web

È possibile regolare la messa a fuoco anche manualmente, ad esempio nei casi descritti di seguito.

Soggetti parzialmente oscurati da goccioline d’acqua
Soggetti con un basso contrasto rispetto allo sfondo
Soggetti più lontani in presenza di soggetti vicini

Nota
Non è possibile eseguire la messa a fuoco manuale tramite l’app Web mentre è in corso l’operazione di zoom.

Suggerimento

È possibile utilizzare la funzione di messa a fuoco automatica anche se viene principalmente utilizzata la messa a fuoco manuale. Per
informazioni dettagliate, vedere “Selezione manuale del soggetto della messa a fuoco (AF Assist) tramite l’app Web”.

Argomento correlato
Controllo dei selettori dell’obiettivo

Selezione manuale del soggetto della messa a fuoco (AF Assist) tramite l’app Web
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Se l’obiettivo è dotato di un selettore di messa a fuoco, spostarlo nella posizione “AF/MF” o “AF”.

Nota
Se il selettore si trova nelle posizioni “Full MF” o “MF” non è possibile eseguire la messa a fuoco dall’unità. Vedere “Obiettivo con selettore
di modalità di messa a fuoco” in “Controllo dei selettori dell’obiettivo”.

1

Spostare verso sinistra il selettore [Auto Focus] nel pannello di controllo della telecamera per disattivare la messa a
fuoco automatica.

La modalità di messa a fuoco manuale è attivata.

 (MF)

2

Regolare la messa a fuoco utilizzando il cursore nella parte inferiore della scheda  (Focus).3
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Regolazione manuale utilizzando il telecomando a infrarossi fornito in dotazione

È possibile regolare la messa a fuoco manualmente utilizzando il telecomando a infrarossi fornito in dotazione.

Suggerimento

È possibile utilizzare la funzione di messa a fuoco automatica anche se viene principalmente utilizzata la messa a fuoco manuale. Per
informazioni dettagliate, vedere “Messa a fuoco manuale durante la messa a fuoco automatica utilizzando il telecomando a infrarossi fornito in
dotazione”.

Argomento correlato
Messa a fuoco manuale durante la messa a fuoco automatica utilizzando il telecomando a infrarossi fornito in dotazione
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Premere il pulsante MF sul telecomando a infrarossi.1

Regolare la messa a fuoco manualmente utilizzando i pulsanti F (lontano) e N (vicino).

Per mettere a fuoco un soggetto lontano, premere il pulsante F.
Per mettere a fuoco un soggetto vicino, premere il pulsante N.

2
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Messa a fuoco specificando una posizione di messa a fuoco (Spot Focus)

Nella modalità di messa a fuoco manuale è possibile specificare la posizione di messa a fuoco desiderata nel pannello dell’immagine
della telecamera.

Nota

La funzione Spot Focus non è attiva se l’obiettivo è impostato per la messa a fuoco manuale.

Suggerimento

Mentre è attiva la modalità di messa a fuoco spot, è possibile disattivarla momentaneamente premendo un pulsante programmabile a cui è stata
assegnata la funzione [Push AF/MF] e attivare invece la messa a fuoco automatica per il periodo in cui il pulsante rimane premuto. La messa a
fuoco ritorna alla modalità manuale non appena si rilascia il pulsante.

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare [Shooting] > [Focus] > [Touch Function in MF] su [Spot Focus] nel menu Web o nel menu della telecamera.1

Spostare verso destra il selettore [Touch Focus] nella scheda  (Focus) per attivare la funzione.2

Spostare verso sinistra il selettore [Auto Focus] nella scheda  (Focus) per disattivare la funzione.3

Specificare la posizione di messa a fuoco.

Sullo schermo appare l’indicatore di messa a fuoco spot e l’immagine viene messa a fuoco sul punto in corrispondenza di tale
indicatore.

Esempio di come specificare la posizione toccando il punto desiderato dell’immagine.

4

186



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Utilizzo della funzione di messa a fuoco automatica temporanea (Push Auto Focus (AF))

Premendo il pulsante [Push AF/MF] in modalità di messa a fuoco manuale, è possibile eseguire la messa a fuoco utilizzando
momentaneamente la messa a fuoco automatica. La messa a fuoco automatica rimane attiva solo mentre il pulsante rimane premuto.
Questa funzione è utile quando si desidera spostare lentamente la messa a fuoco da un soggetto a un altro durante la messa a fuoco
manuale.

Nota

La funzione di messa a fuoco automatica Push non è attiva se l’obiettivo è impostato per la messa a fuoco manuale.

Suggerimento

La stessa operazione è eseguibile anche mediante un pulsante programmabile a cui è stata assegnata la funzione [Push AF/MF].

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare [Shooting] > [Focus] > [Push AF Mode] su [AF] nel menu della telecamera.1

Spostare verso sinistra il selettore [Auto Focus] nella scheda  (Focus) per disattivare la funzione.2

Premere il pulsante [Push AF/MF].

La messa a fuoco automatica rimane attiva finché rimane premuto il pulsante.

La messa a fuoco automatica Push viene disattivata e la messa a fuoco ritorna manuale non appena si rilascia il pulsante.

3
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Utilizzo della funzione Single-Shot Auto Focus (Push Auto Focus (AF-S))

Premere il pulsante [Push AF/MF] mentre è attiva la modalità di messa a fuoco manuale per eseguire rapidamente la messa a fuoco
automatica.
Questa funzione è comoda per mettere rapidamente a fuoco il soggetto prima della ripresa.

Nota
La funzione di messa a fuoco automatica Push non è attiva se l’obiettivo è impostato per la messa a fuoco manuale.

Il riquadro dell’area di messa a fuoco è sempre visibile quando si utilizza il pulsante [Display].

Mentre è attiva la funzione Clear Image Zoom, non è possibile specificare la posizione del riquadro [Focus Area (AF-S)]. Durante la messa a
fuoco automatica Push, viene data priorità all’area al centro dello schermo.

La posizione del riquadro [Focus Area (AF-S)] non può essere configurata durante l’inquadratura automatica PTZ. L’operazione AF dà la priorità
al soggetto seguito.

Suggerimento

La stessa operazione è eseguibile anche mediante un pulsante programmabile a cui è stata assegnata la funzione [Push AF/MF].

Impostare [Shooting] > [Focus] > [Push AF Mode] su [Single-shot AF(AF-S)] nel menu Web o nel menu della telecamera.1

Specificare la posizione su cui regolare la messa a fuoco utilizzando [Shooting] > [Focus] > [Focus Area (AF-S)] nel
menu della telecamera.

Suggerimento
Per spostare la posizione dell’area di messa a fuoco, premere il pulsante programmabile a cui è assegnato [Focus Setting] per
visualizzarne il riquadro in arancione, quindi spostarla toccando il touchscreen.

2

Spostare verso sinistra il selettore [Auto Focus] nella scheda  (Focus) per disattivare la funzione.3

Premere il pulsante [Push AF/MF].

Rilasciando il pulsante prima del completamento della messa a fuoco, la funzione di messa a fuoco automatica Push si arresta.

Durante la messa a fuoco automatica Push, lo stato della messa a fuoco è segnalato dall’indicatore di messa a fuoco.
On: La messa a fuoco è fissa nella posizione di messa a fuoco.
Lampeggiante: Soggetto non a fuoco. Dato che la messa a fuoco non è automatica, cambiare la composizione e le impostazioni
di messa a fuoco per mettere a fuoco il soggetto.
La messa a fuoco ritorna alla modalità manuale non appena si rilascia il pulsante.

4
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La funzione [Push AF Mode] può essere assegnata anche a un pulsante programmabile.

La funzione [Focus Area (AF-S)] può essere assegnata anche a un pulsante programmabile.

È possibile scegliere se visualizzare o meno il riquadro dell’area di messa a fuoco utilizzando [Monitoring] > [Display On/Off] > [Focus Area Ind.
(AF-S)] nel menu della telecamera.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Regolazione automatica tramite l’app Web

L’unità utilizza un sistema di messa a fuoco tramite rilevamento di fase per la messa a fuoco automatica ad alta velocità e tramite
contrasto per la messa a fuoco di precisione.
La combinazione di questi due metodi di messa a fuoco automatica consente di ottenere contemporaneamente rapidità e precisione.

Nota
È necessario che sia montato un obiettivo che supporta la funzione di messa a fuoco automatica.

In base alle condizioni di ripresa potrebbe non essere possibile ottenere la massima precisione.

Non è possibile regolare automaticamente la messa a fuoco su un obiettivo con innesto A-mount.

Suggerimento
Nella modalità di messa a fuoco automatica, è possibile regolare la messa a fuoco utilizzando il cursore Focus nel pannello di controllo della
telecamera. Per informazioni dettagliate, vedere “Selezione manuale del soggetto della messa a fuoco (AF Assist) tramite l’app Web”.

Argomento correlato
Controllo dei selettori dell’obiettivo

Selezione manuale del soggetto della messa a fuoco (AF Assist) tramite l’app Web
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Se l’obiettivo è dotato di un selettore di messa a fuoco, spostarlo nella posizione “AF/MF” o “AF”.

Nota
Se il selettore si trova nelle posizioni “Full MF” o “MF” non è possibile eseguire la messa a fuoco dall’unità. Vedere “Obiettivo con selettore
di modalità di messa a fuoco” in “Controllo dei selettori dell’obiettivo”.

1

Spostare verso destra il selettore [Auto Focus] nel pannello di controllo della telecamera per attivare la modalità.

La modalità di messa a fuoco automatica è attivata.

 (AF)

2
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Regolazione automatica utilizzando il telecomando a infrarossi fornito in dotazione

È possibile regolare la messa a fuoco automaticamente utilizzando il telecomando a infrarossi fornito in dotazione.

Nota
È possibile utilizzare la funzione di messa a fuoco automatica anche se viene principalmente utilizzata la messa a fuoco manuale. Per
informazioni dettagliate, vedere “Messa a fuoco manuale durante la messa a fuoco automatica utilizzando il telecomando a infrarossi fornito in
dotazione”.

Argomento correlato
Messa a fuoco manuale durante la messa a fuoco automatica utilizzando il telecomando a infrarossi fornito in dotazione
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Premere il pulsante AF del telecomando a infrarossi.

Il soggetto viene messo a fuoco automaticamente.

1
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Impostazione dell’area di messa a fuoco automatica e della sua posizione (Focus Area)

È possibile specificare la zona su cui eseguire la messa a fuoco automatica e metterla a fuoco.

Premere il pulsante [Menu] del pannello dei comandi GUI per aprire il menu della telecamera.1

Specificare l’area di messa a fuoco automatica desiderata utilizzando [Shooting] > [Focus] > [Focus Area] nel menu della
telecamera.

[Wide]:
Cerca il soggetto su un ampio angolo dell’immagine durante la messa a fuoco. Non viene visualizzato nessun riquadro.

[Zone]:
Cerca automaticamente una posizione di messa a fuoco all’interno della zona specificata.
Dopo la selezione, specificare la posizione utilizzando i pulsanti freccia del pannello dei comandi GUI.

Per tornare alla posizione centrale, premere e mantenere premuto il pulsante [Set].
[Flexible Spot]:
Mette a fuoco una posizione specificata dell’immagine.
Dopo la selezione, specificare la posizione utilizzando i pulsanti freccia del pannello dei comandi GUI.

2
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Nota
Il riquadro dell’area di messa a fuoco è sempre visibile quando si utilizza il pulsante [Display] nel pannello dell’immagine della telecamera.

Suggerimento
È possibile scegliere se visualizzare o meno il riquadro dell’area di messa a fuoco utilizzando [Monitoring] > [Display On/Off] > [Focus Area
Indicator] nel menu della telecamera.
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Per tornare alla posizione centrale, premere e mantenere premuto il pulsante [Set].
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Modifica rapida dell’area di messa a fuoco (Focus Setting)

È possibile modificare rapidamente la posizione e le dimensioni dell’area di messa a fuoco automatica durante le riprese assegnando
[Focus Setting] a un pulsante programmabile.

Per informazioni dettagliate sui pulsanti programmabili, vedere “Pulsanti programmabili”.

L’operazione varia a seconda dell’impostazione dell’area di messa a fuoco.

Quando [Shooting] > [Focus] > [Focus Area] è impostato su [Flexible Spot] oppure [Zone] nel menu
della telecamera

Per spostare l’area di messa a fuoco, premere il pulsante programmabile a cui è stata assegnata la funzione [Focus Setting] e
regolarne le dimensioni con i pulsanti freccia del pannello dei comandi GUI. Per riportare l’area di messa a fuoco sulla sua
posizione centrale durante la regolazione della posizione, premere il pulsante [Set].
Per modificare le dimensioni dell’area di messa a fuoco, premere e mantenere premuto il pulsante programmabile a cui è stata
assegnata la funzione [Focus Setting]. Dopo averne impostato le dimensioni, spostare l’area di messa a fuoco sulla posizione
desiderata premendo il pulsante [Set]. Al termine, premere il pulsante programmabile a cui è stata assegnata la funzione [Focus
Setting] per tornare alla schermata iniziale.

Quando [Shooting] > [Focus] > [Focus Area] è impostato su [Wide] nel menu della telecamera

È possibile modificare solamente le dimensioni dell’area di messa a fuoco premendo e mantenendo premuto il pulsante
programmabile a cui è stata assegnata la funzione [Focus Setting]. La posizione può essere spostata anche cambiandone prima il tipo
su [Flexible Spot] o [Zone].

Suggerimento

È possibile spostare la posizione dell’area di messa a fuoco [Focus Area (AF-S)] quando [Shooting] > [Focus] > [Push AF Mode] è impostato su
[Single-shot AF(AF-S)] nel menu della telecamera e il selettore [Auto Focus] si trova sulla posizione Off (modalità di messa a fuoco manuale).

Quando è possibile spostare la posizione dell’area di messa a fuoco, il relativo riquadro è visualizzato in arancione.

Argomento correlato
Pulsanti programmabili
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194



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Spostamento del riquadro dell’area di messa a fuoco tramite touchscreen (area di messa a
fuoco Touch)

Per spostare la posizione dell’area di messa a fuoco, premere il pulsante programmabile a cui è assegnato [Focus Setting] per
visualizzarne il riquadro in arancione, quindi spostarla utilizzando il touchscreen del pannello dei comandi GUI.
Toccare lo schermo per spostare l’area di messa a fuoco, centrandola sul punto che è stato toccato. Trascinare con il dito sullo
schermo l’area di messa a fuoco fino a raggiungere la posizione desiderata.

Suggerimento

È possibile abilitare e disabilitare l’uso del touchscreen per l’area di messa a fuoco sulla schermata di ripresa utilizzando un pulsante
programmabile a cui è assegnato [Focus Setting].

Toccare un punto dello schermo.

La posizione toccata diventa il centro dell’area di messa a fuoco.

1

Trascinare l’area di messa a fuoco con il dito per spostarla nella posizione desiderata sullo schermo.2
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Nota

Se si tocca una posizione o si trascina l’area di messa a fuoco su una posizione al di fuori del campo disponibile impostato, l’area di messa a
fuoco viene impostata sul bordo superiore, inferiore, sinistro o destro di tale campo.

Questa funzione non è disponibile nei casi descritti di seguito.

Quando il selettore [Touch Focus] del pannello di controllo della telecamera si trova sulla posizione Off.
Quando il riquadro dell’area di messa a fuoco non è visualizzato oppure è visualizzato in grigio
Durante l’esecuzione dell’inquadratura automatica PTZ

5-041-957-34(1) Copyright 2022 Sony Corporation
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Regolazione dell’operazione di messa a fuoco (Velocità di transizione AF, Sensibilità al
cambiamento del soggetto AF)

L’operazione di messa a fuoco automatica può essere regolata modificandone la velocità di transizione e la sensibilità al cambiamento
del soggetto.

Impostazione della velocità di transizione AF

È possibile specificare la velocità di azionamento del sistema di messa a fuoco in caso di cambiamento del soggetto utilizzando il
pulsante [AF Transition Speed] nel pannello di controllo della telecamera.

Scegliere la velocità desiderata fra i valori disponibili, compresi fra [Speed 1] (lenta) e [Speed 7] (veloce) in incrementi di 1. Premere il
pulsante < per diminuire il valore (velocità minore) o il pulsante > per aumentare il valore (velocità maggiore).
Se impostata su una velocità più bassa, quando il soggetto messo a fuoco cambia, la messa a fuoco segue il soggetto in maniera più
graduale, consentendo la ripresa di immagini di grande impatto espressivo.
Se impostata su una velocità più alta, la messa a fuoco seleziona il soggetto più rapidamente. Nell’esempio riportato di seguito, la
messa a fuoco passa rapidamente dall’edificio sullo sfondo alla persona che cammina in primo piano. Questa impostazione è ideale
per la ripresa di documentari che richiedono una rapida messa a fuoco in quanto il soggetto viene immediatamente messo a fuoco non
appena entra nel campo di ripresa.

Sensibilità al cambiamento del soggetto AF

La sensibilità di cambiamento da un soggetto all’altro può essere impostata secondo le proprie esigenze utilizzando il pulsante [AF
Subj. Shift Sens.] nel pannello di controllo della telecamera.
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Selezionare la sensibilità scegliendo uno dei valori compresi fra [Sens 1] (bloccata) e [Sens 5] (reattiva) in incrementi di 1. Premere il
pulsante < per diminuire il valore (cambiamento lento) o il pulsante > per aumentare il valore (cambiamento veloce).
Se impostata su una sensibilità più bassa, la messa a fuoco non cambia immediatamente anche se un altro soggetto si dovesse
spostare di fronte al soggetto originariamente messo a fuoco.

Se impostata su una sensibilità più alta, la messa a fuoco cambia immediatamente per dare la precedenza al soggetto che si sposta di
fronte.

Suggerimento

Se [AF Speed/Sens.] è assegnata a un pulsante programmabile, ad ogni pressione del pulsante, il pannello dell’immagine della telecamera
visualizza, nell’ordine indicato di seguito, le barre di livello per la regolazione dei valori, consentendo di modificare le impostazioni di velocità di
transizione AF e di sensibilità al cambiamento del soggetto AF:
Velocità di transizione AF → Sensibilità al cambiamento del soggetto AF → Nessuna indicazione …

5-041-957-34(1) Copyright 2022 Sony Corporation
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Selezione manuale del soggetto della messa a fuoco (AF Assist) tramite l’app Web

Dopo aver spostato e regolato la messa a fuoco manualmente, è possibile attivare la messa a fuoco automatica per ottenere una
regolazione fine della messa a fuoco.

Nota
Nella modalità di messa a fuoco automatica assistita, il cambiamento della messa a fuoco diventa più difficoltoso, indipendentemente
dall’impostazione di [Shooting] > [Focus] > [AF Subj. Shift Sens.] nel menu della telecamera.

La messa a fuoco automatica assistita (AF Assist) viene annullata nei seguenti casi:
Quando il soggetto messo a fuoco con il cursore [Focus] non è più visibile.
Quando si passa alla messa a fuoco manuale.
Quando viene avviata la funzione di messa a fuoco automatica con seguimento in tempo reale

Suggerimento
È possibile annullare rapidamente la messa a fuoco automatica assistita anche premendo un pulsante programmabile a cui è assegnato [Push
AF/MF].

La funzione di messa a fuoco automatica con seguimento in tempo reale si arresta quando il cursore [Focus] viene spostato.

In modalità Face/Eye Only AF, la messa a fuoco automatica mette a fuoco il viso più vicino alla posizione di messa a fuoco del cursore [Focus].

Impostare [Shooting] > [Focus] > [AF Assist] su [On] nel menu della telecamera.1

Impostare [Shooting] > [Focus] > [AF Assist Control] su [On] nel menu Web.2

Spostare verso destra il selettore [Auto Focus] nel pannello di controllo della telecamera per attivare la modalità.

La modalità di messa a fuoco automatica è attivata.

3

Impostare la messa a fuoco desiderata utilizzando il cursore [Focus] nel pannello di controllo della telecamera.

[Near]: Messa a fuoco su un soggetto vicino.
[Far]: Messa a fuoco su un soggetto lontano.

Nella messa a fuoco automatica assistita, un eventuale soggetto che si trova alla distanza impostata tramite il cursore [Focus]
verrà messo a fuoco automaticamente.

4
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Messa a fuoco manuale durante la messa a fuoco automatica utilizzando il telecomando a
infrarossi fornito in dotazione

Quando [Shooting] > [Focus] > [AF Assist] è impostato su [On] nel menu della telecamera, è possibile utilizzare i pulsanti F (lontano) e
N (vicino) del telecomando a infrarossi in dotazione per regolare la messa a fuoco del soggetto anche mentre è attiva la messa a fuoco
automatica.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Messa a fuoco manuale temporanea durante la messa a fuoco automatica (Push Manual Focus)

Premere il pulsante [Push AF/MF] mentre è attiva la messa a fuoco automatica per eseguire manualmente la messa a fuoco mentre il
pulsante rimane premuto. La messa a fuoco ritorna alla modalità automatica non appena si rilascia il pulsante.
Questo consente di interrompere momentaneamente la messa a fuoco automatica ed eseguire la messa a fuoco manuale quando un
elemento che non è il soggetto della ripresa attraversa il campo di visuale della ripresa davanti al soggetto desiderato.

Suggerimento
La stessa operazione è eseguibile anche mediante un pulsante programmabile a cui è stata assegnata la funzione [Push AF/MF].

5-041-957-34(1) Copyright 2022 Sony Corporation
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Seguimento con la funzione di rilevamento del viso e degli occhi (Face/Eye Detection AF)

L’unità è in grado di individuare, seguire e mettere a fuoco automaticamente il viso e gli occhi dei soggetti che si trovano all’interno
dell’area di messa a fuoco.
Quando vengono rilevati visi, lo schermo mostra riquadri di rilevamento del viso e degli occhi di colore grigio. Se la messa a fuoco
automatica è possibile, i riquadri diventano di colore bianco e si avvia il seguimento. Quando vengono rilevati occhi e viene eseguita la
messa a fuoco, il riquadro di rilevamento di viso e occhi appare sugli occhi del soggetto. Se vengono rilevate più persone, il soggetto
principale è determinato automaticamente.
Questa funzione è disponibile solo quando la messa a fuoco è in modalità AF o durante Push Auto Focus.

Suggerimento
Quando l’area di messa a fuoco è impostata su [Zone] o [Flexible Spot] e, nella zona di messa a fuoco specificata, si sovrappongono visi o occhi,
i riquadri di rilevamento viso e occhi sono visualizzati in colore bianco e l’unità mette a fuoco automaticamente i visi e gli occhi contenuti in tali
riquadri.

Quando viene utilizzato Push Auto Focus (AF-S), i riquadri di rilevamento viso/occhi dei visi e degli occhi messi a fuoco sono visualizzati in verde.

Impostazione mediante il pulsante [Face/Eye Detection AF] nel pannello di controllo della telecamera.

Premere il pulsante [Face/Eye Detection AF] e impostare l’operazione di messa a fuoco automatica con rilevamento del viso e degli
occhi.

[Face/Eye Only AF]: La telecamera rileva il viso e gli occhi dei soggetti (persone) e segue e mette a fuoco solo il viso e gli occhi
rilevati. Finché non viene rilevato un viso o degli occhi, la funzione AF viene temporaneamente sospesa e sullo schermo appare l’icona
di pausa di messa a fuoco automatica modalità . Questa modalità è efficace quando si desidera seguire e mantenere
automaticamente a fuoco solo il viso e gli occhi del soggetto.
[Face/Eye Priority AF]: La telecamera rileva il viso o gli occhi dei soggetti (persone) e dà priorità al seguimento e alla messa a fuoco
del viso o degli occhi. Se non vengono rilevati visi o occhi, la messa a fuoco avviene in modalità AF (impostazione predefinita).
[AF]: La funzione di AF con rilevamento del viso o degli occhi è disabilitata.

Nota
Mentre è attiva la funzione di Push Auto Focus, viene sempre attivata [Face/Eye Priority AF], anche mentre è selezionata [Face/Eye Only AF].

Quando il selettore [Auto Focus] si trova sulla posizione Off, la funzione di AF con rilevamento del viso o degli occhi è disabilitata (eccetto durante
Push Auto Focus).

Se si spegne il camcorder mentre è selezionata [Face/Eye Only AF], alla successiva riaccensione verrà automaticamente ripristinata la modalità
[Face/Eye Priority AF].

Suggerimento
La modalità operativa AF con rilevamento del viso o degli occhi può essere selezionata anche utilizzando [Shooting] > [Focus] > [Face/Eye
Detection AF] nel menu della telecamera.
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Nascondere i riquadri di rilevamento del viso o degli occhi
È possibile scegliere se visualizzare o meno i riquadri di rilevamento del viso o degli occhi utilizzando [Monitoring] > [Display On/Off] >
[Face/Eye Detection Frame] nel menu della telecamera.

Nota

I visi e gli occhi messi a fuoco con la funzione Push Auto Focus (AF-S) sono identificati mediante riquadri verdi, a meno che tali riquadri non
siano stati disattivati con il pulsante [Display] oppure l’opzione [Face/Eye Detection Frame] sia impostata su [Off].

Selezione della modalità AF con rilevamento del viso o degli occhi tramite un pulsante
programmabile
Assegnare [Face/Eye Detection AF] a un pulsante programmabile. Premendo ripetutamente tale pulsante, si passa in sequenza da
una modalità AF con rilevamento del viso o degli occhi all’altra nell’ordine [Face/Eye Priority AF], [Face/Eye Only AF] e [AF].

Impostazione con Direct Menu

La modalità operativa AF con rilevamento del viso o degli occhi può essere selezionata anche con Direct Menu.

Per informazioni dettagliate sul Direct Menu, vedere “Utilizzo del Direct Menu”.

Argomento correlato
Utilizzo del Direct Menu

5-041-957-34(1) Copyright 2022 Sony Corporation
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Seguimento di un soggetto specificato (Realtime Tracking AF)

L’unità consente di mantenere la messa a fuoco su un determinato soggetto toccandolo sullo schermo oppure selezionandone il
riquadro di rilevamento del viso corrispondente nel pannello di controllo della telecamera.
Il seguimento si avvia non appena viene selezionato il soggetto desiderato e lo schermo visualizza un riquadro di seguimento bianco.

Suggerimento
Il seguimento ha luogo sull’intera area dell’immagine, indipendentemente dall’impostazione dell’area di messa a fuoco.

Quando [Shooting] > [Focus] > [Touch Function in MF] è impostato su [Tracking AF] nel menu Web o nel menu della telecamera, la funzione di
AF con seguimento in tempo reale è supportata anche mentre la messa a fuoco si trova in modalità MF.

In base all’impostazione della modalità operativa della funzione di AF con rilevamento del viso o degli occhi, avranno luogo, per quanto
riguarda il soggetto del seguimento, le azioni indicate di seguito.

[Face/Eye Only AF] o [Face/Eye Priority AF]: Messa a fuoco e seguimento del soggetto specificato.
Se il soggetto da seguire è una persona e se il camcorder ne rileva il viso o gli occhi, la messa a fuoco avviene sul viso o sugli occhi
rilevati.
Se il camcorder rileva il viso o gli occhi del soggetto del seguimento, ne salva il viso. L’icona  indica che è stato salvato un viso da
seguire.

Nota

Se la funzione di AF con seguimento viene avviata durante la messa a fuoco manuale, il viso del soggetto del seguimento non viene salvato.

[AF]: Consente la messa a fuoco e il seguimento di un soggetto specificato. Il rilevamento del viso o degli occhi non ha luogo, anche
se il soggetto del seguimento è una persona.

Nota
La funzione di AF con seguimento in tempo reale non è attiva se l’obiettivo è impostato per la messa a fuoco manuale.

Avvio della messa a fuoco automatica con seguimento in tempo reale

Il seguimento si avvia non appena viene specificato un determinato soggetto da seguire.

Specifica toccando lo schermo
Spostare sulla destra il selettore [Touch Focus] nella scheda  (Focus) del pannello di controllo della telecamera per attivare la
funzione, quindi toccare il soggetto desiderato per seguirlo mentre è attivo uno degli stati indicati di seguito.

Durante la messa a fuoco manuale o durante la messa a fuoco manuale Push e quando [Shooting] > [Focus] > [Touch Function in
MF] è impostato su [Tracking AF] nel menu Web o nel menu della telecamera
Durante la messa a fuoco automatica o durante la messa a fuoco automatica Push (AF)
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Specifica tramite la selezione del riquadro di rilevamento del viso
Spostare il cursore di selezione del viso (sottolineatura arancione) sul soggetto da seguire utilizzando i pulsanti freccia del pannello dei
comandi GUI, quindi premere il pulsante [Set].

A: Riquadri di rilevamento del viso (grigi)
B: Riquadro di seguimento
C: Cursore di selezione del viso (arancione)

Nota
Durante la messa a fuoco manuale non è possibile avviare il seguimento tramite la selezione del riquadro di rilevamento del viso.

Suggerimento

In modalità di messa a fuoco automatica con seguimento in tempo reale è possibile cambiare il soggetto da seguire.

Arresto della messa a fuoco automatica con seguimento in tempo reale

Premere il pulsante  di arresto della funzione di AF con seguimento.

Suggerimento
La messa a fuoco automatica con seguimento in tempo reale si arresterà nei casi descritti di seguito:

Quando vengono azionati il selettore [Auto Focus] o il selettore AUTO/MANUAL dell’obiettivo.
Quando viene selezionata una modalità di messa a fuoco diversa.
Quando viene eseguita l’assistenza alla messa a fuoco automatica.
Quando viene modificata l’impostazione dell’area di messa a fuoco o l’azione di messa a fuoco automatica con rilevamento viso o degli occhi.
Quando viene premuto un pulsante programmabile a cui è assegnata la funzione [Push AF/MF]
Quando il soggetto da seguire non è presente nella schermata della ripresa o se il soggetto rimane fuori fuoco per diversi secondi.
Quando viene spostata la posizione del selettore [PTZ AFR].

Se è stato salvato un viso da seguire (l’icona  (viso da seguire salvato) è visualizzata sullo schermo), la messa a fuoco automatica con
seguimento in tempo reale riprenderà non appena il viso da seguire salvato entra nell’area dell’immagine. Per eliminare dalla memoria il viso da
seguire, uscire dalla modalità di messa a fuoco automatica con seguimento in tempo reale come descritto sopra.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Schermata di regolazione della luminosità

Utilizzando i pannelli di controllo nella schermata delle operazioni live dell’app Web descritti di seguito, è possibile regolare la
luminosità sia variando opportunamente i valori di diaframma, guadagno e, velocità dell’otturatore, sia regolando il livello di luce
mediante i filtri ND. La luminosità può essere regolata anche automaticamente.

Nota
Non è possibile regolare il guadagno quando [Shooting Mode] è impostato su [Cine EI Quick] o [Cine EI]. Se impostato su [Cine EI Quick] o [Cine
EI] anche la luminosità non può essere regolata automaticamente tramite la velocità dell’otturatore. È supportata invece la regolazione
automatica della luminosità tramite diaframma e filtro ND.

Suggerimento

Pannello di controllo della telecamera – Scheda  (Main)1.

Pannello di configurazione di base della telecamera
Visualizza sui vari pulsanti lo stato delle impostazioni delle funzioni di base necessarie per la ripresa. Premere un pulsante per
visualizzare la schermata di configurazione della funzione corrispondente nel pannello di regolazione della configurazione di base
della telecamera sottostante.

2.

Pannello di regolazione della configurazione di base della telecamera
Visualizza il pannello di regolazione della voce di configurazione selezionata nel pannello di configurazione di base della
telecamera.

3.
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Nella modalità Cine EI le riprese avvengono alla sensibilità di base senza utilizzare nessun guadagno allo scopo di massimizzare le prestazioni
del sensore immagine. La luminosità viene regolata utilizzando l’illuminazione e il filtro ND per modulare la quantità di luce che raggiunge il
sensore immagine. Per informazioni dettagliate sull’Exposure Index (EI), vedere “Modifica della distribuzione delle ombre e delle alte luci
nell’immagine registrata”.

Argomento correlato
Modifica della distribuzione delle ombre e delle alte luci nell’immagine registrata
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Impostazione della sensibilità di base

La sensibilità di base può essere impostata prima di iniziare a regolare la luminosità.

Quando [Shooting Mode] è impostato su [Custom]

Premere il pulsante [ISO/Gain] nel pannello di configurazione di base della telecamera e impostare [Base Sensitivity] nel pannello di
regolazione ISO/Gain su [High] o [Low].
Selezionare [Low] in condizioni di illuminazione normale oppure [High] in condizioni di scarsa illuminazione.
Schermata quando [AGC] è disattivato

Schermata quando [AGC] è attivato

Quando [Shooting Mode] è impostato su [Flexible ISO] o [Cine EI]

Premere il pulsante [Base ISO/Exposure Index] nel pannello di configurazione di base della telecamera e impostare [Base ISO] nel
pannello di regolazione Base ISO/Exposure Index su [ISO 12800] o [ISO 800].
Selezionare [ISO 800] in condizioni di illuminazione normale oppure [ISO 12800] in condizioni di scarsa illuminazione.

Suggerimento
Questa impostazione può essere effettuata anche nella scheda  (Main) del pannello di controllo della telecamera.

Questa impostazione può essere effettuata anche utilizzando [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] o [Base ISO] nel menu della
telecamera.

La funzione [Base ISO/Sensitivity] può essere assegnata anche a un pulsante programmabile.
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Nella modalità di ripresa [Cine EI Quick], la sensibilità di base viene impostata automaticamente in base all’impostazione di [Exposure Index].
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Impostazione del livello ottimale per la regolazione automatica della luminosità

Il livello ottimale di regolazione automatica della luminosità può essere impostato utilizzando il cursore [AE Level] nel pannello di
controllo della telecamera.

5-041-957-34(1) Copyright 2022 Sony Corporation

Premere la scheda  (Main) nel pannello di controllo della telecamera.

Se il cursore [AE Level] non è visualizzato, selezionare uno dei due pulsanti di selezione della funzione del cursore e selezionare
[AE Level] nell’elenco.

Il cursore [AE Level] viene visualizzato.

1

Impostare il livello ottimale desiderato utilizzando il cursore.

Spostare il cursore verso sinistra per rendere l’immagine più scura. Spostare il cursore verso destra per rendere l’immagine più
chiara.

Suggerimento

Questa impostazione può essere effettuata anche utilizzando [Shooting] > [Auto Exposure] > [Level] nel menu della telecamera.

2
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Regolazione automatica del diaframma

È possibile regolare automaticamente la luminosità in base al soggetto. È necessario che l’obiettivo utilizzato sia compatibile.

Nota

Non è possibile regolare automaticamente il diaframma su un obiettivo con innesto A-mount.

Suggerimento

La funzione [Auto Iris] può essere assegnata anche a un pulsante programmabile.
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Se è montato un obiettivo con selettore Auto Iris, spostare il selettore sulla posizione AUTO.1

Premere il pulsante [Iris] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [Iris] diventa arancione.

Viene visualizzato il pannello di regolazione Iris.

2

Spostare verso destra il selettore [Auto] per attivare la funzione.

Il diaframma entra in modalità di regolazione automatica. Il valore di diaframma regolato automaticamente appare sul lato destro
del selettore.

3
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Regolazione manuale del diaframma

È possibile regolare la luminosità manualmente.

Regolazione automatica temporanea del diaframma
È inoltre possibile premere il pulsante [Push Auto] nel pannello di regolazione Iris per eseguire la regolazione automatica del
diaframma finché il pulsante rimane premuto.

Suggerimento

Se è montato un obiettivo con selettore Auto Iris, spostare il selettore sulla posizione AUTO.

Nota
Se il selettore Auto Iris dell’obiettivo si trova in posizione MANUAL, le funzioni [Auto Iris] e [Push Auto Iris] dell’unità non hanno effetto. Non
hanno effetto nemmeno le regolazioni manuali del diaframma eseguite sull’unità.

1

Premere il pulsante [Iris] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [Iris] diventa arancione.

Viene visualizzato il pannello di regolazione Iris.

2

Spostare verso sinistra il selettore [Auto] per disattivare la funzione.

Il diaframma entra in modalità di regolazione manuale.

3

Regolare il diaframma utilizzando il cursore [Iris] o i pulsanti di regolazione [Iris].

Suggerimento
Le impostazioni del cursore e dei pulsanti di regolazione sono collegati fra loro.

È possibile anche assegnare il diaframma al cursore nella scheda  (Main) del pannello di controllo della telecamera.

4
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Premendo il pulsante programmabile a cui è assegnata la funzione [Push Auto Iris] viene eseguita la regolazione automatica del diaframma
finché il pulsante rimane premuto.
Il diaframma ritorna alla modalità di regolazione manuale non appena si rilascia il pulsante.
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Regolazione automatica del guadagno

È possibile regolare automaticamente la luminosità utilizzando l’impostazione del guadagno quando [Shooting Mode] è impostato su
[Custom] o [Flexible ISO].
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Impostare [Project] > [Shooting Mode] su [Custom] nel menu Web o nel menu della telecamera.1

Premere il pulsante [ISO/Gain] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [ISO/Gain] diventa arancione.

Viene visualizzato il pannello di regolazione ISO/Gain.

2

Spostare verso destra il selettore [AGC] per attivare la funzione.

Il guadagno entra in modalità di regolazione automatica. Il valore di guadagno regolato automaticamente appare sul lato destro
del selettore.

Suggerimento
È possibile eseguire la stessa azione impostando [Shooting] > [Auto Exposure] > [AGC] su [On] nel menu della telecamera.

La funzione [AGC] può essere assegnata anche a un pulsante programmabile.

3
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Regolazione manuale del guadagno

È possibile regolare manualmente la luminosità utilizzando l’impostazione del guadagno quando [Shooting Mode] è impostato su
[Custom] o [Flexible ISO].
La regolazione del guadagno è utile per regolare l’esposizione mentre si utilizza un valore di diaframma fisso oppure se si desidera
evitare l’aumento del guadagno generato dalla funzione AGC.

Regolazione manuale temporanea del guadagno
È inoltre possibile regolare il guadagno temporaneamente assegnando [ISO/Gain] a un pulsante di selezione della funzione del
cursore nella scheda  (Main) del pannello di controllo della telecamera e utilizzando quindi tale cursore.
Questa funzione è utile se si desidera correggere l’esposizione di un passo senza tuttavia modificare la profondità di campo.
Dopo aver eseguito una delle operazioni indicate di seguito, il risultato della regolazione torna sul valore di preset precedentemente
configurato con [ISO/Gain<L>].

Modifica delle regolazioni di ISO/Gain
Cambiamento della sensibilità di base
Spostamento del selettore AGC sulla posizione On
Commutazione dell’alimentazione dell’unità alla modalità standby

Regolazione automatica temporanea del guadagno tramite un pulsante programmabile

Impostare [Project] > [Shooting Mode] su [Custom] nel menu Web o nel menu della telecamera.1

Premere il pulsante [ISO/Gain] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [ISO/Gain] diventa arancione.

Viene visualizzato il pannello di regolazione ISO/Gain.

2

Spostare verso sinistra il selettore [AGC] per disattivare la funzione.

Il guadagno entra in modalità di regolazione manuale.

3

Regolare il guadagno utilizzando il cursore [ISO/Gain] o i pulsanti di regolazione [ISO/Gain].

Suggerimento

Le impostazioni del cursore e dei pulsanti di regolazione sono collegati fra loro.

4
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Premere il pulsante programmabile a cui è assegnata la funzione [Push AGC] per regolare automaticamente il guadagno finché il
pulsante viene mantenuto premuto.
Il guadagno ritorna alla modalità di regolazione manuale non appena si rilascia il pulsante.
Dopo aver eseguito una delle operazioni indicate di seguito, il risultato della regolazione torna sul valore di preset precedentemente
configurato con [ISO/Gain<L>].

Modifica delle regolazioni di ISO/Gain
Cambiamento della sensibilità di base
Spostamento del selettore AGC sulla posizione On
Commutazione dell’alimentazione dell’unità alla modalità standby

Nota
Questa funzione non può essere eseguita quando [Shooting] > [Iris] > [Bokeh Control] è impostato su [On] nel menu della telecamera.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Regolazione automatica dell’otturatore

È possibile regolare automaticamente l’otturatore in risposta alla luminosità dell’immagine.

5-041-957-34(1) Copyright 2022 Sony Corporation

Premere il pulsante [Shutter] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [Shutter] diventa arancione.

Viene visualizzato il pannello di regolazione Shutter.

1

Premere il pulsante [Shutter Type] e selezionare [Auto] nell’elenco.

Suggerimento
È possibile eseguire la stessa azione impostando [Shooting] > [Auto Exposure] > [Auto Shutter] su [On] nel menu della telecamera.

La funzione [Auto Shutter] può essere assegnata anche a un pulsante programmabile.

2
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Regolazione manuale dell’otturatore

È possibile regolare l’otturatore manualmente.

5-041-957-34(1) Copyright 2022 Sony Corporation

Premere il pulsante [Shutter] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [Shutter] diventa arancione.

Viene visualizzato il pannello di regolazione Shutter.

1

Premere il pulsante [Shutter Type] e selezionare [Speed] nell’elenco.2

Regolare l’otturatore utilizzando il cursore [Speed] o i pulsanti di regolazione [Speed].

Per regolare il tempo di esposizione in modo che corrisponda all’intervallo fotogrammi, selezionare [Off] al passo 2. È inoltre
possibile impostare un valore fisso utilizzando [ECS] (frequenza) o regolarlo automaticamente utilizzando [Auto].
Esempio: Impostazione utilizzando [ECS] (frequenza)

Suggerimento
Le impostazioni del cursore e dei pulsanti di regolazione sono collegati fra loro.

Per utilizzare [Angle] invece di [Speed] o [Off], impostare [Shooting] > [Shutter] > [Mode] su [Angle] nel menu della telecamera.

3
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Informazioni sul filtro ND

In condizioni di illuminazione troppo intensa, è possibile ottenere la luminosità corretta utilizzando un filtro ND.
Nella ripresa di soggetti fortemente illuminati, la chiusura eccessiva del diaframma può dar luogo a sfocature per diffrazione. Questo è
un fenomeno tipico nelle videocamere e fotocamere. È possibile eliminare questo fenomeno ed ottenere risultati migliori utilizzando il
filtro ND.
L’unità dispone delle seguenti modalità di filtro ND.
Modalità Preset

Vedere “Regolazione in modalità Preset”.

Modalità variabile (regolazione automatica)

Vedere “Regolazione automatica in modalità variabile”.

Modalità variabile (regolazione manuale)

Vedere “Regolazione manuale in modalità variabile”.

Argomento correlato
Regolazione in modalità Preset

Regolazione automatica in modalità variabile
Regolazione manuale in modalità variabile

5-041-957-34(1) Copyright 2022 Sony Corporation
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Regolazione in modalità Preset

È possibile selezionare in anticipo tre valori di trasmittanza per il filtro ND per poter passare rapidamente da un valore all’altro durante
le riprese.

Suggerimento
Premendo il pulsante programmabile a cui è assegnato [ND Filter Position] il filtro ND cambia nella sequenza [Clear] → [Preset1] → [Preset2] →
[Preset3] → [Clear].

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare [Shooting] > [ND Filter] > [Mode] su [Preset] nel menu della telecamera.1

Premere il pulsante [ND Filter] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [ND Filter] diventa arancione.

Viene visualizzato il pannello di regolazione ND Filter.

2

Premere il pulsante [ND Filter] e selezionare una delle seguenti opzioni nell’elenco.

[Clear]: Nessun filtro ND.
[Preset1]: Trasmittanza impostata da [Shooting] > [ND Filter] > [Preset1] nel menu della telecamera.
[Preset2]: Trasmittanza impostata da [Shooting] > [ND Filter] > [Preset2] nel menu della telecamera.
[Preset3]: Trasmittanza impostata da [Shooting] > [ND Filter] > [Preset3] nel menu della telecamera.

Quando è selezionato per il filtro ND uno dei preset da [Preset1] a [Preset3], il corrispondente valore di trasmittanza è
visualizzato accanto al nome del filtro ND.

3
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Regolazione automatica in modalità variabile

È possibile abilitare la regolazione automatica dell’esposizione mediante il filtro ND.

Nota
Se il filtro ND entra o esce dalla posizione [Clear] durante la ripresa, il riquadro del filtro ND viene visualizzato sull’immagine e viene emesso un
segnale acustico.

Suggerimento
È possibile inoltre assegnare [Auto ND Filter] a un pulsante programmabile e premere tale pulsante per passare dalla modalità [Auto] a [Manual]
e viceversa.

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare [Shooting] > [ND Filter] > [Mode] su [Variable] nel menu della telecamera.1

Premere il pulsante [ND Filter] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [ND Filter] diventa arancione.

Viene visualizzato il pannello di regolazione ND Filter.

2

Premere il pulsante [ND Filter] e selezionare [Auto] nell’elenco.

Il valore di trasmittanza del filtro ND regolato automaticamente viene visualizzato accanto al pulsante [ND Filter].

3
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Regolazione manuale in modalità variabile

È possibile effettuare la regolazione manuale dell’esposizione mediante il filtro ND.

Regolazione automatica temporanea
È possibile anche assegnare [Push Auto ND] a un pulsante programmabile per attivare momentaneamente la funzione di filtro ND
automatico mantenendo premuto tale pulsante. Al rilascio del pulsante, la funzione di regolazione automatica del filtro ND viene
nuovamente disattivata.
Impostare il filtro ND su [Manual].

Nota
Se il filtro ND entra o esce dalla posizione [Clear] durante la ripresa, il riquadro del filtro ND viene visualizzato sull’immagine e viene emesso un
segnale acustico.

Suggerimento
È possibile inoltre assegnare [ND Filter Position] a un pulsante programmabile e premere tale pulsante per passare dalla modalità [Manual] a
[Clear] e viceversa.

Impostare [Shooting] > [ND Filter] > [Mode] su [Variable] nel menu della telecamera.1

Premere il pulsante [ND Filter] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [ND Filter] diventa arancione.

Viene visualizzato il pannello di regolazione ND Filter.

2

Premere il pulsante [ND Filter] e selezionare [Manual] nell’elenco.3

Regolare la trasmittanza del filtro ND utilizzando il cursore [ND Filter] o i pulsanti di regolazione [ND Filter].

Suggerimento
Le impostazioni del cursore e dei pulsanti di regolazione sono collegati fra loro.

È possibile regolare il filtro ND anche nella scheda  (Main) del pannello di controllo della telecamera.

4
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È possibile anche premere il pulsante [Push Auto] nel pannello di regolazione ND Filter per mantenere attiva la modalità di filtro ND automatico
mentre il pulsante rimane premuto.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Schermata di regolazione del bilanciamento del bianco

È possibile regolare il bilanciamento del bianco utilizzando la schermata delle operazioni live dell’app Web per ottenere un
bilanciamento del bianco che renda l’immagine più naturale.

5-041-957-34(1) Copyright 2022 Sony Corporation

Pannello di configurazione di base della telecamera1.

Pannello di regolazione della configurazione di base della telecamera
Visualizza il pannello di regolazione della voce di configurazione selezionata nel pannello di configurazione di base della
telecamera.

2.
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Regolazione automatica del bilanciamento del bianco

È possibile ottenere un bilanciamento del bianco appropriato e corretto in qualsiasi momento, utilizzando la funzione ATW (auto
tracking white balance).
Quando la funzione ATW è attiva, il valore di bilanciamento del bianco viene corretto automaticamente in risposta ai cambiamenti della
temperatura di colore della sorgente luminosa.

Nota
Non è possibile utilizzare la funzione ATW quando [Shooting Mode] è impostato su [Cine EI] o [Cine EI Quick].

A seconda delle condizioni di illuminazione e del soggetto, la funzione ATW può non essere in grado di ottimizzare sempre il colore.
Esempi:

Quando il soggetto è dominato da un unico colore, ad esempio cielo, mare, prati o fiori.
Quando la temperatura di colore è estremamente alta o bassa.

Se la velocità di correzione automatica ATW non è sufficiente, oppure non è possibile ottenere il risultato appropriato, premere il pulsante [WB
SET] per eseguire il bilanciamento automatico del bianco.

Suggerimento

La modalità ATW prevede cinque velocità di risposta (1, 2, 3, 4, 5) selezionabili utilizzando [Shooting] > [White Setting] > [ATW Speed] nel menu
della telecamera. Più basso il numero, maggiore sarà la velocità di risposta.

In modalità ATW, è possibile “congelare” il valore di bilanciamento del bianco corrente assegnando la funzione [ATW Hold] a un pulsante
programmabile e premendo tale pulsante per sospendere temporaneamente la modalità ATW.

5-041-957-34(1) Copyright 2022 Sony Corporation

Premere il pulsante [White Balance] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [White Balance] diventa arancione.

Viene visualizzato il pannello di regolazione White Balance.

1

Premere il pulsante [White Mode] e selezionare [ATW] nell’elenco.2
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Regolazione manuale del bilanciamento del bianco

È possibile regolare il bilanciamento del bianco manualmente.

Premere il pulsante [White Balance] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [White Balance] diventa arancione.

Viene visualizzato il pannello di regolazione White Balance.

1

Premere il pulsante [White Mode] e selezionare una delle seguenti opzioni nell’elenco.

[Memory A (T/T)]

[Memory A (R/B)]

[Preset]

2

Regolare il bilanciamento del bianco utilizzando i cursori o i pulsanti di regolazione.

Suggerimento
Le impostazioni del cursore e dei pulsanti di regolazione sono collegati fra loro.

La differenza fra [Memory A (T/T)] e [Memory A (R/B)] è che l’asse di regolazione è diverso, ma i risultati sono collegati fra loro.

Per [Memory A (T/T)]
Questa modalità regola il bilanciamento del bianco salvato nella memoria A agendo su temperatura di colore (Temp) e Tint.
È possibile impostare il valore in incrementi di 20 K nel campo da 2000 K a 5600 K. Valori superiori a 5600 K possono essere
impostati a intervalli uguali alla quantità di variazione di colore (in mired) da 5580 K a 5600 K.
Premendo il pulsante [Reset] sulla destra di [Temp] o [Tint] se ne ripristina l’impostazione sul corrispondente valore predefinito.
Per [Memory A (R/B)]
Questa modalità regola il bilanciamento del bianco salvato nella memoria A agendo su R Gain e B Gain.
Premere il pulsante [Reset] per ripristinare il valore predefinito del guadagno corrispondente.
Per [Preset]
Questa modalità regola la temperatura di colore su un valore preimpostato.
Il valore può essere impostato in incrementi di 100 K.

3
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In modalità Preset, è possibile anche assegnare [Preset White Select] a un pulsante programmabile e premere tale pulsante per
impostare un valore predefinito configurato in precedenza.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Esecuzione del bilanciamento automatico del bianco

In modalità Memory A, il valore di bilanciamento del bianco da salvare viene regolato automaticamente.

Premere il pulsante [White Balance] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [White Balance] diventa arancione.

Viene visualizzato il pannello di regolazione White Balance.

1

Premere il pulsante [White Mode] e selezionare [Memory A (T/T)] o [Memory A (R/B)] nell’elenco.

[Memory A (T/T)]

[Memory A (R/B)]

2

Collocare un foglio o un altro oggetto bianco in una posizione con la stessa sorgente di luce e le stesse condizioni di
illuminazione del soggetto, quindi zoomare sul foglio fino a riempire lo schermo di bianco.

3

Regolare la luminosità.

Regolare il diaframma con la procedura descritta in “Regolazione manuale del diaframma”.

4

Premere il pulsante [WB SET] nella sezione di regolazione del bilanciamento del bianco.

[Memory A (T/T)]

[Memory A (R/B)]

5
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Nota
Se la regolazione non può essere eseguita correttamente, viene visualizzato un messaggio di errore sullo schermo per circa tre secondi. Se il
messaggio di errore persiste anche dopo ripetuti tentativi di impostazione del bilanciamento del bianco, rivolgersi al servizio di assistenza tecnica
Sony.

Suggerimento
Può essere eseguito in modalità ATW. Questa modalità è utile per regolare rapidamente il bilanciamento del bianco mentre è attiva la modalità
ATW. Dopo la regolazione, viene ripristinato il normale funzionamento in modalità ATW.

Argomento correlato
Regolazione manuale del diaframma
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Se il bilanciamento automatico del bianco viene eseguito in modalità di memoria, il risultato della regolazione automatica viene
salvato nella memoria A.
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Schermata di configurazione dell’audio

È possibile configurare il livello dell’audio da registrare nella schermata delle operazioni live dell’app Web. Configurare i selettori del
pannello connettori dell’unità e configurare l’audio utilizzando il menu della telecamera o il menu Web.

5-041-957-34(1) Copyright 2022 Sony Corporation

Pannello di controllo della telecamera – Scheda  (Audio)1.
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Selezione del dispositivo di ingresso audio

Impostare i selettori indicati di seguito in base al dispositivo connesso al connettore AUDIO IN.

Nota
L’audio non viene registrato nelle modalità Interval Rec e Slow & Quick Motion.
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Quando è connesso un microfono, impostare il selettore SETUP 2 sul pannello connettori sul retro dell’unità.

CH-1 e CH-2 hanno impostazioni comuni.

1

Impostazione Descrizione

OFF
(predefinito)

Selezionare quando si utilizza un microfono dinamico o un microfono alimentato a batteria. Questo disattiva
l’alimentazione phantom a +48 V e imposta gli ingressi LINE o MIC come sorgente audio CH-1 e CH-2.

ON
Selezionare quando si utilizza un microfono che richiede alimentazione phantom a +48 V. Questo attiva
l’alimentazione phantom a +48V e imposta il microfono con alimentazione phantom come sorgente audio
CH-1 e CH-2.

Impostare il tipo di dispositivo connesso utilizzando [Audio] > [Audio Input] > [AUDIO IN Select] nel menu della
telecamera.

2

Selezionare l’ingresso audio utilizzando [Audio] > [Audio Input] > da [CH1 Input Select] a [CH4 Input Select] nel menu
Web o nel menu della telecamera.

3
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Regolazione automatica del livello di registrazione audio

Impostare il canale per il quale regolare automaticamente il livello di registrazione audio su [Auto] nella pagina [Audio] del menu Web,
oppure utilizzando [Audio] > [Audio Input] > da [CH1 Level Control] a [CH4 Level Control] nel menu della telecamera.
I canali specificati per la regolazione automatica sono indicati dall’icona  (auto) visualizzata accanto al canale corrispondente nella
scheda  (Audio) della schermata delle operazioni live.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Regolazione manuale del livello di registrazione audio

Il livello di registrazione audio può essere regolato manualmente.
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Impostare il canale per il quale regolare manualmente il livello di registrazione audio su [Manual] nella pagina [Audio]
del menu Web, oppure utilizzando [Audio] > [Audio Input] > da [CH1 Level Control] a [CH4 Level Control] nel menu della
telecamera.

1

Premere la scheda  (Audio) nel pannello di controllo della telecamera.2

Nella schermata [Audio] del pannello di controllo della telecamera, impostare il livello di registrazione audio utilizzando
il cursore o i pulsanti di regolazione corrispondenti al canale di cui regolare tale livello manualmente.

Nota
I canali per i quali è visualizzata l’icona  (auto) vengono regolati automaticamente. Le modifiche ai valori apportate utilizzando il cursore
o i pulsanti non sono applicate all’audio registrato.

Suggerimento

Le impostazioni del cursore e dei pulsanti di regolazione di ciascuna riga sono collegati fra loro.

È possibile controllare il livello di ingresso audio in tempo reale utilizzando l’indicatore di livello audio sullo schermo di ripresa.

3
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Utilizzo del Direct Menu

È possibile sia controllare lo stato e le impostazioni dell’unità visualizzandole in sovraimpressione sull’immagine proveniente dalla
telecamera, sia selezionare e modificare le impostazioni utilizzando i pulsanti di comando GUI del telecomando a infrarossi.
Possono essere configurate le impostazioni elencate di seguito.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
Valore [ND Filter]
[Auto Iris]
Valore [Iris]
[AGC]
Valore [Gain]
Valore [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
Valore [Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] e [Frame Rate]

Suggerimento

È possibile eseguire la stessa funzione utilizzando un pulsante programmabile e il pannello dei comandi GUI dell’app Web.
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Premere il pulsante programmabile del telecomando a infrarossi a cui è assegnato [Direct Menu].

Per impostazione predefinita [Direct Menu] è assegnato al pulsante programmabile 1.
Le voci sullo schermo che possono essere configurate tramite Direct Menu sono selezionabili mediante un cursore di colore
arancione.

1

Utilizzando i pulsanti freccia del pannello dei comandi GUI, spostare il cursore sulla voce da impostare, quindi premere
il pulsante [Set].

Appare un menu, oppure la voce viene visualizzata su uno sfondo bianco.

2

Selezionare un’impostazione utilizzando i pulsanti freccia e quindi premere il pulsante [Set].

Il menu o lo sfondo bianco scompaiono e il nuovo valore appare visualizzato con un cursore arancione.
Per uscire dal menu diretto, premere nuovamente il pulsante programmabile a cui è assegnata tale funzione oppure attendere 3
secondi senza eseguire nessuna operazione.

3
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Pulsanti programmabili

Nell’app Web dell’unità sono disponibili dieci pulsanti programmabili a cui possono essere assegnate varie funzioni.
I pulsanti programmabili sono visualizzati nella schermata delle operazioni live e nella schermata delle operazioni di riproduzione.

Nota

L’elenco dei pulsanti programmabili non è visualizzato durante la configurazione delle impostazioni nel pannello delle operazioni di base nella
schermata delle operazioni live. Per concludere l’operazione, premere il pulsante [X] nell’angolo in alto a destra del pannello di regolazione.

Al momento dell’acquisto sono assegnate ai vari pulsanti le seguenti funzioni.
Pulsante 1: [Direct Menu]
Pulsante 2: [Focus Setting]
Pulsante 3: [Rec Review]

I pulsanti da 1 a 3 sono equivalenti ai pulsanti con lo stesso numero presenti sul telecomando a infrarossi fornito in dotazione.

Pulsante 4: [Push Auto ND]
Pulsante 5: [Crop Select]
Pulsante 6: [Marker]
Pulsante 7: [Video Signal Monitor]
Pulsante 8: [Clip Flag OK]
Pulsante 9: [Color Bars]
Pulsante Focus Hold: [Focus Hold]

Il pulsante Focus Hold è equivalente al pulsante Focus Hold su un obiettivo con innesto E-mount.

Modifica della funzione assegnata ai pulsanti
Utilizzare [Project] > [Assignable Button] nel menu della telecamera.
Quando si modifica un’assegnazione, anche l’elenco dei pulsanti programmabili visualizzato cambia.
Per informazioni dettagliate sulle funzioni assegnabili, vedere “Assignable Button” in “Menu della telecamera e impostazioni
dettagliate”.

Argomento correlato
Assignable Button

5-041-957-34(1) Copyright 2022 Sony Corporation

236



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Slow & Quick Motion

Quando il formato di registrazione è impostato su uno dei valori elencati di seguito, è possibile specificare valori diversi per le
frequenze fotogrammi di ripresa e di riproduzione.
La seguente tabella mostra i valori di frequenza fotogrammi configurabili.

Frequenza di sistema: 59.94/50/29.97/25/23.98, Modalità di scansione imager: FF

Frequenza di sistema: 59.94/50/29.97/25/23.98, Modalità di scansione imager: S35

Frequenza di sistema: 24, Modalità di scansione imager: FF

Nota
La funzione Slow & Quick Motion non può essere impostata durante la registrazione, la riproduzione o mentre è visualizzata la schermata delle
miniature.

La modalità Slow & Quick Motion non consente la registrazione di audio.

Nella modalità Slow & Quick Motion, le funzioni di diaframma automatico e otturatore automatico sono disabilitate.

Nella modalità Slow & Quick Motion, la funzione di messa a fuoco automatica presenta le seguenti limitazioni:
Limitazioni dovute a modello di obiettivo, frequenza di sistema e frequenza fotogrammi di ripresa

Codec Formato video Frequenze fotogrammi configurabili

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Codec Formato video Frequenze fotogrammi configurabili

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Codec Formato video Frequenze fotogrammi configurabili

XAVC-I 4096×2160P 1–60

Obiettivo Sony Frequenza di sistema Disponibilità AF

Diverso da SEL16F28 – 7 fps o superiori supportati

SEL16F28

59.94/29.97/23.98 Supportati 30, 60, 120, 240 fps

50.00/25.00 Supportati 25, 50, 100, 200 fps

24.00 Non supportato
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La funzione di messa a fuoco automatica è temporaneamente disattivata se il diaframma è impostato su un valore di F18 o superiore.

Per informazioni dettagliate sull’uso dell’uscita RAW, vedere “Registrazione di video RAW”.

Argomento correlato
Registrazione di video RAW

5-041-957-34(1) Copyright 2022 Sony Corporation
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Registrazione di video a intervalli (Interval Rec)

La funzione Interval Rec consente di registrare video a intervalli determinati nella memoria interna dell’unità. Questa funzione è
efficace per riprendere soggetti che cambiano molto lentamente.
Quando si avvia la registrazione in questa modalità, l’unità registra automaticamente un numero specificato di fotogrammi (Number of
Frames) a intervalli specificati (Interval Time).

A: Intervallo fra le riprese (Interval Time)
B: Numero di fotogrammi in ciascuna ripresa (Number of Frames)

Nota
È possibile utilizzare una sola funzione di registrazione speciale (ad esempio Interval Rec) alla volta.

Se durante l’utilizzo di Interval Rec viene attivata un’altra modalità di registrazione speciale, il camcorder esce dalla modalità Interval Rec.

Il camcorder esce automaticamente dalla modalità Interval Rec se vengono modificate le impostazioni di sistema, ad esempio il formato video.

Le impostazioni della modalità Interval Rec non possono essere modificate durante la registrazione, la riproduzione o mentre è visualizzata la
schermata delle miniature.

Limitazioni durante la registrazione
Non viene registrato audio.
Non è possibile rivedere la registrazione (Rec Review).

Se l’unità viene spenta durante la registrazione
Se l’alimentazione dell’unità entra in modalità standby, l’unità accede per alcuni secondi ai supporti di registrazione per salvare le
immagini contenute in memoria fino al quel momento prima di entrare automaticamente in modalità standby.
In caso di disconnessione del cavo di alimentazione c.c., spegnimento dell’adattatore CA oppure interruzione dell’alimentazione
PoE++, tutte le riprese acquisite fino a quel momento potrebbero andare perdute (per un massimo di 10 secondi). Prestare sempre
la dovuta attenzione.

Impostazione del numero di fotogrammi e dell’intervallo tra le riprese

Impostare [Project] > [Interval Rec] > [Setting] su [On] nel menu Web e impostare [Number of Frames] e [Interval Time].
Allo spegnimento, l’unità esce dalla modalità Interval Rec, ma i valori impostati in [Number of Frames] e [Interval Time] sono
mantenuti. Non è necessario impostarli nuovamente la volta successiva che si utilizza la funzione Interval Rec.

Suggerimento

Questa impostazione può essere effettuata anche utilizzando [Project] > [Interval Rec] nel menu della telecamera.
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Avvio della ripresa

Premere il pulsante START/STOP registrazione per avviare la registrazione. Le indicazioni “Int●Rec” e “Int●Stby” vengono visualizzate
in alternanza.

Arresto della ripresa

Arrestare la registrazione.
Al termine della ripresa, i dati video memorizzati fino a quel momento nella memoria vengono salvati sul supporto di registrazione.
Per uscire dalla modalità Interval Rec, eseguire una delle operazioni seguenti.

Commutare l’alimentazione dell’unità alla modalità standby.
In modalità standby di registrazione, impostare [Project] > [Interval Rec] > [Setting] su [Off].

L’unità esce automaticamente dalla modalità Interval Rec anche quando viene riavviata.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Registrazione di immagini preregistrate nella cache (Picture Cache Rec)

Mantenendo una memoria cache interna di una durata specificata durante le riprese, la funzione Picture Cache Rec consente di
catturare video “retroattivamente” all’avvio della registrazione.

Impostazione delle dimensioni della cache

Impostare [Project] > [Picture Cache Rec] > [Setting] su [On] nel menu Web e quindi impostare le dimensioni della cache in [Cache
Size].

Nota
Picture Cache Rec non può essere utilizzata contemporaneamente a Interval Rec, registrazione simultanea su 2 slot o registrazione proxy.
Quando la funzione Picture Cache Rec viene impostata su On, queste altre modalità di registrazione speciale vengono automaticamente
impostate su Off.

Non è possibile selezionare la modalità Picture Cache Rec durante la registrazione o Rec Review.

Mentre Picture Cache Rec è impostata su On, il codice temporale viene sempre registrato in modalità [Free Run] anche se impostato su [Regen]
o [Rec Run].

L’impostazione [Output Format] potrebbe non essere configurabile nella modalità Picture Cache Rec. In tal caso, impostare provvisoriamente
Picture Cache Rec su Off e modificare le impostazioni desiderate.

Suggerimento

A seconda del formato di registrazione, il tempo di cache potrebbe essere più breve. Controllare il tempo visualizzato in [Project] > [Picture Cache
Rec] > [Cache Rec Time] nel menu Web.

Questa impostazione può essere effettuata anche utilizzando [Project] > [Picture Cache Rec] nel menu della telecamera.

La funzione [Picture Cache Rec] può essere attivata (On) e disattivata (Off) anche usando un pulsante programmabile.

Avvio di Picture Cache Rec

Quando [Picture Cache Rec] è impostata su On, viene visualizzata l’indicazione “●Cache” (in cui ● è verde).
Quando viene premuto il pulsante START/STOP registrazione, la registrazione si avvia e il video viene registrato sulle schede di
memoria a partire dal video contenuto nella memoria cache.

Nota
Se si cambia il formato di registrazione o il Look di base, il video già esistente nella memoria cache viene eliminato e la memoria cache inizia a
registrare nuovo video. Di conseguenza, non è possibile registrare le immagini presenti nella cache prima del cambiamento del formato anche se
la registrazione viene avviata immediatamente dopo il cambiamento del formato.

Se Picture Cache Rec viene impostata su On o Off immediatamente dopo l’inserimento di una scheda di memoria, è possibile che i dati della
cache non vengano registrati sulla scheda.

Il video viene memorizzato nella memoria cache a partire dal momento in cui la funzione di Picture Cache Rec viene impostata su On. La cache
non memorizza video prima dell’impostazione su On della funzione.

Impostazione di [Cache Size] Tempo cache (approssimativo)

[Short] 5 secondi

[Medium] 10 secondi

[Long] 20 secondi

[Max] Valore massimo per ciascun formato di registrazione
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La cache non memorizza video durante l’accesso a una scheda di memoria, ad esempio durante riproduzione, Rec Review o visualizzazione
delle miniature. Durante tale periodo non è possibile registrare immagini nella cache.

Annullamento della modalità Picture Cache Rec

Impostare [Project] > [Picture Cache Rec] > [Setting] su [Off] nel menu Web oppure premere il pulsante programmabile a cui è
assegnata la funzione [Picture Cache Rec].

5-041-957-34(1) Copyright 2022 Sony Corporation
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Registrazione simultanea sulle schede di memoria A e B (Simul Rec su 2 slot)

È possibile registrare contemporaneamente sulle due schede di memoria A e B impostando [Project] > [Simul Rec] > [Setting] su [On]
nel menu Web o nel menu della telecamera.

Registrazione separata sulle schede di memoria A e B

È possibile avviare ed arrestare la registrazione su ciascuna scheda di memoria indipendentemente l’una dall’altra utilizzando il
pulsante START/STOP registrazione oppure il pulsante [2nd Rec START/STOP] nella scheda  (Others).
Per impostazione predefinita, entrambi i pulsanti sono impostati per avviare e arrestare la registrazione simultaneamente su entrambe
le schede memoria A e B.
Quando i pulsanti sono configurati per comandare la registrazione su schede di memoria diverse, la funzione di controllo dell’avvio e
arresto della registrazione [SDI/HDMI Rec Control] segue lo stato di registrazione dello slot A.

Modifica dell’impostazione

Impostare le seguenti opzioni utilizzando [Project] > [Simul Rec] > [Rec Button Set] nel menu della telecamera.

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostazione di [Rec
Button Set] Pulsanti e schede di memoria

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:<Slot
A> <Slot B>

Avvia/arresta la registrazione simultanea su entrambe le schede di memoria A e B premendo uno
qualsiasi dei pulsanti.

Rec Button:<Slot A>
2nd Rec Button:<Slot
B>

Il pulsante START/STOP avvia e arresta la registrazione sulla scheda di memoria A mentre il pulsante
[2nd Rec START/STOP] nella scheda  (Others) avvia e arresta la registrazione sulla scheda di
memoria B.

Rec Button:<Slot B>
2nd Rec Button:<Slot
A>

Il pulsante START/STOP avvia e arresta la registrazione sulla scheda di memoria B mentre il pulsante
[2nd Rec START/STOP] nella scheda  (Others) avvia e arresta la registrazione sulla scheda di
memoria A.

243



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Monitor segnale video

Impostando opportunamente [Monitoring] > [Video Signal Monitor] > [Setting] nel menu della telecamera è possibile scegliere se
visualizzare il segnale video nel pannello dell’immagine della telecamera come forma d’onda, vettorscopio o istogramma.
La linea arancione indica i valori impostati di [Level Marker 1] e [Level Marker 2].
La funzione [Video Signal Monitor] può essere assegnata anche a un pulsante programmabile.

Indicazione dell’oggetto del monitoraggio
Nelle modalità di ripresa Log, l’angolo superiore destro del monitor del segnale video visualizza informazioni relative alle impostazioni
del gamut di colori o della LUT monitor per indicare l’oggetto del monitoraggio.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Flag dei clip

Per aggiungere al clip un flag [OK], premere il pulsante programmabile a cui è assegnata la funzione [Clip Flag OK], quindi selezionare
[Add OK].
Per eliminare un flag [OK] dal clip, premere il pulsante due volte e selezionare [Delete Clip Flag].

Suggerimento
È possibile aggiungere flag ai clip anche utilizzando [Thumbnail] > [Set Clip Flag] nel menu della telecamera.

La schermata delle miniature può essere visualizzata ordinando le miniature in base al tipo di flag dei clip (schermata delle miniature di clip
filtrata). Per informazioni dettagliate, vedere “Operazioni sui clip registrati” in “Schermata delle miniature”.

Argomento correlato
Operazioni sui clip registrati

5-041-957-34(1) Copyright 2022 Sony Corporation
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Compensazione dell’effetto breathing

È possibile specificare se realizzare o meno la compensazione dell’effetto breathing dell’obiettivo utilizzando [Technical] > [Lens] >
[Breathing Compensation] nel menu della telecamera.
Questa funzione corregge il fenomeno per il quale si verificano cambiamenti nell’angolo di visuale al cambiamento della posizione di
messa a fuoco.
Quando la compensazione dell’effetto breathing è attiva, una porzione dell’immagine viene ritagliata elettronicamente per mantenere
un angolo di visuale costante e compensare così questo fenomeno.

Nota
Quando la compensazione dell’effetto breathing è attiva potrebbero aver luogo piccoli cambiamenti nell’angolo di visuale e nella qualità
dell’immagine.

In base all’obiettivo, la funzione di compensazione dell’effetto breathing potrebbe non essere in grado di correggere i cambiamenti all’angolo di
visuale.

La compensazione dell’effetto breathing non è possibile se l’obiettivo montato non supporta tale funzionalità.

Questa funzione è fissata su Off nei casi indicati di seguito.

Quando [Technical] > [Lens] > [Distortion Comp.] è impostato su [Off] nel menu della telecamera
Quando [Shooting] > [S&Q Motion] > [Setting] è impostato su [On] nel menu Web o nel menu della telecamera.
Quando [Project] > [Rec Format] > [Codec] è impostato su [RAW] o [RAW & XAVC-I] nel menu Web o nel menu della telecamera.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Descrizione generale della registrazione proxy

Questa funzione consente di registrare contemporaneamente dati proxy a bassa risoluzione insieme ai dati video originali ad alta
risoluzione.

Per informazioni dettagliate sulle schede di memoria supportate, sulla formattazione delle schede di memoria e sul controllo della
capacità rimanente, vedere “Schede di memoria supportate” in “Preparazione delle schede di memoria”.

Informazioni sul file registrato
L’estensione del nome del file è “.mp4”.
Anche il codice temporale viene registrato simultaneamente.

Destinazione di salvataggio del file registrato
Il file registrato viene salvato nella directory indicata di seguito.

Informazioni sul nome del file
Il nome del file consiste del nome del clip registrato sulla scheda di memoria seguito dal suffisso “S03”.
Per il nome del clip, vedere [TC/Media] > [Clip Name Format] nel menu della telecamera.

Argomento correlato
Schede di memoria supportate

5-041-957-34(1) Copyright 2022 Sony Corporation

Supporto di registrazione Percorso cartella

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Registrazione di proxy

È possibile avviare la registrazione quando la registrazione proxy è abilitata.

Arresto della ripresa
Arrestare la registrazione.

Impostazione del canale audio per la registrazione proxy
Impostare il canale audio per la registrazione dei dati proxy utilizzando [Project] > [Proxy Rec] > [Audio Channel] nel menu della
telecamera.

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare [Project] > [Proxy Rec] > [Setting] su [On] nel menu Web o nel menu della telecamera.1

Inserire una scheda di memoria nello slot per schede CFexpress Type A o SD.

Inserire le schede CFexpress con l’etichetta rivolta verso l’alto.
Inserire le schede SD con l’etichetta rivolta verso il basso.

Nota
La modalità Proxy Rec non può essere impostata su On contemporaneamente a S&Q Motion o Interval Rec. Quando Proxy Rec è
impostata su On, queste altre modalità di registrazione vengono automaticamente impostate su Off.

2

Premere il pulsante START/STOP registrazione.

La registrazione proxy si avvia.

Nota
Se l’unità viene spenta o la scheda viene rimossa durante l’accesso alla scheda, non è possibile garantire l’integrità dei dati contenuti sulla
scheda.
Tutti i dati registrati sulla scheda di memoria potrebbero essere eliminati. Assicurarsi sempre che l’indicatore di accesso alla scheda di
memoria sia spento prima di spegnere l’unità o rimuovere la scheda di memoria stessa.

Assicurarsi che la scheda di memoria non salti fuori dallo slot al momento dell’inserimento o dell’estrazione.

3
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Descrizione generale dei look

Impostando l’unità nella modalità Custom, è possibile regolare i valori di nero, matrice ed altri parametri per creare “look” personalizzati
basati sul look di base.

Salvando diverse combinazioni di impostazioni in file di scena diventa quindi possibile selezionare rapidamente look diversi secondo le
proprie esigenze.
L’unità dispone di sette look preconfigurati.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Selezione di un look

Questo argomento descrive come selezionare un look.

Controllare che [Project] > [Base Setting] > [Shooting Mode] sia impostato su [Custom] nel menu Web o nel menu della
telecamera.

Suggerimento
Nella modalità [Custom], i pulsanti [ISO/Gain] e [Scene File] sono visualizzati nel pannello di configurazione di base della telecamera.

1

Premere il pulsante [Scene File] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [Scene File] diventa arancione.

Viene visualizzato il pannello di regolazione Scene File.

2

Premere il pulsante [Scene File] nel pannello di regolazione e selezionare nell’elenco il file di scena con il look
desiderato.

Nelle impostazioni predefinite sono preconfigurati i seguenti preset:

Suggerimento
È possibile selezionare un look anche usando [Paint/Look] > [Scene File] > [Recall] nel menu della telecamera. È possibile inoltre
richiamare un look preconfigurato usando [Scene File] > [Preset Recall].

Nota

A partire dalla versione software 2.0, il file di scena 5 è preconfigurato su [709tone]. Con l’aggiornamento da una versione software
precedente alla versione 2.0, è visualizzato quando viene eseguito [Maintenance] > [Reset] > [Factory Default] nel menu Web.

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

File di scena 1 [S-Cinetone] [HLG Live]

File di scena 2 [Standard] [HLG Natural]

File di scena 3 [Still] (Non registrato)

File di scena 4 [ITU709] (Non registrato)

File di scena 5 [709tone] (Non registrato)

File di scena da 6 a 16 (Non registrato) (Non registrato)
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Importazione del look di base desiderato

È possibile importare come look di base un file 3D LUT creato con un computer o un altro dispositivo. Possono essere importati fino a
16 file.
Formato di file: File CUBE (*.cube) per una 3D LUT a 17 o 33 punti creata con Catalyst Browse, RAW Viewer o DaVinci Resolve* (di
Blackmagic Design Pty. Ltd.).

Gamut colore di ingresso/Gamma: [S-Gamut3.Cine/S-Log3] o [S-Gamut3/S-Log3]

Gestione della sottoesposizione
Qualora si rilevi una tendenza alla sottoesposizione quando è selezionata l’esposizione automatica durante l’uso di un look di base
importato, correggerlo secondo le esigenze utilizzando [Paint/Look] > [Base Look] > [AE Level Offset] nel menu Web.

Nota

Verificato con Resolve V9.0, V10.0 e V11.0.*

Salvare il file 3D LUT sul dispositivo che esegue l’app Web.1

Aprire [Paint/Look] > [Base Look] nel menu Web.

Viene visualizzato un elenco dei look di base registrati.

2

Premere il pulsante [Import] nella riga di cui si desidera importare il file.

Viene visualizzato il dialogo di selezione dei file.

3

Selezionare il file 3D LUT preparato.

Il file 3D LUT importato diventa il look di base dell’unità.

4

Selezionare il file 3D LUT importato utilizzando [Paint/Look] > [Base Look] > [Select] nel menu della telecamera.5

Configurare [Paint/Look] > [Base Look] > [Input] e [Output] nel menu della telecamera in modo che rifletta gli attributi del
file 3D LUT importato.

6
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La sola importazione di un file 3D LUT non ha alcun effetto sull’immagine. Caricare il file 3D LUT importato utilizzando [Paint/Look] > [Base Look]
> [Select] nel menu della telecamera.

Se [Input] non è impostato correttamente, non sarà possibile ottenere il look desiderato.

Le impostazioni delle voci [Input], [Output] e [AE Level Offset] sono applicate al menu di base selezionato con [Select]. Se è stato importato più di
un file 3D LUT, è necessario selezionarli uno alla volta utilizzando [Select] e configurarne le opzioni di [Input], [Output] e [AE Level Offset]
separatamente per ciascun file.

Le impostazioni configurate di I[Input], [Output] e [AE Level Offset] sono salvate individualmente per ciascuno dei file 3D LUT.

Le opzioni di selezione del look di base e della LUT per i file 3D LUT importati sono comuni alle modalità di ripresa [SDR(BT.709)], [HDR(HLG)] e
Log, ma la conversione di gamma e gamut di colore non viene eseguita in base a tali modalità.

I file 3D LUT non vengono eliminati dall’esecuzione di [Maintenance] > [Reset] > [All Reset (except for Network Settings)] nel menu Web.

L’icona  (errore associazione file 3D LUT) visualizzata davanti all’indicazione di [Base Look Name] indica che non è possibile unire file 3D LUT
ai clip registrati nelle modalità ripresa Log. Importare nuovamente il file 3D LUT.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Personalizzazione di un look

È possibile personalizzare un look basato sul look di base servendosi dei cursori [Master Black], [R Black] e [B Black] nel pannello di
regolazione Scene File del pannello di configurazione di base della telecamera e di [Paint/Look] > [Matrix] ed altre opzioni nel menu
della telecamera.
Collegare l’unità a un televisore o a un monitor e regolare la qualità dell’immagine osservandola sullo schermo.

1: Cursore e pulsanti di regolazione [R Black]
2: Cursore e pulsanti di regolazione [B Black]
3: Cursore e pulsanti di regolazione [Master Black]

Nota
Quando si importa e si applica all’immagine un file 3D LUT, non sarà possibile ottenere il look desiderato e definito in tale file se sono state
modificate le impostazioni di [Paint/Look] > [Matrix] e altre impostazioni diverse dalle impostazioni del look di base nel menu della telecamera.

È possibile resettare tutte le impostazioni personalizzate utilizzando [Paint/Look] > [Reset Paint Settings] > [Reset without Base Look] nel menu
della telecamera.
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Salvataggio di un look

Il look corrente può essere salvato come file di scena nella memoria interna utilizzando [Paint/Look] > [Scene File] > [Store] nel menu
della telecamera.
È possibile richiamare rapidamente il look corrente utilizzando il pannello di regolazione Scene File o servendosi delle funzioni di
Direct Menu.

Nota
Se viene selezionato un altro look senza aver prima salvato il look corrente, il look corrente andrà perso.

Suggerimento
I file di scena preconfigurati possono essere sovrascritti. Per ripristinare un file di scena preconfigurato, caricare il look da ripristinare utilizzando
[Paint/Look] > [Scene File] > [Preset Recall] nel menu della telecamera e quindi salvare il file di scena utilizzando [Scene File] > [Store].

Eliminazione di un look salvato
Il file di scena salvato nella memoria interna può essere eliminato utilizzando [Paint/Look] > [Scene File] > [Delete] nel menu della
telecamera.

Suggerimento
I file di scena eliminati non sono più visualizzati nel pannello di regolazione Scene File o in Direct Menu.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Eliminazione di un look di base

I file 3D LUT importati possono essere eliminati individualmente utilizzando [Paint/Look] > [Base Look] > [Delete] nel menu della
telecamera.
Per eliminare tutti i file 3D LUT importati, utilizzare [Paint/Look] > [Base Look] > [Delete All] nel menu della telecamera.

Nota
Prima dell’eliminazione, controllare che il look di base non sia utilizzato in nessun file di scena. Se viene eliminato un look di base utilizzato in file
di scena, il look dei file di scena che lo utilizzano non sarà corretto.

I file 3D LUT importati non vengono eliminati quando si esegue [Maintenance] > [Reset] > [All Reset (except for Network Settings)] dal menu
Web.

I look di base eliminati non possono essere utilizzati come LUT nelle modalità di ripresa Log.

5-041-957-34(1) Copyright 2022 Sony Corporation

256



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ripresa con regolazione del look in post-produzione

Utilizzando l’unità nelle modalità di ripresa Log*1 e registrando con una gradazione uniforme dell’intero campo dalle ombre alle alte
luci, sarà possibile effettuare regolazioni fini in sede di post produzione, ad esempio, ripristinando la gradazione delle alte luci e delle
ombre solo localmente.
In questo caso, tuttavia, se visualizzate su un monitor convenzionale, le immagini registrate avranno un contrasto generale piuttosto
basso, rendendo più difficoltoso il controllo della messa a fuoco e dell’esposizione.
È possibile applicare una LUT al monitor utilizzato con l’unità per facilitare varie regolazioni durante le riprese. Durante la riproduzione,
è inoltre possibile applicare automaticamente la LUT utilizzata durante la ripresa per controllare rapidamente il risultato finale.
Le LUT sono applicate dai sistemi indicati di seguito. Potrà essere applicata una sola LUT alla volta.

Uscita SDI
Uscita HDMI e streaming
Clip proxy registrato su supporti di registrazione
Clip ad alta risoluzione (principale) registrato su supporti di registrazione
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Termine generico per le modalità Flexible ISO, Cine EI e Cine EI Quick.*1
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Applicazione di una LUT a uscita HDMI e streaming

È possibile applicare una LUT a uscita HDMI e streaming.

Nota

L’immagine inviata in streaming include anche l’immagine del pannello dell’immagine della telecamera dell’app Web.

Suggerimento

Questa impostazione può essere effettuata anche utilizzando [Shooting] > [LUT On/Off] > [HDMI/Stream] nel menu della telecamera.

L’uscita SDI può essere impostata allo stesso modo.

Per video su supporti di registrazione, è possibile effettuare l’impostazione utilizzando [Shooting] > [LUT On/Off] > [Internal Rec] e [Proxy] nel
menu della telecamera.

L’icona  (errore associazione file 3D LUT) visualizzata davanti all’indicazione di [Base Look/LUT] indica che non è possibile unire file 3D LUT ai
clip registrati nelle modalità ripresa Log. Importare nuovamente il file 3D LUT.
Questa icona è visualizzata anche quando l’associazione non riesce a causa di un momentaneo sovraccarico delle capacità di elaborazione.
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Controllare che [Project] > [Base Setting] > [Shooting Mode] sia impostato su [Flexible ISO], [Cine EI] o [Cine EI Quick]
nel menu Web o nel menu della telecamera.

Suggerimento
Nelle modalità di ripresa Log, i pulsanti [Base ISO/Exposure Index] e [Base Look/LUT] sono visualizzati nel pannello di configurazione di
base della telecamera.

1

Premere il pulsante [Base Look/LUT] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [Base Look/LUT] diventa arancione.

Viene visualizzato il pannello di regolazione Base Look/LUT.

2

Selezionare [HDMI/Stream] > [MLUT].3
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Modifica di una LUT

È possibile modificare la LUT da applicare.

Suggerimento

Sull’unità sono disponibili le LUT preconfigurate [s709], [709(800%)] e [S-Log3].

È possibile anche importare e applicare un file 3D LUT. Per informazioni dettagliate, vedere “Importazione del look di base desiderato” e
“Eliminazione di un look di base”.

Questa impostazione può essere effettuata anche utilizzando [Paint/Look] > [Base Look] > [Select] nel menu della telecamera.

Argomento correlato
Importazione del look di base desiderato

Eliminazione di un look di base
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Premere il pulsante [Base Look/LUT] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [Base Look/LUT] diventa arancione.

Viene visualizzato il pannello di regolazione Base Look/LUT.

1

Premere il pulsante [Base Look/LUT] e selezionare il look di base da applicare.2

259



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Modifica della distribuzione delle ombre e delle alte luci nell’immagine registrata

Nelle modalità di ripresa Cine EI e Cine EI Quick, la distribuzione delle ombre e delle alte luci può essere modificata secondo le
proprie esigenze, ad esempio se si desidera dare una priorità alle tonalità delle ombre rispetto alle alte luci. Per farlo, impostare
Exposure Index su un valore diverso dalla sensibilità di base.

Premere il pulsante [Base Look/LUT] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [Base Look/LUT] diventa arancione.

Viene visualizzato il pannello di regolazione Base Look/LUT.

1

Selezionare [HDMI/Stream] > [MLUT].

Una LUT viene applicata a uscita HDMI e streaming.

2

Premere il pulsante [Base ISO/Exposure Index] nel pannello di configurazione di base della telecamera.

La cornice del pulsante [Base ISO/Exposure Index] diventa arancione.

Viene visualizzato il pannello di regolazione Base ISO/Exposure Index.

3

Regolare l’indice di esposizione in base alla distribuzione desiderata di ombre e alte luci utilizzando il cursore [Exposure
Index] o i pulsanti di regolazione [Exposure Index].

Per [Cine EI]

Per [Cine EI Quick]
La sensibilità di base è impostata automaticamente in base al valore di Exposure Index specificato.

4
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Suggerimento

Questa impostazione può essere effettuata anche utilizzando [Shooting] > [ISO/Gain/EI] > [Exposure Index] nel menu della telecamera.

L’uscita SDI può essere utilizzata in maniera analoga.

Il secondo valore numerico dell’impostazione indica quanti passi di informazioni di luminosità sono assegnati alle alte luci (aree con luminosità
superiore al 18% di grigio). Le aree con luminosità superiore sono sovraesposte.
Esempio: In “400EI/5.0E” sono assegnati alla luminosità 5,0 passi.

Questo può essere utilizzato come guida per controllare il tono delle ombre e delle alte luci durante la ripresa. Ricordarsi di ripristinare sempre il
valore di EI originale dopo il controllo dell’esposizione. Inoltre, in modalità Cine EI Quick, fare attenzione a non causare effetti negativi sulla
sensibilità di base.

5-041-957-34(1) Copyright 2022 Sony Corporation

Regolare l’illuminazione e/o il filtro ND in modo che l’immagine della telecamera in uscita su [HDMI/Stream] abbia
l’esposizione appropriata.

5
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Registrazione di video RAW

Il segnale video RAW in uscita sul connettore SDI OUT dell’unità può essere registrato su un registratore esterno supportato.
I formati di uscita RAW supportati sono indicati di seguito.

Frequenza di sistema [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Collegare un registratore RAW esterno al connettore SDI OUT dell’unità.1

Impostare [Project] > [Base Setting] > [Shooting Mode] su [Cine EI], [Cine EI Quick] o [Flexible ISO] nel menu Web o nel
menu della telecamera.

2

Impostare l’angolo di visuale (solamente FF) utilizzando [Project] > [Rec Format] > [Imager Scan Mode] nel menu Web o
nel menu della telecamera.

3

Impostare [Project] > [Rec Format] > [Codec] su [RAW] nel menu Web o nel menu della telecamera.

Selezionando [RAW & XAVC-I] è possibile registrare contemporaneamente video sia su un registratore RAW esterno che sulle
schede di memoria dell’unità.

4

Impostare la risoluzione utilizzando [Project] > [Rec Format] > [RAW Output Format] nel menu Web o nel menu della
telecamera.

5

Controllare che il registratore esterno sia acceso, quindi premere il pulsante START/STOP registrazione nella schermata
delle operazioni live.

Lo stato della registrazione di video RAW è segnalato mediante un’icona nel pannello dell’immagine della telecamera.

Nota
Il segnale di controllo della registrazione viene emesso sul connettore SDI OUT dell’unità. Non è però possibile ottenere lo stato del
registratore esterno. Per questo motivo è possibile che l’unità indichi che la registrazione video RAW sia in corso anche se il registratore

6
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Nota
Se la registrazione viene avviata sul registratore esterno ma non viene premuto il pulsante START/STOP registrazione nella schermata delle
operazioni live, i clip potrebbero non essere registrati correttamente.
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esterno non sta effettivamente registrando. Controllare l’effettivo stato operativo servendosi sempre dell’indicatore del registratore esterno.
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Registrazione di video RAW in modalità Slow & Quick Motion

È possibile registrare video RAW anche in modalità Slow & Quick Motion.

Per informazioni dettagliate sulle frequenze fotogrammi supportate per le riprese, vedere “Slow & Quick Motion”.

Argomento correlato
Slow & Quick Motion

5-041-957-34(1) Copyright 2022 Sony Corporation
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Attivazione e disattivazione della funzione di controllo del bokeh

È possibile regolare facilmente il livello di bokeh collegando al valore di diaframma il filtro ND e il guadagno.

Attivazione e disattivazione della funzione di controllo del bokeh

Questa funzione può essere abilitata solo se è attiva la regolazione manuale dell’esposizione. Impostare il filtro ND sulla modalità
variabile, quindi impostare diaframma, guadagno, otturatore e filtro ND sulla regolazione manuale.
È possibile attivare e disattivare la funzione di controllo del bokeh utilizzando [Shooting] > [Iris] > [Bokeh Control] nel menu della
telecamera.
Quando la funzione di controllo del bokeh è impostata su On, l’icona  (B) viene visualizzata sugli indicatori del filtro ND e del
guadagno.

Nota
Questa funzione è abilitata solo con obiettivi E-mount in grado di comunicare con l’unità.

L’effetto massimo di questa funzione può essere ottenuto utilizzando un obiettivo Sony E-mount.

La funzione di controllo del bokeh viene disattivata (impostata su Off) nei casi indicati di seguito.
Se l’unità viene spenta
Se viene impostato su Auto il diaframma, il guadagno, l’otturatore oppure il filtro ND
Quando viene selezionata una modalità di ripresa diversa.
Quando il filtro ND viene impostato su Clear o su una modalità Preset.
Quando viene rimosso l’obiettivo
Quando l’unità si riavvia, ad esempio, dopo aver cambiato la frequenza.

Suggerimento
Assegnando la funzione [Bokeh Control] a un pulsante programmabile è possibile attivarla (On) o disattivarla (Off) semplicemente premendo il
pulsante a cui è stata assegnata.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Regolazione del livello di bokeh

Regolare le impostazioni nei passi da 2 a 4 secondo le proprie esigenze.

Nota

L’aspetto potrà variare a seconda della velocità operativa, dell’obiettivo, delle impostazioni di ripresa e del soggetto. Potrà variare anche la
luminosità. Si consiglia vivamente di eseguire un test con il camcorder prima delle riprese effettive.

La luminosità potrà variare anche con il cambiamento della direzione del funzionamento del diaframma, ad esempio quando si apre il diaframma
dopo averlo chiuso o quando si chiude il diaframma dopo averlo aperto. In questo caso, è consigliabile effettuare una regolazione leggermente
superiore al necessario, tornare un po’ indietro, controllare la luminosità e quindi iniziare la ripresa. Ad esempio, se si desidera aprire il diaframma
all’apertura F8 e sfocare lo sfondo, chiudere prima l’apertura superando F8, tornare quindi a F8, controllare la luminosità e iniziare la ripresa.

Eseguire le operazioni di controllo del bokeh lentamente. Se è necessario eseguire un cambiamento rapido, cercare di eseguire la regolazione
gradualmente controllando sempre, allo stesso tempo, i cambiamenti apportati all’immagine.

Suggerimento
Quando la funzione di controllo del bokeh è impostata su On, il filtro ND e il guadagno operano insieme per compensare le variazioni di
esposizione dovute alla regolazione del diaframma, consentendo di modificare il livello di bokeh.

Il controllo del bokeh viene prima collegata al filtro ND in risposta al cambiamento del valore di diaframma. Quando non è più possibile agire sul
filtro ND, viene collegato il guadagno.

In modalità MF, si consiglia di aprire prima il diaframma e quindi regolare la messa a fuoco.

Se si utilizza il filtro ND automatico invece della funzione di controllo del bokeh, il filtro ND segue il cambiamento di luminosità del soggetto.

Visualizzazione durante il funzionamento in collegamento di guadagno
Quando la funzione di controllo del bokeh è impostata su On, il cambiamento del valore di diaframma potrebbe causare il
cambiamento del guadagno.
Quando è attivo il collegamento con il guadagno e il guadagno cambia, viene visualizzato un messaggio nella parte superiore dello
schermo e l’icona  (B) sull’indicatore di guadagno lampeggia.

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare la funzione di controllo del bokeh su On.1

Aprire completamente il diaframma.2

Impostare il filtro ND su 1/128.3

Impostare il guadagno su 0 dB e utilizzare l’illuminazione per ottenere l’esposizione corretta.4

Regolare la messa a fuoco.5

Regolare il diaframma.

Questo cambia il livello del bokeh.

6
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Salvataggio e caricamento dei dati di configurazione

Le impostazioni dell’unità possono essere salvate come dati di configurazione utilizzando l’app Web. Questo consente di richiamare
rapidamente un set di impostazioni precedentemente ottimizzato per la situazione attuale.
Questa unità consente di salvare in un file ALL (un file contenente tutte le impostazioni) praticamente tutte le impostazioni relative alle
sue funzioni di telecamera, con l’eccezione indicata nella nota seguente.

Nota
Le impostazioni delle funzioni di rete e le informazioni relative all’autenticazione non vengono salvate. Per informazioni dettagliate sulle voci e gli
elementi salvati, vedere “Elenco delle voci di menu”.

Argomento correlato
Elenco delle voci di menu
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Salvataggio di un file ALL

Questo argomento descrive come salvare un file ALL.

Nota

Non è possibile salvare un file ALL durante l’operazione di inquadratura automatica PTZ. È necessario disattivare l’inquadratura automatica PTZ
prima di poter salvare un file ALL.
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Aprire [Project] > [All File] nel menu Web.1

Premere il pulsante [Save All File] > [Save].

Dopo alcuni istanti, il browser Web eseguirà il download di un file denominato all-file.ALL.

2

Specificare il percorso e il nome desiderato per il file all-file.ALL scaricato e salvarlo.

Per informazioni dettagliate sulle operazioni sui file, fare riferimento alle istruzioni per l’uso del dispositivo.

3
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Caricamento di un file ALL

Questo argomento descrive come caricare un file ALL.

Nota

Al termine del caricamento dei dati di configurazione l’unità si riavvia automaticamente. Dopo il riavvio, ricaricare la pagina nel browser Web.

Non è possibile caricare un file ALL durante l’operazione di inquadratura automatica PTZ. È necessario disattivare l’inquadratura automatica PTZ
prima di poter caricare un file ALL.
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Aprire [Project] > [All File] nel menu Web.1

Premere il pulsante [Load All File] > [Load].

Sul dispositivo che esegue l’app Web si aprirà la finestra di dialogo di apertura di file.

2

Aprire il file da caricare.

Per informazioni dettagliate sulle operazioni sui file, fare riferimento alle istruzioni per l’uso del dispositivo.

3

Quando viene visualizzata la schermata di conferma del nome del file da caricare, premere il pulsante [OK].4

Quando viene visualizzata la schermata dei risultati dell’operazione, premere il pulsante [OK].5

Attendere il riavvio dell’unità, quindi riconnettere l’app Web.6
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Informazioni sul trasferimento di file

I clip proxy e i clip originali registrati sull’unità possono essere trasferiti su un server su Internet o nella rete locale.

Nota

Quando l’alimentazione viene messa in modalità standby, i trasferimenti di file vengono messi in attesa, anche se l’unità rimane alimentata.
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270



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Registrazione di una destinazione di trasferimento file

È possibile registrare il server di destinazione del trasferimento prima di avviare il trasferimento del file.

Selezionare [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (o [Server Settings2], [Server
Settings3]) nel menu Web.

Suggerimento
Il nome dell’opzione selezionabile potrà variare in base alla configurazione di [Display Name] nel passo successivo.

1

Configurare le seguenti voci in [Network] > da [FTP Server 1] a [FTP Server 3] nel menu Web.

[Display Name]
Immettere il nome del server da visualizzare nell’elenco dei trasferimenti al momento di selezionare il server di destinazione del
trasferimento.
[Service]
Visualizza il tipo di server.
[FTP]: Server FTP
[Host Name]
Immettere l’indirizzo o il nome host del server.
[Port]
Immettere il numero di porta del server a cui connettersi.
[User Name]
Immettere il nome utente.
[Password]
Immettere la password.
[Passive Mode]
Attivare o disattivare la modalità Passive.
[Destination Directory]
Immettere il nome della directory sul server di destinazione.

Nota

Se vengono immessi in [Destination Directory] caratteri non validi per il server di destinazione, i file saranno trasferiti sulla directory
principale dell’utente. I caratteri validi e non validi variano a seconda del server.

[Using Secure Protocol]
Specifica se utilizzare o meno il protocollo di trasferimento Secure FTP.
[Root Certificate]
Caricamento o annullamento di un certificato.
[Load]: Carica un certificato CA. Carica certificati in formato PEM.
[Clear]: Elimina il certificato CA.
[None]: Non carica né annulla nessun certificato.

Nota

Impostare l’orologio dell’unità sull’ora corretta prima di caricare un certificato CA.

Durante la registrazione in modalità XAVC-I 4096×2160P/3840×2160P 59.94/50P, non è possibile selezionare [Load].

[Root Certificate Status]: Visualizza lo stato di caricamento del certificato.
[Reset]: Ripristina sui valori predefiniti le impostazioni di Server Settings.

2
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Upload dalla schermata delle miniature di clip proxy contenuti in una scheda di memoria

La schermata delle miniature consente di eseguire individualmente l’upload di clip proxy contenuti in una scheda di memoria.

Nota
Possono essere registrati fino a 200 trasferimenti.
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Premere il pulsante [Thumbnail] nella schermata delle operazioni live dell’app Web.

Il display passa dall’immagine della telecamera alla schermata delle miniature.

1

Selezionare [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] nel menu della telecamera.

Per trasferire tutti i clip proxy contemporaneamente, selezionare [Transfer Clip (Proxy)] > [All Clips].
Il trasferimento dei clip può essere effettuato sia dalla schermata delle miniature che dalla schermata filtrata delle miniature dei
clip.

2

Selezionare il clip da trasferire utilizzando il pulsante [Set], quindi premere il pulsante [Menu].

Viene visualizzata una schermata di conferma del trasferimento.

3

Selezionare [Execute].

I file corrispondenti al clip selezionato vengono registrati come operazione di trasferimento e l’upload ha inizio.
Non appena l’operazione di trasferimento viene registrata, appare la schermata dei risultati del trasferimento.

4

Premere il pulsante [OK].5
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Upload dalla schermata delle miniature di file originale contenuti in una scheda di memoria

È possibile eseguire l’upload di clip originali contenuti in una scheda di memoria dalla schermata delle miniature.

Nota
Possono essere registrati fino a 200 trasferimenti.
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Premere il pulsante [Thumbnail] nella schermata delle operazioni live dell’app Web.

Il display passa dall’immagine della telecamera alla schermata delle miniature.

1

Selezionare [Thumbnail] > [Transfer Clip] > [Select Clip] nel menu della telecamera.

Per trasferire tutti i clip originali contemporaneamente, selezionare [Transfer Clip] > [All Clips].
Il trasferimento dei clip può essere effettuato sia dalla schermata delle miniature che dalla schermata filtrata delle miniature dei
clip.

2

Selezionare il clip da trasferire utilizzando il pulsante [Set], quindi premere il pulsante [Menu].

Viene visualizzata una schermata di conferma del trasferimento.

3

Selezionare [Execute].

I file corrispondenti al clip selezionato vengono registrati come operazione di trasferimento e l’upload ha inizio.
Non appena l’operazione di trasferimento viene registrata, appare la schermata dei risultati del trasferimento.

4

Premere il pulsante [OK].5
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Controllo dello stato del trasferimento del file

È possibile controllare lo stato del trasferimento dei file selezionando [Network] > [File Transfer] > [View Job List] nel menu della
telecamera.

Nota

Possono essere registrati fino a 200 trasferimenti.

L’elenco dei trasferimenti viene mantenuto anche mentre l’unità entra in modalità standby. Tuttavia, potrebbero andare persi fino a 10 minuti delle
ultime informazioni sul progresso dell’attività se l’alimentazione viene interrotta in altri modi.

Qualora si verificasse un errore durante il trasferimento di un file, il trasferimento di un clip con lo stesso nome di un clip trasferito potrebbe non
venire ripreso, in base alle impostazioni e allo stato del server di destinazione del trasferimento. In tal caso, controllare le impostazioni e lo stato
del server di destinazione del trasferimento.

Suggerimento

Se [Network] > [File Transfer] > [Auto Upload (Proxy)] è impostato su [On] nel menu della telecamera ed è presente una connessione di rete, i file
proxy vengono automaticamente trasferiti sul server specificato in [Default Upload Server] al termine della registrazione.

5-041-957-34(1) Copyright 2022 Sony Corporation

275



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Upload tramite Secure FTP

Per proteggere con crittografia l’upload di file, è possibile utilizzare il protocollo FTPS in modalità Explicit (FTPES) per realizzare la
connessione con il file server di destinazione.
Per utilizzare il protocollo Secure FTP, impostare [Using Secure Protocol] su [On] nelle impostazioni del file server di destinazione e
caricarne il relativo certificato.

Per informazioni dettagliate sulla configurazione, vedere “Registrazione di una destinazione di trasferimento file”.

Argomento correlato
Registrazione di una destinazione di trasferimento file
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Informazioni sullo streaming

L’unità è in grado di inviare contemporaneamente in streaming il video e l’audio emessi in uscita sul connettore HDMI.

Nota

Per utilizzare lo streaming come video principale, impostare [Monitoring] > [Output Display] > [SDI] su [On] e [HDMI/Stream] su [Off] nel menu
Web, quindi monitorare lo stato della telecamera su un monitor SDI.

Se il monitor collegato al connettore HDMI non supporta il formato di uscita HDMI configurato utilizzando il menu [Monitoring] nel menu Web o
nel menu della telecamera, l’immagine della telecamera non sarà emessa in uscita sull’app Web e non potrà essere emesso in uscita neanche il
video in streaming.

La risoluzione dello streaming non può essere impostata su un valore superiore alla risoluzione del segnale di uscita HDMI.

Con determinate impostazioni di codec, l’immagine potrebbe apparire distorta se visualizzata da più utenti contemporaneamente.

L’unità supporta i metodi di streaming indicati di seguito. Fra parentesi sono indicati i codec video che possono essere selezionati.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Configurare, nell’ordine, le impostazioni di formato di streaming, le impostazioni del codec video e quindi le impostazioni del codec
audio.

●: Abilitato –: Non abilitato

Suggerimento

L’immagine nel pannello della telecamera dell’app Web è anche un sistema di streaming.

5-041-957-34(1) Copyright 2022 Sony Corporation

Formato di streaming
Impostazione del codec

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Web App – – ● –

È possibile selezionare RTMP quando [Stream] > [Audio Stream] è impostato su [On] nel menu Web.*1

Quando la frequenza di sistema è 59.94 o 50 e il formato di uscita HDMI è 3840×2160 o superiore, l’uscita video 2 non è disponibile.*2
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Impostazione del formato di streaming

Impostare il formato di streaming utilizzando [Stream] > [Stream] > [Stream Setting] > [Setting] nel menu Web.

Quando [Setting] è impostato su [RTSP]

Nello streaming RTSP, l’immagine proveniente da una singola telecamera può essere visualizzata contemporaneamente da un
massimo di cinque utenti.
Possono essere definite fino a due modalità di codec video.
[Port Number]
Imposta il numero di porta da utilizzare per lo streaming RTSP. Il valore predefinito è 554.
La modifica di questa impostazione causa il riavvio del server RTSP.
[Time Out]
Specifica il tempo di timeout del comando Keep-Alive per lo stream RTSP. Il tempo di timeout può essere impostato su un valore
compreso fra 0 e 600 secondi. Il valore predefinito è 60 secondi.
Se impostato su 0 secondi, non avrà luogo nessun timeout dovuto al comando Keep-Alive.
[Authentication]
Specifica se è necessaria o meno l’autenticazione.
[Video Port Number 1], [Video Port Number 2]
Specifica il numero di porta per la comunicazione dei dati di immagine da utilizzare per lo streaming unicast RTSP. Il valore predefinito
per Video Port Number 1 è 51000. Il valore predefinito per Video Port Number 2 è 53000. Immettere un numero pari compreso fra
1024 e 65534. Il numero pari impostato qui, e il successivo numero dispari ottenuto aggiungendo 1 ad esso, diventano i due numeri di
porta utilizzati per la comunicazione e il controllo dei dati di immagine.
[Video Port Number 1] e [Video Port Number 2] corrispondono a [Stream] > [Video Stream] > [Video Stream 1] e [Video Stream 2].
[Audio Port Number]
Specifica il numero di porta per la comunicazione dei dati audio utilizzato per lo streaming unicast RTSP. Il valore predefinito è 57000.
Immettere un numero pari compreso fra 1024 e 65534. Il numero pari impostato qui, e il successivo numero dispari ottenuto
aggiungendo 1 ad esso, diventano i due numeri di porta utilizzati per la comunicazione e il controllo dei dati audio.

Quando [Setting] è impostato su [RTMP]

Con RTMP può essere utilizzata solo la modalità di codec video H.264. Per utilizzare RTMP, [Stream] > [Audio Stream] deve essere
impostato su [On] nel menu Web.
[Server URL]
Imposta l’URL di destinazione dell’upload. Specificare una stringa di caratteri che inizia con “rtmp://” o “rtmps://”.
[Stream Key]
Immettere la Stream Key ricevuta dal sito utilizzato. Premere il pulsante [Clear] se si desidera cancellare il valore immesso.

Nota
È importante conservare la Stream Key con cura. Qualora terzi vengano a conoscenza della Stream Key, lo streaming potrebbe essere
falsificato.

[Root Certificate]
Importa il certificato radice necessario per lo streaming con il protocollo RTMPS. Per importare il certificato radice, premere il pulsante
[Load] e selezionare il certificato radice desiderato. Premere il pulsante [OK] nella finestra di selezione dei file per importare sull’unità il
file selezionato. Se sull’unità è già presente un certificato radice importato, tale certificato radice verrà aggiornato. Per eliminare un
certificato radice importato, premere il pulsante [Delete] nella schermata di configurazione. Lo stato del certificato radice viene
visualizzato in [Root Certificate Status].

Nota
Importare il certificato radice richiesto dal servizio di streaming.

Quando [Setting] è impostato su [SRT-Caller] o [SRT-Listener]

La modalità codec video è solo H.264.
[Destination]
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Visualizzato quando la modalità di streaming è impostata su [SRT-Caller]. Imposta l’URL di destinazione della connessione.
[Port Number]
Visualizzato quando la modalità di streaming è impostata su [SRT-Listener]. Imposta il numero di porta su cui ascoltare. Il valore
predefinito è 4201.
[Latency]
Imposta la latenza su un valore compreso fra 20 ms e 8000 ms. Il valore predefinito è 120.
[TTL]
Imposta il valore di TTL compreso fra 1 e 255. Il valore predefinito è 64.
[Encryption]
Consente di selezionare il metodo di crittografia. Sono disponibili le opzioni Off, AES128 e AES256. Il valore predefinito è Off.
[Passphrase]
Imposta la passphrase da utilizzare per la crittografia. Premere il pulsante [Clear] se si desidera resettare la passphrase configurata.
[ARC]
Impostare su On per abilitare la funzione Adaptive Rate Control.
Se abilitata, la funzione Adaptive Rate Control può ridurre eventuali interruzioni nell’immagine causate dal traffico sulla linea di
comunicazione.

Quando [Setting] è impostato su [NDI|HX]

Una licenza NDI|HX è già preinstallata nelle versioni software 3.00 e successive.

Nota

L’unità è conforme a NDI® HX2 di Vizrt NDI AB.

L’unità può inviare video tramite rete ad applicazioni software e dispositivi hardware compatibili con NDI® HX2.

[License]
Visualizza le informazioni di licenza.
[Source Name]
Visualizza il nome dell’origine.
[Group]
Impostare su On per abilitare la funzione di raggruppamento NDI.
[Group Name]: Specifica il nome del gruppo NDI. È possibile configurare più impostazioni separandole con una virgola.
[Discovery Server 1], [Discovery Server 2]
Specifica il server di individuazione NDI 1 e il server di individuazione NDI 2.
[Reliable UDP Mode]
Impostare su On per abilitare la modalità Reliable UDP.
[Multicast Mode]
Impostare su On per abilitare lo streaming multicast.
[Multicast Prefix]: Imposta il prefisso da utilizzare per lo streaming multicast.
[Multicast Netmask]: Imposta la netmask che determina il range di indirizzi multicast.
[Multicast TTL]: Imposta il valore di TTL per lo streaming multicast. Sono disponibili valori compresi fra 1 e 256. Il valore predefinito è 3.
[Multi-TCP Mode]
Impostare su On per abilitare la modalità Multi-TCP.
[Unicast UDP Mode]
Impostare su On per abilitare la modalità Unicast UDP.

Informazioni sui servizi e il software di terzi
Potrebbero essere applicabili condizioni per l’uso diverse.

La fornitura di servizi e aggiornamenti software potrebbe essere interrotta o terminata senza preavviso.
La descrizione di servizi e software è soggetta a modifiche senza preavviso.
Potrebbero essere necessarie registrazioni e abbonamenti separati.

Sony non potrà essere ritenuta responsabile per eventuali reclami presentati dagli utenti o da terzi dovuto all’uso di servizi e software
di altre società.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Impostazione del codec video per lo streaming

Impostare il codec video utilizzando [Stream] > [Video Stream] nel menu Web.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Possono essere definite fino a tre modalità di codec immagine. Configurare le seguenti impostazioni separatamente per ogni modalità
immagine.
[Video Stream 3] è utilizzato per la visualizzazione del riquadro dell’immagine della telecamera.

Nota
Quando [Stream] > [Stream Setting] > [Setting] è impostato su [RTMP], [SRT-Caller] o [SRT-Listener], alcune delle impostazioni di [Video Stream
1], [Video Stream 2] e [Video Stream 3] ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode]) avranno i loro valori predefiniti.

[Codec 1], [Codec 2], [Codec 3]
Selezionare [H.264], [H.265] o [Off]. Si osservi che [Codec 1] non può essere impostato su [Off]. Inoltre, [Codec 3] è fissato su [JPEG].

Nota
Con determinate combinazioni di varie impostazioni, quali ad esempio le dimensioni immagine, la frequenza fotogrammi e il bit rate di [Codec 1],
[Codec 2] e [Codec 3], potrebbero verificarsi alcuni inconvenienti, indicati di seguito.

Aumento della latenza video.
Salto dei fotogrammi durante la riproduzione video.
Audio intermittente.
Rallentamento della risposta della telecamera a vari comandi.
Rallentamento della risposta della telecamera ai comandi impartiti sul telecomando.
Rallentamento della visualizzazione sullo schermo di monitoraggio e delle operazioni di configurazione.

Qualora si verifichino queste problematiche, provare a risolverle riducendo i valori dei parametri di dimensione immagine, frequenza fotogrammi,
bit rate, oppure modificando i valori di altri parametri di configurazione.

Quando [Stream] > [Stream Setting] > [Setting] è impostato su [RTMP], [SRT-Caller] o [SRT-Listener], [Codec 1] è fissato su [H.264]. [Codec 2] è
fissato su [Off].

Quando vengono modificate le dimensioni immagine o la frequenza di sistema dell’uscita HDMI, [Codec 2] viene impostato su [Off].

Durante l’esecuzione dell’inquadratura automatica PTZ, quando [Stream] > [Stream] > [Stream Setting] > [Setting] è impostato su [RTSP] nel
menu Web, [Codec 2] è fissato su [Off].

[Size 1], [Size 2], [Size 3]
Selezionare le dimensioni immagine da inviare in streaming dalla telecamera.
Le opzioni di dimensioni immagine disponibili variano a seconda delle dimensioni immagine dell’uscita HDMI.

Nota
Quando vengono modificate le dimensioni immagine o la frequenza di sistema dell’uscita HDMI, verranno selezionate le dimensioni immagine
massime.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Imposta la frequenza fotogrammi dell’immagine.
Le unità “fps” indicano il numero di fotogrammi al secondo trasmessi in streaming.
Le opzioni di frequenza fotogrammi disponibili variano a seconda delle dimensioni immagine dell’uscita HDMI.

Nota
Quando vengono modificate le dimensioni immagine o la frequenza di sistema dell’uscita HDMI, verrà selezionata la frequenza fotogrammi
massima.

Durante l’esecuzione dell’inquadratura automatica PTZ, [Frame Rate 2] è limitato a un massimo di 10 fps.
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[I-Picture Mode 1], [I-Picture Mode 2]
Consente di scegliere il metodo per specificare l’intervallo di inserimento dell’I-picture per H.264 e H.265 fra [Time] e [Frame].
Non è impostabile per [Codec 3].
[Time]: Imposta l’intervallo di inserimento dell’I-Picture come tempo.
[Frame]: Imposta l’intervallo di inserimento dell’I-Picture come numero di fotogrammi.
[I-Picture Interval 1], [I-Picture Interval 2]
Specifica l’intervallo di inserimento dell’I-picture in secondi. Imposta un valore compreso fra 1 secondo e 5 secondi. Il valore predefinito
è 1 secondo.
Non è impostabile per [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Specifica l’intervallo di inserimento dell’I-picture per H.264 e H.265 come numero di fotogrammi su un valore compreso fra 15 e 300. Il
valore predefinito è 300 fotogrammi.
Non è impostabile per [Codec 3].
[Profile 1], [Profile 2]
Specifica il profilo codec immagine H.264 o H.265.
[H.264]: Seleziona il profilo [high], [main] o [baseline].
[H.265]: Seleziona il profilo [main] o [main10]. Quando sono abilitati due codec video, è disponibile solo l’opzione di selezione del
profilo [main].
L’efficienza di compressione video aumenta nell’ordine [high], [main] e [baseline]. Selezionare un profilo supportato dal sistema
utilizzato.
Quando [H.265] è impostato su [main10], sarà utilizzato [main10] quando l’uscita HDMI è YCrCb oppure [main] quando l’uscita HDMI è
RGB.
Non è impostabile per [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Selezionare [CBR] o [VBR].
Per mantenere un bit rate costante, selezionare [CBR]. Per mantenere la qualità dell’immagine, selezionare [VBR].
Non è impostabile per [Codec 3].

Nota

La frequenza fotogrammi e il bit rate effettivamente trasmessi in streaming potranno differire dai valori impostati in base alle dimensioni
dell’immagine, la scena ripresa, l’ambiente di rete e altri fattori.

Quando [Stream] > [Stream Setting] > [Setting] è impostato su [RTMP], [SRT-Caller] o [SRT-Listener], [Bit Rate Compression Mode 1] è fissato
su [CBR].

[Bit Rate 1], [Bit Rate 2]
Quando [Bit Rate Compression Mode] è impostato su [CBR], è possibile impostare il bit rate per lo stream video. L’impostazione di un
bit rate elevato consente di trasmettere in streaming video con alta qualità d’immagine.
Non è impostabile per [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Immettere la qualità dell’immagine con un numero compreso fra 1 e 10. Il valore 10 imposta la massima qualità d’immagine. Il valore
predefinito è 6.
Per [Quality 1] e [Quality 2], è possibile impostare la qualità dell’immagine su H.264 impostando [Bit Rate Compression Mode] su
[VBR] e [Codec] su [H.264]. È possibile impostare la qualità su H.265 impostando [Bit Rate Compression Mode] su [VBR] e [Codec] su
[H.265].

5-041-957-34(1) Copyright 2022 Sony Corporation
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Impostazione del codec audio per lo streaming

Impostare il codec audio utilizzando [Stream] > [Audio Stream] nel menu Web.
[Setting]
Impostare su On per abilitare lo streaming dell’audio.

Nota
Prima di poter selezionare RTMP, è necessario che sia stato selezionato On.

[Codec]
Seleziona il tipo di codec da utilizzare per lo streaming dell’audio.
[AAC (256kbps)]: Selezionare questa opzione per dare la priorità alla qualità del suono.
[AAC (128kbps)]: Selezionare questa opzione per dare la priorità alla capacità di dati.
Questa impostazione non ha effetto sul clip registrato dall’unità o sul segnale audio incorporato nel segnale HDMI/SDI.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Avvio e arresto dello streaming

Per [RTSP], [SRT-Listener] e [NDI|HX]

L’unità attende una richiesta di consegna in streaming.
Avviare un’applicazione client per la visualizzazione dello streaming e accedere all’URL mostrato nella tabella seguente.
Immettere i valori per il nome utente e la password configurati sull’unità.

<indirizzo_telecamera>: Indirizzo IP dell’unità.
<Porta>: Porta di ascolto configurata in [Port Number]

Nota

Non è possibile garantire la riproduzione corretta in tutte le applicazioni o dispositivi.

Per [RTMP] e [SRT-Caller]

Premere il pulsante [Stream now] nella scheda  (Stream) della schermata delle operazioni live per avviare lo streaming. Il pulsante
diventa [Stop stream] e l’icona [Stream] appare nella parte superiore del pannello dell’immagine della telecamera.
Premere il pulsante [Stop stream] durante lo streaming per arrestarlo. Il pulsante diventa nuovamente [Stream now] e l’icona [Stream]
scompare dalla parte superiore del pannello dell’immagine della telecamera.

Nota
Non è possibile garantire la riproduzione corretta in tutte le applicazioni o dispositivi.

5-041-957-34(1) Copyright 2022 Sony Corporation

Formato di streaming URL

RTSP
Video Stream 1 rtsp://<indirizzo_telecamera>:<Porta>/video1

Video Stream 2 rtsp://<indirizzo_telecamera>:<Porta>/video2

SRT-Listener srt://<indirizzo_telecamera>:<Porta>

NDI|HX Fare riferimento alle istruzioni per l’uso del dispositivo client compatibile con NDI|HX.
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Schermata delle miniature

Quando si preme il pulsante [Thumbnail] nella schermata delle operazioni di riproduzione oppure il pulsante THUMBNAIL del
telecomando a infrarossi, i clip registrati sulla scheda di memoria vengono visualizzati nel pannello dell’immagine della telecamera.
Questa visualizzazione nel pannello dell’immagine della telecamera è denominata schermata delle miniature.
La schermata delle miniature consente di selezionare un clip e avviarne la riproduzione.
Premere di nuovo il pulsante [Thumbnail] per chiudere la schermata delle miniature e tornare alla visualizzazione della schermata di
ripresa.

Nota
La schermata delle miniature mostra solo i clip registrati nel formato di registrazione correntemente selezionato. Se un clip registrato che avrebbe
dovuto essere presente non è visualizzato, controllare il formato di registrazione. Prestare attenzione a questo fatto prima di procedere con la
formattazione (inizializzazione) dei supporti di memoria.

Elementi dello schermo

La miniatura di un clip selezionato viene visualizzata con uno sfondo arancione.
Nella parte inferiore dello schermo sono visualizzate informazioni relative al clip selezionato.
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Scheda di memoria selezionata
Un’icona di lucchetto, visualizzata alla destra della scheda di memoria, indica se la scheda è protetta contro la scrittura.

1.

Numero del clip/numero dei clip2.

Miniatura (immagine indice)
Visualizza l’immagine indice del clip. Quando si registra un clip, il primo fotogramma viene impostato automaticamente come
immagine indice.
Sotto la miniatura vengono visualizzate informazioni sul clip e sul fotogramma. È possibile scegliere le informazioni visualizzate
utilizzando [Thumbnail] > [Customize View] > [Thumbnail Caption] nel menu della telecamera.

3.

Nome del clip
Visualizza il nome del clip selezionato.

4.

Formato di registrazione
Visualizza il formato del file del clip selezionato.

5.

Informazioni sulla registrazione speciale
Se il clip è stato registrato con una modalità di registrazione speciale, ne indica la modalità.
Se il clip è registrato in modalità Slow & Quick Motion, ne viene indicata la frequenza fotogrammi sulla destra.

6.

Durata del clip7.

Data di creazione8.
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Riproduzione dei clip registrati

I clip registrati possono essere riprodotti mentre l’unità si trova in modalità standby (Stby) di registrazione.
Questo argomento descrive come riprodurre clip registrati utilizzando il pannello dei comandi GUI.

Inserire la scheda di memoria da riprodurre.1

Premere il pulsante [Thumbnail].

Sono visualizzate le miniature dei clip.

2

Utilizzando il pulsanti freccia del pannello dei comandi GUI, spostare il cursore sulla miniatura del clip da riprodurre.

Nota
Non è possibile selezionare i clip toccandoli sul touchscreen.

3
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Nota
Nel passaggio da un clip a un altro la visualizzazione dell’immagine potrebbe momentaneamente frazionarsi o arrestarsi. Durante questo periodo
non è possibile azionare l’unità.

All’avvio della riproduzione, dopo aver selezionato un clip nella schermata delle miniature, si potrebbero verificare momentanee distorsioni
dell’immagine all’inizio del clip. Per visualizzare l’inizio del clip senza distorsioni, mettere in pausa la riproduzione, premere il pulsante 
(precedente) per tornare all’inizio del clip, quindi riavviare la riproduzione.
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Premere il pulsante [Set] nel pannello dei comandi GUI.

La riproduzione si avvia dall’inizio del clip selezionato.

4

Utilizzare il pannello di controllo della riproduzione come desiderato.

Suggerimento

Le operazioni possono essere eseguite anche utilizzando il pannello dei comandi GUI.
Play: Premere il pulsante [Set].
Pausa nella riproduzione: Premere il pulsante [Set] durante la riproduzione. Premere una seconda volta per tornare alla riproduzione
normale.
Salto all’inizio del clip o all’inizio del clip successivo: Premere rispettivamente il pulsante sinistro o il pulsante destro.
Avanti veloce / Indietro veloce: Premere e mantenere premuto il pulsante destro o il pulsante sinistro rispettivamente. La riproduzione
torna alla velocità normale non appena si rilascia il pulsante.
Arresto riproduzione: Premere il pulsante [Cancel/Back].

5

Pulsante Funzione

Pulsante  (play/pausa) Riproduce un clip. Durante la riproduzione, mette in pausa il clip.

Pulsante  (avanti veloce), pulsante
 (indietro veloce)

Riproduce un clip ad alta velocità. Premendo il pulsante, la velocità di
riproduzione incrementa gradualmente (tre velocità).

Pulsante  (precedente), pulsante 
(successivo)

Salta all’inizio del clip corrente o al clip precedente o successivo.

Pulsante  (stop) Arresta la riproduzione e passa alla schermata di ripresa.
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Operazioni sui clip registrati

La schermata delle miniature consente di eseguire operazioni di gestione dei clip e controllarne le proprietà tramite il menu
[Thumbnail] nel menu della telecamera.
Premere il pulsante [Menu] nella schermata delle operazioni di riproduzione per visualizzare il menu della telecamera nel pannello
dell’immagine della telecamera.
Il menu [Thumbnail] del menu della telecamera consente di eseguire le operazioni descritte di seguito.

288



Suggerimento

Per visualizzare il menu della telecamera, è possibile anche premere il pulsante [Menu] nella schermata delle operazioni live.

Utilizzo del menu [Thumbnail] nel menu della telecamera.

Selezionare la funzione desiderata con i pulsanti freccia del pannello dei comandi GUI, quindi premere il pulsante [Set].
Premere il pulsante [Cancel/Back] per tornare alla schermata precedente.

Nota
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A seconda dello stato operativo del camcorder quando viene visualizzato il menu, alcune voci potrebbero non essere selezionabili.

Voci di menu per le operazioni sui clip

Il menu [Thumbnail] del menu della telecamera contiene le seguenti voci che consentono di eseguire varie operazioni sui clip.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Per informazioni dettagliate su ciascuna voce di menu, vedere “Menu [Thumbnail]”.

Visualizzazione della schermata delle proprietà dei clip
Selezionare [Thumbnail] > [Display Clip Properties] nel menu della telecamera per visualizzare la schermata delle proprietà dei clip.
Premere il pulsante  (precedente) o il pulsante  (successivo) per passare rispettivamente al clip precedente o successivo.

Aggiunta di flag ai clip
È possibile aggiungere flag (ovvero contrassegni OK, NG o KP) ai clip per poterne in seguito filtrare la visualizzazione in base ad essi.
Selezionare la miniatura del clip a cui aggiungere il flag, quindi selezionare il tipo di flag desiderato utilizzando [Thumbnail] > [Set Clip
Flag] nel menu della telecamera.

Suggerimento
È possibile aggiungere flag ai clip anche mediante un pulsante programmabile a cui è assegnata la funzione di aggiunta di flag dei clip.

Visualizzazione della schermata delle miniature filtrata
Selezionare [Thumbnail] > [Filter Clips] nel menu della telecamera, quindi selezionare il tipo di flag desiderato per visualizzare solo i
clip che lo contengono.
Per visualizzare tutti i clip, selezionare [All].
È inoltre possibile premere il pulsante [Display] per ordinare la visualizzazione delle miniature in base ai flag.

Eliminazione di clip
I clip contenuti nelle schede di memoria possono essere eliminati secondo le proprie esigenze.
Selezionare [Thumbnail] > [Delete Clip] > [Select Clip] o [All Clips] nel menu della telecamera.
[Select Clip]: Elimina il clip selezionato. È possibile selezionare più clip contemporaneamente.
[All Clips]: Elimina tutti i clip visualizzati.

Scelta delle informazioni visualizzate nella schermata delle miniature
È possibile scegliere le informazioni sui clip o sui fotogrammi visualizzate sotto la miniatura.
Selezionare [Thumbnail] > [Customize View] > [Thumbnail Caption] nel menu della telecamera e selezionare le informazioni da
visualizzare.
[Date Time]: Visualizza la data e l’ora di creazione e dell’ultima modifica del clip.
[Time Code]: Visualizza il codice temporale.
[Duration]: Visualizza la durata del clip.
[Sequential Number]: Visualizza un numero sequenziale su ogni miniatura.
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Impostazione Flag di clip aggiunto

[Add OK] OK

[Add NG] NG

[Add KEEP] KP

290



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Configurazione del menu della telecamera

Premendo il pulsante [Menu] del pannello dei comandi GUI oppure il pulsante MENU del telecomando a infrarossi, viene visualizzato il
menu della telecamera nel pannello dell’immagine della telecamera. Questo menu consente di configurare le varie impostazioni
necessarie per la ripresa e la riproduzione.

Il menu comprende i menu indicati di seguito:

Configurazione del menu

Menu [User]
Contiene voci di menu configurate dall’utente.
Può essere modificato utilizzando [Edit User Menu].
Menu [Edit User]
Contiene voci per la modifica del menu [User].
Menu [Shooting]
Contiene opzioni relative alla ripresa.
Menu [Project]
Contiene le impostazioni di base del progetto.
Menu [Paint/Look]
Contiene opzioni relative alla qualità dell’immagine.
Menu [Pan-Tilt]
Contiene impostazioni relative al movimento di pan e tilt.
Menu [TC/Media]
Contiene impostazioni relative ai codici temporali e ai supporti di registrazione.
Menu [Monitoring]
Contiene impostazioni relative all’uscita video e alla visualizzazione su schermo.
Menu [Audio]
Contiene opzioni relative all’audio.
Menu [Thumbnail]
Contiene opzioni relative alla visualizzazione delle miniature.
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Menu [Technical]
Contiene le impostazioni relative agli elementi tecnici.
Menu [Network]
Contiene opzioni relative alle reti.
Menu [Maintenance]
Contiene le impostazioni del dispositivo stesso, ad esempio l’orologio e la lingua.

Configurazione e struttura del menu della telecamera

Livello 1 Livello 2

User
(Impostazioni di fabbrica)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Livello 1 Livello 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Pan-Tilt P/T Acceleration
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Livello 1 Livello 2

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Utilizzo del menu della telecamera

Premendo il pulsante [Menu] del pannello dei comandi GUI oppure il pulsante MENU del telecomando a infrarossi, viene visualizzato il
menu della telecamera nel pannello dell’immagine della telecamera. Questo menu consente di configurare le varie impostazioni
necessarie per la ripresa e la riproduzione.
Per interagire con il menu, utilizzare i pulsanti del pannello dei comandi GUI.

Pulsante [Menu]: Premere per visualizzare il menu della telecamera. Premere di nuovo mentre è visualizzato il menu della
telecamera per chiuderlo.
Pulsanti freccia: Premere i pulsanti freccia per spostare il cursore verso l’alto, il basso, sinistra o destra nel menu della telecamera e
selezionare voci o impostazioni.
Pulsante [Set]: Premere per applicare la voce selezionata.
Pulsante [Cancel/Back]: Premere per tornare al menu precedente. Le modifiche non completate vengono annullate.

Nota
A seconda dello stato operativo del camcorder quando viene visualizzato il menu, alcune voci potrebbero non essere selezionabili.

Impostazione delle voci dei menu

Utilizzando i pulsanti freccia del pannello dei comandi GUI, spostare il cursore sulla voce da impostare, quindi premere il pulsante [Set]
per applicare l’impostazione.

Nell’area di selezione delle voci del menu vengono visualizzate un massimo di otto righe. Se non possono essere visualizzate
contemporaneamente tutte le opzioni disponibili per una determinata voce, scorrere le opzioni spostando il cursore verso l’alto o
verso il basso.
Se la gamma di opzioni disponibili per una voce secondaria è molto ampia (ad esempio da −99 a + 99), l’area di selezione non
viene visualizzata. Viene invece evidenziato il valore corrente per indicare che tale valore può essere modificato.
Per eseguire una funzione, selezionare [Execute].
Se si seleziona una voce che richiede conferma prima dell’esecuzione, il menu verrà momentaneamente nascosto e verrà
visualizzato un messaggio di conferma. Controllare il messaggio e quindi scegliere se eseguire o annullare la funzione.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Immissione di una stringa di caratteri

Quando si seleziona una voce che richiede l’immissione di caratteri, viene visualizzata la schermata di inserimento caratteri.
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Premere i pulsanti freccia del pannello dei comandi GUI per selezionare il tipo di carattere e applicare l’impostazione.

[ABC]: Caratteri alfabetici maiuscoli
[abc]: Caratteri alfabetici minuscoli
[123]: Caratteri numerici
[!#$]: Caratteri speciali

1

Selezionare un carattere e premere il pulsante [Set] per applicare l’impostazione.

Il cursore si sposta sul campo successivo.
[Space]: Immette uno spazio in corrispondenza della posizione del cursore.
[←] [→]: Sposta la posizione del cursore.
[BS]: Elimina il carattere alla sinistra del cursore (backspace).

2

Al termine, premere il pulsante [Done] per applicare l’impostazione.

La stringa di caratteri viene confermata e la schermata di inserimento dei caratteri si chiude.

3

297



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

User

Questo argomento descrive le funzioni e le impostazioni di ciascuna voce di menu.

Nota

Il menu [User] consente di aggiungere o rimuovere voci del menu [Edit User]. Possono essere configurate fino a 20 voci.
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Voce Descrizione

Base Setting Voce Project > Base Setting

Focus Voce Shooting > Focus

S&Q Motion Voce Shooting > S&Q Motion

LUT On/Off Voce Shooting > LUT On/Off

Simul Rec Voce Project > Simul Rec

Proxy Rec Voce Project > Proxy Rec

Interval Rec Voce Project > Interval Rec

Picture Cache Rec Voce Project > Picture Cache Rec

Assignable Button Voce Project > Assignable Button

Scene File Voce Project > Scene File

Base Look Voce Paint/Look > Base Look

P/T Acceleration Voce Pan-Tilt > P/T Acceleration

Clip Name Format Voce TC/Media > Clip Name Format

Format Media Voce TC/Media > Format Media

Video Signal Monitor Voce Monitoring > Video Signal Monitor

Marker Voce Monitoring > Marker

Zoom Voce Technical > Zoom

Lens Voce Technical > Lens

Edit User Menu Visualizza il menu Edit User.
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Edit User

Selezionando [Edit User Menu] nel menu [User], viene visualizzato il menu [Edit User] al suo livelli più alto.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Add Item
Aggiunge una voce al menu
[User]

– –
Aggiunge una voce di livello 2 al menu
[User].

Customize Reset
Ripristina le voci del menu [User]

– –
Ripristina l’impostazione predefinita delle
voci del menu [User].

Voce di menu di livello 2
selezionata durante la modifica

Delete – Rimuove dal menu [User] la voce di livello 2
registrata.

Move –
Cambia l’ordine delle voci registrate del
menu [User].

Edit Sub Item –
Modifica (aggiunge o elimina) le voci di
livello 3 registrate nel menu [User].

299



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

ISO/Gain/EI

Consente di specificare le impostazioni relative al guadagno.

Argomento correlato
Impostazioni e valori predefiniti di ISO/Gain

Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Mode ISO/dB dB
Seleziona la modalità di
impostazione del guadagno.

ISO/Gain<L>

Per informazioni dettagliate su queste
impostazioni, vedere “Impostazioni e valori
predefiniti di ISO/Gain”.

– Imposta il valore di preset del
guadagno <L>.

Exposure
Index<L>

Quando Base ISO è impostato su ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Quando Base ISO è impostato su ISO
12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Quando Base ISO è
impostato su ISO 800: 800EI
/ 6.0E
Quando Base ISO è
impostato su ISO 12800:
12800EI / 6.0E

Imposta il valore di Exposure
Index<L>.

Shockless
Gain

On / Off Off
Attiva o disattiva la funzione di
guadagno fluido.

Base
Sensitivity

High / Low Low
Imposta la sensibilità di base
per la modalità Custom.

Base ISO ISO 12800 / ISO 800 ISO 800
Imposta la sensibilità di base
ISO per le modalità Cine
EI/Flexible ISO.
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ND Filter

Imposta i valori di preset del filtro ND.
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Mode Preset / Variable Variable Seleziona la modalità del filtro ND.

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 Imposta il valore Preset 1 del filtro ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 Imposta il valore Preset 2 del filtro ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 Imposta il valore Preset 3 del filtro ND.
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Shutter

Consente di specificare le impostazioni relative al funzionamento dell’otturatore elettronico.
Consente di eseguire riprese nitide di soggetti in rapido movimento.

Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Mode Speed / Angle Speed
Seleziona la modalità di impostazione della
velocità dell’otturatore in secondi (Speed) o
in gradi (Angle).

Shutter
Speed
On/Off

On / Off Off

Quando è selezionata la modalità Speed,
specifica se il tempo di esposizione deve
seguire il valore di [Shutter Speed] o deve
essere impostato sul valore massimo di
esposizione.

Shutter
Speed

Da 64F a 1/8000
I valori disponibili variano a seconda della
frequenza fotogrammi del formato video
selezionato.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 1/60 / 1/96
/ 1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Imposta la velocità dell’otturatore quando è
selezionata la modalità Speed.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F /
360.0° / 300.0° / 270.0° / 240.0° / 216.0° / 210.0°
/ 180.0° / 172.8° / 150.0° / 144.0° / 120.0° / 90.0°
/ 86.4° / 72.0° / 45.0° / 30.0° / 22.5° / 11.25° / 5.6°

180.0°
Imposta l’angolo dell’otturatore quando è
selezionata la modalità Angle.

ECS On/Off On / Off Off
Attiva o disattiva la funzione ECS (Extended
Clear Scan).

ECS
Frequency

Da 23.99 a 8000
I valori disponibili variano a seconda della
frequenza fotogrammi del formato di
registrazione selezionato.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Imposta la frequenza ECS quando Mode è
impostato su ECS.
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Iris

Consente di specificare le impostazioni relative al diaframma.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Bokeh
Control

On / Off Off
Attiva o disattiva la funzione di controllo del
bokeh.
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Auto Exposure

Consente di specificare le impostazioni della correzione automatica dell’esposizione.

Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 /
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / ±0 /
−0.25 / −0.5 / −0.75 / −1.0 / −1.25 / −1.5 /
−1.75 / −2.0 / −2.25 / −2.5 / −2.75 / −3.0

±0
Imposta i livelli di luminosità per il valore di
esposizione rilevato automaticamente.

Mode Backlight / Standard / Spotlight Standard

Specifica la modalità operativa della regolazione
dell’esposizione automatica.
Backlight: Modalità controluce (i soggetti ripresi
in controluce appaiono meno scuri)
Standard: Modalità standard
Spotlight: Modalità riflettore (limita il clipping dei
bianchi quando il soggetto è illuminato da
riflettori)

Speed Da −99 a +99 ±0
Imposta la velocità di regolazione della
regolazione dell’esposizione automatica.

AGC On / Off Off
Attiva o disattiva la funzione AGC (controllo del
guadagno automatico).

AGC Limit

Per informazioni dettagliate su queste
impostazioni, vedere “Impostazioni e
valori predefiniti di AGC Limit”.

–
Imposta il guadagno massimo della funzione
AGC.

AGC Point F2.8 / F4 / F5.6 F2.8
Imposta il numero F del diaframma a cui ha inizio
il funzionamento della funzione AGC quando la
funzione AGC è On.

Auto Shutter On / Off Off Attiva o disattiva la funzione di otturatore
automatico.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Imposta la velocità massima della funzione di
otturatore automatico.

A.SHT Point F5.6 / F8 / F11 / F16 F11
Imposta numero F del diaframma a cui ha inizio il
funzionamento della funzione di otturatore
automatico.

Clip High
light On / Off Off

Attiva o disattiva la funzione che ignora le zone
più luminose per dare una risposta più piatta alle
luminanze elevate.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Imposta il campo di misurazione della luce per la
regolazione automatica della luce secondo la
luminosità del soggetto. (Non disponibile quando
l’esposizione viene regolata manualmente)

Detect
Window
Indication

On / Off Off
Attiva o disattiva l’indicazione il campo di
misurazione della luce.
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Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Custom
Width

Da 40 a 999 500
Imposta la larghezza del campo di misurazione
della luce.

Custom
Height

Da 70 a 999 500
Imposta l’altezza del campo di misurazione della
luce.

Custom H
Position

Da −479 a +479 ±0
Imposta la posizione orizzontale del campo di
misurazione della luce.

Custom V
Position

Da −464 a +464 ±0 Imposta la posizione verticale del campo di
misurazione della luce.
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White

Specifica le impostazioni del bilanciamento del bianco.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Preset
White

Da 2000K a 15000K 3200K Imposta il valore di preset del bilanciamento del bianco.

Color
Temp <A>

Da 2000K a 15000K 3200K

Imposta la temperatura di colore di bilanciamento del bianco salvata nella
memoria A.

Nota
Dato che Color Temp è soggetto a clipping a 2000K e 15000K mentre è
attiva la funzione R Gain/B Gain, il valore visualizzato di Color Temp
potrebbe non essere quello corretto per il valore di R Gain/B Gain.

Tint<A> Da −99 a +99 ±0

Imposta il valore del tono di colore (Tint) salvato nella memoria del bianco
A.

Nota

Poiché Tint è soggetto a clipping a ±99 mentre è attiva la funzione R
Gain/B Gain, il valore visualizzato di tono di colore per il valore di R Gain/B
Gain potrebbe non essere quello corretto.

R Gain
<A>

Da −99.0 a +99.0 ±0.0
Imposta il valore di guadagno R del bilanciamento del bianco salvato
nella memoria A.

B Gain
<A>

Da −99.0 a +99.0 ±0.0
Imposta il valore di guadagno B del bilanciamento del bianco salvato
nella memoria A.
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White Setting

Regola le impostazioni del bilanciamento del bianco.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Shockless
White

Off / 1 / 2 / 3 2

Imposta la velocità di risposta del bilanciamento del bianco
quando si cambia la modalità di bilanciamento del bianco.
Off: Commutazione istantanea.
Da 1 a 3: Il passaggio avviene più lentamente (velocità minore
con numero più alto).

ATW Speed 1 / 2 / 3 / 4 / 5 3
Imposta la velocità di risposta in modalità ATW.
La velocità di risposta più veloce è 1 e la velocità di risposta più
lenta è 5.
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Offset White

Specifica le impostazioni di correzione (offset) del bilanciamento del bianco.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Offset White <A> On / Off Off
Seleziona se aggiungere (On) o non aggiungere (Off) un valore di
correzione al valore di bilanciamento del bianco della memoria A.

Offset Color
Temp<A>

Da −99 a +99 ±0
Imposta la correzione della temperatura di colore da aggiungere
al bilanciamento del bianco della memoria A quando [Offset
White <A>] è impostato su On.

Offset Tint<A> Da −99 a +99 ±0
Imposta la correzione del valore del tono di colore Tint da
aggiungere al bilanciamento del bianco della memoria A quando
[Offset White <A>] è impostato su On.

Offset
White<ATW>

On / Off On
Specifica se aggiungere (On) o non aggiungere (Off) un valore di
correzione al bilanciamento del bianco ATW.

Offset Color
Temp<ATW>

Da −99 a +99 ±0
Imposta la correzione della temperatura di colore da aggiungere
al bilanciamento del bianco ATW quando [Offset White<ATW>] è
impostato su On.

Offset
Tint<ATW>

Da −99 a +99 ±0
Imposta la correzione del valore del tono di colore (Tint) da
aggiungere al bilanciamento del bianco ATW quando [Offset
White<ATW>] è impostato su On.
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Focus

Consente di specificare le impostazioni relative alla messa a fuoco.

Argomento correlato
Impostazione dell’area di messa a fuoco automatica e della sua posizione (Focus Area)

Seguimento con la funzione di rilevamento del viso e degli occhi (Face/Eye Detection AF)
Selezione manuale del soggetto della messa a fuoco (AF Assist) tramite l’app Web

Messa a fuoco manuale durante la messa a fuoco automatica utilizzando il telecomando a infrarossi fornito in dotazione

Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

AF Transition
Speed

1(Slow) / 2 / 3 / 4 / 5
/ 6 / 7(Fast)

5
Specifica la velocità dell’azionamento del sistema di messa a fuoco
quando il soggetto cambia durante la messa a fuoco automatica.

AF Subj.
Shift Sens.

1(Locked On) / 2 / 3
/ 4 / 5(Responsive)

5(Responsive)
Imposta la sensibilità al cambiamento del soggetto durante la messa a
fuoco automatica.

Focus Area
Wide / Zone /
Flexible Spot

Wide

Specifica la zona di messa a fuoco per le funzioni di messa a fuoco
automatica e Push Auto Focus (AF).

Vedere “Regolazione automatica della messa a fuoco (Auto Focus)”
e “Impostazione dell’area di messa a fuoco automatica e della sua
posizione (Focus Area)”.

Wide: Cerca il soggetto su un ampio angolo dell’immagine durante la
messa a fuoco.
Zone: Cerca automaticamente un punto di messa a fuoco all’interno
della zona specificata.
Flexible Spot: Mette a fuoco una posizione specificata dell’immagine.

Focus Area
(AF-S)

Flexible Spot Flexible Spot Specifica la zona di messa a fuoco per la funzione Push Auto Focus
(AF-S).

Face/Eye
Detection AF

Face/Eye Only AF /
Face/Eye Priority AF
/ Off

Face/Eye Priority
AF

Abilita o disabilita la modalità AF con rilevamento del viso.
Vedere “Seguimento con la funzione di rilevamento del viso e degli
occhi (Face/Eye Detection AF)”.

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Imposta la modalità di messa a fuoco automatica Push.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Imposta la modalità di funzionamento quando viene toccata l’immagine
della telecamera nella schermata delle operazioni live dell’app Web in
modalità MF.

AF Assist On / Off On

Quando è impostato su On, consente di ignorare momentaneamente la
funzione di messa a fuoco automatica ed eseguire la messa a fuoco
manualmente.

Vedere “Selezione manuale del soggetto della messa a fuoco (AF
Assist) tramite l’app Web” e “Messa a fuoco manuale durante la
messa a fuoco automatica utilizzando il telecomando a infrarossi
fornito in dotazione”.
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S&Q Motion

Consente di specificare le impostazioni relative alla modalità Slow & Quick Motion (vedere “Slow & Quick Motion”).

Argomento correlato
Slow & Quick Motion
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Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Setting On / Off Off Attiva o disattiva la modalità Slow & Quick Motion.

Frame
Rate

Da 1fps a 60fps / 100fps / 120fps /
150fps / 180fps / 200fps / 240fps

–

Imposta la frequenza fotogrammi per le riprese in
modalità Slow & Quick Motion.

Nota

I valori disponibili variano a seconda di frequenza di
sistema, codec e formato video selezionati.
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LUT On/Off

Consente di specificare le impostazioni relative alla LUT.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

SDI MLUT On / MLUT Off MLUT Off
Seleziona se applicare la Monitor LUT al video in
uscita su SDI.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Seleziona se applicare la Monitor LUT al video in
uscita su HDMI e in streaming.

Proxy MLUT On / MLUT Off MLUT Off
Seleziona se applicare la Monitor LUT al video di
registrazione proxy.

Internal Rec MLUT On / MLUT Off MLUT Off
Seleziona se applicare la Monitor LUT al video di
registrazione principale.

LUT On/Off Button
Target

SDI / HDMI/Stream / SDI &
HDMI/Stream

HDMI/Stream
Specifica l’uscita controllata da un pulsante
programmabile a cui è assegnato LUT On/Off.
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Noise Suppression

Consente di specificare le impostazioni relative alla soppressione del rumore.

Suggerimento

Le impostazioni di [Setting(Custom)] e [Level(Custom)] sono riflesse nell’impostazione di [Target Display].
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting(Custom) On / Off On
Attiva o disattiva la soppressione del rumore in
modalità Custom.

Level(Custom) Low / Mid / High Mid
Imposta il livello di soppressione del rumore in
modalità Custom.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Attiva o disattiva la funzione di soppressione del
rumore in modalità di ripresa Log.

Level (Cine EI/Flex.
ISO)

Low / Mid / High Mid
Imposta il livello di soppressione del rumore in
modalità di ripresa Log.
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Flicker Reduce

Consente di specificare le impostazioni relative alla correzione dello sfarfallio.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Mode Auto / On / Off Off Imposta la modalità di correzione dello sfarfallio.

Frequency 50Hz / 60Hz 60Hz
Consente di specificare la frequenza della sorgente di
alimentazione del dispositivo di illuminazione che causa lo
sfarfallio.
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SteadyShot

Consente di specificare le impostazioni relative alla stabilizzazione dell’immagine.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting Active / Standard / Off Off

Imposta la funzione di stabilizzazione dell’immagine.

Nota
Disponibile quando è montato un obiettivo compatibile.

Nelle impostazioni Active e Standard, potrebbero verificarsi
comportamenti anomali durante i movimenti di pan e tilt.

317



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Base Setting

Consente di specificare le impostazioni di base.

Argomento correlato
Configurazione delle operazioni di base
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Imposta la modalità di ripresa.
Vedere “Impostazione della modalità di ripresa” in
“Configurazione delle operazioni di base”.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Imposta il gamut di colore della registrazione o uscita in
modalità Custom.
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Rec Format

Consente di specificare le impostazioni relative al formato di registrazione.

Impostazioni di [RAW Output Format]

I valori predefiniti sono indicati in grassetto.
Sono state omesse le condizioni in cui non è possibile impostare [RAW Output Format].

Impostazioni di [Video Format]

Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Seleziona la frequenza di sistema.

Imager Scan
Mode

FF / S35 FF Seleziona le dimensioni dell’imager.

Codec RAW / RAW & XAVC-I / XAVC-I / XAVC-L XAVC-I

Imposta la modalità di registrazione e
riproduzione dei clip.

Nota
Quando [Imager Scan Mode] è impostato su
[S35], non è possibile selezionare [RAW] e
[RAW & XAVC-I].

RAW Output
Format

Le impostazioni disponibili variano a
seconda dell’impostazione di [Frequency].

Vedere “Impostazioni di [RAW Output
Format]” di seguito.

–

Imposta le dimensioni dell’immagine RAW da
inviare a un registratore RAW esterno.

Nota
Quando [Codec] è impostato su [RAW &
XAVC-I], il valore di [Video Format] cambia in
sincronia con l’impostazione di [RAW Output
Format].

Video
Format

Le opzioni di impostazione disponibili
variano a seconda delle impostazioni di
[Frequency], [Imager Scan Mode] e [Codec].

Vedere “Impostazioni di [Video Format]”
di seguito.

– Imposta il bit rate e le dimensioni dell’immagine.

Frequency Imager Scan Mode Codec Impostazione

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Frequency Imager Scan Mode Codec Impostazione

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Specifica le impostazioni della modalità di ripresa Log (vedere “Impostazione della modalità di ripresa” in “Configurazione delle
operazioni di base”).

Argomento correlato
Configurazione delle operazioni di base
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Imposta il gamut di colore per le modalità di ripresa Log
([Flexible ISO], [Cine EI Quick], [Cine EI]).

Embed
LUT File

On / Off On
Attiva o disattiva la registrazione dei metadati del file 3D
LUT (file CUBE).
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Simul Rec

Specifica le impostazioni della modalità di registrazione simultanea su 2 slot (vedere “Registrazione simultanea sulle schede di
memoria A e B (Simul Rec su 2 slot)”).
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Setting On / Off Off
Attiva o disattiva la modalità di
registrazione su 2 slot.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec Button:<Slot
A> <Slot B> / Rec Button:<Slot A> 2nd Rec Button:
<Slot B> / Rec Button:<Slot B> 2nd Rec Button:<Slot
A>

Rec Button:<Slot A> <Slot
B> 2nd Rec Button:<Slot
A> <Slot B>

Seleziona i pulsanti utilizzati per
controllare la registrazione sui vari
supporti di registrazione.
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Proxy Rec

Configura le impostazioni della modalità di registrazione proxy (vedere “Registrazione proxy”).
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting On / Off Off
Attiva o disattiva la modalità di registrazione
proxy.

Audio
Channel

CH1/CH2 / CH3/CH4 CH1/CH2
Seleziona il canale audio da registrare sui dati
proxy.
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Interval Rec

Configura le impostazioni della modalità di registrazione a intervalli (vedere “Registrazione di video a intervalli (Interval Rec)”).
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Setting On / Off Off

Attiva o disattiva la modalità di registrazione
a intervalli. (Impostando questa modalità su
On, tutte le altre modalità speciali vengono
impostate su Off).

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 /
30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 /
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (ora)

1
Imposta l’intervallo fra registrazioni nella
modalità di registrazione Interval Rec
(Interval Rec impostata su On).

Number of
Frames

1frame / 2frames / 3frames / 6frames /
9frames / 12frames
I valori disponibili variano a seconda della
frequenza fotogrammi del formato video
selezionato.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Imposta il numero di fotogrammi da registrare
in ciascuna ripresa nella modalità di
registrazione Interval Rec (Interval Rec
impostata su On).
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Picture Cache Rec

Configura le impostazioni della modalità di registrazione cache immagine (vedere “Registrazione di immagini preregistrate nella cache
(Picture Cache Rec)”).

Argomento correlato
Registrazione di immagini preregistrate nella cache (Picture Cache Rec)
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Setting On / Off Off Attiva o disattiva la funzione di cache immagine.

Cache Size
Short / Medium / Long /
Max

Max
Specifica il tempo di accumulo delle immagini nella memoria cache
immagine (il tempo di registrazione della cache immagine).

Cache Rec
Time

– –
Indica il tempo di accumulo delle immagini nella memoria cache
immagine (il tempo di registrazione della cache immagine).
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SDI/HDMI Rec Control

Consente di specificare le impostazioni relative alla registrazione SDI/HDMI.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Setting
Off / SDI/HDMI
Remote I/F / Parallel
Rec

Off

Configura l’avvio e l’arresto della registrazione su un dispositivo esterno,
collegato all’unità, tramite i segnali di uscita SDI/HDMI.
Off: Comando a distanza disabilitato.
SDI/HDMI Remote I/F: Comando di avvio e arresto registrazione di un
dispositivo esterno collegato, quando non è inserito nessun supporto di
memoria nell’unità. Non sincronizzato con precisione di fotogramma con i
supporti di memoria dell’unità.
Parallel Rec: Comando di avvio e arresto registrazione di un dispositivo
esterno collegato, quando è presente un supporto di memoria sull’unità.
Sincronizzato con precisione di fotogramma con i supporti di memoria
dell’unità.

Nota

Per il comando tramite il segnale di uscita HDMI, impostare [TC/Media] > [HDMI
TC Out] > [Setting] su [On] nel menu della telecamera.
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Assignable Button

Assegna le funzioni desiderate ai pulsanti programmabili (da <1> a <9>) e al pulsante [Focus Hold Button].
Possono essere assegnate le funzioni indicate di seguito.
[Off]: Nessuna funzione assegnata.
[Base ISO/Sensitivity]: Commuta la sensibilità di base del sensore immagine.
[AGC]: Attiva o disattiva la funzione AGC.
[Push AGC]: Attiva la funzione AGC mentre si tiene premuto il pulsante.
[ND Filter]

In modalità Variable: Regola la trasmittanza del filtro ND. Mantenere premuto per passare in sequenza da Clear a Manual a Auto.
In modalità Preset: Mantenere premuto per passare da un preset all’altro.

[ND Filter Position]: Consente di scegliere il filtro ND.
[Auto ND Filter]: Attiva o disattiva la funzione di filtro ND automatico.
[Push Auto ND]: Attiva la funzione di filtro ND automatico mentre si tiene premuto il pulsante.
[Auto Iris]: Attiva o disattiva la funzione del diaframma.
[Push Auto Iris]: Attiva la funzione di diaframma automatico mentre si tiene premuto il pulsante.
[Bokeh Control]: Attiva o disattiva la modalità di controllo del bokeh.
[Auto Shutter]: Attiva o disattiva la funzione di otturatore automatico.
[AE Level/Mode]: Regola il livello di esposizione automatica AE. Mantenere premuto per passare da una modalità AE all’altra.
[Backlight]: Passa da Backlight a Standard e viceversa.
[Spotlight]: Passa da Spotlight a Standard e viceversa.
[Preset White Select]: Seleziona il valore della modalità di preset del bilanciamento del bianco.
[ATW]: Attiva o disattiva la funzione ATW.
[ATW Hold]: Sospende la funzione ATW.
[AF Speed/Sens.]: Seleziona la velocità di transizione AF e della sensibilità al cambiamento del soggetto AF.
[Focus Setting]: Configura l’area di messa a fuoco.
[Face/Eye Detection AF]: Seleziona le impostazioni di messa a fuoco automatica con rilevamento del viso.
[Push AF Mode]: Seleziona l’impostazione della modalità Push AF.
[Push AF/MF]: In modalità di messa a fuoco MF, attiva la modalità AF mentre il pulsante viene mantenuto premuto. In modalità di
messa a fuoco AF, attiva la modalità MF mentre il pulsante viene mantenuto premuto.
[Focus Hold]: In modalità di messa a fuoco AF, fissa la messa a fuoco mentre il pulsante viene mantenuto premuto.
[S&Q Motion]: Attiva o disattiva la funzione Slow & Quick Motion. Se mantenuto premuto, imposta la frequenza fotogrammi di ripresa.
[LUT On/Off]: Attiva o disattiva la funzione LUT. L’opzione attivata è specificata utilizzando [Shooting] > [LUT On/Off] > [LUT On/Off
Button Target].
[SteadyShot]: Passa in sequenza da Active a Standard a Off.
[Crop Select]: Commuta Imager Scan Mode. La selezione è abilitata all’interno del campo senza modificare il formato di registrazione.
[Rec]: Avvia o arresta la registrazione.
[Picture Cache Rec]: Attiva o disattiva la modalità di registrazione cache immagine.
[Rec Review]: Attiva o disattiva la funzione di revisione della registrazione.
[Clip Flag OK]: Esegue Add OK. Premere due volte per eseguire Delete Clip Flag.
[Clip Flag NG]: Esegue Add NG. Premere due volte per eseguire Delete Clip Flag.
[Clip Flag Keep]: Esegue Add KEEP. Premere due volte per eseguire Delete Clip Flag.
[Slot Select]: Passa dallo slot per schede di memoria (A) allo slot per schede di memoria (B) e viceversa.
[Color Bars]: Attiva o disattiva la barra colori.
[DURATION/TC/U-BIT]: Passa in sequenza da Time Code a Users Bit a Duration.
[Display]: Attiva o disattiva la visualizzazione degli indicatori a schermo.
[Lens Info]: Specifica la modalità dell’indicatore della profondità di campo.
[Video Signal Monitor]: Attiva in sequenza una modalità di monitor del segnale video (ad esempio il monitor della forma d’onda).
[Marker]: Attiva o disattiva la funzione Marker.
[Thumbnail]: Apre o chiude la schermata delle miniature.
[Auto Upload (Proxy)]: Attiva o disattiva il trasferimento automatico dei file proxy.
[Direct Menu]: Visualizza o chiude il Direct Menu.
[User Menu]: Visualizza o chiude il menu User.
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Scene File

Consente di specificare impostazioni relative ai file di scena (vedere “Ripresa con il look desiderato”).
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Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Recall – –

Carica un file di scena memorizzato nella
memoria interna e ne applica le impostazioni
come impostazioni attive per la qualità
dell’immagine.

Store – –
Salva in un file di scena nella memoria interna
lo stato corrente delle impostazioni relative alla
qualità dell’immagine.

Delete – –
Elimina un file di scena memorizzato nella
memoria interna.

Preset
Recall

Quando Shooting Mode è impostato su
Custom e Target Display è impostato su
SDR(BT.709): S-Cinetone / Standard / Still /
ITU709/ 709tone
Quando Shooting Mode è impostato su
Custom e Target Display è impostato su
HDR(HLG): HLG Live / HLG Natural

–
Applica valori preconfigurati delle impostazioni
di qualità dell’immagine (non riscrivibili) alle
impostazioni di qualità dell’immagine correnti.
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Base Look

Consente di specificare impostazioni relative al look di base.
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Select

Quando Shooting Mode è impostato su
Custom e Target Display è impostato su
SDR(BT.709): S-Cinetone / Standard / Still /
ITU709 / 709tone / da User1 a User16
Quando Shooting Mode è impostato su
Custom e Target Display è impostato su
HDR(HLG): HLG Live / HLG Natural / da User1
a User16
Quando Shooting Mode è impostato su una
modalità di ripresa Log: s709 / 709(800) / S-
Log3 / da User1 a User16

Quando Shooting Mode è
impostato su Custom e Target
Display è impostato su
SDR(BT.709): S-Cinetone
Quando Shooting Mode è
impostato su Custom e Target
Display è impostato su HDR(HLG):
HLG Live
Quando Shooting Mode è
impostato su una modalità di
ripresa Log: s709

Seleziona un look di base.

Delete – –
Elimina il look di base
selezionato.

Delete
All

– – Elimina tutti i look di base.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 S-Gamut3.Cine/SLog3

Imposta la gamma di
ingresso per il look di base
selezionato utilizzando
[Select].

Output BT.709 / HLG BT.709

Imposta il gamut di colore di
uscita del look di base
selezionato utilizzando
[Select].

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 5/3EV / 2EV 0EV

Imposta il valore di
riferimento per l’esposizione
del look di base selezionato
utilizzando [Select].
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Reset Paint Settings

Resetta le impostazioni del menu [Paint/Look], con l’esclusione del look di base.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Reset without
Base Look

Execute / Cancel –
Resetta le impostazioni del menu [Paint/Look], con
l’esclusione del look di base.
Execute: Esegue la funzione.
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Black

Consente di specificare le impostazioni relative al nero.
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Master Black Da −99.0 a +99.0 ±0.0 Imposta il livello del nero master.

R Black Da −99.0 a +99.0 ±0.0 Imposta il livello R del nero.

B Black Da −99.0 a +99.0 ±0.0 Imposta il livello B del nero.
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Knee

Consente di specificare le impostazioni relative alla correzione del knee.
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Voce Impostazione della voce
secondaria Impostazione predefinita Descrizione

Setting

Quando Target Display è
impostato su SDR(BT.709): On
/ Off / ---
Quando Target Display è
impostato su HDR(HLG): On /
Off / ---

Quando Target Display è
impostato su SDR(BT.709): Off
Quando Target Display è
impostato su HDR(HLG): Off

Attiva o disattiva la funzione di correzione del
knee.

Nota

Abilitato solo quando [Base Look] > [Select] è
impostato su [Standard], [ITU709], [709tone],
[HLG Live] o [HLG Natural].

Auto
Knee

Quando Target Display è
impostato su SDR(BT.709): On
/ Off / ---
Quando Target Display è
impostato su HDR(HLG): On /
Off / ---

Quando Target Display è
impostato su
SDR(BT.709): On
Quando Target Display è
impostato su HDR(HLG): Off

Attiva o disattiva la funzione di correzione del
knee automatica.

Nota

Abilitato solo quando [Base Look] > [Select] è
impostato su [Standard], [ITU709] o [709tone].

Point 75%-109% 90% Imposta il punto knee.

Slope Da −99 a +99 ±0 Imposta la pendenza del knee.
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Detail

Specifica le impostazioni di regolazione del dettaglio.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Setting On / Off On Attiva o disattiva la funzione di regolazione del dettaglio.

Level Da −7 a +7 ±0 Imposta il livello del dettaglio.

Manual
Setting

On / Off / --- Off Attiva o disattiva la funzione di regolazione manuale del dettaglio.

H/V Ratio Da −2 a +2 ±0

Imposta il bilanciamento tra il dettaglio orizzontale (H) e il dettaglio
verticale (V) per la regolazione manuale del dettaglio.

Nota

Questa voce varia a seconda della versione del software.*1

B/W
Balance

Type1 / Type2 / Type3
/ Type4 / Type5

Type3
Imposta il bilanciamento tra il dettaglio del nero (B) per le zone a bassa
luminanza e il dettaglio del bianco (W) per le zone ad alta luminanza
nella regolazione manuale del dettaglio.

Limit Da 0 a 7 7
Imposta il livello di limite del dettaglio per la regolazione manuale del
dettaglio.

Crispening Da 0 a 7 0
Imposta il livello di miglioramento della nitidezza per la regolazione
manuale del dettaglio.

High Light
Detail

Da 0 a 4 0
Imposta il livello di dettaglio per le zone ad alta luminanza nella
regolazione manuale del dettaglio.

Nel software versione 1.00, la voce di menu è denominata [V/H Balance]. A partire dalla versione software 1.10, la voce di menu è denominata [H/V Ratio].
L’intervallo di impostazione è invariato, da −2 a 0 a +2, tuttavia, l’effetto sulla qualità dell’immagine è diverso.
Versione software 1.00: maggiore è il valore impostato, maggiore è il dettaglio orizzontale (H).
Versione software 1.10 o successiva: maggiore è il valore impostato, maggiore è il dettaglio verticale (V).
Dopo l’aggiornamento del software dalla versione 1.00 alla versione 1.10 o successiva, le impostazioni [All File], [Scene File] ed altre vengono ereditate ma con
polarità invertita (la qualità dell’immagine viene mantenuta).
Se era stata registrata nel menu [User], la voce di menu [V/H Balance] verrà sostituita automaticamente con la voce [H/V Ratio] nel menu [User] dopo
l’aggiornamento del software.

*1
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Matrix

Consente di specificare le impostazioni relative alla correzione della matrice.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

User Matrix On / Off Off
Attiva o disattiva la funzione di matrice
dell’utente.

User Matrix
Level

Da −99 a +99 ±0
Regola la saturazione del colore dell’intera
immagine.

User Matrix
Phase

Da −99 a +99 ±0
Regola il tono di colore (la fase) dell’intera
immagine.

User Matrix R-G Da −99 a +99 ±0 Imposta una matrice R-G definita dall’utente.

User Matrix R-B Da −99 a +99 ±0 Imposta una matrice R-B definita dall’utente.

User Matrix G-R Da −99 a +99 ±0 Imposta una matrice G-R definita dall’utente.

User Matrix G-B Da −99 a +99 ±0 Imposta una matrice G-B definita dall’utente.

User Matrix B-R Da −99 a +99 ±0 Imposta una matrice B-R definita dall’utente.

User Matrix B-G Da −99 a +99 ±0 Imposta una matrice B-G definita dall’utente.
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Multi Matrix

Consente di specificare le impostazioni relative alla correzione multimatrice.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting On / Off Off Attiva o disattiva la correzione multimatrice.

Area
Indication

On / Off Off

Attiva o disattiva la funzione di visualizzazione che
identifica l’area di target corrispondente all’asse del colore
target da regolare selezionato in [Axis].
Le parti dell’immagine acquisita al di fuori dell’area di
target sono visualizzate in monocromia.

Suggerimento
Nella schermata di configurazione della correzione
multimatrice, è possibile attivare o disattivare [Area
Indication] utilizzando il pulsante [Display].

Nota

[Area Indication] viene applicato a tutte le uscite video.
Tenere presente questo fatto quando si utilizza un segnale
di uscita video come segnale principale.

Area
Indication
Control

Menu Only / Menu & RCP Menu Only Specifica l’interfaccia che può controllare [Area Indication].

Reset Execute / Cancel –
Ripristina i valori predefiniti di tonalità (hue) e saturazione
del colore di ciascun asse.

Axis
B / B+ / MG− / MG / MG+ / R / R+
/ YL− / YL / YL+ / G− / G / G+ /
CY / CY+ / B−

B Seleziona l’asse.

Hue Da −99 a +99 ±0
Imposta la tonalità (hue) del colore per la correzione
multimatrice.

Saturation Da −99 a +99 ±0
Imposta la saturazione del colore utilizzato per la
correzione multimatrice.
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P/T Acceleration

Consente di specificare impostazioni relative all’accelerazione dei movimenti di pan e tilt.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Ramp
Curve

Da 1 a 9 8
Seleziona l’accelerazione e la decelerazione per i movimenti di pan
e tilt. Più alto il numero, maggiore l’accelerazione.
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Timecode

Consente di specificare le impostazioni relative al codice temporale.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Mode Preset / Regen / Clock Preset

Imposta la modalità di avanzamento del codice temporale.
Preset: Si avvia da un valore preimpostato.
Regen: Prosegue dal codice temporale della fine del clip
precedente.
Clock: Utilizza l’orologio interno come codice temporale.

Run Rec Run / Free Run Rec Run
Rec Run: Avanza solo durante la registrazione.
Free Run: Avanzamento costante, indipendentemente che la
registrazione sia attiva o meno.

Setting – –
Imposta il codice temporale su un valore arbitrario.
Set: Imposta il valore.

Reset Execute / Cancel –
Azzera il codice temporale (00:00:00:00).
Execute: Esegue la funzione.

TC
Format DF / NDF DF

Imposta il formato del codice temporale.
DF: Drop Frame
NDF: Non-Drop Frame
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TC Display

Consente di specificare le impostazioni di visualizzazione dei dati temporali.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Display
Select

Timecode / Users Bit / Duration Timecode
Consente di scegliere quali dati temporali devono
essere visualizzati.
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Users Bit

Consente di specificare le impostazioni relative ai bit utente.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Mode Fix / Time Fix

Imposta la modalità del bit utente.
Fix: Utilizza per i bit utente un valore fisso arbitrario.
Time: Utilizza ora, minuto e secondo correnti nei bit
utente.

Setting – – Imposta i bit utente su un valore arbitrario.
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HDMI TC Out

Consente di specificare le impostazioni relative all’uscita del codice temporale quando si utilizza HDMI.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting On / Off Off
Consente di selezionare se emettere il codice temporale ad altri
dispositivi per altri scopi, tramite HDMI.
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Clip Name Format

Configura impostazioni relative al nome e all’eliminazione di clip.
Quando [Auto Naming] è impostato su [Cam ID + Reel#], i primi quattro caratteri dei nomi dei clip vengono determinati per ciascun
supporto di registrazione. Quando viene inserito un nuovo supporto di registrazione o quando l’ultimo clip sul supporto di registrazione
non corrisponde alle impostazioni di [Camera ID] o [Reel Number], il nome del clip lampeggia per avvisare.
Quando [Auto Naming] è impostato su [Title], è possibile utilizzare una stringa di caratteri arbitraria come prima parte dei nomi dei clip.

Impostazione di [Title Prefix]

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Auto
Naming

Cam ID + Reel# / Title

Seleziona il formato del nome dei clip.
Cam ID + Reel#: Identificativo telecamera + numero bobina +
numero ripresa + data + stringa casuale
Title: Stringa arbitraria specificata da [Title Prefix] + numero clip

Camera
ID

Da A a Z A

Imposta l’ID della telecamera per la generazione del nome dei clip.

Nota
Configurabile solo quando [Auto Naming] è impostato su [Cam ID +
Reel#].

Reel
Number

Da 001 a 999 001

Imposta la porzione del numero di reel (la “bobina”) utilizzato per la
generazione del nome dei clip.

Nota
Configurabile solo quando [Auto Naming] è impostato su [Cam ID +
Reel#].

Camera
Position

C / L / R C

Imposta la stringa di caratteri della prima porzione dello Shot
Number utilizzato per la generazione del nome dei clip.

Nota

Configurabile solo quando [Auto Naming] è impostato su [Cam ID +
Reel#].

Title Prefix

nnn_(nnn indica le tre
ultime cifre del numero di
serie)
(sono visualizzate max. 7
cifre).

nnn

Imposta la sezione del titolo (da 4 a 46 caratteri) del nome del clip.
Apre una schermata per l’immissione di una stringa di caratteri.

Per informazioni dettagliate su come impostare titoli e la
schermata di immissione di testo, vedere “Impostazione del
titolo” di seguito e “Immissione di una stringa di caratteri”.

Nota
Configurabile solo quando [Auto Naming] è impostato su [Title].

Number
Set

Da 0001 a 9999 0001

Imposta il suffisso di 4 cifre aggiunto al nome del clip.

Nota

Configurabile solo quando [Auto Naming] è impostato su [Title].
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Argomento correlato
Immissione di una stringa di caratteri
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Utilizzando i pulsanti freccia del pannello dei comandi GUI, selezionare il carattere da immettere alla posizione del
cursore nella sezione [Title Prefix], scegliendolo nella sezione di selezione caratteri (il carattere selezionato viene
evidenziato), quindi confermarlo con il pulsante [Set] del pannello dei comandi GUI.

Il carattere selezionato viene inserito e il cursore si sposta verso destra.

1

Ripetere il punto 1 per impostare il titolo.

Utilizzare [BS] quando necessario.

2

Dopo aver impostato il titolo, premere il pulsante [Done] per chiudere la schermata di immissione dei caratteri.

Per informazioni dettagliate sull’utilizzo della schermata di immissione dei caratteri, vedere “Immissione di una stringa di
caratteri”.

Possono essere selezionati i seguenti caratteri:
!#$%()+,-.;=@[ ]^_~ spazio
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Aggiorna il file di gestione delle schede di memoria (vedere “Ripristino delle schede di memoria”).

Argomento correlato
Ripristino delle schede di memoria
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Media(A) Execute / Cancel –
Aggiorna il file di gestione della scheda di memoria
nello slot A.
Execute: Esegue la funzione.

Media(B) Execute / Cancel –
Aggiorna il file di gestione della scheda di memoria
nello slot B.
Execute: Esegue la funzione.
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Format Media

Formatta (inizializza) schede di memoria (vedere “Formattazione (inizializzazione) di schede di memoria”).

Argomento correlato
Formattazione (inizializzazione) di schede di memoria
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Media(A) Full Format / Quick Format / Cancel – Formatta la scheda di memoria nello slot A.

Media(B) Full Format / Quick Format / Cancel – Formatta la scheda di memoria nello slot B.
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Media Life

Visualizza la vita utile rimanente delle schede di memoria.

Nota
Richiede schede di memoria che supportino la visualizzazione della vita utile rimanente.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Media(A) – –
Visualizza la vita utile rimanente della scheda di memoria
nello slot A.

Media(B) – –
Visualizza la vita utile rimanente della scheda di memoria
nello slot B.
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Output Format

Consente di specificare le impostazioni relative al formato di uscita.

Argomento correlato
Formati di uscita e limitazioni
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Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

SDI Per informazioni dettagliate su queste impostazioni, vedere
“Formati di uscita e limitazioni”.

– Imposta la risoluzione delle uscite
SDI e HDMI.HDMI –
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Display On/Off

Consente di specificare le impostazioni di visualizzazione delle indicazioni.
Per visualizzare un’indicazione, selezionare On. Per non visualizzare un’indicazione, selezionare Off.

Voce Impostazione della voce secondaria Impostazione predefinita

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

348



5-041-957-34(1) Copyright 2022 Sony Corporation

Voce Impostazione della voce secondaria Impostazione predefinita

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Consente di configurare le impostazioni del monitor del segnale video.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting Off / Waveform / Vector / Histogram Off Imposta il tipo di monitor del segnale video.

Level Marker
1

0%-109% 70%
Imposta il livello dell’indicatore di livello di
luminanza 1.

Level Marker
2

0%-109% 100%
Imposta il livello dell’indicatore di livello di
luminanza 2.
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Marker

Consente di specificare le impostazioni relative alla visualizzazione degli indicatori.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting On / Off On Attiva o disattiva la visualizzazione di tutti gli indicatori.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Seleziona il colore del segnale dell’indicatore.

Center
Marker

1 / 2 / 3 / 4 / Off Off Seleziona l’indicatore del centro immagine.

Safety Zone On / Off Off Attiva o disattiva la visualizzazione dell’indicatore della
zona di sicurezza.

Safety Area 80% / 90% / 92.5% / 95% 90%
Seleziona le dimensioni dell’indicatore della zona di
sicurezza (come percentuale delle dimensioni totali
dello schermo).

Aspect
Marker

Line / Mask / Off Off Seleziona il tipo di indicatore di aspetto.

Aspect
Mask

Da 0 a 15 12
Imposta il livello del segnale video all’esterno
dell’indicatore.

Aspect
Safety Zone

On / Off Off
Attiva o disattiva la visualizzazione della zona di
sicurezza di aspetto.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Seleziona le dimensioni dell’indicatore della zona di
sicurezza di aspetto come percentuale delle dimensioni
totali dello schermo.

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 /
17:9 / 1.66:1 / 1.85:1 / 2.35:1 / 2.39:1
/ Custom

2.39:1
Imposta la modalità di visualizzazione dell’indicatore di
aspetto.

Custom
Aspect
Ratio

Consente di specificare un valore
desiderato.

01.00:01.00

Imposta il rapporto di aspetto su un valore arbitrario.

Nota
Abilitato quando [Aspect Select] è impostato su
[Custom].

Guide
Frame

On / Off Off
Attiva o disattiva la visualizzazione del riquadro di
guida.

100%
Marker

On / Off Off
Attiva o disattiva la visualizzazione dell’indicatore
100%.

User Box On / Off Off Attiva o disattiva la visualizzazione del riquadro utente.

User Box
Width

Da 3 a 479 240
Specifica la larghezza del riquadro utente (distanza dal
centro ai bordi destro e sinistro).

User Box
Height

Da 3 a 269 135
Specifica l’altezza del riquadro utente (distanza dal
centro ai bordi superiore e inferiore).
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

User Box H
Position

Da −476 a +476 0
Specifica la posizione orizzontale del centro del
riquadro utente.

User Box V
Position

Da −266 a +266 0
Specifica la posizione verticale del centro del riquadro
utente.
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Audio Input

Consente di specificare le impostazioni relative all’ingresso audio.

Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

AUDIO IN
Select

MIC / LINE MIC Seleziona il tipo di dispositivo collegato al connettore AUDIO IN.

Phantom
Power +48V

On / Off Off Visualizza lo stato dell’alimentazione phantom a +48 V.

CH1 Input
Select

AUDIO IN CH1 AUDIO IN CH1 Visualizza la sorgente di ingresso per la registrazione sul canale 1.

CH2 Input
Select

AUDIO IN CH1 / AUDIO
IN CH2

AUDIO IN CH2 Seleziona la sorgente di ingresso per la registrazione sul canale 2.

CH3 Input
Select

Off / AUDIO IN CH1 AUDIO IN CH1 Seleziona la sorgente di ingresso per la registrazione sul canale 3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2 Seleziona la sorgente di ingresso per la registrazione sul canale 4.

AUDIO IN
CH1 MIC Ref.

−80dB / −70dB / −60dB
/ −50dB / −40dB /
−30dB

−50dB
Imposta il livello di riferimento di registrazione dell’ingresso
microfono XLR da AUDIO IN CH1.

AUDIO IN
CH2 MIC Ref.

−80dB / −70dB / −60dB
/ −50dB / −40dB /
−30dB

−50dB
Imposta il livello di riferimento di registrazione dell’ingresso
microfono XLR da AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Seleziona il livello di riferimento di ingresso quando [AUDIO IN
Select] è impostato su LINE.

Reference
Level

−20dB / −18dB / −16dB
/ −12dB / EBUL

−20dB
Seleziona il livello di registrazione del segnale di tono di riferimento
a 1 kHz.

CH1 Wind
Filter

On / Off Off
Abilita o disabilita il filtro di riduzione del rumore del vento per la
registrazione del canale 1.

CH2 Wind
Filter

On / Off Off
Abilita o disabilita il filtro di riduzione del rumore del vento per la
registrazione del canale 2.

CH3 Wind
Filter

On / Off Off
Abilita o disabilita il filtro di riduzione del rumore del vento per la
registrazione del canale 3.

CH4 Wind
Filter

On / Off Off
Abilita o disabilita il filtro di riduzione del rumore del vento per la
registrazione del canale 4.

CH1 Level
Control

Auto / Manual Auto
Seleziona la regolazione automatica o manuale del livello di
ingresso audio per la registrazione sul canale 1.

CH2 Level
Control

Auto / Manual Auto
Seleziona la regolazione automatica o manuale del livello di
ingresso audio per la registrazione sul canale 2.

CH3 Level
Control

Auto / Manual Auto
Seleziona la regolazione automatica o manuale del livello di
ingresso audio per la registrazione sul canale 3.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

CH4 Level
Control

Auto / Manual Auto
Seleziona la regolazione automatica o manuale del livello di
ingresso audio per la registrazione sul canale 4.

CH1 Input
Level

Da 0 a 99 49 Imposta il livello di ingresso per la registrazione sul canale 1.

CH2 Input
Level

Da 0 a 99 49 Imposta il livello di ingresso per la registrazione sul canale 2.

CH3 Input
Level

Da 0 a 99 49 Imposta il livello di ingresso per la registrazione sul canale 3.

CH4 Input
Level

Da 0 a 99 49 Imposta il livello di ingresso per la registrazione sul canale 4.

Master Input
Level

Da 0 a 99 99 Specifica il livello di ingresso audio master.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB / −17dB

Off
Seleziona la caratteristica di limitazione per i segnali di ingresso di
livello elevato quando il livello di ingresso audio viene regolato
manualmente.

CH1&2 AGC
Mode

Mono / Stereo Stereo
Imposta la modalità di regolazione livello automatica per la
registrazione sui canali 1 e 2. Quando è selezionato Stereo, la
regolazione AGC agisce contemporaneamente sui due canali.

CH3&4 AGC
Mode

Mono / Stereo Stereo
Imposta la modalità di regolazione livello automatica per la
registrazione sui canali 3 e 4. Quando è selezionato Stereo, la
regolazione AGC agisce contemporaneamente sui due canali.

AGC Spec
−6dB / −9dB / −12dB /
−15dB / −17dB

−6dB Seleziona la caratteristica AGC.

1kHz Tone on
Color Bars

On / Off Off

Attiva o disattiva l’emissione del segnale di tono di riferimento a 1
kHz durante la visualizzazione delle barre colore.

Nota
Se impostato su [On], viene impostato il segnale del tono di
riferimento a 1 kHz per la registrazione sui canali 3 e 4, anche se
[CH3 Input Select] e [CH4 Input Select] sono impostati su [Off].
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Audio Output

Consente di specificare le impostazioni relative all’uscita audio.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

HDMI/Stream
Output CH

CH1/CH2 / CH3/CH4 CH1/CH2
Imposta la combinazione dei canali audio sulle
uscite HDMI e streaming.
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Display Clip Properties

Visualizza la schermata delle proprietà dei clip.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Display Clip
Properties

– –
Visualizza la schermata delle proprietà dei
clip.
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Set Clip Flag

Consente di specificare le impostazioni relative ai flag dei clip.
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Add OK – – Aggiunge un flag OK.

Add NG – – Aggiunge un flag NG.

Add KEEP – – Aggiunge un flag KEEP.

Delete Clip Flag – – Elimina tutti i flag.
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Lock/Unlock Clip

Consente di specificare le impostazioni relative alla protezione dei clip.
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Select Clip – – Seleziona e blocca/sblocca un clip.

Lock All Clips – – Blocca tutti i clip.

Unlock All Clips – – Sblocca tutti i clip.
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Delete Clip

Elimina clip.
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Select Clip – – Elimina il clip selezionato.

All Clips – – Elimina tutti i clip.
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Transfer Clip

Trasferisce clip.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Select
Clip

– – Trasferisce i clip selezionati.

All Clips – –

Trasferisce tutti i clip.

Nota

Possono essere registrati fino a 200
trasferimenti.
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Transfer Clip (Proxy)

Trasferisce clip proxy.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Select
Clip

– –
Trasferisce i clip proxy corrispondenti ai clip
selezionati.

All Clips – –

Trasferisce i clip proxy corrispondenti a tutti i clip.

Nota

Possono essere registrati fino a 200 trasferimenti.
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Filter Clips

Consente di specificare le impostazioni relative ai clip da visualizzare.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

OK – – Visualizza solo i clip che contengono un flag OK.

NG – – Visualizza solo i clip che contengono un flag NG.

KEEP – – Visualizza solo i clip che contengono un flag KEEP.

None – – Visualizza solo i clip che non contengono nessun flag.

All – –
Visualizza tutti i clip, indipendentemente dalla presenza o
meno di flag.
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Customize View

Consente di scegliere la visualizzazione delle miniature.
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Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Seleziona le informazioni visualizzate
sotto le miniature.
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Color Bars

Consente di specificare le impostazioni della barra colori.
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Setting On / Off Off Attiva o disattiva la barra colori.

Type ARIB / 100% / 75% / SMPTE ARIB Seleziona il tipo di barra colori.
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Genlock

Configura la visualizzazione dello stato di genlock (vedere “Sincronizzazione della fase del segnale video (Genlock)”).

Argomento correlato
Sincronizzazione della fase del segnale video (Genlock)
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Reference Internal / External(HD) / External(SD) –
Visualizza il tipo di segnale di riferimento
genlock.
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Tally

Configura le impostazioni dell’indicatore di registrazione/tally (vedere “Connessione di un segnale di tally”).

Argomento correlato
Connessione di un segnale di tally
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Tally Lamp
Brightness

High / Low / Off High Imposta la luminosità dell’indicatore di registrazione/tally.

G Tally Lamp Enable / Disable Enable Abilita o disabilita l’indicatore di tally G.

Tally Control External / Internal / PTZ
AFR

Internal

Seleziona da dove accettare le informazioni di controllo
dell’indicatore di registrazione/tally dell’unità.
External: Controllo tally dall’esterno della telecamera.
Internal: Controllo tramite le operazioni di registrazione
della telecamera.
PTZ AFR: Controllo tramite stato operativo di PTZ AFR.
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Rec Review

Configura le impostazioni di revisione della registrazione (vedere “Rivedere una registrazione (Rec Review)”).

Argomento correlato
Rivedere una registrazione (Rec Review)
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting 3s / 10s / Clip 3s
Specifica la durata della riproduzione dei clip appena registrati
per la loro revisione.
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Zoom

Consente di specificare impostazioni relative allo zoom (“Regolazione dello zoom”).
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only Imposta il tipo di zoom.
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Lens

Consente di specificare le impostazioni relative agli obiettivi.

Argomento correlato
Compensazione dell’effetto breathing
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Lens Calibration Execute / Cancel –
Esegue la funzione che corregge le differenze nella posizione
dello zoom dovute alle differenze dei singoli obiettivi quando si
utilizza un obiettivo con zoom motorizzato.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Imposta la direzione della ghiera dello zoom.

Nota
Abilitato solo quando si utilizza un obiettivo con innesto E-mount
che consente la scelta della direzione di azionamento della
ghiera dello zoom.

Shading
Compensation

Auto / Off Auto Imposta la compensazione automatica dello shading.

Chroma
Aberration Comp.

Auto / Off Auto
Imposta la compensazione automatica dell’aberrazione
cromatica.

Distortion Comp. Auto / Off Auto Imposta la compensazione automatica della distorsione.

Breathing
Compensation

Auto / Off Off
Imposta la compensazione dell’effetto breathing dell’obiettivo.

Vedere “Compensazione dell’effetto breathing”.

Distance Display Meter / Feet Meter
Specifica le unità di misura visualizzate per informazioni
sull’obiettivo e sulla posizione di messa a fuoco.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length
Specifica il formato di visualizzazione della posizione dello
zoom.
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APR

Esegue la funzione APR.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

APR Execute / Cancel –

Esegue la funzione APR di ricostruzione automatica pixel per la
regolazione automatica del sensore di immagine.
Execute: Esegue la funzione.

Nota

Montare sempre il coperchietto dell’obiettivo prima di eseguire la
funzione APR.
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Wired LAN

Consente di specificare le impostazioni relative alle connessioni su LAN cablata.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

HTTP Port – 80 Visualizza la porta di accesso HTTP.

Detail
Settings

– – Visualizza proprietà della connessione LAN cablata.

DHCP
On / Off

On Indica se DHCP è attivo (On) o no (Off).

IP Address –
Visualizza l’indirizzo IP dell’unità quando [DHCP] è
impostato su [Off].

Subnet Mask –
Visualizza la subnet mask dell’unità quando [DHCP] è
impostato su [Off].

Gateway –
Visualizza il gateway predefinito dell’unità quando [DHCP]
è impostato su [Off].

DNS Auto
On / Off

On
Visualizza l’impostazione di acquisizione automatica del
DNS.
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File Transfer

Consente di specificare impostazioni relative al trasferimento di file (vedere “Informazioni sul trasferimento di file”).

Argomento correlato
Informazioni sul trasferimento di file
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Auto Upload
(Proxy)

On / Off Off Attiva o disattiva l’upload automatico dei file proxy.

Default
Upload Server

Server Settings1 - 3 >
Display Name

–

Seleziona il server per l’upload dei file. Il server selezionato qui
diventa la destinazione per il caricamento dei file dalla schermata
delle miniature e il caricamento automatico dei file proxy.
Visualizza le impostazioni di [Display Name] configurate in [Server
Settings1 a 3].

Clear
Completed
Jobs

Execute / Cancel –
Rimuove dall’elenco i trasferimenti completati.
Execute: Esegue la funzione.

Clear All Jobs Execute / Cancel –
Rimuove tutti i trasferimenti dall’elenco.
Execute: Esegue la funzione.

View Job List – – Visualizza l’elenco dei file da trasferire.
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Language

Imposta la lingua di visualizzazione.
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Select – –
Imposta la lingua di visualizzazione.
Set: Imposta il valore.
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Clock Set

Consente di specificare le impostazioni relative all’orologio interno.

Nota

Quando questa impostazione viene modificata dal menu della telecamera, spegnere l’alimentazione dell’unità e quindi riavviare l’unità. Se viene
avviato lo stato di standby di alimentazione tramite il telecomando a infrarossi o l’app Web, potrebbero verificarsi comportamenti anomali.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Time Zone Da UTC −12:00 a UTC +14:00 –
Imposta la differenza rispetto all’ora UTC in passi di 30
minuti.

Date
Mode

YYMMDD / MMDDYY / DDMMYY YYMMDD

Seleziona il formato di visualizzazione della data.
YYMMDD: Anno, mese, giorno
MMDDYY: Mese, giorno, anno
DDMMYY: Giorno, mese, anno

12H/24H 12H / 24H 24H
Seleziona il formato di visualizzazione dell’ora.
12H: Orologio a 12 ore
24H: Orologio a 24 ore

Date – –
Imposta la data corrente.
Set: Imposta il valore.

Time – –
Imposta l’ora corrente.
Set: Imposta il valore.
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Hours Meter

Visualizza il tempo cumulativo di funzionamento.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Hours(System) – –
Visualizza le ore d’uso totali (non può essere
azzerato).

Hours(Reset) – –
Visualizza le ore d’uso totali (può essere
azzerato).

Reset Execute / Cancel –
Azzera il tempo cumulativo di funzionamento.
Execute: Esegue la funzione.
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Impostazioni e valori predefiniti di ISO/Gain

Il campo di valori di [ISO/Gain<L>] configurabili e i valori predefiniti variano in base alle impostazioni di [Mode], [Base Look] > [Select]
e [Base Sensitivity].
I valori predefiniti sono indicati in grassetto nelle tabelle.

Quando [Mode] è impostato su [ISO]

Quando [Base Look] > [Select] è impostato su [S-Cinetone], [Standard], [ITU709], [709tone] o
[Still]

Quando [Base Look] > [Select] è impostato su [HLG Live] o [HLG Natural]

Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Quando [Base Look] > [Select] è impostato su un valore da [User1] a [User16]

Quando [Mode] è impostato su [dB]

Può essere configurato un valore compreso fra −3dB e +30dB in incrementi di 1dB.
Il valore predefinito è 0dB.
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Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Impostazioni e valori predefiniti di AGC Limit

Il campo di valori di [AGC Limit] configurabili e i valori predefiniti variano in base alle impostazioni di [Mode], [Base Look] > [Select] e
[Base Sensitivity].
I valori predefiniti sono indicati in grassetto nelle tabelle.

Quando [Mode] è impostato su [ISO]

Quando [Base Look] > [Select] è impostato su [S-Cinetone], [Standard], [ITU709], [709tone] o
[Still]

Quando [Base Look] > [Select] è impostato su [HLG Live] o [HLG Natural]

Quando [Base Look] > [Select] è impostato su un valore da [User1] a [User16]

Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Quando [Mode] è impostato su [dB]

Selezionare fra 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Il valore predefinito è 15dB.
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Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] è impostato su
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Impostazioni di qualità dell’immagine salvate per ciascuna modalità di ripresa

Questa sezione descrive in che modo viene salvato lo stato corrente delle voci di configurazione relative alla qualità dell’immagine
nelle modalità di ripresa elencate di seguito. Al cambiamento della modalità di ripresa vengono applicate alla nuova modalità di ripresa
le corrispondenti impostazioni salvate.

Visualizzazione desiderata per la modalità Custom SDR(BT.709)
Visualizzazione desiderata per la modalità Custom HDR(HLG)
Ripresa Log (Cine EI, Cine EI Quick, Flexible ISO)

Le seguenti tabelle mostrano quali voci di configurazione relative alla qualità dell’immagine sono salvate.
“Sì” indica che l’impostazione viene salvata e “No” indica che non viene salvata. Il “Sì” che si estende su più colonne indica
impostazioni comuni.

Voce

Modalità di ripresa

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu Shooting

ISO/Gain/EI

ISO/Gain Sì1) Sì No

Exposure Index No No Sì Sì

Base Sensitivity Sì No

Base ISO No Sì4) No3) Sì4)

White
Preset White Sì Sì

Tutte le altre voci Sì

White Setting Sì

Offset White Sì No

LUT On/Off No Sì

Noise
Suppression

Setting(Custom) Sì Sì No

Level(Custom) Sì Sì No

Setting (Cine EI/Flex.
ISO) No Sì

Level (Cine EI/Flex.
ISO)

No Sì
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Voce

Modalità di ripresa

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu
Paint/Look

Base Look

Select Sì Sì Sì

Input2) Sì

Output2) Sì

AE Level Offset2) Sì

Black Sì Sì No

Knee
Auto Knee Sì No No

Tutte le altre voci Sì Sì No

Detail Sì Sì No

Matrix Sì Sì No

Multi Matrix Sì Sì No

Vengono salvati valori di sensibilità ISO separati per le due modalità Custom SDR(BT.709) e HDR(HLG).1)

Per ciascun Base Look vengono salvate impostazioni distinte che non dipendono dalla modalità di ripresa.2)

La sensibilità di base ISO cambia insieme all’impostazione di Exposure Index.3)

Valore di impostazione comune per le modalità di ripresa Flexible ISO e Cine EI.4)
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Configurazione del menu Web

Premere la scheda [Settings] per passare alla visualizzazione della schermata delle impostazioni.
La schermata delle impostazioni consente di configurare varie impostazioni dell’unità, fra cui le impostazioni iniziali, le impostazioni di
rete, le impostazioni di ripresa e riproduzione tramite il menu Web.

Il menu comprende i menu indicati di seguito:

Configurazione e struttura del menu

Livello 1 Descrizione del livello 1 Livello 2

Shooting Contiene opzioni relative alla ripresa. Focus

Project Contiene le impostazioni di base del progetto.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Contiene opzioni relative alla qualità dell’immagine. Base Look
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Livello 1 Descrizione del livello 1 Livello 2

Pan-Tilt Contiene impostazioni relative al movimento di pan e tilt.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring Contiene impostazioni relative all’uscita video e alla visualizzazione su schermo.
Output Format

Output Display

Audio Contiene opzioni relative all’audio. Audio

Technical Contiene le impostazioni relative agli elementi tecnici.

Tracking Data Output

Tracking Data

Tally

IR Remote

RCP/MSU

Lens Controller

Network Contiene opzioni relative alle reti.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

SSH

Referer Check

Brute Force Attack Protection

Stream Contiene opzioni relative allo streaming.

Stream

Video Stream

Audio Stream
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Nota
[Accessibility] è disponibile solo per i modelli destinati al mercato nordamericano.
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Livello 1 Descrizione del livello 1 Livello 2

Maintenance Contiene le impostazioni del dispositivo stesso, ad esempio l’orologio e la lingua.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

Software
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Utilizzo del menu Web

Premere la scheda [Settings] per passare alla visualizzazione della schermata delle impostazioni che consente di configurare varie
impostazioni dell’unità, fra cui le impostazioni iniziali, le impostazioni di rete, le impostazioni di ripresa e riproduzione tramite il menu
Web.
Configurare le impostazioni nel menu Web su un tablet utilizzandone il touchscreen oppure su un computer utilizzandone il mouse.
Premere il menu relativo agli elementi da configurare per visualizzarne le voci di configurazione e le impostazioni.

Metodo di configurazione

Selezione del valore

Premere il pulsante di scelta dell’opzione desiderata. Il pulsante di scelta dell’opzione selezionata è visualizzato in arancione.

Attivazione o disattivazione di un’opzione

Menu (livello 1)1.

Menu (livello 2)2.

Impostazione3.
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Premere il selettore per attivare o disattivare l’opzione. Il selettore è visualizzato in arancione quando l’opzione è attiva o bianco
quando non è attiva.

Selezione di un valore in un elenco

Premere il pulsante dell’elenco a discesa e selezionare la voce desiderata nell’elenco.

Selezione di un valore numerico

Premere < o > per modificare il valore numerico. Se il valore numerico è sottolineato, è anche possibile immettere il valore
direttamente.

Immissione di caratteri e numeri

Configurazione su schermata separata
Premere il pulsante per eseguire le operazioni di configurazione in un’altra schermata.

Messaggio di guida

La schermata visualizza informazioni di assistenza per la configurazione di alcune impostazioni e messaggi che richiamano
l’attenzione dell’utente.

Salvataggio delle impostazioni

Al termine della configurazione di un’impostazione, premere il pulsante [OK] per salvarla.
Premere il pulsante [Cancel] per annullare le modifiche apportate a un’impostazione e ripristinare il valore precedente.
Premere il pulsante [Reload] per aggiornare la visualizzazione dello schermo.

Nota
Se si preme il pulsante [Reload] prima di salvare un’impostazione, le eventuali modifiche all’impostazione andranno perse.

Se si passa a un’altra pagina prima di salvare un’impostazione, le eventuali modifiche all’impostazione andranno perse.
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Focus

Consente di specificare le impostazioni relative alla messa a fuoco.

Argomento correlato
Selezione manuale del soggetto della messa a fuoco (AF Assist) tramite l’app Web
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Imposta la modalità di messa a fuoco automatica Push.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Specifica il comportamento della messa a fuoco quando viene
toccata la schermata dell’immagine della telecamera in modalità MF.

AF Assist
Control

On / Off On

Se impostato su [On], è possibile utilizzare il cursore Focus nell’app
Web durante la messa a fuoco automatica per regolare la posizione
della messa a fuoco.

Per informazioni dettagliate, vedere “Selezione manuale del
soggetto della messa a fuoco (AF Assist) tramite l’app Web”.

Nota
Questa voce è abilitata solo quando [AF Assist] è impostato su [On]
nel menu della telecamera.
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Base Setting

Consente di specificare le impostazioni di base.

Argomento correlato
Configurazione delle operazioni di base
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Imposta la modalità di ripresa.
Vedere “Modalità di ripresa” in “Configurazione
delle operazioni di base”.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Imposta il gamut di colore della registrazione o uscita
in modalità Custom.
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Rec Format

Consente di specificare le impostazioni relative al formato di registrazione.

Impostazioni di [RAW Output Format]

I valori predefiniti sono indicati in grassetto.
Sono state omesse le condizioni in cui non è possibile impostare [RAW Output Format].

Impostazioni di [Video Format]

Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Seleziona la frequenza di sistema.

Nota
Se viene modificata la frequenza, la
telecamera si riavvia. Dopo il riavvio, ricaricare
la pagina nel browser Web.

Imager Scan
Mode

FF / S35 FF Seleziona le dimensioni dell’imager.

Codec RAW / RAW & XAVC-I / XAVC-I / XAVC-L XAVC-I

Imposta la modalità di registrazione e
riproduzione dei clip.

Nota

Quando [Imager Scan Mode] è impostato su
[S35], non è possibile selezionare [RAW] e
[RAW & XAVC-I].

RAW Output
Format

Le impostazioni disponibili variano a
seconda dell’impostazione di [Frequency].

Vedere “Impostazioni di [RAW Output
Format]” di seguito.

–

Imposta le dimensioni dell’immagine RAW da
inviare a un registratore RAW esterno.

Nota

Quando [Codec] è impostato su [RAW &
XAVC-I], il valore di [Video Format] cambia in
sincronia con l’impostazione di [RAW Output
Format].

Video
Format

Le opzioni di impostazione disponibili
variano a seconda delle impostazioni di
[Frequency], [Imager Scan Mode] e [Codec].

Vedere “Impostazioni di [Video Format]”
di seguito.

– Imposta le dimensioni dell’immagine.

Frequency Imager Scan Mode Codec Impostazione

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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I valori predefiniti sono indicati in grassetto.
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Frequency Imager Scan Mode Codec Impostazione

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

Specifica le impostazioni della modalità di registrazione simultanea su 2 slot (vedere “Registrazione simultanea sulle schede di
memoria A e B (Simul Rec su 2 slot)”).

Argomento correlato
Registrazione simultanea sulle schede di memoria A e B (Simul Rec su 2 slot)
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting On / Off Off
Attiva o disattiva la funzione di registrazione simultanea e
specifica il supporto di destinazione della registrazione.

Rec Button
Slot A / Slot B / Slot A/Slot
B

Slot A/Slot B Visualizza la corrispondenza assegnata fra supporto di
registrazione e pulsante di registrazione.
Impostare [Project] > [Simul Rec] > [Rec Button Set] nel menu
della telecamera.

2nd Rec
Button

Slot A / Slot B / Slot A/Slot
B

Slot A/Slot B
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Proxy Rec

Configura le impostazioni della modalità di registrazione proxy (vedere “Registrazione proxy”).
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Setting On / Off Off Attiva o disattiva la modalità di registrazione proxy.
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Interval Rec

Configura le impostazioni della modalità di registrazione a intervalli (vedere “Registrazione di video a intervalli (Interval Rec)”).

Argomento correlato
Registrazione di video a intervalli (Interval Rec)
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Setting On / Off Off

Attiva o disattiva la modalità di registrazione
a intervalli. (Impostando questa modalità su
On, tutte le altre modalità speciali vengono
impostate su Off).

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 /
30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 /
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (ora)

1
Imposta l’intervallo fra registrazioni nella
modalità di registrazione Interval Rec
(Interval Rec impostata su On).

Number of
Frames

1frame / 2frames / 3frames / 6frames /
9frames / 12frames
I valori disponibili variano a seconda della
frequenza fotogrammi del formato video
selezionato.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Imposta il numero di fotogrammi da registrare
in ciascuna ripresa nella modalità di
registrazione Interval Rec (Interval Rec
impostata su On).
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Picture Cache Rec

Configura le impostazioni della modalità di registrazione cache immagine (vedere “Registrazione di immagini preregistrate nella cache
(Picture Cache Rec)”).

Argomento correlato
Registrazione di immagini preregistrate nella cache (Picture Cache Rec)
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Setting On / Off Off Attiva o disattiva la funzione di cache immagine.

Cache Size
Short / Medium / Long /
Max

Max
Specifica il tempo di accumulo delle immagini nella memoria cache
immagine (il tempo di registrazione della cache immagine).

Cache Rec
Time

– –
Indica il tempo di accumulo delle immagini nella memoria cache
immagine (il tempo di registrazione della cache immagine).
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All File

Esegue operazioni sui file ALL (vedere “Salvataggio e caricamento dei dati di configurazione”).
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Load
All File

– –

Carica un file ALL sull’unità dal dispositivo che esegue l’app Web.

Nota
Dopo aver caricato un file ALL, l’unità si riavvia. Dopo il riavvio, ricaricare la
pagina nel browser Web.

Non è possibile caricare un file ALL durante l’operazione di inquadratura
automatica PTZ. È necessario disattivare l’inquadratura automatica PTZ
prima di poter caricare un file ALL.

Save
All File

– –

Salva le impostazioni dell’unità in un file ALL sul dispositivo che esegue
l’app Web.

Nota

Non è possibile salvare un file ALL durante l’operazione di inquadratura
automatica PTZ. È necessario disattivare l’inquadratura automatica PTZ
prima di poter salvare un file ALL.
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Base Look

È possibile caricare un look di base sull’unità.
Sullo schermo viene visualizzato un elenco dei look di base disponibili. Il look di base attualmente applicato è indicato dall’indicatore ●
alla sinistra del numero del look di base.

[No.]: Numero del look di base
[Base Look Name]: Nome del look di base
[Input]: Segnale di ingresso del look di base
[Output]: Segnale di uscita del look di base
[AE Level Offset]: Valore di offset di riferimento dell’esposizione del look di base

Aggiunta di un look di base
Premere il pulsante [Import] per importare un nuovo look di base. Seguire le istruzioni indicate a schermo.
Dopo l’importazione, impostare i valori appropriati di [Input], [Output] e [AE Level Offset]. Per informazioni dettagliate, vedere
“Importazione del look di base desiderato”.

Argomento correlato
Importazione del look di base desiderato
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P/T Speed

Consente di specificare impostazioni relative alla velocità di pan e tilt.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Speed
Step

Normal / Extended Extended

Imposta il numero di passi di velocità dell’azionamento di pan e tilt.
Normal: La velocità può essere specificata in un intervallo di 24 valori.
Utilizzare questa impostazione per la compatibilità con le telecamere
remote Sony esistenti.
Extended: La velocità può essere specificata in un intervallo di 50 valori.

Speed
Mode

Normal / Slow Normal

Imposta la modalità di velocità dell’azionamento di pan e tilt.
Abilitato solo quando [Speed Step] è impostato su [Normal].
Normal: Agisce nell’intervallo di velocità normale (da minimo a massimo
(60 gradi/secondo)).
Slow: Agisce nell’intervallo di velocità bassa (da minimo a massimo (40
gradi/secondo)).
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P/T Acceleration

Consente di specificare impostazioni relative alla velocità di pan e tilt.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Acceleration Da 1 a 9 8
Seleziona l’accelerazione e la decelerazione per i movimenti di
pan e tilt. Più alto il numero, maggiore l’accelerazione.
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P/T Range Limit

Configura impostazioni relative all’escursione del movimento di pan e tilt.
La schermata descritta di seguito consente di specificare l’escursione del movimento di pan e tilt.

Nota

Questa limitazione impostata viene ignorata all’accensione dell’unità e durante l’esecuzione del reset di pan e tilt. Questa funzione non può
essere utilizzata per evitare ostacoli situati in prossimità dell’unità.

Spostare il selettore [Setting] sulla posizione On.

Questo abilita la funzione di limitazione dell’escursione del movimento di pan e tilt.

1

Controllare l’immagine utilizzando i comandi di pan e tilt della telecamera.2

Per impostare le posizioni a cui limitare il movimento, premere il pulsante [Left], [Right], [Up], [Down] > [Set Current
Value] nelle posizioni desiderate.

[Left]: Lato sinistro della telecamera.
[Right]: Lato destro della telecamera
[Up]: Lato superiore della telecamera
[Down]: Lato inferiore della telecamera

3
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Nota
Le posizioni della telecamera esterne alle posizioni limite non possono essere salvate come preset.

In caso di modifica dell’impostazione [Pan-Tilt] > [P/T Direction] > [Ceiling], le impostazioni limite configurate vengono riportate ai valori predefiniti
di fabbrica.

Questa impostazione non può essere modificata durante la riproduzione, durante la visualizzazione delle miniature, quando si verifica un errore
nel movimento di pan e tilt, quando il pan e tilt non è inizializzato e quando il pan e tilt è bloccato.
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Le posizioni limite sono impostate e visualizzate come valori numerici (di angolazione).
Per annullare un limite, premere il pulsante [Reset] della posizione corrispondente.

Premere il pulsante [OK].

Questa impostazione impedisce che l’escursione del movimento di pan e tilt superi le posizioni limite configurate.

4
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P/T Direction

Consente di specificare impostazioni relative alla direzione di pan e tilt.

Nota
Se viene modificata e applicata una nuova impostazione di [Ceiling], tutte le posizioni di preset vengono eliminate in quanto le coordinate di pan
e tilt risulterebbero invertite.

L’estensione dei movimenti di pan e tilt cambia come illustrato nel seguente diagramma, in base all’impostazione di [Ceiling].

A: Se [Ceiling] è impostato su [Off]
B: Se [Ceiling] è impostato su [On]
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Ceiling On / Off Off
Quando l’unità è montata su un ripiano, impostare su [Off]. Quando l’unità
è montata a soffitto, impostare su [On]. Quando [Ceiling] è impostato su
[On], [Pan Direction] viene automaticamente impostata su [Opposite].

Pan
Direction

Normal / Opposite Normal
Imposta la direzione del movimento orizzontale (pan). Cambiando questa
impostazione, la direzione di movimento è invertita.

Tilt
Direction

Normal / Opposite Normal Imposta la direzione del movimento verticale (tilt). Cambiando questa
impostazione, la direzione di movimento è invertita.
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P/T Preset

Consente di specificare impostazioni relative ai preset della telecamera.

Pan-Tilt
Imposta la velocità dei preset.

Default
Imposta i valori predefiniti configurati quando viene salvata una posizione di preset.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Pan-Tilt Speed
Setting Way

Separate / Common Separate
Specifica se le velocità di preset sono configurate separatamente
oppure utilizzano un’impostazione comune.

Pan-Tilt Speed
for Common

Da 1 a 50 50

Imposta la velocità comune dei preset.

Nota
La massima velocità (24) verrà sempre utilizzata se questo valore
è impostato su 25 o superiore e [Pan-Tilt] > [P/T Speed] > [Speed
Step] è impostato su [Normal].

Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Pan-Tilt Speed
Unit

Speed Table / Time Speed Table
Specifica se, per il ripristino delle posizioni di preset, le unità di
velocità delle posizioni di preset sono configurate utilizzando una
tabella delle velocità o come valori di tempo.

Pan-Tilt Speed
for Separate

Da 1 a 50 50
Imposta la velocità per i preset quando il metodo di selezione della
velocità dei preset è impostato su [Separate].

Pan-Tilt Time
for Separate

Da 1.0 a 99.0 1
Imposta la velocità per i preset quando [Pan-Tilt Speed Unit] è
impostato su [Time].

Zoom Sync On / Off On
Specifica se i movimenti di pan e tilt e le operazioni di zoom sono
sincronizzati o meno durante il ripristino di una posizione di preset.

Zoom Speed Da 0 a 32767 32767 Imposta la velocità dello zoom.

Focus Recall On / Off On Specifica se ripristinare o meno le impostazioni di messa a fuoco.

MF Speed Da 0 a 32767 32767 Imposta la velocità di messa a fuoco per la messa a fuoco manuale.

402



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Format

Consente di specificare le impostazioni relative al formato di uscita.

Argomento correlato
Formati di uscita e limitazioni
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Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

SDI Per informazioni dettagliate su queste impostazioni, vedere
“Formati di uscita e limitazioni”.

– Imposta la risoluzione delle uscite
SDI e HDMI.HDMI –
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Output Display

Consente di specificare impostazioni relative ai segnali di uscita.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

SDI On / Off Off Configura se stato e menu sono incorporati nel segnale di uscita SDI.

HDMI/Stream On / Off On

Configura se stato e menu sono incorporati nel segnale di uscita
HDMI.

Nota

Questa impostazione viene applicata anche all’immagine del segnale di
uscita HDMI, all’immagine di uscita in streaming e all’immagine nel
pannello dell’immagine della telecamera dell’app Web.
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Audio Input

Consente di specificare impostazioni relative agli ingressi audio da CH1 a CH4.

Specifica il livello di ingresso audio master. Il livello di ingresso audio master è utilizzato per tutti i canali da 1 a 4.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Level
Control

Auto / Manual Auto
Seleziona la regolazione automatica o manuale del livello
di ingresso audio.

Level Da 0 a 99 49 Imposta il livello di ingresso.

Input
Select

AUDIO IN CH1 / AUDIO IN
CH2 / Off

CH1 e CH3: AUDIO IN
CH1
CH2 e CH4: AUDIO IN
CH2

Seleziona la sorgente di ingresso audio.

Nota
CH1 è fissato su [AUDIO IN CH1].

Wind Filter On / Off Off
Attiva o disattiva il filtro di riduzione della rumorosità
causata dal vento.

Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Master Da 0 a 99 99 Imposta il livello di ingresso master.
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Audio Output

Consente di specificare impostazioni relative all’uscita audio.

Nota

Questa impostazione viene applicata anche all’audio in uscita in streaming.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

HDMI/Stream
Output CH

CH1/CH2 / CH3/CH4 CH1/CH2
Imposta la combinazione dei canali audio sulle
uscite HDMI e streaming.
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Tracking Data Output

Configura le impostazioni relative all’uscita delle informazioni di tracking.

Destinations
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

IPv4
Address

Indirizzo IPv4 –
Imposta l’indirizzo IP di destinazione delle informazioni
di tracking.

Port Da 1024 a 65534 40000
Imposta il numero di porta di destinazione delle
informazioni di tracking.

Output On / Off Off Attiva o disattiva l’uscita delle informazioni di tracking.
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Tracking Data

Configura le impostazioni relative al contenuto delle informazioni di tracking.

Camera ID

Camera Position
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Camera ID Da 0 a 255 255 Imposta l’identificativo dell’unità.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

X Da −131072.0 a 131071.9 0.0
Imposta la coordinata X della telecamera (unità: 1
mm)

Y Da −1310720 a 1310719 0.0
Imposta la coordinata Y della telecamera (unità: 1
mm)

Z Da −1310720 a 1310719 0.0
Imposta la coordinata Z della telecamera (unità: 1
mm)
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Tally

Configura le impostazioni dell’indicatore di registrazione/tally (vedere “Connessione di un segnale di tally”).

Tally
Specifica impostazioni relativi all’indicatore di registrazione/tally.

TSL UMD
Imposta il metodo di controllo del tally mediante il protocollo TSL UMD.

Argomento correlato
Connessione di un segnale di tally
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Tally Lamp
Brightness

High / Low / Off High Imposta la luminosità dell’indicatore di registrazione/tally.

G Tally Lamp Enable / Disable Enable Abilita o disabilita l’indicatore di tally G.

Tally Control
External / Internal / PTZ
AFR

Internal
Seleziona da dove accettare le informazioni di controllo
dell’indicatore di registrazione/tally dell’unità.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting On / Off Off
Attiva o disattiva il controllo del tally tramite il protocollo TSL
UMD.

Index Da 0 a 65534 1
Imposta il numero di indice per la ricezione del controllo tally
mediante il protocollo TSL UMD.

Port
Number

Da 1024 a 65534 8900
Imposta il numero di porta per la ricezione del controllo tally
mediante il protocollo TSL UMD.
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IR Remote

Consente di specificare impostazioni relative al telecomando a infrarossi.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting On / Off On
Abilita o disabilita il comando dell’unità tramite il
telecomando a infrarossi.

Pan-Tilt
Speed

Normal / Max Normal
Specifica la velocità dei movimenti di pan e tilt richiesti
tramite il telecomando a infrarossi.
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RCP/MSU

Configura impostazioni quando è connesso un RCP/MSU (opzione).
Per informazioni dettagliate, vedere “Connessione di un RCP/MSU (opzione)”.

Nota
Configurare le impostazioni sull’RCP/MSU secondo le esigenze.

Per realizzare un sistema con più telecamere è necessario utilizzare una MSU.

Quando si utilizzano più unità MSU, impostare un’unità MSU come master e tutte le altre unità MSU come client.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

CNS Mode
Off / Bridge / MCS / PC
Control

Off Imposta la modalità di connessione per RCP/MSU.

Master IP
Address

Indirizzo IPv4 0.0.0.0
Imposta l’indirizzo IP del dispositivo master durante la creazione di
un sistema multitelecamera basato su LAN.

Camera No. Camera No. (da 1 a 96) 1 Imposta un numero di telecamera univoco all’interno del sistema
durante la creazione di un sistema multitelecamera basato su LAN.
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Lens Controller

Configura impostazioni relative al dispositivo di comando obiettivo eventualmente montato (opzione).
Per informazioni dettagliate, vedere “Montaggio di un dispositivo di comando obiettivo”.

Nota

Dopo aver modificato [Setting], l’unità si riavvia. Ricaricare la pagina nel browser Web.

Suggerimento

Quando si utilizza l’inquadratura automatica PTZ, impostare accelerazione e/o decelerazione sul valore massimo. Si osservi inoltre che la
precisione potrà variare a seconda dell’obiettivo utilizzato. Verificarne il funzionamento prima dell’uso effettivo.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Setting On / Off Off Specifica se utilizzare o meno un dispositivo di comando obiettivo (opzione).

Mode Da 0 a 15 0

Imposta la modalità operativa del dispositivo di comando dell’obiettivo
(opzione).
Sono disponibili valori compresi tra 0 e 15, ma i valori effettivi che possono
essere selezionati variano in base al dispositivo di comando dell’obiettivo
utilizzato (opzione). Per ulteriori informazioni, fare riferimento alle istruzioni per
l’uso del dispositivo di comando dell’obiettivo.

Reverse On / Off Off Inverte il senso di rotazione del dispositivo di comando dell’obiettivo (opzione).

Initialize – – Inizializza il dispositivo di comando dell’obiettivo (opzione).
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Camera Name

Consente di specificare impostazioni relative al nome della telecamera (nome dell’unità).

Camera Name può contenere da 0 a 8 caratteri. Sono consentiti i caratteri indicati di seguito.
Caratteri alfanumerici
Simboli (spazio !#$`*+-./;<=>?@[\]^_`{|})
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Camera Name – FR7 Imposta il nome della telecamera.
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User

Consente di specificare impostazioni all’accesso all’unità da parte degli utenti.

Impostazioni relative agli utenti amministratore (Administrator) (obbligatorie)

Impostazioni relative agli utenti generici (da User 1 a User 9) (facoltative)
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

User Name – admin Specifica il nome utente.

Current
Password

– –
Quando si modifica la password, immettere la
password corrente.

New Password – – Immettere la nuova password.

Re-Type
Password

– –
Immettere nuovamente la stessa password per
confermarla.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

User Name – – Specifica il nome utente.

Current
Password

– –
Quando si modifica la password, immettere la
password corrente.

New Password – – Immettere la nuova password.

Re-Type
Password – –

Immettere nuovamente la stessa password per
confermarla.
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Wired LAN

Status
Visualizza lo stato della di rete.

IPv4
Consente di specificare impostazioni relative alla rete IPv4.

IPv6
Consente di specificare impostazioni relative alla rete IPv6.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Host Name – – Visualizza il nome host.

MAC Address – – Visualizza l’indirizzo MAC dell’unità.

Ethernet Status – –
Visualizza l’attuale velocità di
comunicazione.

IP Address – – Visualizza l’indirizzo IP dell’unità.

Subnet Mask – – Visualizza la subnet mask dell’unità.

Gateway – –
Visualizza il gateway predefinito IPv4
dell’unità.

Primary DNS Server – –
Visualizza il server DNS primario
dell’unità.

Secondary DNS
Server

– –
Visualizza il server DNS secondario
dell’unità.

IPv6 Address 1 – – Visualizza l’indirizzo IPv6 1 dell’unità.

IPv6 Address 2 – – Visualizza l’indirizzo IPv6 2 dell’unità.

IPv6 Gateway – –
Visualizza il gateway predefinito IPv6
dell’unità.

Link-local IPv6
Address

– –
Visualizza l’indirizzo link-local IPv6
dell’unità.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

DHCP On / Off On Attiva o disattiva la funzione [DHCP].

IP Address – –
Imposta l’indirizzo IPv4 quando [DHCP] è impostato su
Off.

Subnet
Mask

– –
Imposta la subnet mask quando [DHCP] è impostato su
Off.

Gateway – –
Imposta il gateway predefinito IPv4 quando [DHCP] è
impostato su Off.
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Common
Consente di specificare impostazioni comuni alle reti IPv4 e IPv6.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Obtain an IP Address
Automatically

On / Off On
Attiva o disattiva la funzione di acquisizione
automatica dell’indirizzo IPv6.

IP Address – –
Imposta l’indirizzo IPv6 quando [Obtain an IP Address
Automatically] è impostato su Off.

Prefix Length – –
Imposta il prefisso quando [Obtain an IP Address
Automatically] è impostato su Off.

Gateway – – Imposta il gateway predefinito IPv6 quando [Obtain an
IP Address Automatically] è impostato su Off.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

HTTP Port 80, da 1024 a 65534 80 Imposta il numero di porta HTTP.

DNS Auto On / Off On
Specifica se ottenere gli indirizzi DNS dal server
DHCP.

Primary DNS
Server

Indirizzo IPv4/IPv6 –
Imposta il server DNS primario quando [DNS Auto] è
impostato su Off.

Secondary DNS
Server

Indirizzo IPv4/IPv6 –
Imposta il server DNS secondario quando [DNS
Auto] è impostata su Off.
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File Transfer

Consente di specificare impostazioni relative al trasferimento di file.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Auto
Upload
(Proxy)

On / Off Off Attiva o disattiva l’upload automatico dei file proxy.

Default
Upload
Server

Server Settings1 - 3 >
Display Name Server Settings1

Seleziona il server per l’upload dei file. Il server selezionato qui diventa
la destinazione per il caricamento dei file dalla schermata delle
miniature e il caricamento automatico dei file proxy.
Visualizza le impostazioni di [Display Name] configurate in [Server
Settings1 a 3].
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Da FTP Server 1 a 3

Consente di specificare impostazioni relative al trasferimento di file FTP.
Le impostazioni sono comuni per FTP Server 1 a 3.

5-041-957-34(1) Copyright 2022 Sony Corporation

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Display Name – –
Imposta il nome di visualizzazione mostrato nel menu di
configurazione della destinazione di trasferimento.

Service – – Visualizza il tipo di server.

Host Name – –
Imposta il nome host del server di destinazione del
trasferimento.

Port 21, 990, da 1024 a 65534 21
Imposta il numero della porta del server di destinazione del
trasferimento.

User Name – –
Imposta il nome utente per l’autenticazione della
connessione con il server di destinazione del trasferimento.

Password – –
Imposta la password per l’autenticazione della connessione
con il server di destinazione del trasferimento.

Passive Mode On / Off Off Attiva o disattiva la modalità Passive.

Destination
Directory

– – Specifica il nome della directory di destinazione del
trasferimento.

Using Secure
Protocol

On / Off Off
Specifica se utilizzare (On) o non utilizzare (Off) la modalità
di trasferimento Secure FTP.

Root Certificate – –

Carica il certificato radice per il trasferimento in modalità
Secure FTP.
Premere il pulsante [Load] e selezionare un certificato radice
nella schermata visualizzata.
Premere il pulsante [Delete] per eliminare il certificato radice
caricato.

Root Certificate
Status

– – Visualizza lo stato di caricamento del certificato radice.

Reset – –
Ripristina sui valori predefiniti le impostazioni di [Server
Settings].
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SSL

Consente di specificare impostazioni relative a SSL.

SSL
Abilita o disabilita la funzione SSL.

SSL Server Authentication
Consente di specificare impostazioni relative all’autenticazione del server SSL.

Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Function
Disable / Enable / Enable (Allow HTTP connection for some
clients)

Disable
Abilita o disabilita la funzione
SSL.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Certificate
Options

Use a self-signed certificate
(For test use) / Use an
external certificate

–
Specifica il metodo di installazione del certificato del
server SSL.

Status – –
Visualizza la validità del certificato del server SSL quando
[Certificate Options] è impostato su [Use a self-signed
certificate (For test use)].

Issuer DN – –
Visualizza il nome distinto dell’emittente del certificato del
server SSL quando [Certificate Options] è impostato su
[Use a self-signed certificate (For test use)].

Subject DN – –
Visualizza il nome distinto del soggetto del certificato del
server SSL quando [Certificate Options] è impostato su
[Use a self-signed certificate (For test use)].

Available Period – –
Visualizza il periodo di validità del certificato del server
SSL quando [Certificate Options] è impostato su [Use a
self-signed certificate (For test use)].

Extended Key
Usage

– –
Visualizza il metodo di utilizzo della chiave estesa quando
[Certificate Options] è impostato su [Use a self-signed
certificate (For test use)].

Delete – –

Questo pulsante è visualizzato quando [Certificate
Options] è impostato su [Use a self-signed certificate (For
test use)].
Elimina il certificato del server SSL installato.

Import – –
Installa un certificato del server SSL esterno,
selezionandolo da un elenco, quando [Certificate Options]
è impostato su [Use an external certificate].

Private Key
Password

– –
Imposta la password per le informazioni della chiave
privata del certificato del server SSL quando [Certificate
Options] è impostato su [Use an external certificate].
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Reset – –
Questo pulsante annulla la visualizzazione della
password della chiave privata per l’immissione di una
nuova password.

Self-Signed
Certificate
Generation

– –
Premere il pulsante [Generate] per generare un certificato
autofirmato quando [Certificate Options] è impostato su
[Use a self-signed certificate (For test use)].
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SSH

Consente di specificare le impostazioni relative a SSH.

Nota

Per poter utilizzare l’unità in applicazioni che utilizzano Camera Remote SDK, SSH deve essere abilitato. Abilitare solo per applicazioni che si
considerano fidate. Sony non potrà essere ritenuta responsabile per eventuali perdite derivanti dall’utilizzo dell’applicazione.

5-041-957-34(1) Copyright 2022 Sony Corporation

Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Setting On / Off Off  Attiva o disattiva la funzione SSH.

User Name – – Imposta o visualizza il nome utente.

Password – – Imposta la password.
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Referer Check

Consente di specificare impostazioni relative ai controlli del Referer.

Exception List
Consente di specificare impostazioni relative all’elenco delle eccezioni del controllo del Referer.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Setting On / Off On
Abilita o disabilita la funzione dei controllo provenienza
Referer Check.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

No. Da 1 a 10 – Imposta il numero dell’eccezione nell’elenco.

Host
Name

– – Imposta il nome host dell’eccezione.

Port
Number – – Imposta il numero di porta dell’eccezione.

Set – –
Premere per registrare l’eccezione configurata nell’elenco delle
eccezioni.

Delete – –
Selezionare l’eccezione da eliminare e premere il pulsante per
eliminarla dall’elenco delle eccezioni.
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Brute Force Attack Protection

Consente di specificare impostazioni relative alla prevenzione degli attacchi di forza bruta.

Quando viene rilevato un attacco da parte di un utente malintenzionato o aggressore, vengono visualizzate le informazioni dell’elenco
degli aggressori.
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Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

Setting On / Off On Attiva o disattiva la funzione [Brute Force Attack Protection].

Count Da 3 a 100 8
Specifica il numero di tentativi che verranno considerati come un
attacco.
Abilitato quando [Setting] è impostato su On.

Release
Mode

Always / Timer Timer

Specifica la condizione di rilascio.
Abilitato quando [Setting] è impostato su On.
Always: Non eliminare dall’elenco degli aggressori.
Timer: Elimina dall’elenco degli aggressori dopo che è trascorso il
tempo di rilascio impostato utilizzando [Release Time].

Release
Time

Da 30 a 86400 s 60

Specifica il tempo di rilascio.
Abilitato quando [Setting] è impostato su On.
Quando Release Mode è impostato su [Timer], le voci vengono
eliminate dall’elenco degli aggressori dopo che è trascorso il tempo
di rilascio.
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Stream

Consente di configurare impostazioni sullo streaming (vedere “Informazioni sullo streaming”).

Stream Setting
Consente di specificare impostazioni relative al protocollo di streaming.

Nota
Prima di poter utilizzare RTMP, è necessario che [Stream] > [Audio Stream] > [Setting] sia stato impostato su [On] in anticipo.

RTSP
Le seguenti voci sono visualizzate quando [Stream Setting] è impostato su [RTSP].
Consente di specificare impostazioni relative allo streaming RTSP.

RTMP
Le seguenti voci sono visualizzate quando [Stream Setting] è impostato su [RTMP].
Consente di specificare impostazioni relative allo streaming RTMP.

Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Setting
RTSP / RTMP / SRT-Caller / SRT-Listener / NDI|HX /
Off

RTSP
Seleziona il protocollo di
streaming.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Port Number 554, da 1024 a 65534 554 Imposta il numero di porta RTSP.

Time Out Da 0 a 600 60
Imposta il timeout del comando Keep Alive per lo
streaming RTSP.

Authentication On / Off On Attiva o disattiva la funzione di autenticazione RTSP.

Video Port
Number 1

Da 1024 a 65534 51000
Specifica il numero di porta a cui inviare il video 1 per
lo streaming unicast RTSP.

Video Port
Number 2

Da 1024 a 65534 53000
Specifica il numero di porta a cui inviare il video 2 per
lo streaming unicast RTSP.

Audio Port
Number

Da 1024 a 65534 57000
Specifica il numero di porta a cui inviare l’audio per lo
streaming unicast RTSP.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Server URL – –
Imposta l’URL di destinazione della connessione RTMP o
RTMPS.

Stream Key – –
Consente di impostare la Stream Key ottenuta dal lato
server RTMP.
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SRT
Le seguenti voci sono visualizzate quando [Stream Setting] è impostato su [SRT-Caller] o [SRT-Listener].
Consente di specificare impostazioni relative allo streaming SRT.

NDI|HX
Le seguenti voci sono visualizzate quando [Stream Setting] è impostato su [NDI|HX].
Consente di specificare impostazioni relative a NDI|HX.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Root
Certificate

– –

Carica il certificato radice necessario per la connessione
con il server RTMP.
Premere il pulsante [Load] e selezionare un certificato
radice nella schermata visualizzata.
Premere il pulsante [Delete] per eliminare il certificato radice
caricato.
Lo stato è visualizzato in [Root Certificate Status].

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Destination – –
Imposta l’URL di destinazione della connessione quando
l’unità funziona in modalità Caller.

Port
Number

Da 1024 a 65534 4201
Imposta il numero di porta per l’ascolto quando l’unità
funziona in modalità Listener.

Latency Da 20 a 8000 ms 120 Specifica la latenza.

TTL Da 1 a 255 64 Imposta il valore di TTL.

Encryption Off / AES128 / AES256 Off Abilita o disabilita la crittografia e imposta il metodo di
crittografia.

Passphrase
0 oppure stringa da 10 a 79
caratteri

0
Imposta la passphrase da utilizzare per la crittografia.
Premere Reset per annullare la passphrase immessa.

ARC On / Off On Attiva o disattiva la funzione Adaptive Rate Control.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

License – –
Visualizza lo stato di installazione della chiave di
licenza NDI.

Source Name – – Visualizza il nome dell’origine NDI.

Group On / Off Off Attiva o disattiva la funzione di raggruppamento NDI.

Group Name – –
Visualizzato quando la funzione di raggruppamento
NDI è impostata su On.
Specifica il nome del gruppo.

Discovery
Server 1

– – Specifica il server di individuazione NDI 1.

Discovery
Server 2

– – Specifica il server di individuazione NDI 2.

Multicast Mode On / Off Off Attiva o disattiva lo streaming multicast.
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Argomento correlato
Informazioni sullo streaming
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Multicast Prefix 239.255.0.0 239.255.0.0

Visualizzato quando [Multicast Mode] è impostato su
On.
Imposta il prefisso da utilizzare per lo streaming
multicast.

Multicast
Netmask

255.255.0.0 255.255.0.0

Visualizzato quando [Multicast Mode] è impostato su
On.
Imposta la netmask che determina il range di indirizzi
multicast.

Multicast TTL Da 1 a 255 3
Visualizzato quando [Multicast Mode] è impostato su
On.
Imposta il valore TTL per lo streaming multicast.

Multi-TCP
Mode

On / Off Off Attiva o disattiva la modalità Multi-TCP.

Unicast UDP
Mode

On / Off On Attiva o disattiva la modalità Unicast UDP.
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Video Stream

Consente di specificare impostazioni relative ai codec video di streaming.

Video Stream 1
Consente di specificare impostazioni relative al codec video 1.

Video Stream 2
Consente di specificare impostazioni relative al codec video 2.

Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Codec 1 H.264 / H.265 H.264 Imposta il codec per l’immagine 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080 Imposta le dimensioni per l’immagine 1.

Frame Rate 1

Per informazioni dettagliate sulle frequenze
fotogrammi supportate, vedere
“Impostazione del codec video per lo
streaming”.

–
Imposta la frequenza fotogrammi per
l’immagine 1.

I-Picture Mode 1 Time / Frame Time
Imposta l’intervallo di inserimento IDR-
Frame per l’immagine 1 come valore di
tempo o numero di fotogrammi.

I-Picture Interval
1

1 / 2 / 3 / 4 / 5 s 1

Visualizzato quando [I-Picture Mode 1] è
impostato su Time.
Imposta l’intervallo di inserimento IDR-
Frame per H.264 e H.265 come valore
di tempo.

I-Picture Ratio 1 Da 15 a 300 fotogrammi 30

Visualizzato quando [I-Picture Mode 1] è
impostato su Frame.
Imposta l’intervallo di inserimento IDR-
Frame per H.264 e H.265 come numero
di fotogrammi.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high Imposta il profilo per H.264 o H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Imposta la modalità di compressione del
bit rate per l’immagine 1.

Bit Rate 1
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000 /
6000 / 7000 / 8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

16000

Visualizzato quando [Bit Rate
Compression Mode 1] è impostato su
On.
Imposta il valore desiderato di bit rate
quando la modalità di compressione del
bit rate è impostato su CBR.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Imposta la qualità per H.264 o H.265.
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Video Stream 3
Consente di specificare impostazioni relative al codec video 3.

Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Codec 2 H.264 / H.265 / Off Off Imposta il codec per l’immagine 2.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 / 512×270

1920×1080 Imposta le dimensioni per l’immagine 2.

Frame Rate 2

Per informazioni dettagliate sulle
frequenze fotogrammi supportate, vedere
“Impostazione del codec video per lo
streaming”.

–

Visualizzato quando [Codec 2] non è
impostato su Off.
Imposta la frequenza fotogrammi per
l’immagine 2.

I-Picture Mode 2 Time / Frame Time

Visualizzato quando [Codec 2] non è
impostato su Off.
Imposta l’intervallo di inserimento IDR-
Frame per l’immagine 2 come valore di
tempo o numero di fotogrammi.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Visualizzato quando [Codec 2] non è
impostato su Off e, allo stesso tempo, [I-
Picture Mode 2] è impostato su [Time].
Imposta l’intervallo di inserimento IDR-
Frame per H.264 e H.265 come valore di
tempo.

I-Picture Ratio 2 Da 15 a 300 fotogrammi 30

Visualizzato quando [Codec 2] non è
impostato su Off e, allo stesso tempo, [I-
Picture Mode 2] è impostato su [Frame].
Imposta l’intervallo di inserimento IDR-
Frame per H.264 e H.265 come numero di
fotogrammi.

Profile 2
H.264: high / main / baseline
H.265: main

– Imposta il profilo per H.264 o H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Visualizzato quando [Codec 2] non è
impostato su Off.
Imposta la modalità di compressione del bit
rate per l’immagine 2.

Bit Rate 2
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000 /
6000 / 7000 / 8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

8000

Visualizzato quando [Codec 2] non è
impostato su Off e, allo stesso tempo, [Bit
Rate Compression Mode 2] è impostato su
[On].
Imposta il valore desiderato di bit rate
quando la modalità di compressione del bit
rate è impostato su CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Visualizzato quando [Codec 2] è impostato
su H.264 e, allo stesso tempo, [Bit Rate
Compression Mode 2] è impostato su Off.
Imposta la qualità per H.264 o H.265.

Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Codec 3 JPEG JPEG
Imposta il codec per
l’immagine 3.
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Argomento correlato
Impostazione del codec video per lo streaming
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Voce Impostazione della voce secondaria Impostazione
predefinita Descrizione

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Imposta le dimensioni per
l’immagine 3.

Frame
Rate 3

Per informazioni dettagliate sulle frequenze fotogrammi
supportate, vedere “Impostazione del codec video per lo
streaming”.

– Imposta la frequenza
fotogrammi per l’immagine 3.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Imposta la qualità.
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Audio Stream

Consente di specificare impostazioni relative al codec audio di streaming.
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Setting On / Off Off Attiva o disattiva l’uscita audio in streaming.

Codec AAC (128kbps) / AAC (256kbps) AAC (128kbps)
Visualizzato quando [Setting] è impostato su On.
Imposta il codec audio per lo streaming.
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Language

Imposta la lingua di visualizzazione.

Nota
Le lingue disponibili possono variare a seconda del paese o dell’area geografica.
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Voce Impostazione della voce secondaria Impostazione predefinita Descrizione

Language – – Imposta la lingua di visualizzazione.
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Accessibility

Consente di specificare impostazioni relative alla lettura audio (sintesi vocale).

Nota

Questa funzione è disponibile solo sui modelli venduti in Nord America. Alla data di distribuzione, la funzione di lettura dello schermo può essere
utilizzata solo quando la lingua è impostata sull’inglese.

Abilita la funzione di lettura dello schermo del browser Web del dispositivo che esegue l’app Web.
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Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Screen
Reader

On / Off Off 
Attiva o disattiva la funzione di lettura dello schermo nel
pannello delle immagini della telecamera dell’app Web.

Speech
Rate

Slow2 / Slow1 / Normal / Fast1 /
Fast2 / Fast3 / Fast4

Normal
Imposta la velocità della funzione di lettura dello schermo.
Un passaggio di esempio viene letto ad alta voce alla
velocità configurata.

Speech
Volume

Da 1 a 15 7

Imposta il volume della funzione di lettura dello schermo
dell’app Web.
Un passaggio di esempio viene letto ad alta voce al volume
configurato.
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Clock Set

Consente di specificare le impostazioni relative all’orologio interno.

5-041-957-34(1) Copyright 2022 Sony Corporation

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Current Date
& Time

– – Visualizza la data e l’ora correnti configurate sull’unità.

PC Clock – –
Visualizza la data e l’ora correnti del tablet o computer
utilizzato per la configurazione.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-yyyy
hh:mm:ss / dd-mm-yyyy hh:mm:ss

yyyy-mm-dd Imposta il formato di visualizzazione di data e ora.

12 h / 24 h 12 h / 24 h 24 h
Imposta l’ora sul formato di visualizzazione a 12 o 24
ore.

Time Setting
Keep current setting / Synchronize
with PC / Manual setting /
Synchronize with NTP

– Imposta il metodo di configurazione di data e ora.

yy-mm-dd
hh:mm:ss

yy: da 19 a 37
mm: da 01 a 12
dd: da 01 a 31
hh: da 00 a 23
mm: da 00 a 59
ss: da 00 a 59 (secondi)

–
Visualizzato quando [Time Setting] è impostato su
Manual setting.
Imposta data e ora manualmente.

NTP Auto On / Off Off

Visualizzato quando [Time Setting] è impostato su
Synchronize with NTP.
Specifica se ottenere l’indirizzo IP del server NTP dal
server DHCP.

NTP Server Indirizzo IPv4/IPv6 o nome host –

Visualizzato quando [Time Setting] è impostato su
[Synchronize with NTP] e, allo stesso tempo, [NTP
Auto] è impostato su Off.
Specifica il server NTP utilizzato per la
sincronizzazione di data e ora.

Time Zone Da UTC −12:00 a UTC +14:00 – Seleziona il fuso orario.
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Reset

Inizializza l’unità.

Reboot
Riavvia l’unità.

Reset
Esegue il reset delle impostazioni dell’unità.

5-041-957-34(1) Copyright 2022 Sony Corporation

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Reboot Execute –

Riavvia l’unità.
Execute: Esegue la funzione.

Nota

Dopo il riavvio, ricaricare la pagina nel browser
Web.

Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

All Reset (except for
Network Settings)

Execute –

Esegue il reset delle impostazioni dell’unità eccetto le
impostazioni di rete.
Execute: Esegue la funzione.

Nota
I file LUT e i look di base importati non vengono
eliminati.

Network Reset Execute –

Esegue il reset delle impostazioni di rete dell’unità.
Execute: Esegue la funzione.

Nota
Dopo l’esecuzione di Network Reset, l’unità si riavvia.
Dopo il riavvio, ricaricare la pagina nel browser Web.

Factory Default Execute –

Ripristina le impostazioni predefinite di fabbrica
dell’unità.
Execute: Esegue la funzione.

Nota

Dopo l’esecuzione di Factory Default, l’unità si riavvia.
Dopo il riavvio, ricaricare la pagina nel browser Web.
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Information

Visualizza informazioni sulla telecamera e sull’obiettivo. Consente anche di aggiornare il software.

Camera
Visualizza informazioni sulla telecamera e consente di aggiornarne il software.

Lens
Visualizza informazioni sull’obiettivo e consente di aggiornarne il software.

Argomento correlato

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Model
Name

– – Visualizza il nome del modello della telecamera.

Serial
Number

– – Visualizza il numero di serie della telecamera.

Version
Number – – Visualizza la versione del software della telecamera.

Version Up – –

Premere il pulsante [Choose File] e seguire le istruzioni
visualizzate per aggiornare il software della telecamera.

Nota
Dopo l’aggiornamento, l’unità si riavvia. Dopo il riavvio, ricaricare
la pagina nel browser Web.

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Model
Name

– – Visualizza il nome del modello dell’obiettivo.

Serial
Number

– – Visualizza il numero di serie dell’obiettivo.

Version
Number

– – Visualizza la versione del software dell’obiettivo.

Version Up – –

Premere il pulsante [Choose File] e seguire le istruzioni
visualizzate per aggiornare il software dell’obiettivo.

Per informazioni dettagliate, vedere “Aggiornamento del
software di un obiettivo con innesto E-mount”.

Nota
Dopo l’aggiornamento dell’obiettivo, l’unità si riavvia. Dopo il
riavvio, ricaricare la pagina nel browser Web.
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Aggiornamento del software di un obiettivo con innesto E-mount
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System Log

Consente di specificare impostazioni relative al log di sistema.

Il registro acquisito viene visualizzato come mostrato di seguito.

Argomento correlato
Aggiornamento del software di un obiettivo con innesto E-mount

5-041-957-34(1) Copyright 2022 Sony Corporation

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning &
Info

Imposta il livello delle voci da aggiungere al registro di
sistema.

Log Size Da 200 a 1024 1024
Imposta le dimensioni del registro da salvare nel registro di
sistema.

Download as
File – –

Il pulsante [Download] consente di salvare il registro di
sistema su un tablet o un computer dalla schermata
visualizzata.
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HTTP Access Log

Consente di specificare impostazioni relative ai log di accesso HTTP.

5-041-957-34(1) Copyright 2022 Sony Corporation

Voce Impostazione della voce
secondaria

Impostazione
predefinita Descrizione

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning &
Info

Imposta il livello delle voci da aggiungere al registro di
accesso HTTP.

Log Size Da 200 a 1024 1024
Imposta le dimensioni del registro da salvare nel registro di
accesso HTTP.

Download as
File – –

Il pulsante [Download] consente di salvare il registro di
accesso HTTP su un tablet o un computer dalla schermata
visualizzata.

438



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Service

Ottiene informazioni interne dell’unità. Da utilizzare qualora si debba contattare il servizio di assistenza Sony.

5-041-957-34(1) Copyright 2022 Sony Corporation

Voce Impostazione della
voce secondaria

Impostazione
predefinita Descrizione

I agree to download
device information.

– –

Contrassegnare con un segno di spunta per accettare
l’acquisizione di informazioni sul dispositivo e premere il
pulsante [OK].
Premere il pulsante [Download] visualizzato. Dopo alcuni
istanti, il browser Web eseguirà il download di un file
denominato deviceinformation.dat.

Nota
Dopo il download, l’unità si riavvierà. Riavviare l’unità
manualmente se non si riavvia automaticamente. Dopo il
riavvio, ricaricare la pagina nel browser Web.
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Software

Visualizza la licenza software.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Connessione di monitor e dispositivi di registrazione esterni

Per visualizzare le immagini di registrazione e riproduzione dell’unità su un monitor esterno, scegliere il tipo di segnale di uscita video
e collegare l’unità al monitor con un cavo adatto.
È possibile anche collegare dispositivi di registrazione esterni per registrare il segnale in uscita dall’unità.
Il monitor esterno può visualizzare le stesse informazioni che sono visibili nel pannello delle immagini della telecamera, quali ad
esempio informazioni di stato e menu. Impostare su On il tipo di sistema per la visualizzazione a schermo utilizzando [Monitoring] >
[Output Display] nel menu Web.

Nota
Se il monitor collegato al connettore HDMI non supporta il formato di uscita HDMI configurato utilizzando il menu [Monitoring] nel menu Web o
nel menu della telecamera, l’immagine della telecamera non sarà emessa in uscita sull’app Web e non potrà essere emesso in uscita neanche il
video in streaming. Anche l’inquadratura automatica PTZ non funziona.

È possibile impostare sia [Output Display] > [SDI] che [HDMI/Stream] su [Off], ma questa impostazione impedirà l’uso del menu della telecamera
e delle funzioni che dipendono dalla visualizzazione a schermo. Inoltre, le eventuali notifiche di errore dell’unità saranno limitate alla luce fissa o
lampeggiante degli indicatori dell’unità e alla visualizzazione del segnale di notifica in alto a destra nell’app Web. Per essere informati in dettaglio
dello stato, impostare [Output Display] su [On].

Suggerimento
Nelle impostazioni predefinite di fabbrica, [Output Display] > [SDI] è impostato su [Off] e [HDMI/Stream] è impostato su [On]. Per utilizzare lo
streaming come video principale, impostare [SDI] su [On] e [HDMI/Stream] su [Off], quindi monitorare lo stato della telecamera su un monitor
SDI.

Connettore SDI OUT (tipo BNC)

Specificare il formato di uscita utilizzando [Monitoring] nel menu Web o nel menu della telecamera.
Per il collegamento, utilizzare un cavo coassiale da 75 Ω disponibile in commercio.

Nota
Controllare la messa a terra della connessione fra l’unità e il dispositivo esterno prima di accendere i dispositivi.

Si consiglia di accendere l’unità e il dispositivo esterno solo dopo la connessione del cavo coassiale da 75 Ω.
Se il dispositivo esterno deve essere collegato all’unità mentre l’unità è accesa, collegare il cavo coassiale da 75 Ω prima al dispositivo
esterno e solo successivamente all’unità.

Avvio simultaneo della registrazione sull’unità e sul dispositivo esterno
Con l’uscita del segnale SDI abilitata, impostare [Project] > [SDI/HDMI Rec Control] > [Setting] su [SDI/HDMI Remote I/F] o [Parallel
Rec] nel menu della telecamera per abilitare l’emissione di un segnale di trigger REC diretto al dispositivo esterno connesso al
connettore SDI OUT. Questo sincronizzerà la registrazione sul dispositivo esterno con l’unità.

Nota
Se il dispositivo esterno connesso non è compatibile con il segnale di trigger REC, il dispositivo non può essere comandato.

Quando [Project] > [SDI/HDMI Rec Control] > [Setting] è impostato su [SDI/HDMI Remote I/F] nel menu della telecamera, verrà emesso solo il
segnale di trigger REC nel caso in cui non sia inserito nessun supporto di registrazione e viene azionato pulsante START/STOP registrazione.

Connettore HDMI OUT (tipo A)

Impostare l’uscita su On o Off e specificarne il formato nel menu [Monitoring] nel menu della telecamera.

Avvio simultaneo della registrazione sull’unità e sul dispositivo esterno
Con l’uscita del segnale HDMI abilitata, impostare [TC/Media] > [HDMI TC Out] > [Setting] su [On] e [Project] > [SDI/HDMI Rec
Control] > [Setting] su [SDI/HDMI Remote I/F] o [Parallel Rec] nel menu della telecamera per abilitare l’emissione di un segnale di
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trigger REC diretto al dispositivo esterno connesso al connettore HDMI OUT. Questo sincronizzerà la registrazione sul dispositivo
esterno con l’unità.

Nota

Se il dispositivo esterno connesso non è compatibile con il segnale di trigger REC, il dispositivo non può essere comandato.

Quando [Project] > [SDI/HDMI Rec Control] > [Setting] è impostato su [SDI/HDMI Remote I/F] nel menu della telecamera, verrà emesso solo il
segnale di trigger REC nel caso in cui non sia inserito nessun supporto di registrazione e viene azionato pulsante START/STOP registrazione.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Connessione con RCP/MSU/CNA-2

Alcune delle funzioni dell’unità possono essere comandate a distanza collegando all’unità, tramite un cavo LAN, un pannello di
comando a distanza (RCP), quale ad esempio un RCP-3500/3501, un’unità di configurazione master (MSU), quale ad esempio una
MSU-3500, oppure un adattatore di rete per il controllo della telecamera CNA-2.
Il metodo di connessione varierà a seconda della configurazione dei dispositivi correlati e dell’applicazione.

Per informazioni dettagliate sulla connessione uno a uno tra l’unità e un RCP, vedere “Connessione uno a uno tra l’unità e un
RCP”.
Per informazioni dettagliate sulla connessione di più telecamere utilizzando una MSU o software di comando a distanza della
telecamera, vedere “Utilizzo dell’unità in ambienti multitelecamera con MSU/Software di comando a distanza della telecamera”.

Argomento correlato
Connessione uno a uno tra l’unità e un RCP
Utilizzo dell’unità in ambienti multitelecamera con MSU, CNA-2 o Software di comando a distanza della telecamera

5-041-957-34(1) Copyright 2022 Sony Corporation
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Connessione uno a uno tra l’unità e un RCP

Nota

Facendo riferimento a “Elenco delle funzioni supportate”, configurare l’unità in modo che soddisfi le condizioni operative per le funzioni che si
desidera utilizzare, quindi abilitare la connessione con un RCP utilizzando la procedura descritta di seguito.

Argomento correlato
Elenco delle funzioni supportate

5-041-957-34(1) Copyright 2022 Sony Corporation

Accendere ciascun dispositivo.1

Impostare [Technical] > [RCP/MSU] > [CNS Mode] su [Bridge] nel menu Web della telecamera.2

Configurare le seguenti impostazioni sull’RCP.

Per informazioni dettagliate sulla configurazione, fare riferimento alle istruzioni per l’uso dell’RCP.

3

Impostare la modalità di connessione sulla modalità Bridge.1.
Registrare l’indirizzo IP della telecamera.2.
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Utilizzo dell’unità in ambienti multitelecamera con MSU, CNA-2 o Software di comando a
distanza della telecamera

Utilizzando una MSU o un apposito software di comando a distanza, è possibile collegare insieme più telecamere.

Nota
Facendo riferimento a “Elenco delle funzioni supportate”, configurare l’unità in modo che soddisfi le condizioni operative per le funzioni che si
desidera utilizzare, quindi abilitare la connessione con una MSU o un software di comando a distanza della telecamera utilizzando la procedura
descritta di seguito.

Argomento correlato
Elenco delle funzioni supportate

5-041-957-34(1) Copyright 2022 Sony Corporation

Accendere ciascun dispositivo.1

Configurare le impostazioni di rete del sistema utilizzando la MSU o il software di comando a distanza della telecamera.

Per informazioni dettagliate sulla configurazione, fare riferimento alle istruzioni per l’uso della MSU o del software di comando a
distanza della telecamera.

2

Configurare le seguenti impostazioni utilizzando [Technical] > [RCP/MSU] nel menu Web della telecamera.3

Se si utilizza una MSU o un CNA-2, impostare [CNS Mode] su [MCS]. Se si utilizza un software di comando a distanza della
telecamera, impostare [CNS Mode] su [PC Control].

1.

Impostare l’indirizzo IP della MSU master o del software di comando a distanza della telecamera in [Master IP Address].2.
Impostare il numero di telecamera sul quale verrà registrata la telecamera in [Camera No.].3.
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Elenco delle funzioni supportate

La seguente tabella mostra le funzioni supportate e le relative condizioni operative.

Pannello
delle

operazioni
Funzioni dell’unità Condizioni operative

IRIS Regolazione manuale del diaframma –

AUTO IRIS Attivazione e disattivazione di Auto Iris –

ND Regolazione della trasmittanza in modalità ND
variabile e selezione di posizione predefinita

–

MASTER
GAIN

Regolazione manuale del guadagno (in passi di 3 dB)
Abilitato quando la modalità di ripresa è impostata su
Custom e, allo stesso tempo, [Shooting] > [ISO/Gain/EI] >
[Mode] è impostata su [dB] nel menu della telecamera.

WHITE (R/B)
Regolazione manuale del bilanciamento del bianco
(R Gain/B Gain)

Abilitato quando [White Mode] è impostato su [Memory A
(R/B)] o [Memory A (T/T)].WHITE (Color

Temp)

Regolazione manuale del bilanciamento del bianco
(temperatura di colore/tono di colore)

RCP > [Color Temp]: Temperatura di colore del
bilanciamento del bianco
RCP > [Balance]: Valore del tono di colore del
bilanciamento del bianco

AWB Regolazione automatica del bilanciamento del bianco –

ATW
Attivazione e disattivazione della funzione ATW (Auto
Tracing White Balance)

Abilitata quando la modalità di ripresa è impostata su
Custom.

BLACK R/B Regolazione del bilanciamento del nero
Abilitata quando la modalità di ripresa è impostata su
Custom.

446



Nota

Pannello
delle

operazioni
Funzioni dell’unità Condizioni operative

MASTER
BLACK

Regolazione del livello del nero master

Abilitata quando la modalità di ripresa è impostata su
Custom.
H/V Ratio e Crispening sono abilitati quando
[Paint/Look] > [Detail] > [Manual Setting] è impostato su
[On] nel menu della telecamera.
Per abilitare o disabilitare la funzione di visualizzazione
che identifica le aree oggetto della correzione
multimatrice da un RCP, impostare [Paint/Look] > [Multi
Matrix] > [Area Indication Control] su [Menu & RCP] nel
menu della telecamera.
La funzione di visualizzazione che identifica le aree
oggetto della correzione multimatrice e BARS
funzionano solo in modalità Bridge.

DETAIL

Attivazione o disattivazione della funzione di
regolazione del dettaglio
Impostazione del livello del dettaglio
Impostazione di H/V Ratio
Impostazione di Crispening

User Matrix

Attivazione o disattivazione della funzione di
correzione della matrice dell’utente
Impostazione dei valori di correzione della
matrice (R-G/R-B/G-R/G-B/B-R/B-G)

Multi Matrix

Attivazione o disattivazione della funzione di
correzione multimatrice
Impostazione di tonalità (hue) e saturazione del
colore utilizzato per la correzione multimatrice
Attivazione e disattivazione della funzione di
visualizzazione delle aree oggetto della
correzione multimatrice

Knee

Attivazione e disattivazione della funzione di
correzione del knee
Attivazione e disattivazione della funzione di
correzione automatica del knee
Impostazione del punto di knee e dell’inclinazione del
knee

BARS Attivazione e disattivazione delle barre colori

SHUTTER

Attivazione o disattivazione della funzione
dell’otturatore
Impostazione della velocità dell’otturatore
(Non sono supportati attivazione e disattivazione
della funzione di otturatore automatico,
impostazione dell’angolo di otturazione,
impostazione dell’otturatore lento, impostazione
di ECS)

Nota
In base alla velocità di otturatore configurata, le
impostazioni dell’otturatore dell’RCP potrebbero
non essere visualizzate.

Le impostazioni dell’otturatore dell’RCP
potrebbero non essere visualizzate
correttamente se l’otturatore non può essere
azionato dall’RCP.

Se l’otturatore automatico è attivo, l’otturatore automatico
continuerà a funzionare anche se si attiva o disattiva
l’otturatore o si modifica il valore della velocità
dell’otturatore dall’RCP.
Quando l’otturatore è impostato su [Angle], l’attivazione o
disattivazione dell’otturatore e la modifica della velocità
dell’otturatore dall’RCP non sono supportate.

CALL/Tally Supporta la visualizzazione della funzione CALL/Tally Abilitato quando [Technical] > [Tally] > [Tally Control] è
impostato su [External] nel menu Web.
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Dopo aver configurato l’unità in modo che soddisfi le condizioni operative della funzione che si desidera utilizzare, abilitare il collegamento tra
unità e RCP/MSU/CNA-2. Se le condizioni operative vengono regolate dopo l’abilitazione della connessione, potrebbero verificarsi
comportamenti anomali.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Utilizzo del Telecomando RM-IP500 (opzionale)

L’unità può essere azionata da un telecomando Sony RM-IP500 dotato di software versione 2.2 o successiva. I dispositivi comunicano
fra di loro mediante il protocollo VISCA over IP (LAN).
In base al comando desiderato, potrebbe essere necessario osservare la visualizzazione a schermo dell’unità. Preparare un monitor
che possa essere utilizzato per controllare la visualizzazione a schermo.
Il Telecomando RM-IP500 consente di eseguire le operazioni indicati di seguito.

Selezione della telecamera su cui agire
Regolazione dell’inquadratura (movimento orizzontale pan, verticale tilt e zoom).
Regolazione della messa a fuoco (eccetto tramite touchscreen)
Registrazione e richiamo delle posizioni di preset
Utilizzo dei menu dell’unità (eccetto il menu Web)
Regolazione della luminosità
Regolazione del bilanciamento del bianco
Regolazione del bilanciamento del nero
Impostazione del livello di ingresso audio
Avvio e arresto della registrazione
Esecuzione di funzioni assegnate pulsanti programmabili dell’unità
Operazioni di inizializzazione del controller dell’obiettivo
Azionamento della funzione di inquadratura automatica PTZ
* Funzionamento su RM-IP500 versione 2.30 e successive.

Per informazioni dettagliate sull’utilizzo del Telecomando RM-IP500, fare riferimento alle sue istruzioni per l’uso.

Nota

Quando si preme il pulsante PRESET durante l’operazione di inquadratura automatica pan/tilt, la prima pressione mette in pausa l’inquadratura
automatica. Assicurarsi che le operazioni di pan/tilt si siano arrestate, quindi premere nuovamente il pulsante PRESET per richiamare un preset.

Suggerimento
Quando si utilizza un Telecomando RM-IP500, utilizzare la maschera comandi specifica per questa unità fornita con il telecomando stesso.

RM-IP500 (con maschera comandi specifica per questa unità)
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Connessione di un Telecomando RM-IP500

Per informazioni dettagliate sull’assegnazione delle funzioni del Telecomando RM-IP500, fare riferimento alle sue istruzioni per
l’uso.

5-041-957-34(1) Copyright 2022 Sony Corporation

Spostare sulla posizione ON il selettore SETUP 3 dell’unità per abilitare la comunicazione tramite VISCA over IP.

Nota
La posizione del selettore viene registrata alla riaccensione dell’unità.

1

Collegare il Telecomando RM-IP500 alla stessa rete dell’unità.2

Seguire la procedura descritta nelle istruzioni per l’uso del Telecomando RM-IP500 per configurare la connessione
VISCA over IP (LAN) su di esso.

Assegnare questa unità utilizzando il menu RM > AUTO IP SETUP > ASSIGN CAM.

3

Assegnare le funzioni di questa unità ai pulsanti e alle manopole, secondo le proprie esigenze, utilizzando le seguenti
voci del menu RM del Telecomando RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Informazioni su Camera Remote SDK

Camera Remote SDK (Software Development Kit) è un ambiente di sviluppo che consente lo sviluppo di soluzioni e applicazioni per
videocamere e fotocamere Sony. L’utilizzo di questo SDK consente di comandare a distanza videocamere e fotocamere Sony tramite
un PC host e sviluppare applicazioni esclusive per le riprese e il trasferimento di immagini. L’SDK fornisce anche molte funzioni, come
la modifica delle impostazioni della telecamera, l’avvio e l’arresto della registrazione, il monitoraggio live view e altro ancora.
Per informazioni dettagliate, visitare il seguente sito Web:
https://www.sony.net/CameraRemoteSDK/

5-041-957-34(1) Copyright 2022 Sony Corporation
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Sincronizzazione con un dispositivo esterno

Per le riprese con più unità, le unità utilizzate possono essere sincronizzate insieme su un codice temporale o un segnale di
riferimento specifico tramite il loro connettore GENLOCK.

Per informazioni dettagliate sul genlock, vedere “Sincronizzazione della fase del segnale video (Genlock)”.
Per informazioni dettagliate sulla sincronizzazione dei codici temporali, vedere “Sincronizzazione del codice temporale con altri
dispositivi”.

Argomento correlato
Sincronizzazione della fase del segnale video (Genlock)

Sincronizzazione del codice temporale con altri dispositivi

5-041-957-34(1) Copyright 2022 Sony Corporation
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Sincronizzazione della fase del segnale video (Genlock)

Per consentire la sincronizzazione genlock, è possibile fornire un segnale di riferimento al connettore GENLOCK.
I segnali di riferimento utilizzabili in ingresso variano a seconda della frequenza di sistema del formato di registrazione selezionato.

È possibile controllare lo stato della sincronizzazione esterna utilizzando [Technical] > [Genlock] > [Reference] nel menu della
telecamera.

Nota
Se il segnale di riferimento non è stabile, sarà impossibile ottenere la sincronizzazione genlock.

Il subcarrier non è sincronizzato.

Quando si utilizza la sincronizzazione esterna in un ambiente rumoroso, si consiglia di utilizzare la sincronizzazione a tre livelli, la quale offre una
maggiore immunità al rumore.

5-041-957-34(1) Copyright 2022 Sony Corporation

Frequenza di sistema del formato di registrazione Segnali di riferimento in ingresso consentiti

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i
1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Sincronizzazione del codice temporale con altri dispositivi

Impostare l’unità che fornisce il codice temporale su una modalità in cui il codice temporale continui ad avanzare (es. Free Run o
Clock).

Nota

Controllare che il codice temporale di riferimento e il segnale video di riferimento siano in un rapporto di fase conforme agli standard SMPTE per i
codici temporali.

Durante il funzionamento in modalità di sincronizzazione esterna, il codice temporale acquisisce istantaneamente la sincronizzazione con il
codice temporale esterno e nella sezione di visualizzazione dei dati temporali viene visualizzato il valore del codice temporale esterno. Tuttavia,
non avviare immediatamente la registrazione. Prima di avviare la registrazione è necessario attendere alcuni secondi la stabilizzazione del
generatore del codice temporale.

Se la frequenza del segnale video di riferimento e la frequenza fotogrammi dell’unità non sono identiche, non sarà possibile ottenere la
sincronizzazione e l’unità non potrà funzionare correttamente. In questo caso, il codice temporale non potrà sincronizzarsi correttamente con il
codice temporale esterno.

Se la sorgente del codice temporale esterno viene disconnessa, il codice temporale potrà variare di un fotogramma all’ora rispetto al codice
temporale di riferimento.

Per rilasciare la sincronizzazione esterna
Cambiare l’impostazione di [TC/Media] > [Timecode] nel menu della telecamera.
La sincronizzazione esterna viene annullata anche quando si cambia frequenza di sistema o quando si avvia la registrazione in una
modalità di registrazione speciale (Slow & Quick Motion o Interval Rec).

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostare le seguenti opzioni in [TC/Media] > [Timecode] nel menu della telecamera.

Impostare [Mode] su [Preset].
Impostare [Run] su [Free Run].

1

Premere il pulsante programmabile a cui è assegnata la funzione [DURATION/TC/U-BIT] per visualizzare il codice
temporale sullo schermo.

2

Fornire un segnale di riferimento video HD o SD sul connettore GENLOCK e il codice temporale di riferimento sul
connettore TC IN.

Il generatore del codice temporale dell’unità si sincronizza con il codice temporale di riferimento e sullo schermo appare
l’indicazione “EXT-LK”.
Una volta trascorsi dieci secondi circa dall’acquisizione della sincronizzazione, lo stato di sincronizzazione esterno viene
mantenuto anche se la sorgente di riferimento esterna del codice temporale viene scollegata.

3
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Collegamento di un microfono esterno o di un dispositivo audio esterno

È possibile fornire in entrata il segnale proveniente da un microfono esterno o da un dispositivo audio esterno e incorporarne l’audio
nel video registrato o nel video in uscita dell’unità.

Collegare il microfono esterno o il dispositivo audio esterno utilizzando un cavo XLR.

Quando l’audio è impostato su [LINE] utilizzando [Audio] > [Audio Input] > [AUDIO IN Select] nel menu della telecamera, il
connettore AUDIO IN funziona come il connettore AUDIO IN CH-1 e il connettore AUDIO IN CH-2.

1

N. pin Funzione

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Spegnere l’unità e collegare il cavo XLR al connettore AUDIO IN.2

Spostare il selettore SETUP 2 per abilitare l’alimentazione phantom in base alle esigenze.

Attivare l’alimentazione +48 V (alimentazione phantom) come descritto di seguito.
Selettore 2
Specifica se deve essere attiva l’alimentazione +48 V (alimentazione phantom) quando è connesso un dispositivo di ingresso
audio.

Nota

3

Impostazione Descrizione

OFF
(predefinito)

Questo disattiva l’alimentazione phantom a +48 V e imposta gli ingressi LINE o MIC come sorgente audio
CH-1 e CH-2.

ON
Questo attiva l’alimentazione phantom a +48V e imposta il microfono con alimentazione phantom come
sorgente audio CH-1 e CH-2.
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Prima di spostare il selettore sulla posizione ON, assicurarsi che il microfono connesso sia compatibile con l’alimentazione a +48V per
evitare di danneggiarlo. Controllare questa impostazione prima di procedere con il collegamento.

Accendere l’unità e impostare il tipo di dispositivo connesso utilizzando [Audio] > [Audio Input] > [AUDIO IN Select] nel
menu della telecamera.

4
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Gestione ed editing di clip con un computer

È possibile eseguire la gestione e l’editing di clip utilizzando un computer.

Importazione di clip utilizzando un lettore di schede (opzione)

Collegare al computer un lettore di schede SD o CFexpress Type A e importare i clip utilizzando un software che supporti il formato di
registrazione di questa unità, ad esempio Catalyst Browse.

Utilizzo di un sistema di editing non lineare

In un sistema di editing non lineare, è necessario utilizzare un software di editing (opzione) che supporti i formati registrati dall’unità.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Emissione di un segnale su fibra ottica

È possibile emettere un segnale SDI convertito a segnale ottico collegando un modulo SFP+ (opzione) al connettore OPTICAL
dell’unità. Utilizzare un modulo SFP+ appropriato per la banda di segnale di ciascun formato.
Banda di segnale

4K (59.94p, 50p): 12G
4K (diverso da 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (diverso da 59.94p, 50p): 1.5G

Nota
Utilizzare un modulo conforme agli standard indicati di seguito.

Standard SFF
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

Standard SDI
ST297/ST292/ST424/ST425/ST2081/ST2082

Sul modulo SFP+ viene emesso in uscita lo stesso segnale fornito al connettore di uscita SDI.

L’unità non supporta l’ingresso di segnale su fibra ottica.

Utilizzare un modulo SFP+ per fornire in uscita un segnale su fibra ottica. Per informazioni dettagliate sui moduli SFP+ verificati rivolgersi al
proprio rivenditore o al servizio di assistenza Sony.

5-041-957-34(1) Copyright 2022 Sony Corporation

* Livello di potenza I (1,0 W)
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Connessione di un segnale di tally

Questo argomento descrive il controllo del segnale tally.

Illuminazione dell’indicatore tally tramite un segnale proveniente da un dispositivo di comando a
distanza

È possibile illuminare l’indicatore tally tramite un comando VISCA over IP da un dispositivo esterno, ad esempio un Telecomando RM-
IP500.
Impostare [Technical] > [Tally] > [Tally Control] su [External] nel menu Web o nel menu della telecamera.

Illuminazione dell’indicatore tally da un dispositivo esterno

È possibile illuminare l’indicatore tally dell’unità con luce rossa o verde da un dispositivo esterno, ad esempio un Telecomando RM-
IP500 o uno switcher. È possibile controllare il tally utilizzando comandi trasmessi sulla rete oppure utilizzando un ingresso di segnale
tally sul connettore OPTION dell’unità.
Impostare [Technical] > [Tally] > [Tally Control] su [External] nel menu Web o nel menu della telecamera.
Quando si immette un segnale tally sul connettore OPTION, cortocircuitare il pin 7 a GND (pin 4 o 5) per illuminare l’indicatore tally
verde oppure il pin 8 a GND (pin 4 o 5) per illuminare l’indicatore tally rosso.

Nota
Quando [Tally Control] è impostato su [External], l’indicatore tally non segnala lo stato di registrazione dell’unità.

Se sono immessi in entrata contemporaneamente un tally rosso e un tally verde, l’indicatore dell’unità si illumina in rosso.

Specifiche dei pin del connettore OPTION

N. pin Direzione del segnale Specifiche del segnale

1 – Segnale RS-232C TX (per dispositivo di comando obiettivo)

2 – Segnale RS-232C RX (per dispositivo di comando obiettivo)

3 OUT

Uscita indicatore tally verde
Uscita di basso livello quando l’indicatore tally verde è illuminato.
Hi-Z (uscita open-drain) quando l’indicatore tally verde non è illuminato.

4 – GND (massa)

5 – GND (massa)

6 OUT

Uscita indicatore tally rosso
Uscita di basso livello quando l’indicatore tally rosso è illuminato.
Hi-Z (uscita open-drain) quando l’indicatore tally rosso non è illuminato.
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Illuminazione dell’indicatore tally di un dispositivo esterno utilizzando un segnale proveniente dall’unità

È possibile illuminare l’indicatore tally di un dispositivo esterno utilizzando un segnale proveniente dall’unità collegando insieme il pin 3
e il pin 6 del connettore OPTION come mostrato di seguito.
Esempio di connessione dei pin 3 e 6 del connettore OPTION

Nota
Non applicare tensione ai pin 7 e 8.

Non collegare dispositivi esterni in grado di applicare tensione al connettore OPTION.

Qualora venga applicata al pin 3 o al pin 6 una tensione di picco o una tensione di ritorno, si potrebbero causare guasti, emissione di fumo o
incendi.

Specificare il formato di uscita utilizzando [Technical] > [Tally] > [Tally Control] nel menu Web o nel menu della telecamera.
[Internal]: Stato dell’operazione di registrazione dell’unità
[External]: OR logico dei segnali di tally rosso e verde ricevuti dall’unità tramite segnali IN e telecomandi.

5-041-957-34(1) Copyright 2022 Sony Corporation

N. pin Direzione del segnale Specifiche del segnale

7 IN
Ingresso di comando esterno tally verde
Il cortocircuito a GND (pin 4 o 5) fa sì che l’indicatore tally dell’unità si illumini di verde.

8 IN
Ingresso di comando esterno tally rosso
Il cortocircuito a GND (pin 4 o 5) fa sì che l’indicatore tally dell’unità si illumini di rosso.
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Emissione in uscita dei dati di tracking

L’unità è in grado di emettere in uscita informazioni di tracking di pan, tilt, zoom, messa a fuoco e diaframma sincronizzate con un
segnale di sync.
Questa funzione fornisce i dati utilizzando il protocollo standard free-d.

Suggerimento
Per impostare due o più destinazioni di output, ripetere i passi da 3 a 6 del punto 2 per [Destinations] > [2], [3] e [4] per ciascuna ulteriore
destinazione di output.

Le destinazioni di output dei dati di tracking possono essere configurate solo utilizzando IPv4.

È possibile impostare le coordinate della telecamera per i dati di tracking della posizione XYZ utilizzando [Tracking Data] > [Camera Position] >
[X][Y][Z].

Formato dei dati di uscita

Suggerimento

Informazioni tecniche dettagliate sono reperibili nel documento “free-d Integration manual for AR/VR systems”. Rivolgersi a un rappresentante
commerciale Sony.

I dati di tracking forniti in uscita dall’unità consistono di dati conformi al formato Type D1 specificato nel protocollo free-d.

Nota
Nelle seguenti situazioni i dati di tracking potrebbero subire ritardi o i loro valori potrebbero non essere aggiornati:

Mentre è attivo S&Q Motion
Durante la visualizzazione del menu della telecamera
Durante la visualizzazione della schermata delle miniature
Durante la riproduzione di clip registrati
Durante la visualizzazione del menu Web

Impostare [Output] su [Off] per le destinazioni di cui non è necessario inviare dati di tracking.

In caso di output verso più client, a partire dalla seconda destinazione e per le destinazioni successive avrà luogo un ritardo costante nella
temporizzazione della trasmissione rispetto al segnale genlock. (Il ritardo aumenta per ogni client successivo. In determinati ambienti di rete si
potrà verificare un aumento della latenza).

5-041-957-34(1) Copyright 2022 Sony Corporation

Accedere all’app Web.1

Selezionare il metodo di output dei dati di tracking.2

Impostare l’ID dell’unità in [Technical] > [Tracking Data] > [Camera ID] nel menu Web.1.
Specificare l’indirizzo IP di destinazione dell’output in [Destinations] > [1] > [IPv4 Address].2.
Specificare il numero di porta di destinazione dell’output in [Destinations] > [1] > [Port].3.
Impostare [Destinations] > [1] > [Output] su [On].4.
Premere il pulsante [OK].5.
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Montaggio di un dispositivo di comando obiettivo

Montando un dispositivo di comando obiettivo disponibile in commercio (opzione) compatibile con questa unità, è possibile azionare lo
zoom di un obiettivo con zoom manuale utilizzando l’app Web, un’unità RM-IP500 (opzione) o il telecomando a infrarossi.
Per ulteriori informazioni sul montaggio del dispositivo di comando obiettivo, fare riferimento alle relative istruzioni per l’uso.
Per informazioni dettagliate sulla regolazione dello zoom mediante un dispositivo di comando obiettivo, fare riferimento a “Regolazione
dello zoom mediante un dispositivo di comando obiettivo”.

Nota
Prima di procedere con l’utilizzo del dispositivo di comando obiettivo, leggerne attentamente le istruzioni per l’uso e assicurarsi di averne
compreso appieno l’utilizzo. Sony non potrà essere ritenuta responsabile per eventuali reclami di qualsiasi tipo derivanti dall’uso di un dispositivo
di comando obiettivo.

Clear Image Zoom non è disponibile quando è abilitato un dispositivo di comando obiettivo. Si consiglia di impostare il rapporto di Clear Image
Zoom su 1,0× o disabilitare Clear Image Zoom.

Mentre è abilitato il dispositivo di comando obiettivo, non sarà possibile registrare o riprodurre operazioni di inquadratura della telecamera.

Argomento correlato
Regolazione dello zoom mediante un dispositivo di comando obiettivo

5-041-957-34(1) Copyright 2022 Sony Corporation
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Regolazione dello zoom mediante un dispositivo di comando obiettivo

Utilizzare la procedura seguente per montare un dispositivo di comando obiettivo (opzione) e regolare lo zoom.

Controllo dello stato del dispositivo di comando obiettivo
Premere il pulsante  (stato della telecamera) nell’area comune della schermata dell’app Web per visualizzare la schermata di stato
della telecamera.

Collegare il dispositivo di comando obiettivo al connettore OPTION del pannello connettori dell’unità.

Per informazioni dettagliate sulla connessione, fare riferimento alle istruzioni per l’uso del dispositivo di comando obiettivo.

1

Configurare il dispositivo di comando obiettivo per l’obiettivo zoom utilizzato.

Per ulteriori informazioni, fare riferimento alle istruzioni per l’uso del dispositivo di comando dell’obiettivo.

2

Bloccare il movimento di pan e tilt dell’unità e montare l’obiettivo zoom.

Per informazioni dettagliate, vedere “Montaggio dell’obiettivo”.

3

Regolare il dispositivo di comando obiettivo in modo che possa azionare l’obiettivo zoom.4

Assicurarsi di mantenere l’equilibrio del corpo della telecamera spostandolo avanti o indietro in modo che la base
scorrevole rimanga orizzontale.

Per ulteriori informazioni fare riferimento alle Istruzioni per l’uso del dispositivo di comando dell’obiettivo e a “Montaggio
dell’obiettivo”.

5

Impostare [Technical] > [Lens Controller] > [Setting] su [On] nel menu Web e premere il pulsante [OK].

L’unità si riavvierà. Attendere il completamento dell’operazione di reset pan e tilt.

6

Premere il pulsante  (inizializza dispositivo di comando obiettivo) nella scheda  (Others) del pannello di
controllo della telecamera della schermata delle operazioni live dell’app Web.

Il dispositivo di comando obiettivo entra in movimento per rilevare l’escursione dello zoom. Per ulteriori informazioni, fare
riferimento alle istruzioni per l’uso del dispositivo di comando dell’obiettivo.
Quando l’indicazione  (errore dispositivo di comando obiettivo) nella sezione in alto a sinistra del pannello dell’immagine della
telecamera diventa  (dispositivo di comando obiettivo pronto), le operazioni di preparazione sono completate.

Nota
Annotare l’escursione operativa dell’obiettivo al momento dell’inizializzazione del dispositivo di comando dell’obiettivo stesso.

7

Regolare lo zoom utilizzando il cursore [Zoom] dell’app Web o i pulsanti di comando dello zoom del telecomando a
infrarossi.

8
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Questa schermata consente anche di controllare lo stato del dispositivo di comando obiettivo.

Nota
Inizializzare sempre il dispositivo di comando obiettivo dopo ogni sostituzione dell’obiettivo.

Clear Image Zoom non è disponibile quando è abilitato un dispositivo di comando obiettivo. Si consiglia di impostare il rapporto di Clear Image
Zoom su 1,0× o disabilitare Clear Image Zoom.

Suggerimento
Quando si utilizza l’inquadratura automatica PTZ, impostare accelerazione e/o decelerazione sul valore massimo. Si osservi inoltre che la
precisione potrà variare a seconda dell’obiettivo utilizzato. Verificarne il funzionamento prima dell’uso effettivo.
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Stato Descrizione

Off Utilizzare lo zoom motorizzato dell’obiettivo E-mount.

Communication
Error

Si è verificato un errore di comunicazione tra l’unità e il dispositivo di comando dell’obiettivo.
Controllare il collegamento tra unità e dispositivo di comando obiettivo, quindi inizializzare il dispositivo di
comando obiettivo facendo riferimento alle relative istruzioni per l’uso.

Uninitialized Eseguire l’inizializzazione.

Initializing Attendere il completamento dell’inizializzazione.

Initialization
Failed

Controllare il collegamento tra unità e dispositivo di comando obiettivo, quindi inizializzare il dispositivo di
comando obiettivo facendo riferimento alle relative istruzioni per l’uso.

Working Azionare lo zoom mediante il dispositivo di comando obiettivo.

Rotation Error
I valori di escursione dello zoom memorizzati potrebbero non corrispondere all’escursione effettivamente
consentita dall’obiettivo. Inizializzare il dispositivo di comando dell’obiettivo.

System Error Controllare il collegamento tra l’unità e il dispositivo di comando dell’obiettivo, inizializzare il dispositivo di
comando dell’obiettivo facendo riferimento alle relative istruzioni per l’uso oppure spegnere e riaccendere l’unità
e il dispositivo di comando dell’obiettivo.Unknown Error
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Precauzioni per l’uso

Informativa sulla privacy
La funzione di seguimento della telecamera utilizza tecnologie di intelligenza artificiale e riconoscimento facciale per identificare
automaticamente i soggetti e comandare i movimenti di pan, tilt e zoom in modo da mantenere il soggetto nell’inquadratura
dell’immagine. Questa funzione elabora i dati “biometrici” facciali dei soggetti selezionati come oggetto del seguimento dall’utente.
Questi dati di riconoscimento sono memorizzati all’interno della telecamera per un certo periodo e non sono inviati a Sony. La
telecamera non memorizza al suo interno nessun’altra informazione osteoscheletrica o facciale acquisita. Questi dati di riconoscimento
possono essere eliminati spegnendo la telecamera, mettendola in stato di standby o arrestando la funzione di seguimento.
Utilizzando questa funzione della telecamera, l’utente accetta di essere responsabile per la raccolta e dell’uso di immagini e dati dei
soggetti in conformità con le leggi applicabili in materia di protezione dei dati. Si consiglia di informare i soggetti della tecnologia di
seguimento e riconoscimento facciale utilizzata da questa telecamera prima dell’inizio delle riprese. In caso di domande, rivolgersi
all’assistenza clienti Sony.

Precauzioni per l’uso
Durante le riprese con questa telecamera, rispettare la privacy degli altri e rispettare tutte le leggi, i regolamenti sulla privacy
nonché le norme morali locali esistenti nei luoghi in cui si stanno eseguendo le riprese.
Non utilizzare questa telecamera per scopi illegali o indebiti.
Non utilizzare questa telecamera allo scopo di diffamare, abusare, molestare, perseguitare, minacciare o violare i diritti legali di
altri, inclusi i diritti alla privacy e alla pubblicità.
Questa telecamera non è destinata ad applicazioni militari o di polizia.

Precauzioni per il trasporto e l’imballaggio
Durante il trasporto o l’imballaggio dell’unità, osservare le seguenti precauzioni ed evitare di assoggettarla a forti vibrazioni o urti.

Rimuovere l’obiettivo e montare il coperchietto di protezione del corpo.
Dopo aver spostato la testa della telecamera (A) in avanti, bloccarla in posizione ruotando la levetta di blocco della testa della
telecamera (B) nella direzione indicata dalla freccia.

Orientare la testa della telecamera in modo che sia rivolta verso la parte anteriore dell’unità e bloccarla utilizzando la levetta di
blocco pan/tilt.

Rimuovere i cavi di collegamento.

Condensa
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Qualora l’unità venga spostata rapidamente da un ambiente freddo a uno caldo, oppure se la temperatura ambiente dovesse
aumentare improvvisamente, è possibile che si formi umidità sulle superfici esterne dell’unità e/o al suo interno. Questo fenomeno è
denominato condensazione. In tal caso, spegnere l’unità ed attendere la scomparsa della condensazione prima di riavviarla. L’utilizzo
dell’unità mentre è presente condensazione può causare danni all’unità stessa.

Fenomeni intrinsechi al sensore immagini CMOS della telecamera

Nota
Di seguito si descrivono alcuni fenomeni che potrebbero apparire nelle immagini. Tali fenomeni sono intrinsechi dei sensori di immagine. Non
possono esser considerati malfunzionamenti.

Macchiette bianche
I sensori di immagine sono prodotti con tecnologie di elevatissima precisione. Ciononostante possono presentarsi sullo schermo, in
alcuni rari casi, piccole macchiette bianche causate da raggi cosmici o altri motivi.
Questo fenomeno è intrinseco al principio di funzionamento dei sensori immagine e non indica la presenza di guasti. Eseguire
regolarmente la funzione APR.
Le macchiette bianche tendono ad apparire principalmente nei seguenti casi:

in caso di elevate temperature ambiente
se è stato aumentato il guadagno (sensibilità)

Sfarfallio
Nelle riprese effettuate con illuminazione prodotta da lampade fluorescenti o LED o ai vapori di sodio o di mercurio, lo schermo
potrebbe presentare fenomeni di sfarfallio e i colori potrebbero apparire alterati.

Meccanismi di motorizzazione dell’obiettivo e dei movimenti di pan e tilt
Qualora il meccanismo di motorizzazione dell’obiettivo e del movimento di pan e tilt non venga utilizzato per un periodo di tempo
prolungato, è possibile che si verifichi un aumento della viscosità dei lubrificanti applicati al suo interno, impedendo al meccanismo di
muoversi. Azionare regolarmente l’obiettivo e il meccanismo pan e tilt.

Componenti di consumo
La ventola e la batteria ricaricabile incorporata sono considerate componenti di consumo e dovranno essere sostituite
periodicamente.
Se l’apparecchio viene utilizzato a temperatura ambiente, il ciclo normale di sostituzione è di circa 5 anni. Tuttavia, ciò ha un valore
puramente indicativo e non implica alcuna garanzia sulla durata di vita prevista di questi componenti.
Per ulteriori informazioni sulla sostituzione dei componenti, rivolgersi al proprio rivenditore.

La vita utile prevista dell’adattatore CA e del condensatore elettrolitico è di circa 5 anni a temperature normali e in condizioni di
utilizzo normale (8 ore al giorno per 25 giorni al mese). Se le condizioni di utilizzo eccedono i valori normali sopra indicati, la vita
prevista si ridurrà proporzionalmente.

Si consiglia di eseguire dei controlli periodici per assicurare il funzionamento corretto dell’apparecchio e prolungarne la vita utile. Per
ulteriori informazioni sui controlli, contattare il servizio di assistenza tecnica Sony.

Batteria ricaricabile incorporata
L’unità è dotata di una batteria ricaricabile interna che consente la memorizzazione di data, ora e altre impostazioni anche quando
l’unità è spenta. La batteria interna si ricarica mentre l’unità rimane collegata a una presa di corrente elettrica tramite l’adattatore CA o
viene alimentata tramite PoE++. La ricarica richiede 24 ore indipendentemente dal fatto che l’unità sia accesa o spenta. Se l’unità non
è connessa a un adattatore CA collegato a una sorgente di alimentazione, la batteria ricaricabile si scaricherà completamente dopo
circa 2 mesi. Utilizzare l’unità dopo aver ricaricato la batteria. In ogni caso, l’unità funziona correttamente anche se la batteria
ricaricabile è scarica, purché non sia necessario registrare la data.

Ambienti d’impiego e conservazione
Conservare su una superficie piana in un ambiente ben ventilato.
Evitare di usare o conservare l’unità negli ambienti indicati di seguito.

Luoghi esposti a pioggia o acqua (anche sotto tettoie).
All’aperto e in luoghi in cui sono presenti temperature superiori a 40 °C.
Ricordare che in estate, in climi caldi, la temperatura all’interno di un’auto con i finestrini chiusi può facilmente superare i 50 °C.
In luoghi in cui sono presenti temperature inferiori a 0 °C.
In ambienti umidi o polverosi. In ambienti in cui l’unità potrebbe essere esposta alla pioggia.
In luoghi soggetti a forti vibrazioni o impatti.
Luoghi in cui si generano radiazioni, raggi X e intensi campi magnetici.
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In prossimità di impianti di trasmissione radio o TV che producono forti campi elettromagnetici.
In esposizione alla luce solare diretta o in prossimità di fonti di riscaldamento per periodi prolungati.

Nota sui raggi laser
I raggi laser possono danneggiare il sensore immagine CMOS. Qualora vengano riprese scene in cui sono presenti raggi laser,
prestare attenzione ad evitare che tali raggi colpiscano il sensore immagine CMOS della telecamera. I particolare, i fasci laser ad alta
potenza generati da dispositivi medicali o di altro tipo possono causare danni anche se riflessi o diffusi.

Prevenzione delle interferenze elettromagnetiche causate da dispositivi di comunicazione
portatili
L’uso di telefoni portatili e di altri dispositivi di comunicazione in prossimità di questa unità potrebbe causare malfunzionamenti ed
interferenze con i segnali audio e video. Si consiglia di spegnere eventuali dispositivi di comunicazione portatili nelle vicinanze di
questa unità.

Non collocare questo prodotto nelle vicinanze di dispositivi medicali
Questo prodotto (accessori inclusi) contiene magneti che potrebbero interferire con pacemaker, valvole shunt programmabili per il
trattamento dell’idrocefalo o altri dispositivi medicali. Non collocare questo prodotto nelle vicinanze di persone che fanno uso di tali
dispositivi medicali. Consultare il proprio medico prima di usare questo prodotto se si fa uso di dispositivi medicali.

Precauzioni per la sicurezza
SONY NON SARÀ RESPONSABILE PER DANNI DI QUALSIASI TIPO RISULTANTI DALLA MANCATA IMPLEMENTAZIONE DI
ADEGUATE MISURE DI SICUREZZA SUI DISPOSITIVI DI TRASMISSIONE, DA INEVITABILI PERDITE O FUGHE DI DATI
RISULTANTI DALLE SPECIFICHE TECNICHE DELLA TRASMISSIONE O DA PROBLEMATICHE RELATIVE ALLA SICUREZZA
DI QUALSIASI TIPO.
A seconda dell’ambiente operativo, il sistema potrebbe risultare accessibile in rete a terzi non autorizzati. Prima di collegare
l’apparecchio in rete, assicurarsi che la rete sia protetta in modo sicuro.
Dal punto di vista della sicurezza, quando si utilizza l’apparecchio connesso a una rete, si raccomanda fortemente di accedere alla
finestra di controllo tramite un browser Web e modificare le impostazioni di controllo degli accessi cambiando le impostazioni
predefinite di fabbrica. Inoltre, si consiglia di impostare una password di lunghezza sufficiente e che non possa essere indovinata
facilmente da altri, quindi conservarla in maniera sicura.
Il collegamento del prodotto a una rete deve essere realizzato mediante un sistema in grado di fornire funzioni di protezione, ad
esempio un router o un firewall. In caso di collegamento senza tale protezione si potrebbero verificare problemi di sicurezza.

Alimentazione
L’unità non è dotata di un pulsante di alimentazione. Per spegnere l’unità, verificare che tutte le operazioni siano terminate e che
l’unità sia in stato di standby di alimentazione, quindi scollegare l’adattatore CA. Quando si utilizza l’alimentazione PoE++,
scollegare il cavo LAN.
Ove possibile, utilizzare una sorgente di alimentazione collegata a un luogo in cui sia facile inserire e rimuoverne la spina di
alimentazione.
Se si utilizza una presa elettrica situata in un ambiente polveroso, pulire regolarmente la zona intorno alla presa per evitare
dispersioni di corrente.
Scollegare l’alimentazione quando non in uso.

Precauzioni per le parti in movimento
Assicurarsi che corpi estranei non entrino nelle parti mobili.
Non applicare forza eccessiva nello spostamento manuale di parti. Questo potrebbe causare un guasto.
Non interferire con il funzionamento delle parti mobili durante il movimento. In caso contrario potrebbero verificarsi danni o
infortuni.
Le parti mobili potrebbero non funzionare correttamente se l’unità non viene utilizzata per un periodo prolungato. Azionare
regolarmente le funzioni di pan e tilt dell’unità.

Precauzioni per il funzionamento continuo
L’unità può rimanere alimentata 24 ore al giorno, 365 giorni all’anno (stato di standby di alimentazione).
Eseguire sempre un test di ripresa e verificare che l’unità funzioni normalmente.

La ripresa continua per periodi superiori a 24 ore non è garantita.
Se si desidera eseguire riprese di durata superiore alle 24 ore, mettere l’unità in stato di standby di alimentazione e quindi
riavviarla.

Si osservi che Sony non potrà essere ritenuta responsabile per nessun tipo di risarcimento relativo al contenuto delle immagini
qualora malfunzionamenti di qualsiasi tipo impediscano l’esecuzione di riprese.
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Verificare sempre che l’apparecchio stia funzionando correttamente prima di usarlo. LA SONY NON SARÀ RESPONSABILE DI
DANNI DI QUALSIASI TIPO, COMPRESI, MA SENZA LIMITAZIONE A, RISARCIMENTI O RIMBORSI A CAUSA DELLA PERDITA
DI PROFITTI ATTUALI O PREVISTI DOVUTA A GUASTI DI QUESTO APPARECCHIO, SIA DURANTE IL PERIODO DI VALIDITÀ
DELLA GARANZIA SIA DOPO LA SCADENZA DELLA GARANZIA, O PER QUALUNQUE ALTRA RAGIONE.
SONY NON SARÀ RESPONSABILE PER RICHIESTE O RICORSI DI NESSUN TIPO PRESENTATI DA UTENTI DI QUESTO
APPARATO O DA TERZI.
SONY NON SARÀ RESPONSABILE PER LA CANCELLAZIONE O LA MANCATA CONTINUAZIONE PER QUALSIASI CAUSA O
CIRCOSTANZA DI SERVIZI CORRELATI A QUESTO APPARATO.

Precauzioni per la funzione di registrazione
Eseguire sempre una registrazione di prova, e verificare che il contenuto sia stato registrato correttamente. SONY NON SARÀ
RESPONSABILE DI DANNI DI QUALSIASI TIPO, COMPRESI, MA SENZA LIMITAZIONE A, RISARCIMENTI O RIMBORSI A
CAUSA DI GUASTI DI QUESTO APPARECCHIO O DEI SUOI SUPPORTI DI REGISTRAZIONE O QUALSIASI ALTRO
SUPPORTO O SISTEMA DI MEMORIZZAZIONE PER REGISTRARE CONTENUTI DI QUALSIASI TIPO.
Verificare sempre che l’apparecchio stia funzionando correttamente prima di usarlo. LA SONY NON SARÀ RESPONSABILE DI
DANNI DI QUALSIASI TIPO, COMPRESI, MA SENZA LIMITAZIONE A, RISARCIMENTI O RIMBORSI A CAUSA DELLA PERDITA
DI PROFITTI ATTUALI O PREVISTI DOVUTA A GUASTI DI QUESTO APPARECCHIO, SIA DURANTE IL PERIODO DI VALIDITÀ
DELLA GARANZIA SIA DOPO LA SCADENZA DELLA GARANZIA, O PER QUALUNQUE ALTRA RAGIONE.
SONY NON SARÀ RESPONSABILE PER RICHIESTE O RICORSI DI NESSUN TIPO PRESENTATI DA UTENTI DI QUESTO
APPARATO O DA TERZI.
SONY NON SARÀ RESPONSABILE PER LA PERDITA, RIPARAZIONE O RIPRODUZIONE DEI DATI REGISTRATI SUL
SISTEMA DI MEMORIZZAZIONE INTERNO, SU SUPPORTI DI REGISTRAZIONE O SU QUALSIASI ALTRO TIPO DI
SUPPORTO O SISTEMA DI MEMORIZZAZIONE.
SONY NON SARÀ RESPONSABILE PER LA CANCELLAZIONE O LA MANCATA CONTINUAZIONE PER QUALSIASI CAUSA O
CIRCOSTANZA DI SERVIZI CORRELATI A QUESTO APPARATO.

5-041-957-34(1) Copyright 2022 Sony Corporation
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Formati di uscita e limitazioni

Questo argomento descrive i formati di uscita e le relative limitazioni.

Nota

La risoluzione del formato di uscita è limitata dalle impostazioni di [Project] > [Rec Format] > [Frequency], [Codec] e [Video Format] nel menu
Web o nel menu della telecamera.

La risoluzione del formato di uscita è limitata anche dalla combinazione con la frequenza fotogrammi S&Q. Oltre a quanto indicato nella seguente
tabella dei formati di uscita per il connettore SDI OUT/HDMI OUT, l’uscita HDMI passa a Full HD o inferiore anche nei casi indicati di seguito.

[Shooting] > [S&Q Motion] > [Setting] è impostato su [On]
[Shooting] > [S&Q Motion] > [Frame Rate] è superiore a 60fps

In questi casi, le opzioni di uscita HDMI 4096×2160P e 3840×2160P di [Monitoring] > [Output Format] > [SDI/HDMI] sono disattivate e non
possono essere selezionate.

L’immagine non viene emessa in uscita se è configurata una risoluzione superiore a quella dell’immagine di riproduzione.

Formati di uscita per il connettore SDI OUT/HDMI OUT

Quando la frequenza di sistema è 50/59.94 Hz

Impostazione Formato di uscita selezionabile

Modalità di registrazione e/o
riproduzione

Risoluzione di uscita
RAW/

Risoluzione di
registrazione interna

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW) (4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P (impostazione
predefinita)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P (impostazione
predefinita)
1920×1080i
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Quando la frequenza di sistema è 25/29.97 Hz

Impostazione Formato di uscita selezionabile

Modalità di registrazione e/o
riproduzione

Risoluzione di uscita
RAW/

Risoluzione di
registrazione interna

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(impostazione predefinita)

1920×1080P (impostazione
predefinita)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(impostazione predefinita)

1920×1080P (impostazione
predefinita)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(impostazione predefinita)

1920×1080P (impostazione
predefinita)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Uscita arrestata) 720×480P2)

720×576P3)

Non è possibile eseguire la sovraimpressione sulla visualizzazione della schermata.1)

Quando la frequenza di sistema è 59.942)

Quando la frequenza di sistema è 503)
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Quando la frequenza di sistema è 23.98 Hz

Impostazione Output Format (risoluzione di uscita)

Modalità di registrazione e/o
riproduzione

Risoluzione di uscita RAW/
Risoluzione di

registrazione interna
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i (impostazione
predefinita)

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i (impostazione
predefinita)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (impostazione
predefinita)

1920×1080i (impostazione
predefinita)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (impostazione
predefinita)

1920×1080i (impostazione
predefinita)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Impostazione Output Format (risoluzione di uscita)

Modalità di registrazione e/o
riproduzione

Risoluzione di uscita RAW/
Risoluzione di

registrazione interna
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P (impostazione
predefinita)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (impostazione
predefinita)
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Quando la frequenza di sistema è 24 Hz

5-041-957-34(1) Copyright 2022 Sony Corporation

Impostazione Output Format (risoluzione di uscita)

Modalità di registrazione e/o
riproduzione

Risoluzione di uscita RAW/
Risoluzione di

registrazione interna
SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P (impostazione
predefinita)

1920×1080P (impostazione
predefinita)

1920×1080PsF 1920×1080P

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P (impostazione
predefinita)

1920×1080P (impostazione
predefinita)

1920×1080PsF 1920×1080P

1920×1080

1920×1080P (impostazione
predefinita)

1920×1080P (impostazione
predefinita)

1920×1080PsF 1920×1080P

Impostazione Output Format (risoluzione di uscita)

Modalità di registrazione e/o
riproduzione

Risoluzione di uscita RAW/
Risoluzione di

registrazione interna
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P (impostazione
predefinita)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P (impostazione
predefinita)

4096×2160P
1920×1080P (impostazione
predefinita)
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Ricerca e risoluzione dei problemi

Alimentazione

Uscita immagine

Problema Causa Soluzione

L’unita non si
accende.

L’alimentatore CA non è saldamente collegato al
connettore DC IN.

Inserire il cavo di alimentazione saldamente fino
all’arresto.

Il cavo di alimentazione CA non è inserito saldamente
nell’adattatore CA o nella presa di corrente.

Inserire il cavo di alimentazione saldamente fino
all’arresto.

La connessione del cavo LAN fra il dispositivo di
alimentazione PoE++ e l’unità non è ben salda.

Controllare che il cavo sia ben inserito fino al blocco
in posizione.

Il cavo LAN è collegato al connettore OPTION e non al
connettore LAN.

Collegare correttamente il cavo LAN al connettore
LAN.

L’unità è collegata a un dispositivo di alimentazione che
non supporta la modalità PoE++ come specificato da
IEEE802.3bt, Type 4, Class 8.

Collegare l’unità a un dispositivo di alimentazione che
supporti la modalità PoE++ (in conformità a
IEEE802.3bt, Type 4, Class 8).

L’assorbimento di potenza totale supera la potenza
nominale massima erogabile dal dispositivo di
alimentazione PoE++.

Fare riferimento alle istruzioni per l’uso del dispositivo
PoE++.

Il cavo di rete connesso è di una categoria che non
supporta l’alimentazione PoE++.

Utilizzare un cavo di rete di categoria 5e o superiore
collegato al connettore LAN.

La telecamera, il dispositivo di alimentazione PoE++ e i
dispositivi accessori non sono collegati a terra.

Collegare a terra la telecamera, il dispositivo di
alimentazione PoE++ e i dispositivi accessori.

Problema Causa Soluzione

Non viene emessa in uscita alcuna
immagine.

I dispositivi collegati non sono collegati correttamente.
Collegare correttamente i
dispositivi collegati.

La configurazione iniziale non è stata completata
correttamente.

Completare la configurazione
iniziale utilizzando l’app Web.

Non viene emessa in uscita alcuna
immagine dal connettore HDMI.

Il segnale in uscita configurato non è supportato dal
dispositivo di destinazione dell’uscita HDMI.

Modificare l’impostazione del
formato di uscita HDMI o utilizzare
un dispositivo che supporti tale
segnale di uscita.

Il cavo utilizzato non supporta lo standard HDMI di uscita.
Utilizzare un cavo che supporti lo
standard HDMI di uscita in uso.
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Telecomando

Telecomando a infrarossi

Problema Causa Soluzione

Non viene emessa in uscita alcuna
immagine dal connettore SDI.

Il cavo utilizzato non supporta lo standard SDI di uscita.
Utilizzare un cavo che supporti lo
standard SDI di uscita in uso.

Il monitor collegato al connettore SDI non supporta il
segnale di uscita.

Utilizzare un monitor che supporti
lo standard SDI di uscita.

Il formato di registrazione è impostato per l’uscita RAW.

Modificare il formato di
registrazione specificando
un’impostazione diversa
dall’uscita RAW.

L’uscita HDMI è impostata sulla risoluzione SD.
Impostare l’uscita HDMI su una
risoluzione diversa da SD.

Nessuna immagine viene emessa
dalla fibra ottica o l’immagine è
distorta.

Il modulo utilizzato non è conforme agli standard SFF o
SMPTE oppure non soddisfa il livello di potenza I (1,0
W).

Vedere “Emissione di un segnale
su fibra ottica”.

Quando si utilizza la
sincronizzazione esterna, non
viene emessa in uscita alcuna
immagine oppure l’immagine è
distorta.

Non viene fornito in entrata un segnale di
sincronizzazione esterno adatto al formato del segnale
video configurato.

Fornire in entrata un segnale di
sincronizzazione esterno adatto al
formato del segnale video
configurato.

È presente rumore nell’audio.

La telecamera, il dispositivo di alimentazione PoE++ e i
dispositivi accessori non sono collegati a terra.

Collegare a terra l’unità, il
dispositivo di alimentazione
PoE++ e i dispositivi accessori.

Nell’ambiente in cui si sta utilizzando l’unità sono presenti
dispositivi che generano intensi campi elettromagnetici
(ad esempio antenne di trasmettitori TV o radio,
trasmettitori radioamatoriali, motori per condizionatori
d’aria, trasformatori di potenza).

Mantenere l’unità lontano da
dispositivi che generano forti
campi elettromagnetici.

L’obiettivo, il supporto dell’obiettivo e il sistema di
motorizzazione sono a contatto con l’unità o con oggetti
circostanti emettendo rumori anomali.

Montare correttamente
l’obiettivo.

Verificare l’assenza di
eventuali ostacoli vicino alla
telecamera.

Problema Causa Soluzione

Il telecomando a infrarossi non
funziona quando ne vengono
premuti i pulsanti.

Il comando a distanza a infrarossi è stato
disabilitato.

Impostare [Technical] > [IR Remote] > [Setting] su
[On] nel menu Web.

La batteria è scarica oppure la polarità
della batteria non è corretta.

Azionare il telecomando a infrarossi vicino al
sensore IR dell’unità. Se il LED di alimentazione
lampeggia, sostituire la batteria.

La configurazione iniziale non è stata
completata correttamente.

Completare la configurazione iniziale utilizzando
l’app Web.

La velocità del movimento di pan
e tilt lenta.

La velocità di pan e tilt comandata dal
telecomando a infrarossi è impostata
sulla modalità normale.

Impostare [Technical] > [IR Remote] > [Pan-Tilt
Speed] su [Max] nel menu Web.

Il comando sta agendo su una
telecamera diversa da quella
desiderata.

Il segnale a infrarossi è stato ricevuto da
una telecamera diversa da quella
prevista.

Impostare [Technical] > [IR Remote] > [Setting] su
[Off] nel menu Web della telecamera che non si
desidera comandare.
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RM-IP500

App Web

Problema Causa Soluzione

Non è possibile azionare la telecamera
con il Telecomando RM-IP500.

L’alimentatore della telecamera
non è collegato.

Controllare che l’indicatore POWER dell’unità si
illumini con luce verde o arancione.

La telecamera o il telecomando
non sono connessi alla rete.

Controllare le connessioni dell’unità e del
telecomando.

La configurazione iniziale della
telecamera non è stata
completata.

Completare la configurazione iniziale utilizzando
l’app Web.

La funzione di comunicazione
VISCA over IP non è stata
abilitata.

Spostare sulla posizione ON il selettore SETUP 3
situato sul pannello dei connettori dell’unità e quindi
riavviarla.

L’indirizzo IP della telecamera
è cambiato.

Controllare l’indirizzo IP della telecamera
utilizzando[Network] > [Wired LAN] nel menu Web o
nel menu della telecamera.

L’indirizzo IP della telecamera è stato
modificato utilizzando AUTO IP SETUP sul
Telecomando RM-IP500.

Sono trascorsi almeno 20
minuti dall’avvio della
telecamera.

Riavviare l’unità. L’indirizzo IP può essere modificato
utilizzando AUTO IP SETUP entro i primi 20 minuti
dall’avvio dell’unità.
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Problema Causa Soluzione

Impossibile connettersi mediante un
browser Web.

Non è connesso un cavo LAN di
categoria 5e o superiore.

Collegare un cavo LAN di categoria 5e o superiore.

La connessione alla LAN non è
corretta oppure la rete non sta
funzionando correttamente.

Controllare che il LED Link del connettore LAN sia
illuminato. Se il LED Link non è illuminato,
contattare l’amministratore di rete.

L’alimentatore della telecamera non
è collegato.

Vedere la precedente sezione “Alimentazione”.

Non è configurato un indirizzo IP
valido per l’unità.

Eseguire un reset della rete.
Per informazioni dettagliate sul reset delle
impostazioni di rete, vedere “Reset delle
impostazioni dell’unità”.

Configurare l’unità sulla modalità di indirizzo IP fisso
e collegarla direttamente a un computer impostato
sull’indirizzo 192.160.0.200 o un altro indirizzo
univoco. Specificare 192.160.0.100 in un browser
Web per aprire l’app Web.

Per informazioni dettagliate, vedere
“Connessione dell’unità a un dispositivo di rete
tramite connessione cablata”.

L’indirizzo IP configurato è già
utilizzato da un altro dispositivo.

Controllare che gli indirizzi IP dei dispositivi di rete
siano univoci.

Innanzitutto, collegare l’unità direttamente a un
computer su cui è aperto un browser Web, quindi
avviare l’unità in modalità indirizzo IP fisso.

Per informazioni dettagliate, vedere
“Connessione dell’unità a un dispositivo di rete
tramite connessione cablata”.

Si è verificato un conflitto di indirizzi
IP perché è stato connesso alla
stessa rete un dispositivo
configurato sulla modalità di indirizzo
IP fisso.

Spostare il selettore SETUP 4 (modalità indirizzo IP
fisso) dell’unità sulla posizione OFF, quindi riavviare
l’unità.

La subnet mask configurata non
corrisponde alla subnet di rete
utilizzata.

Eseguire un reset della rete.
Per informazioni dettagliate sul reset delle
impostazioni di rete, vedere “Reset delle
impostazioni dell’unità”.

Si sta eseguendo l’accesso all’unità
sulla stessa rete locale tramite un
server proxy.

Modificare la configurazione in modo che non venga
utilizzato un server proxy.

Il gateway predefinito configurato per
l’unità non è corretto.

Eseguire un reset della rete.
Per informazioni dettagliate sul reset delle
impostazioni di rete, vedere “Reset delle
impostazioni dell’unità”.

L’URL immesso non è corretto.

Immettere l’URL corretto e riprovare.
Per informazioni sull’URL dell’app Web, vedere
“Accesso all’app Web tramite un browser Web”.
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Problema Causa Soluzione

La porta HTTP non è corretta.

Visualizzare il menu della telecamera su un monitor
esterno e controllare l’impostazione di [Network] >
[Wired LAN] > [HTTP Port]. Se è configurato un
valore diverso da 80, aggiungere il numero di porta
HTTP al nome host o all’indirizzo IP immesso nel
browser Web.
Ad esempio, se la porta HTTP è impostata su 8080,
immettere http://<Indirizzo IP>:8080

Il numero di porta HTTP dell’unità
viene filtrato o bloccato.

Impostare il numero di porta HTTP dell’unità su un
numero che non venga filtrato o bloccato.

La cache del browser Web sta
avendo effetti indesiderati.

Eliminare la cache del browser Web.

Impossibile connettersi all’app Web
utilizzando il codice 2D (codice QR).

Il dispositivo in uso non supporta
mDNS.

Utilizzare un dispositivo che supporti mDNS.
Se si utilizza un dispositivo che non supporta
mDNS, immettere l’indirizzo IP direttamente nel
browser Web.

Il tablet o il computer è connesso a
una rete diversa da quella della
telecamera.

Collegare il tablet o il computer alla stessa rete
locale dell’unità.

Impossibile connettersi all’app Web
immettendo manualmente l’URL.

Il dispositivo in uso non supporta
mDNS.

Utilizzare un dispositivo che supporti mDNS.

Il tablet o il computer è connesso a
una rete diversa da quella della
telecamera.

Collegare il tablet o il computer alla stessa rete
locale dell’unità.

La schermata di autenticazione viene
visualizzata continuamente.

Il nome utente o la password
immessi non sono corretti.

Immettere nome utente e password registrati. Se
sono state dimenticate le informazioni registrate
sull’utente, vedere “Switch RESET” in “Pannello
connettori” per inizializzare le informazioni utente
per la connessione di rete.

Il nome utente e la password
potrebbero essere stati modificati da
un utente che ha effettuato l’accesso
utilizzando un altro browser Web.

Verificare con l’amministratore dell’unità che il nome
utente e la password siano corretti.

L’immagine della telecamera non
viene visualizzata nell’app Web.

L’uscita HDMI della telecamera è
impostata su 720×480 o 720×576.

Modificare la risoluzione dell’uscita HDMI dell’unità.

È collegato un monitor HDMI che
non supporta il segnale di uscita
HDMI della telecamera.

Rimuovere il monitor HDMI o utilizzare un monitor
HDMI che supporti le impostazioni dell’uscita HDMI.

L’unità è stata riavviata e la sessione
è stata disconnessa.

Attendere un minuto circa e ricaricare il browser
Web.

La cache del browser Web sta
avendo effetti indesiderati.

Eliminare la cache del browser Web.

L’immagine della telecamera viene
visualizzata nell’app Web con una
bassa risoluzione.

È stata impostata una bassa
risoluzione per lo stream 3 utilizzato
dall’app Web.

Incrementare il valore utilizzando [Stream] > [Video
Stream] > [Size 3] nel menu Web.

Premendo il pulsante [Menu], il menu
della telecamera non appare.

Il menu della telecamera è
configurato in modo da non essere
incorporato nel segnale di uscita
HDMI.

Impostare [Monitoring] > [Output Display] >
[HDMI/Stream] su [On] nel menu Web.
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Ripresa

Telecamera

Pan/tilt

Problema Causa Soluzione

Il valore di un’impostazione nella
schermata delle impostazioni non
viene aggiornato o visualizzato
correttamente.

La schermata delle impostazioni
dell’app Web non riflette
automaticamente le impostazioni
modificate in un’altra app Web.

Premere il pulsante [Reload] nella parte inferiore
della schermata delle impostazioni dell’app Web. I
valori delle impostazioni nella schermata di
configurazione visualizzata vengono ricaricati e
aggiornati.

Si verificano effetti causati dalle
impostazioni dei file temporanei
Internet.

Eliminare la cache del browser Web.

Impossibile eseguire il download del
file di configurazione o del registro.

La funzione di download dei file del
browser Web è disabilitata.

Abilitare la funzione di download dei file del browser
Web.

La schermata delle impostazioni
dell’app Web è accessibile, ma non è
possibile eseguire operazioni nella
schermata delle operazioni live e
nella schermata delle operazioni di
riproduzione.

La schermata delle operazioni
dell’app Web è bloccata.

Spostare il selettore di blocco, in alto a destra
nell’app Web, sulla posizione  (sblocco
operazioni).

La visualizzazione della schermata
dell’app Web richiede del tempo.

L’immagine in streaming proveniente
dall’unità viene visualizzata da più
utenti contemporaneamente.

Ridurre il numero di utenti che possono accedere
all’app Web contemporaneamente.

L’immagine appare distorta o a scatti.

Le informazioni video non vengono
trasmesse correttamente a causa di
congestione nel percorso di
comunicazione.

Ridurre il bit rate di streaming, impostare [Video
Stream 3] > [Size] sul minor valore possibile oppure
ridurre la velocità per creare un margine nella banda
di comunicazioni.

La memoria del tablet è occupata da
più browser Web in esecuzione.

Chiudere tutti i browser Web in esecuzione in
background.

Sono aperte troppe schede del
browser Web, rallentando il
funzionamento.

Chiudere tutte le schede non utilizzate.

L’eccessivo accumulo di dati nella
cache e nella cronologia di
navigazione del browser Web sta
rallentando il funzionamento.

Eliminare la cache del browser Web.

Problema Causa Soluzione

L’immagine appare distorta all’inizio
e alla fine del movimento di pan e
tilt.

L’immagine può apparire distorta se è attivata la
funzione di stabilizzazione dell’immagine
dell’obiettivo.

Disattivare la funzione di
stabilizzazione dell’immagine
dell’obiettivo.

L’angolo di visuale è cambiato senza
che sia stato richiesto dall’utente.

Si è verificato il fenomeno dell’effetto breathing
dell’obiettivo.

Vedere “Compensazione dell’effetto
breathing”.

Impossibile azionare la messa a
fuoco, lo zoom o il diaframma.

I selettori sull’obiettivo potrebbero essere impostati
incorrettamente.

Vedere “Controllo dei selettori
dell’obiettivo”.

Problema Causa Soluzione

Impossibile eseguire il reset
di pan e tilt.

La levetta di blocco pan/tilt si trova
nella posizione LOCK.

Spostare la levetta di blocco pan/tilt sulla posizione
UNLOCK.
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Problema Causa Soluzione

La telecamera non si arresta
nella posizione prevista.

La sezione telecamera non è bilanciata
correttamente.

Spostare la sezione telecamera in avanti o indietro fino a
raggiungere la posizione corretta, come descritto in
“Montaggio dell’obiettivo”, quindi riaccendere l’unità.

È montato un obiettivo che non
supporta la funzione di pan e tilt.

Facendo riferimento alle informazioni sulla compatibilità
degli obiettivi, montare un obiettivo che supporta la
funzione di pan e tilt, quindi riaccendere l’unità.

Non è possibile eseguire il reset di pan
e tilt.

Eseguire il reset di pan e tilt come descritto in “Reset di
Pan e Tilt”.

È stata applicata una forza eccessiva
sul corpo della telecamera che ha
causato un errore di controllo del
movimento di pan e tilt.

La telecamera non torna a
rivolgersi in avanti anche se
è stato premuto il pulsante

 (posizione iniziale
pan/tilt).

È attiva la modalità di montaggio a
soffitto.

Impostare [Pan-Tilt] > [P/T Direction] > [Ceiling] nel menu
Web in base all’effettiva modalità di installazione, quindi
riaccendere l’unità. Se la telecamera è montata a soffitto, il
pannello connettori si troverà sul lato anteriore.

Il movimento di pan e tilt è
limitato.

È stata configurata una limitazione
all’escursione del movimento di pan e
tilt.

Se del caso, annullare le impostazioni di limitazione al
movimento, come descritto in “P/T Range Limit”.

È stata applicata una forza eccessiva
sul corpo della telecamera che ha
causato un errore nel movimento di
pan e tilt.

Eseguire il reset di pan e tilt come descritto in “Reset di
Pan e Tilt”.

I movimenti di pan e tilt si
spostano nella direzione
opposta a quella desiderata.

L’impostazione della modalità di
montaggio a soffitto è diversa dalle
effettive condizioni di montaggio.

Impostare [Pan-Tilt] > [P/T Direction] > [Ceiling] nel menu
Web in base all’effettiva modalità di installazione.

Le impostazioni relative alla direzione
del movimento di pan e tilt sono state
cambiate.

Controllare le impostazioni di [Pan-Tilt] > [P/T Direction]
nel menu Web.

L’immagine non si muove in
maniera fluida all’inizio e alla
fine del movimento di pan e
tilt.

Le impostazioni di accelerazione e
decelerazione del movimento di pan e
tilt sono configurate su valori eccessivi.

Ridurre i valori delle impostazioni di accelerazione e
decelerazione del movimento di pan e tilt per migliorare la
fluidità degli spostamenti all’inizio e alla fine dei movimenti
di pan e tilt utilizzando [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] nel menu Web o nel menu della telecamera.
Si osservi che, così facendo, l’obiettivo impiegherà più
tempo per raggiungere la velocità massima.

Il movimento di pan e tilt si è
fermato.

La sezione telecamera non è bilanciata
correttamente.

Spostare la sezione telecamera in avanti o indietro fino a
raggiungere la posizione corretta, come descritto in
“Montaggio dell’obiettivo”, quindi riaccendere l’unità.

L’impostazione della curva di rampa
(accelerazione e decelerazione) è
troppo alta per l’obiettivo montato.

Se è montato un obiettivo di grandi dimensioni, ridurre il
valore di [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] nel
menu Web o nel menu della telecamera.

Si sta utilizzando un obiettivo di grandi
dimensioni.

Rivolgersi al servizio di assistenza Sony.
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Problema Causa Soluzione

Il movimento di pan e tilt
dell’unità appare impedito.

La levetta di blocco della vite di
fissaggio del piedino del supporto
dell’obiettivo entra in collisione con la
telecamera.

Ruotare verso l’alto la levetta di blocco della vite di
fissaggio del piedino del supporto dell’obiettivo.

La levetta di blocco del supporto
dell’obiettivo entra in collisione con la
telecamera.

Ruotare verso l’alto la levetta di blocco del supporto
dell’obiettivo.

La levetta di blocco del corpo della
telecamera entra in collisione con la
telecamera.

Controllare che la levetta di blocco del corpo della
telecamera sia perfettamente sulla posizione LOCK.

Si verificano rumori anomali
durante il movimento di pan
e tilt.

La telecamera non è bilanciata
correttamente.

Spostare il corpo della telecamera in avanti o indietro fino
a raggiungere la posizione corretta, in modo che la base
scorrevole rimanga orizzontale.

L’impostazione della curva di rampa
(accelerazione e decelerazione) è
troppo alta per l’obiettivo montato.

Se è montato un obiettivo di grandi dimensioni, ridurre il
valore di [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] nel
menu Web o nel menu della telecamera.

La testa della telecamera non è fissata
in posizione e, durante il
funzionamento, si percepiscono rumori
dovuti al suo movimento.

Spostare la levetta di blocco del corpo della telecamera
sulla posizione LOCK.

Quando viene riprodotta una
posizione di preset,
l’inquadratura risulta
spostata rispetto
all’originale.

La temperatura ambiente nel momento
in cui la posizione di preset viene
riprodotta potrebbe essere cambiata
significativamente rispetto alla
temperatura presente al momento del
suo salvataggio.

Salvare nuovamente la posizione di preset.

Non è stata eseguita la procedura di
calibrazione dell’obiettivo.

Eseguire la procedura di calibrazione utilizzando
[Technical] > [Lens] > [Lens Calibration] nel menu della
telecamera.

L’obiettivo montato è diverso da quello
presente al momento del salvataggio
della posizione di preset. Potrebbe
anche essere diversa la posizione dello
zoom manuale.

Salvare nuovamente la posizione di preset.

I movimenti di pan, tilt e
zoom non risultano
sincronizzati quando viene
richiamata una posizione di
preset.

L’intervallo di velocità dello zoom
dell’obiettivo supera l’intervallo di
velocità dei movimenti di pan e tilt.

Regolare la velocità o il tempo di movimento di pan e tilt in
modo che il loro intervallo ricada entro l’intervallo di
velocità dello zoom.

Il pannello di controllo
dell’inquadratura dell’app
Web è disattivato e non può
essere utilizzato.

Non è possibile eseguire movimenti di
pan e tilt mentre è visualizzata la
schermata delle miniature e durante la
riproduzione.

Visualizzare la schermata di controllo della riproduzione e
uscire dalla schermata delle miniature oppure arrestare la
riproduzione.

Non è possibile eseguire movimenti di
pan e tilt se non è possibile
visualizzare l’immagine della
telecamera nell’app Web.

Vedere “App Web” in “Ricerca e risoluzione dei problemi”.

La levetta di blocco pan/tilt si trova
nella posizione LOCK.

Spostare la levetta di blocco pan/tilt sulla posizione
UNLOCK.
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Inquadratura automatica PTZ

Problema Causa Soluzione

Appare il messaggio
“Execute Pan-Tilt Reset”
sotto al pannello di controllo
dell’inquadratura nell’app
Web.

È stata applicata una forza eccessiva
sul corpo della telecamera che ha
causato un errore nel movimento di
pan e tilt.

Eseguire il reset di pan e tilt come descritto in “Reset di
Pan e Tilt”.

Problema Causa Soluzione

L’inquadratura automatica PTZ non
può essere attivata.

Non è montato un obiettivo E-
mount in grado di comunicare con
l’unità.

Montare un obiettivo E-mount in grado di comunicare
con l’unità.

Il formato di uscita HDMI è
superiore a 1920×1080.

Impostare il formato HDMI su un valore di 1920×1080
o inferiore.

L’impostazione di streaming è
[RTSP] e [Video Stream] > [Codec
2] è impostato su un valore diverso
da [Off].

Impostare [Stream] > [Video Stream] > [Codec 2] su
[Off] nel menu Web.

L’impostazione di streaming è
[NDI|HX] e [Video Stream] >
[Frame Rate 2] è impostato su un
valore superiore a 10fps.

Impostare [Stream] > [Video Stream] > [Frame Rate 2]
su un valore di 10fps o inferiore.

È stata eseguita la registrazione, la
riproduzione oppure la
formattazione di una scheda di
memoria mentre l’unità è
alimentata tramite PoE++.

Arrestare la registrazione, la riproduzione o la
formattazione di una scheda di memoria, quindi
eseguire l’operazione.

Le operazioni di pan, tilt e zoom
non si arrestano.

Riattivare l’inquadratura automatica PTZ dopo aver
arrestato le operazioni di pan, tilt e zoom.

Il seguimento non si avvia.
Non è stato selezionato nessun
oggetto del seguimento.

Toccare una persona.

Il riquadro del viso di una persona è
verde, ma il viso non viene seguito.

L’operazione è in pausa.
Premere il pulsante [Resume] nel pannello di controllo
PTZ AFR oppure toccare la persona da seguire.

L’immagine non è perfettamente
nitida.

[Speed Step] è impostato su
[Normal].

Impostare [Speed Step] su [Extended].

La risposta della funzione di
seguimento non è sufficientemente
rapida. Il movimento si avvia in
ritardo.

[Ramp Curve] è impostato su un
valore di 6 o inferiore.

Impostare [Ramp Curve] su un valore di 7 o superiore.

La risposta dello zoom è lenta
quando si utilizza un controller
dell’obiettivo (opzionale).

La modalità operativa del controller
dell’obiettivo (opzionale) è
impostata per fornire
un’accelerazione e una
decelerazione graduali.

Impostare la modalità operativa sulla massima
accelerazione e/o decelerazione utilizzando [Lens
Controller] > [Mode].

Il seguimento subisce interruzioni.
La persona soggetto del
seguimento occupa uno spazio
eccessivo nella composizione.

Ridurre le dimensioni della persona, ad esempio, in
modo da creare maggiore spazio nella direzione del
movimento.

Il seguimento si arresta
improvvisamente.

[Personal Identification] è attivato e
il riconoscimento facciale è in
funzione.

Se l’operazione non è intenzionale, disattivare
[Personal Identification].
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Registrazione e riproduzione

Trasferimento di file

Problema Causa Soluzione

Il seguimento passa a una persona
con un viso simile quando questa
appare sullo schermo.

[Personal Identification] è attivato e
il riconoscimento facciale è in
funzione.

Se l’operazione non è intenzionale, disattivare
[Personal Identification].

La telecamera non si sposta nella
posizione di preset

Il seguimento automatico tramite
inquadratura automatica PTZ è
attivo.

Quando si preme il pulsante PRESET durante
l’operazione di inquadratura automatica pan/tilt, la
prima pressione mette in pausa l’inquadratura
automatica. Assicurarsi che le operazioni di pan/tilt si
siano arrestate, quindi premere nuovamente il
pulsante PRESET per richiamare un preset.

Non è possibile mettere a fuoco il
soggetto del seguimento o altre
persone a causa della presenza di
più persone all’interno del campo di
visuale.

La messa a fuoco automatica è
attiva.

Utilizzare la messa a fuoco manuale.

Problema Causa Soluzione

La registrazione non si avvia
quando si preme il pulsante di
registrazione START/STOP.

La scheda di memoria è piena.
Sostituire la scheda di memoria con un’altra che
disponga di spazio sufficiente.

La scheda di memoria deve essere
ripristinata.

Ripristinare la scheda di memoria come descritto in
“Ripristino delle schede di memoria”.

L’indicatore di registrazione/tally è
configurato per funzionare come
indicatore tally e quindi non mostra lo
stato di registrazione.

Configurare l’indicatore di registrazione/tally per
funzionare come indicatore di registrazione come
descritto in “Connessione di un segnale di tally”.

La registrazione audio non è
possibile.

Non è connesso nessun microfono.
Collegare un microfono o un dispositivo audio al
connettore AUDIO IN del pannello connettori.

L’impostazione di [Master Input Level] è
configurata sul valore minimo.

Regolare [Master Input Level].

L’audio registrato risulta
distorto.

Il livello di ingresso audio è impostato su
un valore troppo elevato.

Regolare [CH1 Input Level] su [CH4 Input Level] e
[Master Input Level].

Quando si utilizza un microfono in un ambiente
rumoroso, ad esempio un ambiente con musica dal
vivo, regolare prima [AUDIO IN CH1 MIC Ref.] e
[AUDIO IN CH2 MIC Ref.].

L’audio registrato contiene un
elevato livello di rumore.

Il livello di ingresso audio è impostato su
un valore troppo basso.

Regolare le impostazioni di [Audio Input Level] e
[Audio] > [Audio] > [Audio Input] > [AUDIO IN CH1
MIC Ref.] o [AUDIO IN CH2 MIC Ref.].

Non è possibile riprodurre clip.

È in corso l’editing di un clip.

Non è possibile riprodurre clip se sono stati modificati
i nomi di file o delle cartelle oppure se il clip è in uso
su un computer. Questo non indica la presenza di
guasti.

Il clip è stato registrato con un’altra
telecamera.

Non è sempre possibile riprodurre clip registrati con
altre telecamere, oppure potrebbero essere
visualizzati con dimensioni errate. Questo non indica
la presenza di guasti.
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Streaming IP

Problema Causa Soluzione

L’upload del file non avviene
correttamente.

Il nome utente e la password sul
server non sono corretti.

Il nome utente e la password sul server potrebbero non
essere corretti. Immettere i valori corretti.

Problema Causa Soluzione

Lo streaming non è
disponibile.

Il nome utente o la password
immessi nell’applicazione client
per visualizzare lo streaming
proveniente dall’unità non sono
corretti.

Se il formato di streaming dell’unità è impostato su [RTSP],
[SRT-Listener] oppure [NDI|HX], è necessario immettere il
nome utente e la password impostati per questa unità
nell’applicazione client. Immettere nome utente e password
corretti.

Il protocollo di streaming non è
impostato.

Selezionare il protocollo desiderato utilizzando [Stream] >
[Stream Setting] nel menu Web.

Sono state impostate sei o più
sessioni RTSP.

Impostare il numero di sessioni su un valore non superiore a
cinque.

Il numero di porta UDP non è
impostato correttamente.

Controllare il numero di porta e altre impostazioni per il
protocollo desiderato utilizzando [Stream] > [Stream] > [Stream
Setting] nel menu Web.

La comunicazione UDP è
bloccata.

Controllare le impostazioni del software di protezione.

L’audio non viene trasmesso
in streaming.

Lo streaming dell’uscita audio è
impostato su [Off].

Impostare [Stream] > [Audio Stream] > [Setting] su [On] nel
menu Web.

Lo streaming è stato
disconnesso.

Mentre era in corso lo streaming,
sono state modificate impostazioni
relative al protocollo o al codec di
streaming.

Configurare le impostazioni relative al protocollo e al codec di
streaming prima di avviare lo streaming.

Le dimensioni immagine di
[Video Stream 1] non
possono essere impostate
su 4096×2160 o 3840×2160.

Le dimensioni immagine sono
impostate su 1920×1080 quando
[Output Format] è impostato su
HDMI.

Le dimensioni dell’immagine per lo streaming non possono
essere impostate su un valore superiore a quello
dell’immagine HDMI. Modificare le dimensioni dell’immagine
HDMI utilizzando [Monitoring] > [Output Format] nel menu
Web.

Le frequenza fotogrammi di
[Video Stream 1] non può
essere impostata su 60 FPS
o 50 FPS.

La frequenza fotogrammi dello
streaming è impostata su 29.97 o
inferiore.

La frequenza fotogrammi utilizzata per lo streaming è limitata
dalla frequenza del sistema. Modificare la frequenza di sistema
utilizzando [Rec Format] > [Frequency] nel menu Web.

Non è possibile accedere
allo stream [Video Stream 3].

[Video Stream 3] non supporta
RTSP/SRT/NDI.

Utilizzare [Video Stream 1] o [Video Stream 2].

La schermata RTSP/SRT
non è aggiornata o
visualizzata correttamente.

Il numero della porta utilizzata per
RTSP o SRT è filtrato o bloccato.

Cambiare il numero della porta RTSP o SRT su un valore non
filtrato o bloccato dai dispositivi che ricevono lo stream.
Oppure cambiare il numero della porta usata per RTSP o SRT
sull’unità.

L’immagine appare distorta o
a scatti.

Le informazioni video non
vengono trasmesse correttamente
a causa di congestione nel
percorso di comunicazione.

Ridurre il bit rate di streaming oppure impostare il codec di
[Video Stream 2] ([Codec 2]) su [Off] in modo da creare un
margine nella banda di comunicazione.

L’ordine dei pacchetti video è
cambiato all’interno del canale di
comunicazione.

Utilizzare lo stesso provider di servizi Internet sia sul lato
dell’unità che sul lato del ricevitore.

Unità non rilevata come
dispositivo NDI.

Il protocollo di streaming non è
impostato su NDI|HX.

Per rilevare l’unità come dispositivo NDI, il protocollo di
streaming deve essere impostato su NDI|HX. Impostare
[Stream] > [Stream Setting] su [NDI|HX] nel menu Web.
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Collegamento con dispositivi esterni

Sincronizzazione esterna

Tally

Dispositivo di comando obiettivo

Problema Causa Soluzione

Unità non utilizzabile come
dispositivo NDI.

La licenza NDI|HX non è installata.

Una licenza NDI|HX è già preinstallata nelle versioni software
3.00 e successive. Se si utilizza una versione precedente alla
3.00, installare la licenza NDI|HX. È possibile verificare se è
presente una licenza NDI|HX utilizzando [Stream] > [Stream] >
[Stream Setting] > [NDI|HX] > [License] nel menu Web.

Problema Causa Soluzione

Impossibile eseguire la
sincronizzazione con
l’origine esterna.

Non viene fornito in entrata un segnale di
sincronizzazione esterno adatto al formato
del segnale video configurato.

Fornire in entrata un segnale di sincronizzazione
esterno adatto al formato del segnale video
configurato.

Sull’unità è presente una doppia
terminazione.

L’unità è dotata di un terminatore da 75 Ω incorporato.
Collegare direttamente alla sorgente del segnale (uno
a uno) oppure utilizzare un distributore (splitter).

Problema Causa Soluzione

L’indicatore tally
non si illumina.

La luminosità dell’indicatore tally è impostata su
Off.

Impostare la luminosità appropriata utilizzando [Technical]
> [Tally] > [Tally Lamp Brightness] nel menu Web.

L’indicatore di registrazione/tally è configurato
come indicatore di registrazione.

Configurare l’indicatore di registrazione/tally per funzionare
come indicatore tally come descritto in “Connessione di un
segnale di tally”.

È connesso un telecomando RM-IP500 ma
VISCA over IP è disabilitato.

Spostare sulla posizione ON il selettore SETUP 3 situato
sul pannello connettori dell’unità.

La connessione del connettore OPTION non è
corretta oppure l’apposito pin non è
cortocircuitato a GND.

Cortocircuitare a GND il pin 7 o il pin 8 del connettore
OPTION come descritto in “Connessione di un segnale di
tally”.

Problema Causa Soluzione

 (stato della
telecamera) visualizza
[Communication Error].

La telecamera non riesce a
comunicare con il dispositivo
di comando dell’obiettivo.

Controllare il collegamento tra l’unità e il dispositivo di comando
dell’obiettivo, quindi spegnere e riaccendere l’unità e il dispositivo di
comando dell’obiettivo.

 (stato della
telecamera) visualizza
[Rotation Error].

Si è verificato un errore di
rotazione nel dispositivo di
comando dell’obiettivo.

I valori di escursione dello zoom memorizzati potrebbero non
corrispondere all’escursione effettivamente consentita dall’obiettivo.
Inizializzare il dispositivo di comando dell’obiettivo.
Se il problema persiste, contattare il rappresentante del produttore del
dispositivo di comando dell’obiettivo.

 (stato della
telecamera) visualizza
[System Error].

Si è verificato un errore di
sistema nel dispositivo di
comando dell’obiettivo.

Controllare il collegamento tra l’unità e il dispositivo di comando
dell’obiettivo, inizializzare il dispositivo di comando dell’obiettivo
facendo riferimento alle relative istruzioni per l’uso oppure spegnere e
riaccendere l’unità e il dispositivo di comando dell’obiettivo.
Se il problema persiste, contattare il rappresentante del produttore del
dispositivo di comando dell’obiettivo.
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Argomento correlato
Accesso all’app Web tramite un browser Web

Connessione dell’unità a un dispositivo di rete tramite connessione cablata

Reset delle impostazioni dell’unità
Reset

Emissione di un segnale su fibra ottica

Pannello connettori
Compensazione dell’effetto breathing

Controllo dei selettori dell’obiettivo

Montaggio dell’obiettivo
Reset di pan e tilt

P/T Range Limit

Ripristino delle schede di memoria
Connessione di un segnale di tally

5-041-957-34(1) Copyright 2022 Sony Corporation

Problema Causa Soluzione

 (stato della
telecamera) visualizza
[Unknown Error].

Si è verificato un errore
sconosciuto nel dispositivo di
comando dell’obiettivo.

Controllare il collegamento tra l’unità e il dispositivo di comando
dell’obiettivo, inizializzare il dispositivo di comando dell’obiettivo
facendo riferimento alle relative istruzioni per l’uso oppure spegnere e
riaccendere l’unità e il dispositivo di comando dell’obiettivo.
Se il problema persiste, contattare il rappresentante del produttore del
dispositivo di comando dell’obiettivo.

Non è possibile utilizzare
Clear Image Zoom.

Clear Image Zoom non è
disponibile quando è abilitato
un dispositivo di comando
obiettivo.

L’utilizzo di un controller dell’obiettivo causa il blocco
dell’ingrandimento di Clear Image Zoom. Disattivare
temporaneamente il controller dell’obiettivo e regolare l’ingrandimento
di Clear Image Zoom.
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Messaggi di errore e avvisi

Qualora si verifichi sull’unità una condizione di avvertimento, di avviso, o che altrimenti richieda una conferma, il pannello
dell’immagine della telecamera visualizzerà un messaggio opportuno e cominceranno a lampeggiare in rosso sia l’indicatore
registrazione/tally sia gli indicatori POWER e NETWORK sul pannello anteriore.

Nota
Il lampeggiamento dell’indicatore registrazione/tally è abilitato solo se [Technical] > [Tally] > [Tally Control] è impostato su [Internal] e, allo stesso
tempo, [Tally Lamp Brightness] non è impostato su [Off] nel menu Web o nel menu della telecamera.

Lo stato dell’inquadratura automatica PTZ è indicato quando l’indicatore di registrazione/tally lampeggia in verde. Per informazioni dettagliate fare
riferimento a “Controllo da remoto dello stato dell’inquadratura automatica PTZ”.

Messaggi di errore

Nel caso in cui gli indicatori POWER e NETWORK lampeggino come descritto di seguito, adottare le misure indicate.

L’unità cessa di funzionare se appare il seguente avviso.

Messaggi di avvertimento

Qualora vengano visualizzati i seguenti messaggi, eseguire le procedure indicate.

Indicatore POWER Indicatore
NETWORK Causa e soluzione

Lampeggiamento
lento arancione

Lampeggiamento
lento verde

L’unità non è in grado di funzionare normalmente. Per informazioni dettagliate,
vedere [Maintenance] > [System Log] nel menu Web. Se il problema persiste anche
dopo aver messo l’unità in modalità standby o aver spento e riacceso
l’alimentazione, rivolgersi al servizio di assistenza Sony.

Lampeggiamento
rapido arancione

Lampeggiamento
rapido verde

Si è verificato un malfunzionamento sull’unità. Contattare il servizio di assistenza
Sony.

Messaggio
visualizzato

Indicatore di
registrazione/tally Causa e soluzione

E + codice
d’errore

Lampeggiamento
rapido

Indica un’anomalia dell’unità. La registrazione si arresta, anche se il pannello
dell’immagine della telecamera continua a visualizzare ●REC.
Spegnere l’unità e controllare la presenza di problemi nei dispositivi collegati, cavi o
supporti di memorizzazione. Se l’errore persiste anche dopo aver riacceso l’unità,
rivolgersi al proprio servizio di assistenza tecnica Sony. In base allo stato, l’unità potrebbe
non emettere nessun avvertimento acustico né visualizzare un messaggio di errore.

Messaggio
visualizzato

Indicatore di
registrazione/tally Causa e soluzione

Temperature High Lampeggiante
La temperatura interna è elevata.
Spegnere il camcorder e lasciarlo raffreddare prima di utilizzarlo nuovamente.

Media Temperature
High

Lampeggiante
La temperatura della scheda CFexpress risulta elevata.
Sostituire la scheda o lasciarla raffreddare prima di utilizzarla nuovamente.

Voltage Low Lampeggiante
La tensione sul connettore DC IN è bassa (livello 1). Controllare la sorgente di
alimentazione.
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Messaggi di avviso e messaggi operativi

Al centro dello schermo potranno essere visualizzati i seguenti messaggi di avviso e operativi. Seguire le istruzioni fornite per risolvere
il problema.

Messaggio
visualizzato

Indicatore di
registrazione/tally Causa e soluzione

Insufficient Voltage Lampeggiamento rapido
La tensione sul connettore DC IN è insufficiente (livello 2). La registrazione è
disabilitata.
Collegare un’altra sorgente di alimentazione.

Media Near Full Lampeggiante
La capacità rimanente sulla scheda di memoria si sta esaurendo.
Sostituire non appena possibile.

Media Full Lampeggiamento rapido
Non è possibile registrare o copiare clip perché la capacità rimanente sulla
scheda di memoria è insufficiente.
Sostituire immediatamente.

Clips Near Full Lampeggiante
Ci si sta avvicinando al numero massimo di clip che possono essere registrati
sulla scheda di memoria.
Sostituire non appena possibile.

Clips Full Lampeggiamento rapido
È stato raggiunto il numero massimo di clip che possono essere registrati sulla
scheda di memoria.
Non è possibile registrare o copiare altri clip. Sostituire immediatamente.

Last Clip Recording Lampeggiante
Il clip in corso di registrazione è l’ultimo clip che può essere registrato in quanto
è stato raggiunto il numero massimo di clip consentito.
Preparare una nuova scheda di memoria.

Media(A) Life Near
End1) Lampeggiante

La scheda di memoria si sta avvicinando alla fine della sua vita utile. Sostituire
non appena possibile.

Media(A) Life End1) Lampeggiamento rapido
La scheda di memoria ha raggiunto la fine della sua vita utile. Sostituire
immediatamente.

Media(A) Near
Full1) Lampeggiante Quando si utilizza la funzione Simul Rec

Media(A) Full1) Lampeggiamento rapido Quando si utilizza la funzione Simul Rec

Media(A) Clips
Near Full1) Lampeggiante Quando si utilizza la funzione Simul Rec

Media(A) Clips
Full1) Lampeggiamento rapido Quando si utilizza la funzione Simul Rec

Media(A) Last Clip
Rec1) Lampeggiante Quando si utilizza la funzione Simul Rec

(Nessuna
indicazione)

Lampeggiante

Si è verificato un errore sconosciuto nel dispositivo di comando dell’obiettivo.
Controllare lo stato nella schermata dello stato della telecamera dell’app Web.
Per informazioni dettagliate, controllare il registro eventi di sistema nell’app
Web.

Per la scheda dello slot B è visualizzato “(B)”.1)

Messaggio sul display Causa e soluzione

Backup Battery End
Please Change

La carica della batteria di backup è insufficiente.
Caricare la batteria di backup mantenendo l’unità collegata a un alimentatore per
almeno 24 ore.
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Informazioni sugli errori di streaming RTMP

L’unità potrebbe visualizzare le seguenti informazioni di errore. Eseguire le operazioni descritte di seguito, secondo il caso.

Messaggio sul display Causa e soluzione

Unknown Media(A)1)

Please Change

È stata inserita una scheda di memoria che è stata partizionata oppure che contiene
un numero di clip superiore al massimo gestibile da questa unità.
La scheda non può essere utilizzata nell’unità e deve essere sostituita.

Cannot Use Media(A)1)

Unsupported File System

È stata inserita una scheda con un file system diverso oppure non formattata.
La scheda non può essere utilizzata nell’unità e deve essere sostituita oppure
formattata con l’unità.

Media Error
Media(A) Needs to be Restored1)

Si è verificato un errore sulla scheda di memoria e la scheda deve essere ripristinata.
Ripristinare la scheda di memoria.

Media Error
Cannot Record to Media(A)1)

La scheda di memoria potrebbe essere danneggiata e non può essere utilizzata per
la registrazione.
La riproduzione è possibile, è consigliabile quindi eseguire una copia e sostituire la
scheda di memoria.

Media Error
Cannot Use Media(A)1)

La scheda di memoria potrebbe essere danneggiata e non può essere utilizzata per
la registrazione o la riproduzione.
La scheda non può essere utilizzata nell’unità e deve essere sostituita.

Media(A) Error1)

Recording Halted
Playback Halted

La registrazione e la riproduzione sono state arrestate a causa di un errore durante
l’utilizzo della scheda di memoria.
Se il problema persiste, sostituire la scheda di memoria.

Media Reached Rewriting Limit
Change Media(A)1)

La scheda di memoria ha raggiunto la fine della sua vita utile.
Eseguire un backup e sostituire la scheda immediatamente. Se si continua a
utilizzare la scheda è possibile che la scheda non consenta più l’esecuzione di
registrazioni o riproduzioni.
Per ulteriori informazioni, consultare le istruzioni per l’uso della scheda di memoria.

The specified address is invalid.
L’indirizzo specificato non è valido.
Controllare che l’impostazione sia corretta.

Cannot Use Specified Port Number
Il numero di porta specificato non è valido.
Controllare che l’impostazione sia corretta.

Lens I/F Error(xx:xx)

È stato rilevato un errore dell’obiettivo durante la comunicazione I/F dell’obiettivo E-
mount montato.
Controllare lo stato della connessione con l’obiettivo E-mount.
Se il problema persiste, rivolgersi al servizio di assistenza Sony riferendo il codice
d’errore visualizzato (cinque caratteri fra parentesi).

Cannot add auto upload job of Proxy file
because maximum number of upload jobs
was reached.

È stato raggiunto il numero massimo di trasferimenti consentito.
Eliminare i trasferimenti non più necessari. Anche le impostazioni della destinazione
del caricamento automatico per i file proxy potrebbero essere incorrette. Controllare
che l’impostazione sia corretta.

Fan Stopped

La ventola si è arrestata.
Verificare che non vi sia polvere o corpi estranei.
Se l’errore persiste anche dopo aver rimosso eventuale polvere o corpi estranei,
rivolgersi al proprio servizio di assistenza tecnica Sony.

Per la scheda dello slot B è visualizzato “(B)”.1)

Codice d’errore
Descrizione Soluzione

RTMP RTMPS

1002
1004

2002
2004 Impossibile connettersi al server RTMP.

Controllare che le impostazioni dell’URL del server siano corrette.
Controllare la connessione di rete.
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Informazioni sugli errori di streaming SRT

L’unità potrebbe visualizzare le seguenti informazioni di errore. Eseguire le operazioni descritte di seguito, secondo il caso.

5-041-957-34(1) Copyright 2022 Sony Corporation

Codice d’errore
Descrizione Soluzione

RTMP RTMPS

1003 2003 Impossibile risolvere il nome di dominio.
Controllare che le impostazioni dell’URL del server siano corrette.
Controllare la connessione al server DNS.

–
2005
2008

Errore CRL
Controllare che le impostazioni dell’URL del server siano corrette.
Verificare che la destinazione della connessione sia un sito
attendibile.

2006 Errore del certificato CA
Controllare che le impostazioni di data e ora siano corrette.
Controllare che il certificato CA sia corretto.

– 2007
Non è installato nessun certificato CA.
Errore di autenticazione del certificato
server.

Installare un certificato CA.
Verificare che la destinazione della connessione sia un sito
attendibile.

4002 La sessione RTMP è stata disconnessa.
L’unità potrebbe essere stata disconnessa dal lato server RTMP.
Verificare che le impostazioni corrispondano al parametro di codec
consigliato del servizio.

4003
La qualità della connessione di rete è
insufficiente.

Controllare la connessione di rete.

Altro Altri errori.

Codice
d’errore Descrizione Soluzione

SRT-Caller

1001 Errore imprevisto
L’unità potrebbe non funzionare normalmente. Spegnere e
riaccendere l’unità.

1002 Comunicazione disconnessa a causa di modifiche
alle impostazioni

La comunicazione è stata interrotta perché le impostazioni
sono state modificate.
Ristabilire la connessione.

5001 Errore imprevisto
L’unità potrebbe non funzionare normalmente. Spegnere e
riaccendere l’unità.

5005 Errore di connessione
Controllare che l’impostazione della destinazione della
connessione sia corretta.

5006 Errore di crittografia Controllare che l’impostazione di crittografia sia corretta.

5007 Errore imprevisto L’unità potrebbe non funzionare normalmente. Spegnere e
riaccendere l’unità.5008 Errore imprevisto

5009 Errore di trasmissione
L’unità è stata disconnessa durante la comunicazione.
Controllare la connessione di rete.
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Elenco delle voci di menu

Le seguenti tabelle elencano le voci dei menu dell’unità.

Legenda
“Menu della telecamera” e “menu Web”
●: disponibile
▲: alcune voci disponibili
–: non disponibile

“All File” e “Scene File”
Sì: impostazione salvata in file ALL o in file di scena
No: impostazione non salvata.

“All Reset (except for Network Settings)”
Quando viene eseguito [Reset]> [Reset] > [All Reset (except for Network Settings)] nel menu Web:
Sì: voce inizializzata (escluse le impostazioni di rete)
No: non applicabile

“Network Reset”
Quando viene eseguito [Reset]> [Reset] > [Network Reset] nel menu Web:
Sì: voce inizializzata (impostazioni di rete)
No: non applicabile

“Factory Default”
Sì: ripristino della voce alle impostazioni di fabbrica
No: non applicabile

Shooting

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Sì Sì Sì Sì Sì

ND Filter ● – Sì Sì*1 Sì No Sì

Shutter ● – Sì Sì Sì No Sì

Iris ● – Sì Sì Sì No Sì

Auto Exposure ● – Sì Sì*2 Sì No Sì

White ● – Sì No Sì No Sì

White Setting ● – Sì No Sì No Sì

Offset White ● – Sì No Sì No Sì

Focus ● ▲ Sì No Sì No Sì

S&Q Motion ● – Sì No Sì No Sì

LUT On/Off ● – Sì No Sì No Sì

Noise
Suppression

● – Sì Sì Sì No Sì

Flicker Reduce ● – Sì No Sì No Sì
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Project

Paint/Look

Pan-Tilt

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

SteadyShot ● – Sì No Sì No Sì

[Mode] non applicabile*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] non applicabile*2

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● Sì No Sì No Sì

Rec Format ● ● Sì No Sì*1 No Sì

Cine EI/Flex.ISO
Set

● – Sì No Sì No Sì

Simul Rec ● ● Sì No Sì No Sì

Proxy Rec ● ▲ Sì No Sì No Sì

Interval Rec ● ● Sì*2 No Sì No Sì

Picture Cache
Rec

● ● Sì No Sì No Sì

SDI/HDMI Rec
Control

● – Sì No Sì No Sì

Assignable
Button

● – Sì No Sì No Sì

All File – ● No No No No No

[Frequency] non applicabile*1

[Setting] non applicabile*2

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – No No No No No

Base Look ● ▲ Sì*1 No Sì*1 No Sì*1

Reset Paint
Settings

● – No No No No No

Black ● – Sì Sì Sì No Sì

Knee ● – Sì Sì Sì No Sì

Detail ● – Sì No Sì No Sì

Matrix ● – Sì Sì Sì No Sì

Multi Matrix ● – Sì*2 Sì*2 Sì No Sì

dati LUT importaiti come look di base non applicabile*1

[Axis] non applicabile*2
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TC/Media

Monitoring

Audio

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● No No Sì No Sì

P/T
Acceleration

● ● No No Sì No Sì

P/T Range
Limit

– ● No No Sì No Sì

P/T Direction – ● No No Sì No Sì

P/T Preset – ● No No Sì No Sì

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – Sì*1 No Sì No Sì

TC Display ● – Sì No Sì No Sì

Users Bit ● – Sì*1 No Sì No Sì

HDMI TC Out ● – Sì No Sì No Sì

Clip Name
Format

● – *2 No Sì No Sì

Update Media ● – No No No No No

Format Media ● – No No No No No

Media Life ● – No No No No No

[Setting] non applicabile*1

[Auto Naming] applicabile, [Camera ID] non applicabile*2

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output Format ● ● Sì No Sì No Sì

Output Display – ● Sì No Sì No Sì

Display On/Off ● – Sì No Sì No Sì

Video Signal
Monitor

● – Sì No Sì No Sì

Marker ● – Sì No Sì No Sì

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ Sì No Sì No Sì

Audio
Output ● ▲ Sì No Sì No Sì
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Thumbnail

Technical

Network

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – No No No No No

Set Clip Flag ● – No No No No No

Lock/Unlock Clip ● – No No No No No

Delete Clip ● – No No No No No

Transfer Clip ● – No No No No No

Transfer Clip
(Proxy)

● – No No No No No

Filter Clips ● – No No No No No

Customize View ● – Sì No Sì No Sì

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color Bars ● – *1 No *1 No Sì

Genlock ● – No No No No No

Tracking Data
Output

– ● Sì No Sì No Sì

Tracking Data – ● Sì No Sì No Sì

Tally ● ● Sì No Sì No Sì

Rec Review ● – Sì No Sì No Sì

Zoom ● – Sì No Sì No Sì

IR Remote – ● No No Sì No Sì

RCP/MSU – ● Sì No Sì No Sì

Lens Controller – ● No No Sì*2 No*2 Sì*2

Lens ● – Sì No Sì No Sì

APR ● – No No No No No

[Type] applicabile, [Setting] non applicabile*1

Solo [Setting] applicabile*2

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● No No No No Sì

User – ● No No No Sì Sì

Wired LAN*1 ▲ ● No No No Sì Sì
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Stream

Maintenance

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

File Transfer ● ▲ No No Sì Sì Sì

FTP Server 1 – ● No No Sì No Sì

FTP Server 2 – ● No No Sì No Sì

FTP Server 3 – ● No No Sì No Sì

SSL – ● No No No Sì Sì

SSH – ● No No No Sì Sì

Referer Check – ● No No No Sì Sì

Brute Force Attack
Protection

– ● No No No Sì Sì

Non configurabile mediante il menu della telecamera (solo visualizzazione)*1

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting – ● No No Sì*1 No Sì*1

Video
Stream

– ● Sì No Sì No Sì

Audio
Stream

– ● Sì No Sì No Sì

[NDI|HX] > [License] non applicabile*1

Voce
(livello 2)

Menu della
telecamera

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● No No Sì No Sì

Accessibility – ● Sì No No No Sì

Clock Set ● ● No No Sì*2 No Sì

Reset – ● No No No No No

Hours Meter ● – No No No No No

Information – ● No No No No No

System Log – ● No No No No Sì

HTTP Access
Log

– ● No No No No Sì

Service – ● No No No No No

Software – ● No No No No No

Informazioni di data e ora non applicabili*1

Informazioni di [Time Zone], data e ora non applicabili*2
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Schermata delle impostazioni PTZ AFR

5-041-957-34(1) Copyright 2022 Sony Corporation

Schermata delle
impostazioni Funzione applicabile All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Initial Setup Tutte No No No No No

Framing Tutte No No Sì No Sì

Tracking Operation Tutte Sì No Sì No Sì

Start Position
Impostazione della
posizione iniziale

No No Sì No Sì

Detection Settings Tutte Sì No Sì No Sì

Others Tutte Sì No Sì No Sì

496



Guida

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Impostazioni salvate per le posizioni di preset

“Sì” indica che l’impostazione della posizione di preset viene salvata e “No” indica che non viene salvata.

Impostazioni relative a pan/tilt

Impostazioni relative allo zoom

Impostazioni relative alla messa a fuoco

Visualizzato su Voce Salvato

Pannello di controllo dell’inquadratura della schermata delle
operazioni live

Posizione pan e tilt Sì

[Pan-Tilt Speed] No

[Pan-Tilt] nel menu Web

[P/T Speed] No

[P/T Acceleration] No

[P/T Range Limit] No

[P/T Direction] No

[P/T Preset] > [Pan-Tilt] No

[P/T Preset] > [Default] > [Pan-Tilt Speed Unit] Sì1)

[P/T Preset] > [Default] > [Pan-Tilt Speed for
Separate] Sì1)

[P/T Preset] > [Default] > [Pan-Tilt Time for
Separate] Sì1)

I valori delle impostazioni esistenti al momento del salvataggio della posizione di preset sono salvati come valori di tale posizione di preset. Dopo il salvataggio, i
valori potranno essere modificati per ciascuna posizione di preset. Per informazioni dettagliate, vedere “Modifica della velocità di transizione (pan-tilt/zoom/fuoco)
durante il ritorno a una posizione di preset”.

1)

Visualizzato su Voce Salvato

Pannello di controllo dell’inquadratura della schermata delle operazioni
live

Posizione dello zoom (distanza di messa a
fuoco)

Sì

[Zoom Speed] No

[Pan-Tilt] > [P/T Preset] > [Default] nel menu Web
[Zoom Sync] Sì1)

[Zoom Speed] Sì1)

[Technical] > [Zoom] nel menu della telecamera. [Zoom Type] No

I valori delle impostazioni esistenti al momento del salvataggio della posizione di preset sono salvati come valori di tale posizione di preset. Dopo il salvataggio, i
valori potranno essere modificati per ciascuna posizione di preset. Per informazioni dettagliate, vedere “Modifica della velocità di transizione (pan-tilt/zoom/fuoco)
durante il ritorno a una posizione di preset”.

1)

497



Argomento correlato
Modifica della velocità di transizione (pan-tilt/zoom/fuoco) durante il ritorno a una posizione di preset

5-041-957-34(1) Copyright 2022 Sony Corporation

Visualizzato su Voce Salvato

Pannello dell’immagine telecamera della schermata
delle operazioni live

Soggetto specificato per il seguimento della funzione Realtime
Tracking AF

No

Coordinate specificate per la messa a fuoco spot No

Scheda  (Focus) della schermata delle operazioni
live

Selettore [Touch Focus] No

Selettore [Auto Focus] Sì

Stato pulsante [Focus Hold] No

Stato pulsante [Push AF/MF] No

[Face/Eye Detection AF] Sì

[AF Subj. Shift Sens.] Sì

[AF Transition Speed] Sì

Posizione di messa a fuoco Sì1)

[Shooting] > [Focus] nel menu Web

[Push AF Mode] (comprese le impostazioni tramite pulsanti
programmabili)

No

[Touch Function in MF] No

[AF Assist Control] No

[Pan-Tilt] > [P/T Preset] > [Default] nel menu Web
[Focus Recall] Sì2)

[MF Speed] Sì2)

[Shooting] > [Focus] nel menu della telecamera.

Dimensioni e posizione dell’area di messa a fuoco impostate
utilizzando [Focus Area]

Sì

Posizione dell’area di messa a fuoco impostata utilizzando
[Focus Area (AF-S)]

Sì

Non ripristinata quando il selettore [Auto Focus] si trova sulla posizione On. Ripristinata quando impostato su Off.1)

I valori delle impostazioni esistenti al momento del salvataggio della posizione di preset sono salvati come valori di tale posizione di preset. Dopo il salvataggio, i
valori potranno essere modificati per ciascuna posizione di preset. Per informazioni dettagliate, vedere “Modifica della velocità di transizione (pan-tilt/zoom/fuoco)
durante il ritorno a una posizione di preset”.

2)
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Diagrammi a blocchi

Audio Input

Audio Output

5-041-957-34(1) Copyright 2022 Sony Corporation
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Aggiornamento del software di un obiettivo con innesto E-mount

L’unità consente di aggiornare il software di obiettivi con innesto E-mount.
Fare riferimento al sito Web dell’obiettivo per informazioni sugli obiettivi che possono essere aggiornati e per ottenere il necessario
software.
Il software viene aggiornato utilizzando il menu Web.

Nota

Non eseguire le seguenti azioni fino alla conclusione dell’aggiornamento.
Scollegare la rete
Rimozione dell’obiettivo
Spegnere l’alimentazione

Se viene visualizzato un messaggio che indica che l’aggiornamento non è riuscito, controllare la descrizione visualizzata e provare a ripetere
l’aggiornamento.

5-041-957-34(1) Copyright 2022 Sony Corporation

Montare un obiettivo E-mount sull’unità.1

Controllare [Maintenance] > [Information] > [Lens] > [Model Name] e [Version Number] nel menu Web.

Il numero della versione software dell’obiettivo E-mount viene visualizzato sul lato.
Controllare il numero di versione del software e quindi aggiornare il software se necessario.

2

Scaricare il file di aggiornamento del software dell’obiettivo (per Windows, con estensione .exe) sul dispositivo che
esegue l’app Web.

3

In [Maintenance] > [Information] > [Lens] > [Version Up], premere il pulsante [Choose File] e selezionare il file di
aggiornamento che è stato scaricato.

4

Seguire le istruzioni indicate a schermo.5
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Montaggio della protezione del pulsante di sblocco dell’obiettivo

È possibile impedire la rimozione involontaria dell’obiettivo montando l’apposita protezione sul pulsante di sblocco dell’obiettivo fornita
con la staffa per montaggio a soffitto CIB-PCM1 (opzione).

Nota
Questo non impedisce completamente la rimozione dell’obiettivo.

Argomento correlato
Montaggio dell’obiettivo

5-041-957-34(1) Copyright 2022 Sony Corporation

Montare l’obiettivo.

Per informazioni dettagliate sul come montare un obiettivo, vedere “Montaggio dell’obiettivo”.

1

Spostare la levetta di blocco pan/tilt sulla posizione LOCK per bloccare il movimento di rotazione e inclinazione del
corpo della telecamera.

2

Spostare il corpo della telecamera su una posizione che consenta il montaggio della protezione contro lo sblocco
dell’obiettivo.

3

Montare la protezione contro lo sblocco sul pulsante di sblocco dell’obiettivo.4

Assicurare la protezione contro lo sblocco dell’obiettivo con l’apposita vite di fissaggio.5
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Licenze

Licenza MPEG-4 AVC Patent Portfolio

QUESTO PRODOTTO È SOGGETTO A LICENZA AVC PATENT PORTFOLIO PER USO PERSONALE E NON COMMERCIALE DEL
CLIENTE O ALTRI USI PER I QUALI NON SI RICEVE ALCUN COMPENSO PER
(i) CODIFICARE VIDEO IN CONFORMITÀ ALLO STANDARD AVC (“AVC VIDEO”) E/O
(ii) DECODIFICARE AVC VIDEO CODIFICATO DA UN CLIENTE IMPEGNATO IN ATTIVITÀ PERSONALE E/O OTTENUTO DA UN
PROVIDER VIDEO CON LICENZA PER FORNIRE AVC VIDEO.
NESSUNA LICENZA È CONCESSA O È DA RITENERSI IMPLICITA PER ALTRO USO. ULTERIORI INFORMAZIONI SONO
DISPONIBILI PRESSO MPEG LA, L.L.C. VISITARE IL SITO HTTP://WWW.MPEGLA.COM

Ottenere software sotto licenza GPL/LGPL

Questo prodotto utilizza software a cui si applicano le licenze GPL/LGPL. Questa nota ha lo scopo di informare l’utente del suo diritto
di accesso, modifica e ridistribuzione del codice sorgente per tali programmi software secondo le condizioni stabilite dalle licenze
GPL/LGPL.
Il codice sorgente è fornito su Internet. Per il download, utilizzare il seguente URL e seguire le istruzioni.
https://oss.sony.net/Products/Linux/
Preferiremmo non essere contattati relativamente al contenuto del codice sorgente.

Codice sorgente μT-Kernel

Questo prodotto utilizza il codice sorgente di μT-Kernel sotto T-License 2.1 concessa da TRON Forum (www.tron.org).

CONTRATTO DI LICENZA PER L’UTENTE FINALE

Iniziando a utilizzare questo prodotto, l’utente accetta i termini del contratto di licenza del software.
Il contratto di licenza del software tra il cliente e Sony è disponibile sul nostro sito Web (https://rd1.sony.net/help/di/el23/h_zz/).

5-041-957-34(1) Copyright 2022 Sony Corporation
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Specifiche tecniche

Generale

Peso
Circa 4,6 kg (solo corpo)
Circa 6,0 kg (con obiettivo SELP28135G)

Dimensioni
Vedere “Dimensioni esterne”.

Alimentazione
19,5 Vcc
PoE++ (conforme a IEEE802.3bt, Type 4, Class 8)

Potenza assorbita
19,5 Vcc: 80,0 W (max.)
PoE++: 71,3 W (max)　

Temperatura di funzionamento
Da 0 °C a 40 °C

Temperatura di conservazione
Da −20 °C a +60 °C

Formato di registrazione video
XAVC Intra
Modalità XAVC-I 4K/QFHD: VBR, bit rate 600 Mbps (max), MPEG-4 AVC/H.264
Modalità XAVC-I HD: CBG, 223 Mbps (max), MPEG-4 AVC/H.264

XAVC Long
Modalità XAVC-L QFHD: VBR, bit rate 150 Mbps (max), MPEG-4 H.264/AVC
Modalità XAVC-L HD 50: VBR, 50 Mbps (max), MPEG-4 H.264/AVC
Modalità XAVC-L HD 35: VBR, 35 Mbps (max), MPEG-4 H.264/AVC

Formato di registrazione audio
LPCM 24 bit, 48 kHz, 4 canali

Frequenza di fotogrammi di registrazione

XAVC Intra
Modalità XAVC-I 4K: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
Modalità XAVC-I QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Modalità XAVC-I HD: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
Modalità XAVC-L QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Modalità XAVC-L HD 50: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
Modalità XAVC-L HD 35: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Tempo di registrazione e/o riproduzione
XAVC Intra
Modalità XAVC-I QFHD: 59.94P, circa 30 minuti (con CEA-G160T)
Modalità XAVC-I HD: 59.94P, circa 78 minuti (con CEA-G160T)
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XAVC Long
Modalità XAVC-L QFHD: 59.94P, circa 115 minuti (con CEA-G160T)
Modalità XAVC-L HD 50: 59.94P, circa 155 minuti (con CEA-G80T)
Modalità XAVC-L HD 35: 59.94P, circa 210 minuti (con CEA-G80T)

Nota
I tempi di registrazione e riproduzione potrebbero variare a seconda delle condizioni di utilizzo e delle caratteristiche della memoria. I tempi di
registrazione e di riproduzione si riferiscono alla registrazione continua di un unico clip. I tempi effettivi potrebbero essere inferiori a seconda del
numero di clip registrati.

Sezione azionamento pan/tilt

Velocità minima di rotazione orizzontale (pan): 0,02 gradi/sec.
Velocità minima di rotazione verticale (tilt): 0,02 gradi/sec.
Velocità massima di rotazione orizzontale (pan): 60 gradi/sec.
Velocità massima di rotazione verticale (tilt): 60 gradi/sec.
Estensione di rotazione orizzontale (pan): da −170 gradi a +170 gradi.
Estensione di rotazione verticale (tilt): da −30 gradi a +195 gradi.
Classificazione del criterio di rumorosità: NC35 o inferiore
Posizioni preselezionate (preset): 100

Sezione telecamera

Dispositivo di imaging
Sensore CMOS Exmor R, 35mm full frame (35,6 × 23,8 mm)

Numero di pixel
Circa 12,9 megapixel (pixel totali)
Circa 10,3 megapixel (pixel effettivi)

Messa a fuoco automatica
Metodo di rilevamento: Rilevamento di fase/rilevamento del contrasto

Filtri ND interni
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
ND a variazione lineare: Da 1/4ND a 1/128ND

Sensibilità ISO
ISO 800/12800 (modalità Cine EI, sorgente di illuminazione D55)

Innesto obiettivo
E-mount

Latitudine
15+ stop

Velocità otturatore
Da 64F a 1/8000 sec. (23.98P)

Angolo otturatore
Da 5,6° a 360°, da 2 a 64 fotogrammi

Slow & Quick Motion
XAVC QFHD: Da 1 fps a 120 fps
XAVC HD: Da 1 fps a 240 fps
XAVC 4K: Da 1 fps a 60 fps
XAVC HD (S35): Da 1 fps a 120 fps
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Bilanciamento del bianco
Da 2000 K a 15000 K

Guadagno
Da −3 dB a +30 dB (in incrementi di 1 dB)

Look di base
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Sezione audio

Frequenza di campionamento
48 kHz

Quantizzazione
24 bit

Risposta di frequenza
Modalità MIC ingresso XLR: Da 20 Hz a 20 kHz (±3 dB o inferiore)
Modalità LINE ingresso XLR: Da 20 Hz a 20 kHz (±3 dB o inferiore)

Gamma dinamica
Modalità MIC ingresso XLR: 80 dB (tipico)
Modalità LINE ingresso XLR: 90 dB (tipico)

Distorsione
Modalità MIC ingresso XLR: 0,08% o inferiore (livello di ingresso −40 dBu)
Modalità LINE ingresso XLR: 0,08% o inferiore (livello di ingresso +14 dBu)

Sezione ingressi/uscite

Ingressi
DC IN

Conforme a EIAJ, 19,5 Vcc

AUDIO IN

Tipo XLR, 5 pin, femmina
Selezionabile LINE / MIC / MIC+48V
MIC: Riferimento da −30 dBu a −80 dBu

GENLOCK IN

Connettore BNC, 1,0 Vp-p, 75 Ω

TC IN

Connettore BNC

Uscite
SDI OUT

Connettore BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Connettore tipo A

Connettore di uscita OPTICAL

Conforme a SFP+
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* L’unità non supporta l’ingresso di segnale ottico.

Ingressi/uscite
Connettore LAN

RJ-45, 1000BASE-T

Connettore OPTION

Connettore di ingresso/uscita tally (RJ-45)

Sezione slot supporti di memoria

Slot per schede CFexpress Type A / SD (2)

Accessori forniti

Adattatore CA (1)
Cavo di alimentazione (1)
Telecomando a infrarossi (1)
Coperchietto del corpo (1) (montato sull’unità)
Piastrina di fissaggio cavo HDMI (1)
Prima di usare l’apparecchio (1)
Libretto di garanzia (1)

Dimensioni esterne

Le dimensioni indicate sono approssimative.
Unità: mm

Corpo della telecamera
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Staffa per montaggio a soffitto

Design e caratteristiche tecniche soggette a modifiche senza preavviso.

Vite per treppiede*1
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Marchi di fabbrica

 è un marchio di Sony Group Corporation.
XAVC e  sono marchi registrati di Sony Group Corporation.
I termini HDMI e HDMI High-Definition Multimedia Interface e il logo HDMI sono marchi o marchi registrati di HDMI Licensing
Administrator, Inc. negli Stati Uniti e in altri paesi.
Microsoft e Windows sono marchi di fabbrica o marchi registrati di Microsoft Corporation negli Stati Uniti e/o altri paesi.
Mac e macOS sono marchi registrati di Apple Inc. negli Stati Uniti e in altri paesi.
Il logo “Catalyst Browse” è un marchio o un marchio registrato di Sony Group Corporation.
IOS è un marchio o un marchio registrato di Cisco negli USA e in altri paesi ed è utilizzato su licenza.
iPadOS, Safari e iPad sono marchi di Apple Inc., registrati negli Stati Uniti e in altri paesi e regioni.
Android e Google Chrome sono marchi o marchi registrati di Google LLC.
Wi-Fi è un marchio registrato di Wi-Fi Alliance.
Il logo SDXC è un marchio di SD-3C, LLC.
CFexpress e il logo CFexpress Type A sono marchi registrati di CompactFlash Association.
NDI® è una tecnologia di connettività video ed è un marchio registrato di Vizrt NDI AB negli Stati Uniti e in altri paesi.
JavaScript è un marchio registrato o un marchio di Oracle Corporation e/o delle sue affiliate negli Stati Uniti e in altri paesi.
Intel, il logo Intel e Intel Core sono marchi di Intel Corporation o delle sue società controllate.
QR Code è un marchio di fabbrica di Denso Wave Inc.
DaVinci Resolve è un marchio registrato di Blackmagic Design Pty. Ltd.
Altri nomi di società o prodotto sono marchi o marchi registrati dei rispettivi detentori. In questo documento i marchi non sono
contrassegnati dai simboli ™ o ®.
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